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About this guide

This guide is for the systems integrator who is responsible for installing and configuring system software.

This document is part of the Niagara Enterprise Security technical documentation library. Released versions of
this software include a complete collection of technical information that is provided in both online help and
PDF formats.

The topics and procedures describe how to install and configure the software. Some procedures require
Workbench. Others require the web Ul. Most apply equally to single (stand-alone) controller systems and
company-wide systems where controllers are joined and subordinate to a Supervisor station. Procedures that
apply to only stand-alone or company-wide systems are noted in the text.

Document change log
This topic summarizes the changes made to this document.

March 21, 2025
¢ Updated the guide to include the "NAC Controller" related topics.
* Added new "Note" in the "Creating and updating the HSQL database password" topic.

June 1, 2023
Edited "Creating and updating the HSQL database password" topic in the "Controller Commissioning"
chapter.

November 3, 2022
Made changes to “Access Rights” topic for clarification.

August 3, 2022
Updated “Personnel data from the LDAP server” chapter.

June 9, 2022

Edited Access Right topic in the “Controller setup, users and schedules map” chapter for access right for
tenant.

July 31, 2021

Added “Configuring Asure ID secure communication” to the “Personnel setup chapter” and updated “Photo
ID configuration troubleshooting” in the “Maintenance” chapter.

January 20, 2021
Added a section titled “Mobile intrusion keypad setup” to the “Intrusion zone management” chapter.

Added the topic “Adjusting controller memory” to the “Troubleshooting” section of the “Maintenance”
chapter.

June 29, 2020
Added information about network ports when using fox streaming to deliver video content.

June 5, 2020
Added information specifying that the mySql Connector/J must be renamed when installed.

April 23, 2020
¢ Added information about securing browser communication with a camera using certificates.

® Added a section in troubleshooting for failure to connect to a remote camera.

¢ Significantly edited the “Video Installation” chapter, adding the Maxpro driver, removing Web Start, and
adding HTMLS streaming.
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¢ Updated the Axis and Milestone sections in the “Video Installation” chapter.
* Added Certificate Wizard information.

¢ Updated the New Camera window and Axis Video Camera tab in the Axis section of the “Video
Installation” chapter.

¢ Significantly upgraded the Photo ID section in the “Personnel setup” chapter, including setting up users
when oBIX is used as a server.

¢ Added best practice information to “System Security” chapter regarding the security benefits of changing
certificates frequently.

¢ Added a topic titled “Configuring the WebService for Easy Lobby.”

¢ Added a step to “Preparing a MySQL database” for renaming the Connector/J and added a
troubleshooting Q and A related to the Connector/J name.

August 8, 2019

* Reorganized document and added updates related to Niagara 4.8 release.

* Updated procedure for creating MySQL database to include creating a user other than “root.”
* Removed references to the system passkey, which is no longer required.

October 9, 2018

Minor editorial updates.

September 17, 2018

Initial release for version 2.4

Related documentation
Several documents provide additional information about this software.

* Niagara Enterprise Security Facility Manager's Guide
* Niagara Enterprise Security Reference

* Niagara Enterprise Security Operator's Guide

® Niagara Station Security Guide

® Niagara FIPS 140-2 Configuration Guide

e JACE-8000 Install and Startup Guide

* Niagara Graphics Guide

® Niagara Video Framework Guide
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Chapter 1. About this system

The Enterprise Security system provides the hardware and software to integrate a building’s access control
devices. Depending on the system, the devices may include controllers connected to badge readers, displays
and keypads, motion detectors, video cameras, other sensors, fire alarms, and more.

Features

Figure 1. Integrating video and graphics support
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As the industry’s leading facility management software platform, this system, built on the Niagara
Framework®, provides exceptional interoperability within traditional secure environments. It extends easily
and integrates with many diverse facility systems, including environmental controls, lighting, energy
management, fire and video, to create a unified, intelligent building.

The system is scalable from single-door solutions to multi-building and multi-campus deployments. It provides
control and alarm supervisory and management functions through a browser-based interface that allows
authorized users (based on password and privilege level) to carry out system configuration and management
functions.

Stand-alone controllers may be added to the system, as needed over time, while monitoring and
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administration follows a hierarchical model built around Supervisor, peer, and subordinate relationships.

Feature Description

Networking * Features open solution-connectivity via oBIX, BACnet, SNMP, Modbus, and other non-
proprietary protocols
* Provides a distributed architecture with high availability at remote locations.
Interfaces

* Provides a web-based interface that is easily managed via a standard browser providing a
common GUI experience regardless of manufacturer or protocol. This interface includes all
the relevant building access features.

¢ Includes a general-purpose building automation tool,Workbench, which offers additional
features, such as sophisticated graphics, and general-purpose building automation tools.

Data collection
and reporting

Collects historical data and events with powerful ad-hoc reporting for on-screen viewing or
exporting to PDF or CSV format.

* Provides real-time data on graphical floor plans, historical data, events in tables and
customized reports.

Scheduling Provides calendar functions and scheduling tools.

Access and Enables company-wide configurations with access and intrusion zones that span multiple controllers.
intrusion zones

Threat-level

management

Diagnostics Includes remote diagnostics and provisioning tools for servicing the system.

Documentation Includes context-sensitive online documentation.

Stand-alone installation

A single controller managing multiple doors and other hardware provides a cost-effective solution for small
companies, schools and other institutions. It differs from a company-wide installation in that it does not require
a Supervisor computer.

To install a stand-alone controller (platform), commission it, and to create a station, the installer uses
Workbench running on a PC, which is temporarily connected to the same network as the controller.

Access to the station for the purpose of monitoring alarms and performing routine maintenance requires any
device (computer, laptop, tablet, or smartphone) connected to the network that is capable of running a
browser. The first time you access each platform and station, a Guided Setup Wizard prompts you through the
post-software-installation and configuration process.

These features are not available for stand-alone controllers:

¢ Integrated Photo ID for badges

e LDAP integration for authenticating employees

® The use of a Milestone XProtect Corporate driver to provide video surveillance

Other feature limitations that require Workbench for both the Supervisor and controller include:

* Integrated programming that requires a wire sheet
e The setting up of non-Boolean schedules
* The customizing of door sequence operations that require a wire sheet

Many factors impact the network, including the number of devices, the frequency of processing transactions,
and the size and frequency of generated reports. When a large installation operates on a stand-alone platform
without a Supervisor PC, performance may be impacted. Although metrics are available, it is very difficult to
establish a rule of thumb to work in every situation. The more you add to the installation, the higher the risk of
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impacting key functions, such as access validation, alarming, and card management.

Company-wide installations

A network of, potentially, hundreds of controllers meets the needs of large companies and government
agencies. This type of installation includes at least one Supervisor PC.

PCs, tablets and mobile phones—any client device that can run a browser can manage a system network.

Figure 2. Company-wide network architecture
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Reader modules and eight input/output modules connected to a single controller can provide a total of 32 card
readers and an additional 64 input and 64 output monitoring points. These key components are connected to
the controller across an RS-485 network. The controller exposes the system to web browsers, other controllers,
and one or more Supervisors when configured as part of a network.
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Software installation involves installing Workbench on the Supervisor PC followed by using Workbench to
commission each remote controller and create each remote station.

Once the software is installed, the system, running in a browser, provides access to the Supervisor platform
and station, and to each controller platform and station. The first time you access each platform and station, a
Guided Setup Wizard prompts you through the post-software-installation and configuration process.

Platform (host), station, client, server

A system network includes a station running on the Supervisor PC, and at least one station running on a
controller with reader modules and input/output modules attached.

Connections among system entities are frequently referred to using the standard network terms of client and
server. A clear understanding of these terms is important for solving networking issues and ensuring
communication security.

e Workbench is always a client.

* A platform provides the hardware foundation for the software interface. A platform runs basic software. It
may be a PC localhost or a remote controller, such as a JACE.

A platform (controller or Supervisor PC) is always a server. A host is another name for a platform.

* A station consists of the system software and an HSQL database. A station runs the software providing
access for client browsers to view and control system components.

A station may be a client or a server. A station, running on any type of controller or Supervisor platform
performs all control logic and stores information including: card holder data, configuration data, system
activity logs, and system relational hierarchy data

Software

The system’s software includes operating systems, browsers, relational databases and video drivers. Some
software modules run on the controller and others on the Supervisor PC.

System/driver Supported Comments
Operating system for the Supervisor ~ Windows 10 x64 From the release of Niagara 4.9, the following
station operating systems are no longer supported:

Windows 2016 x64
Windows 7 x86

Windows 2019 x64
Windows 7 x64
Windows 8.1 x86
Windows 10 x86
Windows Server 2012 x64

Controller stations run under the QNX
operating system, which is provided.

Browser for the Supervisor station Internet Explorer 6.1 and later For configuration only, use Workbench and
Niagara Web Launcher. The Web Launcher
Mozilla Firefox 5.0 and later application supports any browser view that

requires the WebApplet.

Niagara Web Launcher Google Chrome 75 supports only the
monitoring and loading of HTML

Google Chrome 79 .
views.
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System/driver Supported Comments
JRE Plug-in for browsers (applicable to Oracle Java Version 8, update 241
the WebApplet environment) High-level sanity test done with the

latest JRE8 update 212 dated 18 April

2019.

Web Launcher supports both 32-bit
and 64-bit JRE.

Relational database in a Supervisor MySQL From the release of Niagara 4.9, the following
station database versions are no longer supported:
MS SQL Server 2016
MS SQL Server 2012
MS SQL Server 2017
Oracle 11g

MySQL 8.0 is supported but was not
tested.

Controller stations use an HSQL
database, which is provided.

Video drivers nAxis: Axis Video Driver Milestone Professional plus (Xprotect
Professional) NVR Version 2018 R3 Build: 5924

nMilestone: Milestone Video driver and 2009 R2
(Professional and Professional plus

editions) Milestone Xprotect Corporate NVR

Version: 2019 R3 13.3a Build 44

Milestone Xprotect Video driver
)Professional plus and Corporate
editions)

Controller, options and modules

The heart of the system is a JACE-8000 controller that manages access to a facility by locking or unlocking
doors depending on the data received from a badge via a badge reader. The controller processes information
that it receives from all physical devices and the data stored in the system database.

The system supports both hardware and software modules. Hardware modules are add-on units that expand
the capabilities of a given controller:

Model/option Supported Comments
JACE platforms JACE-8000 all-in-one controller provides access control, HVAC,  Security JACE 602/616 with Niagara
and video from a single device. Enterprise Security 2.3 can join to a

Niagara Enterprise Security 4.9
Supervisor and replicate.

Option cards Dual RS-485 Option Card for the JACE-8000

NAC Controllers IP Based network integration The supported controllers are Azure
and ZKTeko controllers.

Refer to the hardware documentation to determine how many and which hardware modules your controller(s)
need.

Software modules are programs (.jar files) that reside in the system’s modules folder. Software modules may
require licensing.
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Equipment

In addition to controllers, a system consists of a group of devices that work together. These devices can
include badges, readers, intrusion detection devices, fire alarm devices, motion detectors, video cameras, and
more. The third-party equipment, the number of doors, readers, and other devices impacts the number of
modules, enclosures, power supplies and Supervisor PCs the installation needs.

Model/option Supported Comments

Cameras AXIS M5014 Version 5.50.3.1 FFmpeg video on 64-bit clients

AXIS M1065-L Version 7.20.1

AXIS 215 PTZ Version 4.49

Readers Third-party readers come in a variety of shapes and sizes, with
different features. Some have keypads; others have a weather- These devices detect the

f housing; . . o
proof housing; and so on information on a badge and

transmit it to a controller.
Reader categories identify
devices by their associated
technology, and by the way
they read a badge, such as,
touch, insertion, and swipe.

* Proximity readers require
only that the badge pass
close to the read surface.

* Insertion readers require
the person to insert the
badge into the reader,
often only half way, and
then pull the badge out.

* Swipe readers require
that the badge pass
completely through the
reader.

Badges/cards Third-party cards or badges are supported. The system:

¢ Centrally managed card
holder and credential
database.

* Multiple access cards per
person

* Supports live credential
enrollment from any card
reader.

¢ Provides simultaneous
support for multiple
access card formats.

A variety of possible
technologies and formats
provide badges (also called
cards). Some of the most
common technologies include:

e Bar Code
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Model/option

Elevator control

Door hardware

Remote reader modules

Remote input output modules

Building automation

Supported

Third-party door hardware.

10724, SEC-R2R

10723, SEC-RIO

UL-294 and CE listed systems available for access-control-only
installations

* inputs - DI1 through DIn
* supervised inputs - SI1

About this system

Comments

e Barium Ferrite (BaFa)
* Magnetic Stripe

® Proximity

® Smart Card

e Wiegand (the system
supports Wiegand-style
card readers)

The system uses a door’s latch
or dead bolt to lock and
unlock the door. There are
many types of locking
mechanisms. The most
common include:

e door strikes

* magnetic locks

¢ electric door devices
¢ panic or push bars

DIN-mountable modules that expand
the door reader capacity by two, with
associated supervised inputs and
outputs.

DIN-mountable modules that expand
capacity with eight supervised inputs
and eight relay outputs.

Inputs and outputs are the
physical connections (points)
on controller modules. Two
types of inputs are available
on the modules attached to a
controller.

though Sin: In addition to
being an input, a
supervised input monitors
the state of the wiring
between the controller and
the switch.

Output relays serve multiple
functions, such as controlling
the floors a person may select
when riding in an elevator.
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Inputs
Digital inputs (DI) are devices that monitor the state of electronic contacts. These include three general
devices:

¢ Door sensors are contact devices that monitor the state of a door.
* Exit requests provide access to leave through a door without having to present a badge.

* ADA (Americans with Disabilities ACT) controls can be used with power-assisted doors that open and
close automatically. On the outside of a facility, you can configure such doors to open only when the door
is unlocked (after a validation or during a scheduled unlock period).

® Other inputs include devices that detect a glass break, and motion sensors.

Outputs

Digital outputs (DO) are devices that control door hardware or annunciate an alarm. For example, if a door
contact (input) senses that a door has been held open too long, an output bell or horn can audibly alert
personnel that the door is open. Outputs may turn on and off lights, heaters and air conditioners.

SmartKey devices
These devices provide a keypad and display screen for arming and disarming assigned intrusion zones.

Capacities
The system supports a limited number of devices, users and database records.
Maximum number of ... Server JACE-8000
Personnel 1,000,000 20,000
Card Readers 10,000 32
Access Rights 25,000 250
Schedules 15,000 100
Alarm Capacity 50,000 7,500
Access Zones 25,000 50
Intrusion Zones N/A 25
Intrusion Keypads N/A 6
On-line Historical Records 25,000,000 50,000
Simultaneous system users 25 10
Number of controllers 500 n/a

NOTE: To use the web Ul to check for your software versions, licensed counts and other information, from the
main menu naviagate to Controller/System Setup > Miscellaneous > Controller/Server Maintenance.
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Chapter 2. Setup prerequisites

Before installation, a certain amount of planning is required. This includes surveying the third-party equipment
already in place, determining needed equipment, identifying any additional third-party requirements, and
deciding on names and credentials.

Both hardware and software require configuration and preparation. Before installing software, all controllers,
modules, enclosures and power supplies should be installed. Devices, such as readers and keypads should be
physically installed and connected to the local area network. The following hardware documentation provides
information:

e JACE-8000 Controller (12977) Mounting and Wiring Guide

® Remote 2 Reader Module (10724) Mounting & Wiring Guide.

® Remote 2 Reader Module (10724) Mounting & Wiring Guide.

* Small (10728) Security Enclosure Install Sheet

® Direct I/O-16 Module Installation and Configuration Guide

® Direct I/O-34 Module Installation and Configuration Guide

* Remote I/O Module (T-10-16-485) Mounting and Wiring Instructions
* Remote I/O Module (10723) Mounting & Wiring Guide

Before using the system, make sure that all setup prerequisites are met and that the host platform and system
components are configured properly.

Licensing

Each installation (controller and Supervisor PC) requires at least one valid license file for operation. This file is
specific to the installed platform, which is identified by its host ID that appears in the first line of the license file
(a digitally-signed text/xml file). The system uniquely calculates this ID for each device.

Before licensing each controller, you should license your PC to run the software. This PC may be your
Supervisor PC, or, if you do not require a Supervisor, this is usually a laptop temporarily connected to the
controller or to the network that also serves the controller.

Your purchase of the software starts a license file for the PC that will serve as your Supervisor PC on the
licensing server. This unbound license contains a key (a hexadecimal number). Upon fulfillment of an order, the
licensing server sends this key to you by email.

When you install the software on the PC, the installation program calculates the host ID for the PC. At the end
of installation, an online form that contains the calculated host ID automatically opens. You enter the license
key and item number you received in the email along with your name and email address. Using this self-serve
process, the licensing server immediately finishes (binds) your host ID to your license key and emails the
completed license file back to you as an attachment.

More details about licensing
For more detailed information about licensing your controller or your supervisor, refer to the following topics in
the Workbench online help system:

e JACE-8000 Install and Startup Guide
Preparing for new JACE commissioning
¢ Niagara 4 Installation Guide
Confirm the license
¢ Niagara Platform Guide

Request License
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About the licensing server

Supervisor PC requirements

The software runs on a user-supplied computer providing many of the same functions and benefits that a
remote controller provides. This system may run a Supervisor for managing multiple controllers. In a stand-
alone installation, it is usually a laptop capable of running the software. Compared to a remote controller, a
computer has different requirements and configuration options.

Hardware and operating system
The number of PCs required to serve as system servers depends on the number of remote controllers you

require.

Component 250 or less controllers More than 250 controllers

Processor Pentium IV @ 2GHz Core 2 Duo 2GHz

Memory 16 GB 32/64 GB

Disk Capacity 100 GB 250 GB

Operating System Windows 10 x64 Windows 10 x64
Windows 2016 x64 Windows 2016 x64
Windows 2019 x64 Windows 2019 x64

PC requirements include a working Ethernet adapter with TCP/IP support (browser capable). An Ethernet TCP/
IP connection to a controller is required to install the software and configure properties.

NOTE: An administrator-level Windows user account and password for each server platform are required to
install the system software.

The computer must be connected to the network that includes the remote controllers.

Java
The PC must be running Sun Java Runtime Environment (JRE) version 1.8 or higher.

Browser
Your Supervisor computer must have access the Internet using a supported browser and to your local area
network. The following table includes a list of browser support levels.

Browse Version Support
Mozilla Firefox Version 5.0 and later
Niagara Web Launcher Latest version
Google Chrome Version 79 and later

These browsers allow you to view both applet views and Hx views concurrently.

Upgrading the OS in the Supervisor PC

Before installing the software on your Supervisor computer, upgrade the operating system to the latest
version, and/or download and install the latest security patches for the specific OS that is running on the
Supervisor computer.

Step 1. If you are upgrading the operating system in a computer that already contains a functioning
Supervisor station, back up the station to a safe location before updating the operating system.

CAUTION: Typically, an installation of OS updates or security patches ends with a system reboot.
Please keep this in mind when you install OS updates on a Supervisor computer. Use the backup
feature (System Backups view) to backup your Supervisor station to a safe location, before
installing updates!

Step 2. Download and install the latest security patches for the specific OS that is running on the
computer.
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Step 3. If you are running a firewall, configure it to recognize the station’s port: 3011 or 5011 (if you are
using TLS security).

g Windows Firewall with Advanced Security .

File Action VYiew Help
= 5E =

E7 Inbound Rules

Outbound Rules _
EF',: Connection Sfcuriw Rulec '@Nlagara[} All Yes Allow Mo

Mame Profile Enabled Action Cherricle

» & Monitoring | NiagaraD Properties L= |
| General I Programs and Services | Computers
Protocols and Ports | Scope | Advanced | Users

Protocaols and ports

wf Protocal type: [TCF' "]
Protocol number: =
Local port: [Speciﬂc Parts "]
30N
Bample: 80, 443, 5000-5010
Remote port: [.F'u.ll Ports "]

Example: 80, 443, 5000-5010

Imtemet Control Message Protocaol
{ICMP) settings:

Supervisor database requirement

All installation procedures that employ a true company-wide solution (anything other than a stand-alone
controller) require that, prior to installation, a suitable RDBMS (Relational Database Management System) be
installed and running on the Supervisor computer or available to the software on a remote server. You need
only one SQL (Structured Query Language) server.

Third-party Orion databases

The system requires an Orion database to store people, badges, access rights, tenants, floors and other data.
An Orion database is an open-source RDBMS for managing uncertain data. While any number of databases
may appear as options, and may be used to store data, the system provides licenses for, and has been tested
with the latest versions of these third-party Orion databases:

e MySQL
e Oracle
e MS SqlServer

Secure database connection
To prevent malicious hacker attacks on the database or station, the station must be able to authenticate the
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database server (especially if it is remote) and communication between station and server must be encrypted.

Documentation
Some databases may require additional licensing. For more information, refer to this online documentation.

* MySQL database documentation.

http://dev.mysql.com/doc/
http://dev.mysql.com/doc/refman/5.1/en/installing.html

e SqlServer database documentation.

https://docs.microsoft.com/en-us/sql/sql-server/sql-server-technical-documentation?view=sql-server-2017

https://docs.microsoft.com/en-us/sql/sql-server/install/planning-a-sql-server-installation ?view=sq|-server-2017

Preparing a MySQL database

The MySQL database is an Oracle Corporation RDBMS that requires a GPL (General Purpose License) or
proprietary license.

Prerequisites:
Your computer has access to the Internet. You are preparing a database for the first time.

Step 1.
Step 2.

Step 3.

Step 4.

Step 5.
Step 6.

Step 7.

24

Make a MySQL folder on your desktop or somewhere else on your hard drive.

Download and extract three resources from http://dev.mysql.com (downloading may require
you to create an Oracle Account).

e MySQL Community Server
* Connector/J: for this standardized database driver, scroll down to MySQL Connectors. The

connector may be named mysgl-connector-java-x.x.x.Jjar, where x.x.x is the version
number.

* MySQLWorkbench (For this application, scroll down to MySQL Workbench.)

Run the installer.

Select the Full option, which installs both the server and MySQL Workbench. For Type of
Networking, select Server Computer.

The installer sets up the server and MySQL Workbench.

If possible, verify with the framework release documentation that the version of the Connector/J
you downloaded is compatible with the framework.

Locate and rename the Connector/J to this generic name: mysgl-connector-java.jar.

Copy the renamed Connector/J to your C: \Niagara\Niagara.home\jre\lib\ext folder,
where: C: represents your drive, and Niagara\Niagara home represents the location and
version number of your unique N4 installation.

Use MySQL Workbench to create a new schema (new database) and get it running.
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Make sure that the new schema has a default Charset/Collation of 1atinl, latinl bin, a user
account other than “root,” and a strong password.

NOTE: The MySQL default “root” user connects only to a schema associated with localhost. For
maximum flexibility and security, create a custom user for your schema.

As a minimum, you will need this information to connect from the Supervisor station to the
database:

* Name of the MySQL schema (used in the Database Name property)

* User Name (other than “root”) required to access the schema (used for the User Name
property)
e Password required to access the schema (used for the Password property)

Acquiring an SQL Server Express database
With SQL Server 2016 Express (Microsoft) you can build desktop and small server data-driven applications up
to 10 GB.

Step 1. Navigate to https://www.microsoft.com/en-us/sqgl-server/sqgl-server-editions-
express and download the database.

Step 2. Run the .exe file and follow the installation steps.
For more information, refer to the Microsoft SQL Server Forum.

Result
As a minimum, you will need this information to connect the Supervisor station to this database:

¢ Name of the MSSQL database (used in the Database Name property)
* User Name required to access the MSSQL database (used in User Name property)

* Password required to access the MSSQL database (used as the Password to access the database)

Security requirements

This system requires the latest technology and procedures to prevent malicious attacks. This includes physical
security, running the software on your Supervisor PC behind a firewall, strong password protection, as well as
communications security within each station and between stations.

Physical location
In company-wide installation with multiple routers, controllers and Supervisor PCs, each piece of equipment
needs to be physically secure. Make sure that no casual visitor has access to these pieces of equipment.

Firewall

A firewall program running on the Supervisor computer is highly recommended. Initially, you should disable the
firewall while configuring a new system. After configuration, remember to enable the firewall allowing access
through PC ports as necessary.

User names, passwords, and passphrases

* User names and passwords protect access to platforms, stations, and the Supervisor and controller
databases.

* A passphrase protects the platform’s file system.
All passwords and passphrases are case sensitive.

Best practice: When you receive a new controller, you may choose to power it up and verify that it is functional
before placing it in stock ready to assign to a particular job. At this time, its passphrase and user credentials
may be very generic. You should create stronger passphrases and passwords before installing the controller at
a customer site.
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Secure communication

Two aspects of communication are important: encryption, and server authentication. If either is compromised,
your system becomes vulnerable to an external attack. Without secure communication links, the remote
controllers will not connect to the system station.

PKI (Public Key Infrastructure), which uses certificates to verify server identity and encrypt data transmission,
provides this secure link. If the station’s server certificate is signed by an external CA (Certificate Authority),
such as Verisign and Thawte, EntsecAsurelD should connect to a station without requiring additional
configuration.

NOTE: Having a recognized CA sign the server certificate provides the highest level of PKI security and
requires the least amount of system preparation because the root certificates for recognized CAs already
reside in the client’s Windows trust store.

If, instead of using an external CA, you are your own CA, you use your root certificate to sign each station'’s
server certificate and import it into the station’s User Key Store. Then you import your root CA certificate into
each station’s Windows trust store.

Secure communication is configured with admin privileges using Workbench. The Niagara Station Security
Guide explains how secure communication works and provides procedures for creating and signing certificates,
and for installing certificates (server and signed CA root certificates) in a station.

Caveat

In Niagara 4.9, RTSP (Real Time Streaming Protocol) over TCP (Transmission Control Protocol), which is used
for streaming media servers (video on demand and voice recording), is not secure. It does not use a TLS
connection.

Planning lists

As you prepare for an installation, make a list of the hardware, software, licenses, names and codes you need.
Print out these pages and keep the actual list secure as you work on the system.

The interview
The interview you have with the customer should identify:

* Which door(s) employees use to routinely enter the building

* On what days of the week they routinely enter the building

* During what hours of the day they routinely enter the building
* Person types

¢ Departments

* Names of supervisor personnel

e Card formats

e Facility codes

e Access rights

You will use this information in advance to prepare the system and create a blank template file in Excel, which
the customer can use to provide comma-delimited personnel records. This guide documents how to set up the
system and import the collected personnel data.

Licenses and hardware
System Display Name :

Table 1. Licenses

Description License key Quantity
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Description License key Quantity

Table 2. Hardware

Description Part number Quantity

Table 3. Third-party power supplies and batteries

Description Quantity

Table 4. Doors and readers

Description Module/Location name Door name Associated reader

Table 5. Inputs and outputs

Description Module/Location name Di/Sdi name

System names

Table 6. Network, platform and station names

Network Host

Location IP Address Name

Domain name Platform Passphrase Station Display Name

Table 7. Platform credentials

Platform/
station IP

address  User name Password
or other
name

Supervisor

Controller

Table 8. User names

Cell/
mobile
number

Email

Role User name Password address

Admin

Badge
Operator

Maintenance
Operator

Personnel
Management
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Table 9. Schedule names

Schedule names Days of the week Hours of the day

Company root certificate name:

Table 10. Certificate folder names

Type of folder Location

Root certificate folder
Server CSR folder
Signed CSR folder

Server certificate backup (with private keys)

Table 11. Certificate names

IP

Address,

Display

Name or Server/host cert name CSR name
Domain

name

(Subject)

Table 12. Supervisor station Orion database names and credentials

You need only one of these for a Supervisor station.
Schema/database

Database T Connector/J version User Name Password
My SQL

MSSQL N/A

SQL Server N/A

Express

Table 13. Controller station HSQL database passwords

Each controller should have a unique and strong password to protect its HSQL database.
IP address or Name Password

Installing Workbench

A wizard manages the installation of Workbench and the web Ul. The software installation ZIP file is available
for downloading from your software vendor. This procedure describes how to install Workbench for the first
time on a computer.

Prerequisites:
The PC is connected to the network shared by the remote controller(s). You downloaded the Workbench
installation executable ZIP file and have the necessary license(s) to use the software.

This computer could belong to a systems integrator who connects it temporarily to the network that supports
a stand-alone controller. Or it could be a computer connected to the network and used daily to manage a
complex, company-wide system.

NOTE: The system supports only English. Additional lexicons are available to Workbench users only.

Step 1. Close all open applications.
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Step 2.
Step 3.

Step 4.

Step S.

Step 6.

Extract all files from the software image ZIP file to any folder on your hard drive.

Open Windows Explorer, navigate to the folder you just created, and double-click the
Installer 64.exe file.
The Installation wizard opens.

To begin the installation, click Next, accept the license agreement and click Next.
The wizard collects information with a series of prompts including:

* Where to set up the Niagara Home Folder. This folder defaults to:C: \niagara\niagara
followed by the version numbers. The System Home (Sys Home or niagara_home) is where
the wizard installs Workbench, and from where you use Workbench to commission each
remote controller. The System Home contains the core software modules, the JRE (Java
Runtime Environment), binary executables, and licenses (in the C: \niagara\
niagara[version numbers]\security\licenses subfolder). It contains no
configuration files. Except when upgrading, the runtime files in the System Home are read-
only. Although you may specify another location for the System Home, the default folder is
generally recommended as the remote controllers use this same System Home directory.

To enable Workbench to commission remote controllers (hosts), leave This instance of
. will be used as an installation tool selected.

If you select a different location for the System Home, a confirmation window requests
approval. The Refresh button recomputes the space available statistic, and can be useful if
you change the target drive location from the default C: to another drive partition.

* Where to set up the User Home folder. This location defaults to C: \Programbata\
Niagara4.x\<brand>. This folder contains all configurable data including stations,
templates, registry, logs and other data. Separating data that can be configured from the
software System Home (C:\niagara\niagara) is a security feature of the Niagara Framework
and is designed to prevent unauthorized software manipulation.

* What to define for the system passphrase. You may skip this step and set up the system
passphrase later.

The system uses this phrase (which defaults to the factory default platform password:
Admin12345) to protect sensitive information stored in file systems, and on the SD card in
each controller. The system passphrase encrypts portable files, such as backups and station
copies. You should define a strong system passphrase.

If your installation is licensed for FIPS (Federal Information Processing Standard), the
passphrase must be at least 14 characters including at least one number, as well as lower and
upper case letters.

WARNING: Remember, and store the system passphrase in a safe place. If you lose it, you will
lose access to encrypted data.

¢ Where to install shortcuts.

Depending on each individual installation, the wizard may present additional prompts.

When all information is collected, click Next.
The wizard installs the software and prompts you for what to do next.

The platform daemon is a program that runs independently from the core runtime. It is pre-
installed at the factory on every controller, and runs when the controller boots up. The platform
daemon, locally installed and running on a PC, opens the Workbench client platform connection
to the local (My Host) platform and enables remote client platform connections to the PC.

To continue, click Finish.
Workbench confirms that the software is licensed. This may take a minute or so. After confirming
the license, the wizard closes and, if you configured it to do so, opens Workbench.
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Installing the PC’s license

If you received a license file as an email attachment, installing it is a matter of saving it to the correct System
Home folder.

The System Home folder defaults to the software installation folder: C: \Niagara\MySoftware (where
MySoftware is the version of the system you are installing).

Step 1. Create a subfolder under the 1icenses folder of the System Home, for example, C:\Niagara\
MySoftware\licenses\SupervisorLicenses

Step 2. Copy the tridium.license file to the subfolder you just created.

Managing licenses

The License Manager view allows you to view, upload and remove licenses.

Prerequisites:
The software is installed and configured. You are working in the web Ul.

Step 1. To view access this view, click Controller (System) Setup > Miscellaneous > License Manager
The License Manager view opens.

Step 2. To view a license, click on the hyperlinked file name.
The license file opens in the browser.

Step 3. Toremove a license, click the check box to the left of the license hyperlink and click Delete.

Step 4. To upload a new license, browse for the license in the Upload New license, certificate or lar File
section, and click Upload.

NOTE: If you update your license file you may need to clear your browser cache to view the
updated file. For how to clear the browser’s cache, refer to your browser documentation.
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Chapter 3. Software installation

Installing on a PC or laptop is the first step to configuring a Supervisor platform and station as well as each
controller platform and station.

The big steps are:

1. Install Workbench on a PC (either your PC or laptop for a stand-alone network, or the network's
Supervisor PC for a company-wide network).

Configure and install the certificates required to ensure secure network communication.
Commission and configure one or more controllers.

Set up users, access rights and schedules.

Set up network devices including doors, readers, keypads, etc.

Connect and join one or more controllers to the Supervisor.

NOo kv

Set up personnel and badges.

Getting to know Workbench

Workbench is the name for the framework’s graphical user interface. There are several ways to start
Workbench. Depending on your configuration and licensed features additional information may be required.

Prerequisites:
You are working on a PC.

Step 1. To open Workbench click start and navigate to the Niagara folder.
The Start menu displays the Workbench options.
Step 2. Click on one of the following:

* To open from an Administrator: Command Prompt window, type -- start wb or -sin
the command prompt.

The splash screen opens.

¢ To open with a background command-line console and launch Workbench, click
(Console), type wb at the console command prompt, and press Enter.

Workbench opens with a console, which stays open even if you close the program.
* To openWorkbench and a console, click Workbench (Console).

This opens a command window that immediately launches the program. Closing this
console closes the corresponding instance of Workbench.

¢ Click Workbench alone or double-click its icon on your desktop.
The splash screen opens.

TIP: Opening Workbench with a background console ensures that you (and Technical Support)
have ready access to important diagnostic information in the event that something goes wrong in
the Supervisor platform or station. If you wait until you are already experiencing symptoms before
you open the console, you may miss the opportunity to gather important data.
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If you skipped the passphrase when you installed the software or if your installation requires
FIPS, and the passphrase you created does not meet the FIPS requirementsWorkbench prompts
you to define the passphrase now.

E‘

Update System Passphrase
Workbench was started in FIPS mode but the system passphrase iz not FIPS compliant

The system has detected that your system passphrase is not FIPS compliant. FIPS mode
requires passwords to contain:

- at least 14 character(s)

- at least 1 digit(s)

- at least 1 lower case character(s)

- at least 1 upper case character(s)

Please update your system passphrase,

Current Passphrase:

New Passphrase: & Passphrase does not meet requirements

Confirm Passphrase:

Mote: If you have any existing backups orstations, make a note of the old system
passphrase and store itin a secure location, It may be required to unlock the backups

and stations.
oK Skip

Step 3. Enter the current passphrase (defaults to the platform password for new installations), and create
a new passphrase or skip it again and click OK.
If the platform requires FIPS, skipping this configuration window disables FIPS.

Step 4. If you skipped updating the FIPS passphrase, click File > Non-FIPS Restart.
Workbench starts again and prompts you to confirm that you choose to work without FIPS.

Step 5. Later, to re-enable FIPS, click File > FIPS Restart.
Workbench restarts.

Adding the RDBMS driver

A Supervisor station requires the RDBMS (Relational Database Management System) driver, which supports the
Supervisor station’s database. This driver is not appropriate for a controller station.

Prerequisites:
You are using Workbench connected to a Supervisor PC.

Step 1. Inthe Nav tree, navigate to the Config > Drivers and double-click on the Drivers node.

Step 2. Click the New button on the Driver Manager view.
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The New window opens.

Typeto Add 6 Rdbms Metwork
Mumberto Add |1 [1-100]

0K | Cancel

Step 3. Select the Rdbms Network from the drop-down list and click OK.
A second New window opens.

Mame Type Enabled 7

6 RdbmszNetwork RdbmsMNetwork  true

. Name RdbmsNetwork
. Type Rdbms Network

. Enabled -. true

OK | Cancel |

Step 4. Use this window to give the network a unique name and click OK.

Setting up the Supervisor’s database password

When you upgrade a Supervisor station from AX to N4, the migrator preserves the password for the
Supervisor's third-party database (MySQL, Oracle, MS SqlServer).

Prerequisites:
The third-party database exists in the Supervisor station.

If no database exists in the Supervisor station, create the new database schema and import to the new schema
the database tables that you previously exported.

Step 1. Using a browser (web Ul), make a connection to the station.

Step 2. Click System Setup > Miscellaneous > Configure Database.
The Configure Database view opens to the Database Services tab.

Step 3. Select the Database tab, for example, MySQLDatabase or SqlServerDatabase.
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Step 4.

Step 5.

The selected database (MySQLDatabase or SqlServerDatabase.) tab opens.

fa Home d&d” Monitoring ﬁ Personnel #¥ System Setup Ay Threat Levels

[ Schedules & User Management B= Backups ¥ Remote Devices #F Access Setup #£¥% Intrusion

Configure Database
H save | & Manage Databases B set Orion Database | B8 Restart Station

Database Services MySQLDatabase

Status [{ok} |
Enabled
Fault Cause | |
Health Ok [27-Jun-22 5:09 PM EDT]
Alarm Source Info alarm Source Info 3

|ip:|oca|host |
Host Address B
User Name |MySQLUserName |
Password [seessens
Database Name | myentsec |

Port
Extra Connection Properties| |
Max Active Connections
Peak Active Connections I:l
Active Connections Cl

Confirm that:

* Enabledis set to true.

* Host Address is localhost (for the Supervisor station).
® User Name is correct for the password.

* Database Name matches the name of the database.

To change the Password type a new, strong password and click Save.

The password must contain a minimum of 10 alphanumeric-only characters along with these
special characters: @ # ! $ & + > <] [) (. The password strength check requires at least: 1 digit, 1
upper case character and 1 lower case character.

After making any database change, the framework restarts the station. After the station restarts,
the database should connect using the new credentials, providing data communication from the
newly-connected database.

If Status is {down} and Fault Cause reports that Workbench cannot find the connector even though a connector
isinthe C:\Niagara\Niagara-home\jre\lib\ext folder, make sure that the connector you are using is
compatible with the MySQL software version. For example, version 5 connector will not work with MySQL

version 8.

The User Name to define on the MySQLDatabase tab is the database User Name, not your station's User

name.

34
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Installing Workbench

A wizard manages the installation of Workbench and the web Ul. The software installation ZIP file is available
for downloading from your software vendor. This procedure describes how to install Workbench for the first
time on a computer.

Prerequisites:
The PC is connected to the network shared by the remote controller(s). You downloaded the Workbench
installation executable ZIP file and have the necessary license(s) to use the software.

This computer could belong to a systems integrator who connects it temporarily to the network that supports
a stand-alone controller. Or it could be a computer connected to the network and used daily to manage a
complex, company-wide system.

NOTE: The system supports only English. Additional lexicons are available to Workbench users only.
Step 1. Close all open applications.
Step 2. Extract all files from the software image ZIP file to any folder on your hard drive.

Step 3. Open Windows Explorer, navigate to the folder you just created, and double-click the
Installer 64.exe file.
The Installation wizard opens.

Step 4. To begin the installation, click Next, accept the license agreement and click Next.
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Step 5.

Step 6.

The wizard collects information with a series of prompts including:

* Where to set up the Niagara Home Folder. This folder defaults to:C: \niagara\niagara

followed by the version numbers. The System Home (Sys Home or niagara_home) is where
the wizard installs Workbench, and from where you use Workbench to commission each
remote controller. The System Home contains the core software modules, the JRE (Java
Runtime Environment), binary executables, and licenses (in the C:\niagara\
niagara[version numbers]\security\licenses subfolder). It contains no
configuration files. Except when upgrading, the runtime files in the System Home are read-
only. Although you may specify another location for the System Home, the default folder is
generally recommended as the remote controllers use this same System Home directory.

To enable Workbench to commission remote controllers (hosts), leave This instance of
. will be used as an installation tool selected.

If you select a different location for the System Home, a confirmation window requests
approval. The Refresh button recomputes the space available statistic, and can be useful if
you change the target drive location from the default C: to another drive partition.

Where to set up the User Home folder. This location defaults to C: \ProgrambData\
Niagara4.x\<brand>. This folder contains all configurable data including stations,
templates, registry, logs and other data. Separating data that can be configured from the
software System Home (C:\niagara\niagara) is a security feature of the Niagara Framework
and is designed to prevent unauthorized software manipulation.

What to define for the system passphrase. You may skip this step and set up the system
passphrase later.

The system uses this phrase (which defaults to the factory default platform password:
Admin12345) to protect sensitive information stored in file systems, and on the SD card in
each controller. The system passphrase encrypts portable files, such as backups and station
copies. You should define a strong system passphrase.

If your installation is licensed for FIPS (Federal Information Processing Standard), the
passphrase must be at least 14 characters including at least one number, as well as lower and
upper case letters.

WARNING: Remember, and store the system passphrase in a safe place. If you lose it, you will
lose access to encrypted data.

* Where to install shortcuts.
Depending on each individual installation, the wizard may present additional prompts.

When all information is collected, click Next.
The wizard installs the software and prompts you for what to do next.

The platform daemon is a program that runs independently from the core runtime. It is pre-
installed at the factory on every controller, and runs when the controller boots up. The platform
daemon, locally installed and running on a PC, opens the Workbench client platform connection
to the local (My Host) platform and enables remote client platform connections to the PC.

To continue, click Finish.
Workbench confirms that the software is licensed. This may take a minute or so. After confirming
the license, the wizard closes and, if you configured it to do so, opens Workbench.

Creating a Supervisor station

To create a Supervisor station you use a station-create wizard within Workbench.

Prerequisites:

You are working in Workbench running on a PC.

Step 1. Click Tools > New Station.

36

The New Station Wizard opens.
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Step 2. Enter a Station Name, select NewEntSecSupervisorStationTemplate.ntpl and click Next.
The Next button remains disabled until you give the station a name. This name is usually a
technical name to identify the station. Later you can use the Network TCP/IP Settings view to give
the station a friendly Station Display Name.
The window for configuring the station password opens.

Step 3. Click Set Password, create a strong password, click OK

Step 4. Select copy it to secure platform for “localhost” with Station Copier, and click
Finish.
The wizard creates and copies the Supervisor station and displays Transferring station “[Station
Name]” with two start-up options. These options configure when the station starts. When
installing new software or upgrading existing software the recommendation is to leave these

options enabled. Otherwise you must start the station in the Application Director before you can
connect to it.

Step 5. To continue with the transfer, click Next, followed by clicking Finish.
The wizard asks if you want to open the Application Director.

Step 6. Click Yes and confirm that the station you created is running.

Installing the PC’s license
If you received a license file as an email attachment, installing it is a matter of saving it to the correct System

Home folder.

The System Home folder defaults to the software installation folder: C:\Niagara\MySoftware (where
MySoftware is the version of the system you are installing).

Step 1. Create a subfolder under the 1icenses folder of the System Home, for example, C:\Niagara\
MySoftware\licenses\SupervisorLicenses

Step 2. Copy the tridium.license file to the subfolder you just created.

Opening a platform connection to the PC

Opening a platform connection loads the software and utilities related to managing the software’s interface to
the computer. This connection is required before connecting to a station.

Prerequisites:
Workbench is installed on your PC and running.
Step 1. To open a platform connection to the Supervisor platform (localhost), do one of the following:
* Right-click My Host and click Open Platform. The Connect window opens.

* Expand My Host and right-click the platform and click Connect. The Authentication window
opens.

* Click File > Open > Open Platform. The Connect window opens.
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a\ Open Platform with TLS

Q\

Authentication
Logon required for access

Connect to the host's secure platform daemaon

Session

Type FT Platform TLS Connection

Host |IP localhos

Port 5011

OK | Cancel |

»> G

Realm

Mame

Scheme HTTP-Basic

Credentials

Username MylUserName

password | (TXXTTTXXTIIYN

[#] rememberthese credentials

VASILTDRXETS2.global.ds.honeywell.com

OK | Cancel |

On the left is the Connect window. On the right is the Authentication window. Both windows

assume a secure connection.

Step 2. Enter your computer credentials, enable Remember these credentials, and click OK.
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The Identify Verification window opens with the message: Unable to verify host
identity.

Identity Verification *

A Unable to verify host identity

The supplied certificate could not be validated:

- the certificate was issued for a different address
- the certificate was not issued by a trusted authority

ASMN.1View  PEM View

Properties:

Version w3

Serial Mumber 45 df 05 80 6= bk c% 92 Oa 21 44 37

Iszued By Niagarad

Issuer DN CH=Niagarad,0=Tridium, =035

Subject Hiagarad

Subject DN CH=Niagarad4,=Tridium, =035

Mot Before Tue Oct 23 13:32:02 EDT 2018

Mot After Wed Cct 23 13:32:02 EDT 2019

Key Algorithm R3L

Key Size 2043

Signature Algorithm SHR2S56WITHRSL

Signature Size 256

Basic Constraints Subject Type: End Entity

Key Usage digitalSignature, keyEncipherment

Extended Key Usage TLS Web Serwver Ruthentication ({1.3.6.1.5.5.7.3.1), TLS5 Web Clie
MD5 Fimgerprint 97:3%:2l:0d:3d:2e:78:63:54:02:02:2d:deicB: 04 22

Accept Reject |

An Issued By property that is the same as the Subject property indicates that this certificate
has been signed by its own private key. As a self-signed certificate, it can encrypt data
communication, but it cannot authenticate the server (the platform) to its client (Workbench).
This is because none of the root certificates in the Workbench Trust Store recognize this
certificate. Since you know that the platform is a valid server you can accept the self-signed
certificate temporarily so as to continue. The acceptance of this self-signed certificate is
temporary. Later, you will configure signed certificates that provide server authentication as well
as data encryption without human intervention.

Step 3. To continue, click Accept.
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The system completes making the connection between the host and Workbench, and displays the

Nav Container View.

- Nav
h@ o |? @ My Metwaor
. @ My Host: (entSecSupT

» & My File System
b O My Madules

b ¥ MyTools
© @ Platform
& Station (entSecSupTest_01)
4 192.168.1.10
- Palette
w X 3

Platform

Name

@ Application Director

o Certificate Management
o Lexicon Installer

a License Manager

o Platform Administration
e Station Copier

6 TCP/IP Configuration

a Remote File System

8 cbjects

Description 7
Control applications and access console ow
Manage X.50% Certificates and Host Exempti
Install lexicons to support additional langu:
Manage licenses and certificates

Update the platform daemon's portor cred:
Transfer stations to and from the remote ho
Manage the host's TCP/IP settings

The remote host's file system

Step 4. Double-click the Application Director
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The Application Director view opens.

- Nav Application Director

# '] @ My Netwark Connected to localhost
Name Type  Status  Details Auto-Start Restarto

& My Host: VA51L TDRXETS2.global.c
& My File System

0 My Modules
cp L fnFo [nre] Launching Niagara Buntime Environment E Auto-Start
Mxacs INFQ [15:22:06 06-Jun-19 EDT] [nre] Booting
& Platform INFO [15:22:07 06—Jun-19% EDT] [ay3] Logging initialized E Restarton Failure
INFO [15:22:09% 06—Jun-19% EDT] [ay3.registry] Up-to-date [1
&) application Director INFQ [15:22:09 06-Jun-19 EDT] [sys.registry] Loaded [42ms] Start
INFO [15:22:10 0Og—Jun-19% EDT] [3y3] Niagara runtime booted
©) certificate Management INFO [15:22:10 06-Jun-19 EDT][sys] Lobding "C:\ProgramDat S
) INFO [15:22:12 06-Jun-1% EDT] [sys] Loaded (2718ms) Restart
© Lexicon installer INFO [15:22:13 06-Jun-19 EDT] [alarm.database] Loading... _ Restart |
@Licensel‘v‘lanager INFO [15:22:13 Og-Jun-19 EDT] [alarm.databass] Loaded [Oms Reboot
com.tridium.orion.OrionException: Database ORD not config
o Platform Administration at com.tridium.orion.BAbstractOrionApp.getRdbms (BAbstrac Kill
at com.tridium.orion.BAbstractOrionApp.getOrionDatabase |
e Station Copier at com.tridiumx.entsec.BEnterpriseSecurityService.linkTc Dump Threads
) ) . at com.tridiumx.entsec.BEnterpriseSecurityService.servic
6 tcrip configuration at com.tridium.sys.service.ServiceManager.startService (S Save Bog
at com.tridium.sys.service.ServiceManager.starthllServic _
at com.tridium.sys.station.Station.initServices(Station. Verify Software
* Palette at com.tridium.sys.station.Station.bootStation(Station.]

at com.tridium.sys.station.Station.main({Station.java:ll: L
E] E . Iyt at sun.reflect.NativeMethodRccessorImpl.invokel (Native ¥ Clear Qutput
[ analytics

at sun.reflect.NativeMethodhccessorImpl.invoke (NativeMet e
sun.reflect.DelegatingMethodhccessorImpl. invoke (Deleg p

0 Constant Blocks java.ln_ang.reflect.ﬁetho-d.invoke {HP:t.ho-d.java:aiSSj Output Dialog
com.tridium.sys.Nre.runClass (Nre.java: 398)

0 Filter Blocks com. tridium. sys.Nre.main (Nre.java:233) Stream To File
com.tridium. sys.Nre.bootatrap (Nre.java:150)
ﬂ DeadbandFilter sun.reflect.NativeMethodAccessorImpl. invokel (Native M
. . sun.reflect.NativeMethodAccessorImpl. invoke (NativeMet Output Settings
Q InvalidValueFilter -- - - DR - - =

EMySupervism station Running fox=n/a,fox==4211 http=n/a http=443 true true

Step 5. If you cannot see the station, click the top of the console and drag down.

Step 6. To start the station, click Start.

Setting up domain names
In the absence of a DNS (Domain Name System) server, the system can correlate station IP addresses with
domain names. Domain name connections may be easier to remember than IP addresses.

Prerequisites:
You are connected to a computer and running Workbench.

Step 1. Open Workbench using Run as administrator (right-click the icon on the desktop and click Run as
administrator, or right-click the application in the start menu and click More > Run as
administrator.

Step 2. Inthe Nav tree, expand My File System > C: > Windows > System32 > drivers > etc, right-click
hosts and click AX Text File Editor.
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Step 3.

Step 4.

Step 5.
Step 6.

Step 7.
Step 8.
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The hosts file opens in the AX Text File Editor view editor.

r 127.0.0.1 localhost

192.168.1.9 supervisor.thecompany.lan
192.168.1.10 controller.thecompany.lan

- Nav
I;:B O @Mymc—twnrl-c

Q drivers
QO ave
D DriverData
D en-Us
o es-ES

Views » AX Text File Editor

- AX Text File Viewer
Cut -

~ Hex File Editor
Lopy —
Paste Guide Help

Duplicate Bajadoc Help

Delete Spy Local

FELEN S

Refresh Tree Node

Go Into

Y - [ - [ -

Scroll to the end of the document, place your cursor at the end of the last line and press Enter to
create a new line.

Type a line for each Supervisor and controller:
<999.999.99.99 > where:

® <999.999.99.99> is the IP address on the network of the PC or controller.
® <domainName> is the domain name the system can use to connect to the controller.
There must be at least one space between the IP address and the domain name on each line.

Click the Save button (B ).

To verify that the hosts file contains the domain names, open a platform connection to your
localhost and double-click TCP/IP Configuration.

To open the Hosts File, click the double down arrows ( ¥).

If needed, scroll to the bottom of the file and confirm that the IP addresses are associated with
the correct display names.
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Chapter 4. System security

The system exists to protect buildings and the people who work in them from multiple external threats. This
chapter concerns securing this system itself so that only authorized users may view and configure its
properties, and all communication within the system is protected from malicious activity.

The security of your access system relies on these factors:

* Physical protection: Supervisor stations need to be located in physically secure areas. Controllers need to
be located where they cannot be easily accessed by unauthorized personnel.

¢ Data communication and server authentication should be secured by signed PKI (Public Key Infrastructure)
certificates.

* Passwords need to be robust and changed regularly.

* User permissions need to be configured based on need. Few should serve as administrators with
unfettered access to platforms and stations.

Most of the procedures in the chapter use Workbench running on a PC. Some procedures are also available in
the web UL

Secure communication certificate setup

Secure communication applies to data transmitted among entities, which may be geographically far apart. The
Niagara Framework supports TLS (Transport Layer Security), a cryptographic protocol for server authentication
and secure encryption of data over the Internet. This is the same level of security provided by credit card
companies and banks.

Setting up a secure network involves one or more of these tasks:

¢ Creating folders to organize PKI (Public Key Infrastructure) certificates and certificate signing requests.

e Creating a root CA (Certificate Authority) certificate (if the company serves as its own certificate
authority).

¢ Creating server certificates, one for each PC, controller/station, and other connected device, such as a
camera.

¢ Sending a certificate signing request for each server certificate to a recognized external CA for signing, or
signing the requests in house using the company’s root CA certificate with its private key.

® Matching the signed server certificate requests with the original certificates.
e Configuring each platform/station for secure communication. This step identifies the certificate.

e If the company serves as its own CA, importing its root CA certificate with its public key into the User
Trust Store of each controller and PC, into the Windows trust store, and into the browser trust store.

¢ Confirming the Windows certificate.
* Importing the root CA certificate into the Java Control Panel.

If you can connect to all the subordinate stations and devices in the network, you can perform all of these
steps using Workbench running on a single PC. If the network is geographically distributed, you may need to
transport certificates. You can email the root CA certificate with only its public key. Do not email any certificate
with its private key.

You can also use the Certificate Wizard to create a root CA and server certificates, however, if you are new to

certificate management, work through the individual steps using the Certificate Management tool. This will
give you a better understanding of the steps. Then use the wizard.
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PKI certificates
TLS uses PKI (Public Key Infrastructure) certificates to authenticate each server and encrypt data transmitted
within the system.

Signed certificates
A certificate is an electronic document, signed by a recognized CA (Certificate Authority), which proves to a
network client that the presenting server owns a valid public key.

Figure 3. A signed certificate

CERTIFICATE

Issued By CertificateAuthorityRootCert

Subject 127.65.21.50

Among the many properties in a certificate, a certificate’s Subject identifies the entity to which the certificate
belongs, that is, its owner. This is usually an IP address or a Station Display Name. Its Issued By property
identifies the root certificate of the CA that signed the certificate after verifying the validity of the owner and
the certificate’s key. Without a CA-signed certificate, a client cannot authenticate the server and no
communication should take place.

Some connections occur over a local area network. Others include a browser and the Internet. For
communication to be secure, certificate authentication and encryption is required at each connection step:
device or service through Niagara to another device on the LAN or through a network firewall to a browser
and on to the Internet.

In a LAN, each platform/station can function as a server and as a client. Workbench is always a client. As a
server, each platform/station presents its own signed certificate to the client. As a client, Workbench and each
platform/station authenticate a received server certificate by comparing it with the root CA certificate in the
client's trust store that signed the server certificate.

If a secure network connection cannot be made between server and client, you may temporarily accept the
server'’s self-signed certificate.

In a broader connection that includes the Internet, a remote device, such as a camera is a server that sends live
and recorded video to a client station. The browser in an Internet connection requires that the camera have a
signed server certificate that is recognized by a root CA certificate in its (the browser’s) trust store.

If the camera cannot make a secure browser connection, you may have to temporarily connect using http://. If
you switch from an https:// to an http:// connection, empty the browser’s cache before attempting the http://
connection.

The best practice is to use only server certificates signed by a root CA certificate in the clients’ (station and
browser) trust stores. This chapter explains how to install a server certificate in a station. You install a signed
server certificate in a camera using its configuration web page.
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Self-signed certificates
When you connect to a Supervisor and controller platform/station for the first time using Workbench, the
platform/station, functioning as a server, presents its default self-signed tridium certificate to Workbench.

Figure 4. A self-signed certificate

Identity Verification >

A Unable to verify host identity

The supplied certificate could not be validated:

- the certificate was issued for a different address
- the certificate was not issued by a trusted authority

Properties:

Version w3

Serial Mumber 45 46 05 20 &= bk c9 92 0a 21 44 37
Izzued By Niagarad

|zsuer DN CH=Niagarad,0=Tridium, C=1U5
Subject Niagarad

Subject DM CH=Niagarad, C=Tridium, C=15
Mot Before Toe Oct 23 13:32:02 EDT 2018
Mot After Wed Oct 23 13:32:02 EDT 201%
Key Algorithm RSR

Kew Size 2043

Signature Algorithm SHR2SEWITHRSL

Signature Size 256

Basic Constraints
Keyw Usage

Extended Key Usage
MD5 Fingerprint

Subject Type: End Entity
digitalSignature, keyEncipherment

TLS Web Server RAuthentication (1.3.6.1.5.5.7.3.1), TLS Web Clie
97:39:el:0d:3d:2e:73:63:94:02:02: 2d:deic8:0d: 22

Accept Reject |

You can tell that this server certificate is self-signed rather than CA-signed because its Issued By property and
Subject property are the same. In other words, it signed itself. The system can use this certificate to encrypt
data transmitted between client and server but it cannot use this certificate to authenticate the server. You
manually authenticate the server by accepting this self-signed certificate.

For communication between entities to be secure without human intervention, each platform/station must

present to a client its own signed server certificate, and each client needs a copy of the root CA certificate
used to sign the server certificate so that the client can compare the signatures and verify the server’s identity.
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Each browser you use (which functions as a client) also requires the root CA certificate used to sign the server
certificate(s) sent to it.

After the identity of the server is verified, encrypted communication using the certificate keys begins.

Connections that require security
Many connections within a system require security, including:

¢ Platform/station to Workbench connection (Niagarad)
e Computer to platform (Niagarad)

e Station to local or remote Supervisor (Https)

* Supervisor to local or remote platform/station (Foxs)
* Browser to station (Https)

e Station to station (Foxs)

e Database connection

e Station to DVR/NVR/camera connection (Https)

e Other device connections

¢ LDAP connection

Certificate stores

Each platform and its station share the same set of certificate stores. A certificate store is where the system
and standard Internet browsers keep store certificates.
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Figure 5. Certificate Management stores
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The screen captures show the User Key Store tab for three sets of certificate stores, which you can access from
Workbench.

1. Clicking Tools > Certificate Management opens the Workbench Certificate Management view.
2. Four stores populate each Certificate Management view, each with a tab:
* The User Key Store tab contains the platform/station’s server certificate.
e Each System Trust Store contains the root CA certificates (with only the public key of each) for the
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most common external certificate authorities.

® The User Trust Store tab contains the root CA certificate (with only its public key) of the company when
it serves as its own CA.

¢ The Allowed Hosts tab contains the self-signed certificates that require human verification of their
authenticity.

Icons identify the state of each certificate in the tabs of the Certificate Management view.

e A green shield with a check (tick) mark (%) identifies signed certificates and approved exceptions (self-
signed certificates that have been accepted).

¢ A yellow shield with an exclamation mark (" ") identifies a self-signed certificate. A server certificate is
one of these until it gets signed. The root CA certificate is forever one of these. There is no higher
authority to sign it!

e A red shield with a white X (&) identifies a rejected exception.

3. Expanding the localhost Platform node and double-clicking Certificate Management opens the localhost
(PC) Certificate Management view. These stores belong to a PC’s platform and station.

4. Expanding a controller Platform and double-clicking Certificate Management opens the controller’s
Certificate Management view. These stores belong to a controller platform and station.

The called-out information above explains how to access the Certificate Management stores from each
Workbench and Platform node. The same stores for each platform/station are also available under the Station
node in the Nav tree by expanding Station > Config > Services > Platform Services, and double-clicking
CertManagerService.

To access the same stores using the web Ul, click Controller (System) Setup > Remote Devices > Certificate
Management.

The goal for each platform/station is for its server certificate, which is visible in the User Key Store, to be
signed (green shield) by either a root CA certificate in the System Trust Store or User Trust Store, and for its
Allowed Hosts tab to be empty.

To demonstrate all functions, this chapter assumes you are serving as your own CA (Certificate Authority). The
steps require administrative privileges and use Workbench to create a root CA certificate, export server
certificates, sign server certificate signing requests, import them back into the User Key Store, and import the
root CA certificate into the station’s User Trust Store.

Getting all your PKI certificates configured up front should make life easier when you start configuring network
devices. The Niagara Station Security Guide provides more detailed information about how PKI certificates
work.

Creating certificate storage

The first time you access a Certificate Management view, the system creates an empty certManagement
folder in its User Home (Niagara 4 and later) or Sys Home (NiagaraAX).

Prerequisites:

You have admin privileges and are working in Workbench on a PC (Supervisor or otherwise). All controllers
have been commissioned.

Step 1. To open the Certificate Management tool, click Tools > Certificate Management.
This opens the Workbench the User Key Store.

Step 2. To view the certManagement folder, expand the Nav tree: My Host > My File System > User
Home > certManagement.

Step 3. To create a new folder, right-click certManagement, and click New > New Folder.
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Step 4. Name the folder rootcert.

Step 5. Create two more folders naming them serverCSRs and signedCSRs.

Result
The file system on your PC serves as the central location for setting up PKI certificates.

Figure 6. The central location for certificate management

Certificate Management

Certificate Management [*localhost”
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l:) User Home
Certificate Management D certManagement
Certificate Management for Niag{ Workbench 0
rootcert B =
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To simplify what can be a complex process, this document encourages you to create a root certificate and
server certificate(s) using Workbench and the certManagement folders. If your installation involves a single
controller, you may not need these folders, but in a large company-wide installation, separating the certificates
and CSRs simplifies the task. Using intermediate certificates (refer to the Niagara Station Security Guide) only
increases the complexity making some type of folder structure unavoidable.

Certificate Wizard

The latest Niagara version supports a Certificate Wizard. This wizard, available as a view on the platform root,
provides a complete, continuous workflow that helps you properly set up certificates to harden a platform and
station against cyber attack.

The wizard assumes prior experience in various types of certificate setup and a reasonable level of confidence
in performing such procedures as are commonly done using the Certificate Management tool. That being the
case, you will find that the Certificate Wizard simplifies the certificate setup process for a station by combining
several steps into a continuous workflow. If you are unfamiliar with certificates, work through individual setup
procedures using the Certificate Management tool as described elsewhere in this guide. The individual
procedures will help you gain a better understanding of the steps involved.
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Figure 7. Certificate Wizard platform tool with default selections

Certificate Wizard 4

® options for certificate creation and installation
Certificate checklist

Please select the options below for generating and signing the server certificate foryourtarget host:
E Generate server certificate
[# sign server certificate
@ Sign with local CA certificate Generate New
|z Install CA certificate to target usertrust store
] Export the CA certificate
&> Export CSR forsigning by external CA

[0 Set the minimum TLS level for all services (niagarad, fox service, web service): TLSvl.2

Finish ¥ cancel

Back

As an alternative to using the Certificate Management tabs to create and install a CA root certificate, the
Certificate Wizard generates the root CA certificate and exports it with only its public key in preparation to
install in a browser.

NOTE: The Certificate Wizard is intended to be used for a single platform at a time, not for provisioning
multiple platforms.

The Certificate Wizard may be configured to perform some or all of the following tasks:

* Generate a new root CA certificate on the local host that can be used to sign all server certificates.
e Generate a new server certificate for a host platform.

¢ Sign a server certificate with a new or existing root CA certificate.

* Export a server certificate CSR (signing request) for signing by an external certificate authority.

* Install a root CA certificate into the User Trust Store of a platform/station selected from the daemon
directory.

Once the Certificate Wizard generates the files, they must still be installed into all of the appropriate devices.
This is accomplished via the Certificate Management tool found in the Workbench Tools menu.

Generating a CA certificate and signed Server certificate using the Certificate Wizard

This procedure describes how to use the Certificate Wizard workflow to complete a series of certificate-related
steps for a platform and/or station.

Prerequisites:

You have the required authority to create certificates. You are working in Workbench on a computer that is
dedicated to certificate management, is not on the Internet or the company’s LAN and is physically secure in a
vault or other secure location. You have a thumb drive ready to which to copy the root CA certificate for safe
keeping.

Step 1. In Workbench, open a localhost platform connection and in the Application Director view click
Stop to stop any station that is running.

Step 2. Inthe Nav tree, right-click on the platform and click Certificate Wizard.
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The Certificate Wizard window opens displaying options for certificate creation and installation.

@ options for certificate creation and installation
Certificate checklist

Please select the options below for generating and signing the server certificate foryourtarget host:
[#] Generate server certificate
[ sign server certificate
& Signwith local CA certificate (Generate New
[# Install CA certificate to target user trust store
———f | Export the CA certificate
&> ExportCSR forsigning by external CA

[ Set certificate to be used for niagarad, Foxservice, and web service

—3of | Set the minimum TLS level for all services (niagarad, fox service, web service): TLSv1.2

Back P Next Finish ¥ cancel

Step 3. In addition to the default selections, configure two optional properties.

* To export the root CA certificate with its private key, click on Export the CA certificate. It is
a good idea to back up this certificate for archival storage in a secure location.

¢ To configure the TLS version, Set minimum TLS level for all services > TLSv1.2.

NOTE:

TLSv1.0 and TLSv1.1 are still supported for backwards compatibility, but it is
recommended to use TLSv1.2 and higher.
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Step 4.
Step 5.
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The Configure CA Certificate window opens for you to enter the root CA certificate information.

Mot Before
Mot After

Key Size

Certificate Usage

Alternate Server !

Email Address

Key Usage

ame

Configure CA Certificate >

==| Generate Self Signed Certificate

= | Generates a self signed certificate and inserts it into the keystore

Alias CL Root Cert Acme Ops (required)

Common Mame (CN) Rcme Support Ops (required)
*thiz may contain the host name or address of the server

Organizational Unit(OU) |Rcme Support Ops

COrganization (O) Rcme, Inc. (required)

Locality (L) Richmond

State/Province (ST) Virginia

Country Code (C) Us | (required)

25-Jan-2021 05:43 FM ES5ST
25—Jan-2022 05:43 FM EST

sl Ll

> 1024 bits & 2048 bits <> 3072 bits > 4096 hits

&> Server <> Clien 0 Code Signing

supportlacme. com

[] pigital signature [] Mon-repudiation [] Key encipherment
[] pata encipherment [] Key agreement [#] Certificate signing
CRLsigning [] Encipheronly [] Decipheronly

] ==

In the Configure CA Certificate window, fill in the form, and click OK.

When prompted for a Private Key Password, enter and confirm a strong password (minimum 10
characters, include at least one of each: a number, lowercase, and uppercase character), and click
OK. For example, Privatel23%.
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The software creates the new root CA certificate in the background. When complete, the wizard
opens another Configure CA Certificate window. This one is for the server certificate.

Configure Server Certificate >

Generate Self Signed Certificate
Generates a self signed certificate and inserts it into the keystore

Alias

Common Mame (CN)

Organizational Unit {OU)
COrganization (O)
Locality (L)
State/Province (ST)
Country Code (C)

Mot Before

Mot After

Key Size
Certificate Usage
Alternate Server Mame

Email Address

Key Usage

ServerCerthcmeSup (required)
2eme Support Server Certificate (required)
*thiz may contain the host name or address of the server
LomeSupport

Rcme, Inc. (required)
Richmond

Virginia

Us | (required)

25—Jan-2021 05:25 PM EST
25-Jan-2022 05:25 BM EST

sl Ll

> 1024 bits & 2048 bits <> 3072 bits > 4096 hits

SUppPOrt.acme. com
supportlacme. com

Digital signature D

[] cRLsigning [] Encipheronly [] Decipheronly

OK | Cancel |

Step 6. Inthe Configure Server Certificate window, fill in the form, and click OK.

This process generates a server certificate that is ready to be signed. The platform will never be
a client, but the station will routinely function as a one, and, since the platform and the station

share the same trust store, only one server certificate is required. You will need to run the wizard
again when this certificate expires.
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Server certificate generation occurs in the background. When complete the wizard opens the
Certificate Signing window.

Certificate Signing *

Certificate Signing
Sign a certificate signing request with a selected CA certificate.

Select a certificate signing request to sign:

EerverCertAcmeSup
Properties:
Subject Acme Support Server Certificate
Subject DN C=US,5T=Virginia,L=Richmond,0=Acme\, Inc.,0U=AcmeSupport,CN=
Key Algorithm RSA
Key Size 2048
Signature Algorithm sha256WithRSAEncryption (1.2.840.113549.1.1.11)
Signature Size 256
Extensions:
Identifier: X509v3 Key Usage (2.5.29.15)
isCritical: true

digitalSignature, keyEncipherment
Identifier: X509v3 Subject Rlternative Name (2.5.2%.17)
isCritical: false
E ¥X50%v3 Subject Alternative Name (2.5.29.17)
Acme Support Serwver Certificate
SUpport.acmes . com
supportlacme.com

Identifier: X509v3 Issuer Alternative Name (2.5.29.18)

MotBefore: |25-Jan-2021 05:56 PM EST|4
Not After: 25-Jan-2023 05:56 PM EST|4

CA Alias:

CA Password:

Save As: PEM

0K | Cancel |

NOTE: The server certificate that is about to be signed is already selected. You cannot change the
selection. Also, the root CA certificate and the CA password are already identified. There is no
need to make other selections or entries.

Step 7. In the Certificate Signing window, review the details (similar to the example shown) and click OK
to continue.
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Step 8.

Step 9.

Step10.

March 21, 2025

Since we did not choose to export the CSR, the wizard does not display it but proceeds directly to
import the signed CSR into the Supervisor station’s User Key Store and the new root CA
certificate into its User Trust Store. When complete the wizard opens the Certificate Export
window.

Certificate Export >

Certificate

[#] Exportthe public certificate

TableView = ASN.1View PEM View

Properties:

Version 3

Serial Mumber 43 03 05 93 11 04 a3 91 €= 8a 43 ££

lzsued By CA Root Claires BC

lssuer DN CW=CL Root Claires PC,0U=Tridium TechPuks

0\ Private Key

[#] Exportthe private key

Private Key Password (required): (esssssssse

[#] Encryptexported private key

[#] Reuse password to encrypt private key

0K | Cancel ‘

In the Certificate Export window, in addition to the default selection, click the optional check box:
Export the private key, enter the private key password, and click OK.

By default, the wizard exports the root CA certificate with only its public key. This is appropriate
for distributing the root CA certificate, which must be imported to the User Trust Store of every
platform/station throughout the enterprise, any PC that hosts an instance of the Workbench, and
any browser used to monitor and control the system. You export a root CA certificate with its
private key only for the purpose of backing it up to a secure location.

The wizard opens the Certificate Export window.

Use the folder icon to locate the storage location for the exported root CA certificate in the
localhost file system, such as an added subfolder in your certManagement folder (as shown) or a
thumb drive, and click Save.

Within the certManagement folder, you can create subfolders for storing certificates and
certificate signing requests (CSRs). In the above example, the RootCerts folder is a suitable
location for the root CA certificate with its public key, while the Vault folder simulates a secure
storage location for the root CA certificate with its private key, which should be kept under lock
and key.

On completion, the wizard acknowledges that the export was successful.

To continue, click OK.
The Select Station window opens.
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Step11. In the Select Station window, click the drop-down list of all stations in the Platform Daemon
Home, and select the station to Set the TLS levels on, and click OK.
The wizard displays a progress summary as you complete the various steps.

Step12. When prompted with the message, “All operations are complete”, click OK and Finish.
The wizard modifies the station’s .bog file in the Platform Daemon Home.

Result

The Certificate Wizard successfully generated the new server certificate for the Supervisor PC, and the new
root CA certificate for use in signing other server certificates. Those certificates are exported to the
certManagment folder in the local file system for subsequent use. Additionally, the wizard set the TLS levels on
the selected station to the selected value: TLSv1.2.

Creating a root CA certificate

A company'’s root CA certificate is a self-signed certificate. Companies that serve as their own CA use its
private key to sign their intermediate, server, client and code-signing certificates. The root CA certificate
resides in the Workbench Certificate Management User Key Store with both its public and private keys. You
export it with only its public key so that you can import it into each platform/station’s User Trust Store.

Prerequisites:

You have the required authority to create certificates. You are working in Workbench on a computer that is
dedicated to certificate management, is not on the Internet or the company’s LAN and is physically secure in a
vault or other secure location.

Step 1. Access the Workbench Certificate Management view by clicking Tools > Certificate Management.
The Certificate Management view opens to the User Key Store.

Certificate Management for Niagara Workbench

User Key Store System Trust Store User Trust Store Allowed Hosts
Alias Subject Not After Key Algorithm Key Size Valid i
e  default  Niagara4  19-Sep-20244:10PMEDT  RSA 2048 true
E 2 4 EY + X
New Import Reset

As of Niagara 4.13, the default tridium certificate was replaced by the default certificate,
which has enhanced features and cannot be deleted. The installation of a new Niagara version
will not by default include a tridium certificate, but upgrading a system may have both, the
tridium and the default certificate.

Step 2. Confirm that you opened the Workbench User Key Store and click the New button at the bottom
of the view.

NOTE: If you opened the platform/station Certificate Management view by mistake, you can still
create a root CA certificate, but it will not be available to sign the other certificates.
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The Generate Self Signed Certificate window opens.

E Generate Certificate

Generates a signed or self-signed certificate and inserts it into the key store

General Attributes

Alias @

Distinguished Name (DN) @
Not Before @

Not After @

Key Algorithm

Key Size @

Certificate Usage

Extensions

rootCACert (required)

CN=Root CA Certificate, OU=MyDepartment, O=MyCompany ¢ (required)

08-Nov-2023 342 PM~ EST
08-Nov-2024 342 PMv EST
@ RSA OEC

D) 1024 bits ® 2048 bits (O 3072 bits O 4096 bits
O Server O Client ® CA O Code Signing O Custom

Type Critical Value

Digital signature, Certificate signing, CRL

Key Usage @ true @ ALt

DNS Name:Root CA Certificate

Subject Alternative Name @ @ false

Subject Type=CA
Basic Constraints 3 true @

G) Add Extension

OK Cancel

Path Length Constraint= None

rd (required)
Z

£ X
Z

£ X

System security

All certificates begin as self-signed certificates. Only the root CA certificate remains self-signed
because it sits at the top of the certificate chain.

Step 3. Fillin the form and click OK.
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Step 4.

Step 5.

Step 6.

e Use Alias to identify this as a root certificate.
® Use the Distinguished Name (CN) edit mode to fill in the following information:

® The Common Name (CN) becomes the Subject (also known as the Distinguished Name). For
a root CA certificate, the Common Name (CN) may be the same as the Alias.

* Organization should be the name of the company.

e Although Locality and State/Province are not required and are arbitrary, leaving them
blank generates a warning message.

® The two-character Country Code is required and must be a known value, such as: US, IN,
CA, FR, DE, ES, etc. (refer to the ISO CODE column at countrycode.org).

* Based on the Not Before and Not After dates, certificate validity defaults to a year. A
longer period is not recommended and not tolerated by some browsers. Changing to a new
certificate annually or even within a year makes it more likely that your certificate contains the
latest cryptographic standards, and reduces the number of old, neglected certificates that
can be stolen and re-used for phishing and drive-by malware attacks.

* Key Size defaults to 2048. A larger key improves security and does not significantly affect
communication time. The only impact it has is to lengthen the time it takes to create the
certificate initially.

* For Certificate Usage, select CA.

* The HTML5 Generate Certificate window allows you to add extensions, which specify
information such as alternative subject names and usage restrictions to certificates.

* Key Usage: defines the purpose (for example, encipherment, signature, certificate signing)
of the key contained in the certificate. You can use it to restrict the usage of a certificate's
key only to permitted operations. For example, a key that should only be used for key
management should have the keyEncipherment bit set.

® Subject Alternative Name: allows identities to be bound to the subject of the certificate.
Defined options include an Internet electronic mail address, a DNS name, an IP address,
and a Uniform Resource Identifier (URI).

* Extended Key Usage: indicates one or more purposes for which the certificate may be
used in addition to or in place of the basic purposes indicated in the key usage extension.
In general, this extension will appear only in end entity certificates. You can create a
custom key usage extension that must be an OID with numbers separated by decimals (for
example, 1.2.3).

The Private Key Password window opens.

Enter and confirm a strong password, and click OK.
The system informs you that the certificate has been submitted. Soon the certificate appears
behind the Info message in the User Key Store table.

To continue, click OK.
The root CA certificate now exists with both its keys in the Workbench User Key Store. From this
location you can use it to sign other certificates (intermediate, server, client and code-signing).

NOTE: The exclamation icon ( ') indicates that the certificate is not signed by a Certificate
Authority. For a server, client, or code signing certificate, it means that the certificate will not be
trusted by other parties. For a root CA, which itself is the source of trust, this is normal and
expected.

For this certificate to authenticate the certificates it signs, you now need to export it with only its
public key and import it into the User Trust Store of each client computer and platform/station.

Select the new root CA certificate and click Export.
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The Certificate Export window opens.

Certificate Export

Export format PEM

Information for certificate Root CA Certificate

b

B Export the public certificate
File Name rootcacert.pem

»

Private Key

JExport the private key
Private Key Password(required)

Encrypt exported private key
Reuse password to encrypt private key

Password

Confirm

System security

CAUTION: Do not click the check box to Export the private key.The only time you click this
check box is when you are backing up the certificate to another location for safe keeping.

Step 7. To create the root CA certificate that will reside in each client’s User Trust Store, click OK.
The Certificate Export window opens with the file ready to export as a .pem file.

Certificate Export

) My File System

N Bookmarks

X

LI File Spaces Current Path
CifUsers/ /- H tridium {certManagement

«mam||E=z(0-88

E] code-signing certificate.pem
E] root ca certificate 2.pem

E] root ca certificate.pem

E] tridium.pem

File name: rootcace

Files of type: PEM Files

Save

Cancel

Notice the Current Path. This is where the system stores the exported certificate.
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Step 8. Navigate to a rootcert folder or location on a thumb drive, and click Save.
The system reports that it exported the certificate successfully.

Step 9. To complete the export, click OK.

Next steps

When exported with only its public key, the root CA certificate may be freely distributed. You are ready to
manually import the root CA certificate with only its public key into the User Trust Store of the computer,
usually a Supervisor (or engineering) computer, from which to either manually, or with a provisioning job, install
this certificate in the User Trust Store of all remote platforms/stations.

Creating a server certificate and CSR (Certificate Signing Request)

This procedure creates a server certificate and its CSR. These are the first steps in getting the server certificate
signed.

Prerequisites:
You are working in Workbench on a PC (Supervisor or otherwise) and are able to connect to all controllers.

Step 1. Open the Certificate Management view for your localhost or a controller by right-clicking Platform
> Views > Certificate Management. If required to connect to the platform, enter the platform
credentials, and click OK.

The view opens with the focus on the User Key Store.

Step 2. Confirm that you are viewing the correct Certificate Management stores.

Step 3. Click New.
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A blank Generate Self Signed Certificate window opens.

Generate Self Signed Certificate
Generates a self signed certificate and inserts itinto the keystore

Alias ControllerCert {required)
Commaon Mame (CN) 192.1658.1.10 {required)
*thiz may contain the host name or address of the server

Organizational Unit (OU) The Department

Organization (0] The Company (required)
Locality (L) The Town

State/Province (ST) The State

Country Code (C) Us irequired)

Mot Befare 28-How-2018 05:47 AM EST ﬁ

Mot After 28-HNow-2019 09:47 AM EST j‘

Key Size & 1024 bits @ 2048 bits & 3072 bits &> 4096 bits

Certificate Usage & Server > Client > CA > CodeSigning

Alternate Server Mame

Email Address namdfthecompany . com

OK | Cancel |

Step 4. Fill in the form with information for the current platform/station and click OK.
Alias identifies the type of certificate and purpose in words. The Common Name should be the IP
address or domain name of the platform/station. Organization is the name of the company.
Define Locality, State/Province, and two-digit Country Code. Leave Certificate Usage set
at the default (Server), and provide an Email Aeddress. The rest of the properties can remain at
their default values.
After a bit, the system creates a self-signed server certificate, which appears in the User Key Store
table with a yellow shield.

Step 5. Select the new server certificate and click Cert Request.
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The Certificate Request Info window opens for the server certificate.

Certificate Request Info

==| 192.168.1.10

Information for certificate request 192.168.1.10

Properties:

Version

Serial Mumber
Izsued By

Izsuer DM

Subject

Subject DM

Mot Before

Mot After

Key Algorithm

Key Size

Signature Algorithm
Signature Size

Basic Constraints
Key Usage
Extended Key Usage
MD5 Fingerprint

bleView: = ASN.1View PEM View

w3

45 d& 05 20 cf Ta ce 7f 2a lc &9 b2

192.168.1.10

CN=1%2.162.1.10, 0U=MyDepartment , 0=MyCompany, LI=My Town, 5ST=My St&
192.168.1.10

CH=1%2.163.1.10,0U=MyDepartment , O=MyCompany, L=My Town, ST=My S5tz
Mon Nowv 26 14:03:04 EST 2018

Tue Wow 26 14:03:04 EST 2019

R5L

20483

SHR2S6WITHRSL

256

Subject Type: End Entity

digitalSignature, keyEncipherment

TLS Web Server huthentication (1.3.6.1.5.5.7.3.1), TLS Web Clie
4d:1f:dd:01:d2:1a:62:87:35:594:058:5]1:81:fb: 622k

OK Cancel

Step 6. Confirm that the Issued By and Subject fields contain the expected IP address (or domain name)

and click OK.

The Choose Export Directory window opens.

Step 7. Navigate to the serverCsRs folder you created (My Host > My File System > User Home >
certManagement > serverCSRs), and click Save.
You now have a self-signed server certificate in the platform/station User Trust Store and a
certificate signing request for that certificate in the certManagement\serverCSRs folder.

Step 8. If you are using an external CA, email the certificate request to the external CA, and wait for it to

returned signed.

Signing a server certificate

Signing a certificate is a simple procedure. Certificates look a lot alike. The Certificate Management stores look
a lot alike Follow the procedure carefully confirming at each step that you are working in the correct stores
with the correct root and server certificate

Prerequisites:

You are working in Workbench on the PC (Supervisor or otherwise) that you used to create the root certificate.

Step 1. Click Tools > Certificate Signer Tool.
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The Certificate Signing window opens.

Certificate Signing

==| Certificate Signing
gﬁ Sign a certificate signing request with a selected CA certificate.

Select a certificate signing request to sign:

Mot Before; |28-Nov-2018 10:04 BM EST &
Mot After: 27-Howv-2020 10:04 BM EST j
CA Alias: rootcertificate

CA Passwaord:

0K Cancel |

Notice that the CA Alias identifies the root certificate.

System security

Step 2. Click the folder icon to the right of Select a certificate signing request to sign:,
navigate to the serverCsRs folder you created (My Host > My File System > User Home >

certManagement > serverCSRs), click the server CSR, and click Open.
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the Certificate Signing window for the server certificate opens.

Certificate Signing
Sign a certificate signing request with a selected CA certificate.

el

| Select a certificate signing request to sign:

file:/C:/Usera/Tulie/Niagarad.&/tridium/certManagement/serve] Bl |

Properties:

Subject 192.1638.1.10

Subject DM C=U5,5T=The State L=The Town,0=TheCompany,0U=TheDepartmer

Key Algorithm RSA

Key Size 2048 |

Signature Algorithm sha2 56WithRSAEncryption (1.2.840,113549,1.1.11) [

Signature Size 256 .

|
Extenszions:
Identifier: X509%vw3 EKey Usage (2.5.29.135)
isCritical: true

digitalSignature, keyEncipherment
Identifier: X509%v3 Subject Alternative Name (2.5.2%.17)
isCritical: false
E X50%v3 Subject Rlternative Name (2.5.29.17)
152.1658.1.10
Controller Cert for 1%2.165.1.10
mailfthecompany.com

Identifier: X50%w3 Issuer Alternative Name (2.5.29.18)

Mot Before; |28-Nov-2018 10:04 BM EST 4
Mot After: 27-How-2020 10:04 BEM EST ﬁ
| CAAlias: rootcertificate

| CAPazsword:

OK Cancel |

Step 3. Verify that the Subject identifies the expected platform/station IP address or domain name and
that the CA Alias identifies the root certificate.

Step 4. To sign the certificate, enter the root certificate’s CA Password and click OK.
The certManagement folder opens.

Step 5. Double-click the signedCsSRs folder and click Save.

Result
You now have a signed server certificate request.

Matching a server certificate with its signed CSR

You now import the signed CSR into the User Key Store where it updates the original server certificate you
created.

64 March 21, 2025



Niagara Enterprise Security Installation and Maintenance Guide

Prerequisites:

You are working in Workbench on a PC (Supervisor or otherwise).

System security

Step 1. Open the Certificate Management view for your localhost or a controller by right-clicking Platform
> Views > Certificate Management. If required to connect to the platform, enter the platform
credentials, and click OK.

The view opens with the focus on the User Key Store.

Step 2. Select the original server certificate and click Import.

Step 3. Navigate to the signedCsRs folder, select the signed CSR (.pem file), and click Open.
the Certificate Import window opens.

Certificate [mport

Certificate Import
Information forimported certificate 192.168.1.10

EnterAlias |controllercert

TableView | ASM.1View PEM View

Properties:

Version

Serial Mumber
Iszued By

Issuer DM

Subject

Subject DM

Mot Before

Mot After

Key Algorithm

Key Size

Signature Algorithm
Signature Size

Basic Constraints
Key Usage
Extended Key Usage
MD5 Fingerprint

w3

45 dé 05 80 c5 £8 5d £3 cS 34 Bb =6

TheCompanyRootCertificate

CH=ThelompanyRooctlertificate, 0=Thelompany, L=The Town,3T=The S5tz

1%2.168.1.10

C=03,5T=The 5State,lL=The Town,0=The Company,U=The Department,CE

Wed Nowv 28 10:13:44 EST 2018
Fri HWow 27 10:13:44 EST 2020
R5L

20483

SHRZSEWITHRSR

256

Subject Type: End Entity

digitalSignature, keyEncipherment

TLS Web Server huthentication (1.3.6.1.5.5.7.3.1), TLS Web Clie

TE:15:58f:a8:12:94:64:52:5e:d1:38:46:

OK Cancel |

£7:92:459: 42

Step 4. Confirm that this is no longer a self-signed certificate and click OK.
The Issued By field contains the name of the root CA certificate. The Subject contains the IP
address or domain name.
The yellow shield with the exclamation mark changes to a green shield with a check mark.
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Result
The platform/station now is not ready to connect to a client presenting its own CA-signed certificate.

Changing TLS settings

Change TLS Settings is a utility under Platform Administration. This utility configures secure communication
including defining the server certificate to use for the platform.

Prerequisites:
You are working in Workbench and can connect to your localhost as well as to each controller.

The server certificate defaults to the self-signed default certificate. Before you can make secure connections,
you need to change this certificate to the server certificate that you created. You need to do this for the
localhost and for each controller on the network.

Step 1. Open a secure platform connection to the controller (port 5011).

Step 2. Double-click the Platform Administration utility.
The Platform Administration view opens.

Step 3. Click the Change TLS Settings button.
The Platform TLS Settings window opens.

State TLSOnly | State Enabled

Port 5011 :F‘Drt 5011

Certificate supervisorcert | Certificate controllercert

Protocol TLSv1.2 !Prutu-::ul TLSv1.0+

Use Extended Master Secret .- true I Use Extended Master Secret .- true

TLS Cipher Suite Group Recommended !TLS Cipher Suite Group Recommended
Save Cancel I Save Cancel

The window on the left is for the localhost, and that on the right is for a controller.

Step 4. Confirm that:
® Stateis TLS Only.
e Portis 5011
* Certificate is the server certificate you created for each platform/station.

* The rest of the properties are configured at their defaults.

Importing the root certificate into a platform/station User Trust Store

When serving as your own CA, each client requires the root certificate with its public key in its User Trust Store.
If your server certificates are signed by an external CA, its root certificate and public key should already be in
the platform/station’s System Trust Store

Prerequisites:
You are working in Workbench running on a PC.

Step 1. To open the Certificate Management view for the platform/station, expand Platform and double-
click Certificate Management.
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The Certificate Management view opens to the User Key Store tab.
Step 2. Click the User Trust Store tab.
Step 3. Click Import.

Step 4. Locate and select the root certificate’s .pem file (My Host > My File System > User Home >
certManagement > rootcert, and click Open.

Step 5. Confirm that you are importing the correct root certificate (in this chapter it is the only root
certificate), and click OK.
The system imports the root certificate.

Certificate Management

Certificate Management for "localhost™

User Key Store  System Trust Store  User Trust Store  Allowed Hosts

You have user certificates that identify these certificate authorities:

User Trust Store 1 objects

Alias Subject Mot After Key Algorithm Ke R

E mycompanyroot MyCompanyRoot TueMow2611:57:32 EST 2019

'J'iew | @Delete | @Import | '_.;.Appruve

@ Export

The green shield with the check mark indicates that your company'’s root certificate with its
public key is in the client User Trust Store, ready to verify the identify of the server certificates
signed by its private key.

Result
Your platform/station is ready to function as a client. Using this certificate it verifies that the server certificates
presented to it are valid if, and only if, they were signed by this certificate’s private key.

NOTE: You need to do this for the Supervisor platform/station as well as for each controller platform/station.

Importing the root certificate into the Workbench User Trust Store

When serving as your own CA, each client requires the root certificate with its public key in its User Trust Store.
If your server certificates are signed by an external CA, its root certificate and public key should already be in
the platform/station’s System Trust Store.

Prerequisites:
You are working in Workbench running on a PC.
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Step 1. To open the Certificate Management view, click Tools > Certificate Management.
The Workbench Certificate Management view opens to the User Key Store.

Step 2.
Step 3.
Step 4.

Step 5.

Result

Niagara Enterprise Security Installation and Maintenance Guide

Click the User Trust Store tab.

Click Import.

Locate and select the root certificate’s .pem file (My Host > My File System > User Home >
certManagement > rootcert, and click Open.

Confirm that you are importing the correct root certificate (in this chapter it is the only root

certificate), and click OK.

The system imports the root certificate.

The green shield with the check mark indicates that your company’s root certificate with its
public key is in the client User Trust Store, ready to verify the identify of the server certificates

signed by its private key.

Workbench is ready to function as a client. Using this certificate it verifies that the server certificates presented

to it are valid if, and only if, they were signed by this certificate’s private key.

Installing a root certificate in the Windows trust store

For communication to be secure when accessing a station using the web Ul, a company'’s root certificate must
be imported into the Windows trust store.

Prerequisites:
Using Workbench, you exported the root certificate into a directory you can access from the PC. (The
extension for a root certificate file name is .pem).

Step 1.

Step 2.

68

On the PC, open a Windows command prompt by clicking Start and typing cmd .

The Command Prompt window opens.

Type certmgr.msc and press Enter.
The certificate manager window opens.

File Action View Help
L sl REREYE 7 No:

&4 certmgr - [Certificates - Current User] - O ¥

__;JJ Certificates - Current User
| Personal
| Trusted Root Certification Au
| Enterprise Trust
| Intermediate Certification Au
| Active Directory User Object
| Trusted Publishers
| Untrusted Certificates
| Third-Party Root Certificatior
| Trusted People
| Client Authentication lssuers
| Other People
| MSIEHistorylournal
| Smart Card Trusted Roots

Logical Store Mame

Dpersonal

DTrusted Root Certification Authorities
D Enterprise Trust

Dlntermediate Certification Authorities
DActive Directory User Object
DTrusted Publishers

D Untrusted Certificates

DThird—Part}r Root Certification Authorities
DTrusted People

D Client Authentication Issuers
DOther People

DMSIEHistDr}rJaurnaI

DSmart Card Trusted Roots

L4
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Step 3. Inthe column to the right, right-click the Trusted Root Certificate Authorities folder and click All

Tasks > Import.
the Certificate Import wizard window opens.

Step 4. Follow the steps of the wizard to browse to the User Home where the root certificate .pem file is
located, select to view All Files..., select the file and click Open.

Step 5. Finish the wizard.

Importing the root certificate into the Java Control Panel

Importing the root certificate into the JAVA Control Panel is necessary to use Java WebStart. Disclaimer: this
software may function differently from what is described here.

Prerequisites:
You are working in Windows on a PC. Your root certificate is available either in the User Home folder or on a

thumb drive.
Step 1. Click the Windows Start button and open the Windows Control Panel.

Step 2. Inthe All Control Panel Items list, double-click Java.
The Java Control Panel opens.

Step 3. Select the Security tab, and click Manage Certificates (lower-right).
Step 4. If necessary, select Trusted Certificates from the drop-down list.

Step 5. To add the new root certificate, click Import, navigate to the root certificate, select it, and click
Open.
The certificate appears in the list.

Step 6. To complete the import, click Close and OK.

Exporting to back up certificates

Once all certificates are in place, it is a good idea to back up all certificates to a thumb drive or other storage
device, such as a completely separate computer that resides in a vault.

Prerequisites:
You are working in Workbench on the PC that you used to set up certificates.

Step 1. Open the Workbench Certificate Management view by clicking Tools > Certificate Management, in
the User Key Store, select the company’s root certificate and click Export.
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The Certificate Export window opens.

Certificate Export

Certificate

[# Exportthe public certificate

Tableview = ASN.lView PEM View

Properties:

Version w3

Serial Humber 45 dg 05 20 b3 1d 32 81 1f &3 02 06

Issued By TheCompanyRootlertificate

lsser DM CH=TheCompanyRootCertificate, O=Thelompany

q‘ Private Key

[# Exportthe private key
Private ey Password (required): |ttt Lt
[# Encrypt exported private key

[#] Reuse password to encrypt private key

OK Cancel |

Step 2. Click the option to Export the certificate’s private key.

Step 3. Create a strong password to protect this private key and click OK.
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Q File Spa ces Current Path
C:/Users/Iulie/Niagara. 7/tridium/certManagement; rootcert

4« O A E O-8 3

| E] rootcertificate.pem

&) My File System

A Bookmarks

Filename: | rootcertificate with privatekey.pem Save

Files of type: PEM Files Cancel

The Export Certificate file path window opens.

Step 4. Add to the name text to indicate that this file contains the private key, navigate to the rootcert
folder, and click Save.

Step 5. Create a new folder under certManagement called servercerts.

Step 6. Navigate to each controller/station Certificate Management folder and save each server certificate
with its private key in the new My File System > User Home > certManagement > servercerts
folder.

Step 7. Using Windows' File Explorer, copy the entire certManagement folder to a thumb drive or other
location.

Step 8. Delete the contents of the certManagement folder.

DANGER: DO NOT LEAVE A ROOT CERTIFICATE OR SERVER CERTIFICATES WITH THEIR
PRIVATE KEYS IN A PC FILE SYSTEM THAT MAY BE COMPROMISED! STORE THESE
CERTIFICATES ONLY ON A THUMB DRIVE OR PC THAT IS IN A SECURE AND LOCKED VAULT.
AS A BEST PRACTICE, AVOID STORING CERTIFICATES IN THE CLOUD.

Result
If you followed these procedures, the company’s communication within this system is secure. Bear in mind, that
certificates expire. When they expire you may need to sign and import new certificates again.

Cleaning up the stores

As this document explained at the beginning of the chapter, the goal is for each platform/station to have a
single CA-signed server certificate in its User Key Store, the root certificate that signed it either in the System
Trust Store or User Trust Store, and an Allowed Hosts tab that is empty. After setting up these certificates, this
procedure prompts you to delete all self-signed and otherwise unapproved certificates.

March 21, 2025 71



System security Niagara Enterprise Security Installation and Maintenance Guide

Prerequisites:
You are working in Workbench on a PC.

Step 1. To open the Workbench Certificate Management view, click Tools > Certificate Management.
Step 2. Delete any default tridium certificate in the User Key Store.

Step 3. To open a localhost or controller Certificate Management view, do one of the following:
* Open and connect to the platform and click Platform > Certificate Manatement.

* Open and connect to the running station and clickStation > Config > Services >
PlatformServices > CertManagerService.

Step 4. Delete any default tridium certificate in the User Key Store.
Step 5. Click the Allowed Hosts tab and delete any certificates in this tab.

Verifying the certificates

After running the Certificate Wizard or manually setting up certificates it is important to confirm that
communication within your system is secure.

Prerequisites:
You ran the Certificate Wizard or created and imported your own certificates.

NOTE:

The platform and the station share the same trust store, while the Workbench application has its own trust
store.

Step 1. From the local platform, double-click on Certificate Management and verify that the certificates
were installed:

* The server certificate appears in the User Key Store.

* The new root CA certificate appears in the User Trust Store. This is a copy of the root CA
certificate exported with the public key.

Certificate Management for "localhost”
User Key Store System Trust Store User Trust Store Allowed Hosts

You have local certificates:

User Key Store 3 objects
Alias Subject Not After Key Algorithm @
supervisor-ncloud N4:supervisor-nCloud:Tst-992F-13CF-3E1B-2348 Mon Jul26 13:50:13EDT 2027 EC
o default Niagarad Fri Dec22 10:38:44 EST 2023 RSA ‘
5 newmansupOservercert Sup0 Server Cert Claires PC Fri Sep 24 07:56:53 EDT 2021 RSA

Certificate Management for "localhost”®
User Key Store System Trust Store User Trust Store Allowed Hosts

You have user certificates that identify these certificate authorities:

User Trust Store 1 objects
Alias Subject Not After Key Algorithm  Key Size Valid B
5 carootcertcnewman CARootClaire'sPC  FriDec22 10:38:44 EST 2023 true
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Step 2. From the Workbench, click Tools > Certificate Management.

Step 3. Confirm that the new root CA certificate created by this instance of the Workbench (for use by the
rd) is in the Workbench User Key Store alongside the self-signed Tridium server certificate.
Workbench is a client when connecting to platforms and stations, so it is worth pointing out that
this is not a Server Certificate. The root CA certificate is available to Workbench for use in signing
Server Certificates.

Notice that the root CA certificate was not imported into the Workbench User Trust Store by the
Certificate Wizard. You need to import the root CA certificate into this location to ensure that
this instance of the Workbench can validate server certificates while handshaking with platforms
and stations on the network.

Step 4. To import the root CA certificate into the Workbench User Trust Store, Click Import, locate and
select the new root CA certificate in ~certManagement, and click OK.

Certificate Management for Niagara Workbench
User Key Store  System Trust Store  User Trust Store  Allowed Hosts

You have user certificates that identify these certificate authorities:

User Trust Store 0 objects
Alias _Subject Mot After Key Algorithm Key Size Valid ®
Certificate Import >

5 Certificate Import
Information forimported certificate CA Root Claire's PC

EnterAlias

TableView ASN.1View PEM View

Properties:

Version Certificate Management for Niagara Workbench

Serial Numbsg

Issued By User Key Store  System Trust Store User Trust Store  Allowed Hosts

Issuer DN

Subject You have user certificates that identify these certificate authorities:

Subject DN _

et ot User Trust Store 1 objects
Alias Subject Not After Key Algorithm  Key Size Valid =
¥ carootclaire'spc CARootClaire'sPC  Fri Dec22 10:38:44 EST2023 true

Step 5. Verify that the TLS level for each of the following is set to TLSv1.2:

® Platform TLS Settings — Using the Platform Administration tool, view the Change TLS
Settings option and verify the Protocol value.

* Station Web Service — In a station connection open a Property Sheet view on the Web
Service and verify the Https Min Protocol property value.

* Station Fox Service — Open a Property Sheet view on the Fox Service and verify the Foxs
Min Protocol property value.

Step 6. Select the appropriate server certificate for use in secure platform and station connections.
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¢ Set the new server certificate to be used for secure platform (niagarad) communications.
e Set the new server certificate to be used for secure station communications via Fox and Web
services.

For details, refer to the Niagara Station Security Guide

Accepting a self-signed certificate after a change

Your system is less secure if, instead of implementing signed server certificates, you accept self-signed
certificates. If, after acceptance, the self-signed certificate’s public key changes, the system negates the
certificate, changes the green shield icon on the Allowed Hosts tab to a yellow icon with an exclamation mark (

), and denies access, causing an error.

Prerequisites:
You are working in Workbench and are connected to the appropriate station.

If you trust the new key, follow this procedure to accept the changed certificate. If you suspect something is
wrong, investigate further. Do not accept a self-signed certificate with a new public key unless you are
confident that it is secure. Better yet, stop using self-signed certificates and implement signed certificates,
which provide server authentication as well as encryption.

Step 1. To access an Allowed Hosts tab do one of the following:

* To access the Workbench Allowed Hosts list, click Tools > Certificate Management, and click
the Allowed Hosts tab.

* To access the platform/station Allowed Hosts list, expand Platform and double-click
Certificate Management in the Nav tree. Then, click the Allowed Hosts tab.

* You may also access the platform/station stores by expanding Station > Config > Services >
PlatformServices and double-clicking CertManagerService in the Nav tree.

The tab opens.

Step 2. To confirm that the public key changed, select the certificate row in the table and click View.
The certificate opens in the Detected Public Key Change window.

Detected Public Key Change X
Niagaras / 172.16.11.205 Detected Public Key Change x
Achangein the publickey that was previously approved has been detected. . N
Niagarad / 172.16.11.205 Detected Public Key Change X

; Achangein the publickey that was previously approved has been detected.
[TableView! | ASN.1View = PEMView

Niagarad / 172.16.11.205
Fabicien | ASuview  pEMview Achangein the public key that was previously pproved has been detected

Properties:
signatureAlgorithm ~ SHA25EWITHRSA TableView, ~ASN.1View PEM View
Version (-) 256 ' §

R isCritical: true

digitalSignature, keyEncipherment

Signature Size
Serial Number *
Basic Constraints SIS G L L Identifier: X509v3 Issuer Alternative Name (2.5.29.18)
Key Usage digitalsignature, keyEncipherrent isCritical: false
ExtendedKeyUsage  TLS Web Server Authencication (1.3.6.1.5  X509v3 Issuer Alternative Name (2.5.28.18)
() 22:e2tabi00t27iboren:212mi4 tridiumfostld [ .4.1.413L.2)

Ittt [ Qnx-TITAN-2A1E~ FA-3FFE
(-) Identifier: X5 ubject Key Identifier (2.5.29.14)

isCritical: false

Issued By

IssuerDn

MDS Fingerprint

Subject
SHA1 Fingerprint
ntifier |

SubjectDN valid

Not Before Extensions:

Not After Identifier: ¥509v3 Key Usage (2.5.29.15)
isCritical: true Identifier:

Key Algorithm digitalSignature, keyEncipherment

KeySize 048 Tdentifier: ¥505v3 Issuer Alternacive Name (2.5.25.1%)
e isCritical: false
Signature Algorithm  SHA2SEWITHRSA ¥509v3 Issuer Alternative Name (2.5.28.1%)

tridiurHostTd (1.3.6.1.4.1.4131.2)
Accept |  Reject

Qnx-TITAN-2A1E-40F6-ASFA-SFFB

Accept | Reject

Accept |  Reject

The screen captures show an example certificate after scrolling down to the mid-scroll and end-
scroll regions.

Step 3. Confirm at least the Issued By and Subject properties.
The two names should be names you recognize as belonging to your company.

Step 4. Accept the self-signed certificate with the new public key, click Accept.
The certificate icon changes to a green shield with a check mark.
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Setting up HTTP Authentication scheme for third party application

Any Third party software that requires communication through Https port, require HTTPBasicScheme
authentication. If this authentication scheme is not available in the web UI, this procedure documents how to
use Workbench to add this scheme to your Supervisor station.

Prerequisites:
Using Workbench you are connected to the Supervisor station.

Step 1. To confirm the authentication schemes, navigate to Config > Services > AuthenticationService >
Authentication Schemes.

Step 2. If HTTPBASICScheme is not a listed option, open the baja palette and expand
AuthenticationSchemes > WebServicesSchemes.

Step 3. Drag HTTPBasicScheme to Config > Services > AuthenticationService > Authentication Schemes
in the Nav tree.

Step 4. Using the web Ul, create a web user.
Related tasks

e Setting up the Obix role
* Setting up an Easy Lobby user

Preparing a secure MySQL database

Data encryption server authentication are important aspects of secure communication.

Prerequisites:
You downloaded MySQL, set up a database, created a separate unique user (not root), and assigned a
password. MySQL Workbench is open.

MySQL refers to the secure communication as SSL (Secure Socket Layer). While this term is still used, the actual
technology is now TLS (Transport Layer Security). Recent MySQL program files default to TLS (SSL) support.
Older versions, such as version 5.7 offer secure communication, but do not enable it by default.

This procedure sets configures a MySQL database and the database user to require secure communication.

Step 1. To confirm that MySQL version 8.0 defaults to secure communication, click Database > Manage
Server Connections in MySQL Workbench, click the SSL tab and confirm that Use SSLis
configured to enable secure communication.

MySQL version 8.0 defaults to If available, which means that it supports TLS.

Step 2. To confirm that an earlier version of MySQL is configured for secure communication, use the
Windows Command Prompt.

a. Change directories to C:\Program Files\MySQL\MySQL Server n.n\bin (replace n.n with the
MySQL version number).

b. Run this command to open the MySQL Console: mysql -u<name> -p (replace <name> with
your MySQL user name).

C:\Program Files\MySQL\MySQL Server 5.7\bin>mysql —uentsecuser —p

c. Enter your password.
The MySQL Console opens.

Enter password: *****kxkx
Welcome to the MySQL monitor. ... etc.

d. From within the console, run this command: mysql> show global variables like ‘%ss|%’;.
The monitor displays a table of variables.
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Step 3.

e. Confirm that value of have openssl is YES and the value of have ssl is YES
“YES” mean that the database is configured for secure communication.

If MySQL does not default to secure communication, either use MySQL Workbench to enable SSL
or download a more recent version.

Step 4. To update a MySQL user to require secure communication, enter these commands at the

Result
The database is ready for you to install a client and the CA root certificates.

Command Prompt:
mysql> UPDATE mysqgl.<user> SET ssl type = ‘ANY’; where <user> is the name of a user you
created in MySQL Workbench.

mysql> FLUSH PRIVILEGES;

Using OpenSSL to create certificates

While Niagara provides its own Certificate Manager, which is capable of creating and signing certificates, some
applications and browsers cannot use the resulting certificates. This procedure ensures that the three
certificates it creates will work to secure communication with a MySQL database.

Prerequisites:
The MySQL monitor is open using the Windows Command Prompt

IMPORTANT: The CN (Common Name) for each certificate must be unique. Two certificates cannot share the

same hame.

76

Step 1.

Step 2.

Step 3.

Step 4.

Step S.

Download OpenSSL from here: https://www.openssl.org/source/ and install it on your Supervisor
PC.

To create a folder for the certificates enter:
mkdir C:\<path> where <path> defines a folder name.

In Windows, set up an environment variable for OpenSSL as follows:
OPENSSL_CONF=c:\OpenSSL-Win64\bin\openssl.cfg

Open the MySQL monitor.
For specific steps, refer to the previous topic.

Create three certificates: root CA (Certificate Authority), server certificate signed by the root CA
certificate and a client certificate also signed by the root CA:
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Your file names can be different from the example names.

Example file

] Command

Certificate

root CA  ca-key.pemca- openssl genrsa 2048 > "C:/mysqlCerts/ca-key.pem"
certificate cert.pem

openssl| req -new -x509 -nodes -days 3600 -key "C:/mysqlCerts/ca-
key.pem" > "C:/mysqlCerts/ca-cert.pem"

server server- openssl req -newkey rsa:2048 -days 3600 -nodes -keyout "C:/mysqlCerts/

AU e server-key.pem" > "C:/mysq|Certs/server-req.pem"
key.pemserver-

req.pem openssl x509 -req -in "C:/mysqlCerts/server-req.pem" -days 3600 -CA
"C:/mysqlCerts/ca-cert.pem" -CAkey "C:/mysqlCerts/ca-key.pem"
-set_serial 01 > "C:/mysqlCerts/server-cert.pem"

client client- openssl| req -newkey rsa:2048 -days 3600 -nodes -keyout "C:/mysqlCerts/

certificate cert.pemclient- _p: & " e, I "
key.pemdlient- client-key.pem C:/mysqlCerts/client-req.pem

req.pem openss| x509 -req -in "C:/mysqlCerts/client-req.pem" -days 3600 -CA
"C:/mysqlCerts/ca-cert.pem" -CAkey "C:/mysqlCerts/ca-key.pem"
-set_serial 01 > "C:/mysqlCerts/client-cert.pem"

Step 6. To update the MySQL config file (my.ini) change directories to: C:\ProgramData\MySQL\MySQL
Server 5.7\, open my.ini using Notepad and add this command in the [mysqld] section and add
these commands.
ssl-ca = "C:/mysqlCerts/ca-cert.pem"

ssl-cert = "C:/mysqlCerts/server-cert.pem"
ssl-key = "C:/mysqlCerts/server-key.pem"

Step 7. Restart the MySQL service/server and confirm that communication with the MySQL database is
now secure using the MySQL monitor again with the ssl command.
mysql> show global variables like '%ss|%';
Both have openss| and have ssl should report YES.

Step 8. Another way to confirm that MySQL is configured for secure communication is to issue the status
command in the monitor.
mysql> status
This row in the list reports that SSL is in use:

SSL: Cipher in use is DHE-RSA-AES256-SHA
Step 9. To connect to the database using a user that requires a secure connection, enter this command in

the monitor:
mysql.exe -<ussluser> -p --ssl-mode=REQUIRED

where <ussluser> is a user that requires a secure connection.

Step10. To double-check, you should get an error if you attempt to connect this same user without the ssl-
mode=Required option.
mysql.exe -ussluser -p --ss|=0
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Chapter 5. Controller commissioning

A controller platform may come with a station already installed, or you may be required to install the station
distribution software yourself. There are multiple ways to install and create stations using Workbench. This
chapter assumes the majority circumstance. Installing a stand-alone controller represents a single instance of
the procedures in this chapter.

You initialize and configure a controller after placing it on the network and applying power to it. Initialization
using Workbench includes:

* Logging in to the controller platform.

¢ If the controller needs a station, using the distribution installer to create the station.
e Commissioning the station.

* |Installing the license.

After completing procedures in Workbench, you log in to the station and configure devices using the web Ul.

Opening a platform connection to a controller (niagarad)

Connecting to the controller using Workbench demonstrates that the controller is on line and functioning.
Workbench provides tools for installing software and commissioning the controller station.

Prerequisites:
The controller is new from the factory. The only software on it are factory defaults. It is connected to the same
network as the Supervisor PC, has a valid IP address, and its power is on. You are running Workbench on your
Supervisor PC.

Step 1. To open a connection to the platform daemon that is running on the controller, click File > Open >
Open Platform.
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Step 2.

The Connect/Open Platform window opens.

q\ Open Platform with TLS

Connect to the host's secure platform daemon

Session

Type | gT Platform TLS Connection

Host [P 172.31.66.10 » M -

Port 5011

oK Cancel |

Niagara Enterprise Security Installation and Maintenance Guide

The daemon runs automatically when the controller is powered up. As shown above, the
connection defaults to a secure Type Platform TLS Connection. After initial platform
configuration you will always access the platform using this type of secure connection. (TLS

stands for Transport Layer Security.)

For this initial installation purposes only, the system requires a regular platform connection.

q\ Open Platform
Connect to the host's platform daemaon

Session

Type |7rr Platform Connection

Host |IP 172.31.66.10 » O -

Port | 3011

OK Cancel

Change Type to Platform Connection and click OK.
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The Authentication window opens and prompts you for your credentials.
a\ Authentication
Logon required for access
Realm

Mame EntSec-J3-10
Scheme SCRAM-SHAS12

Credentials
Username tridium

Passward TITIIL

] iRememberthese credentials

0K Cancel

The factory default Username is tridium. The factory default Password is niagara.

Step 3. Confirm the factory default credentials, and click OK.
The platform detects the default credentials and opens the Change Platform Defaults Wizard.

*\ Change Platform Defaulis Wizard

Welcome to the Change Platform Defaults Wizard!

Before you can connect to this platform, the following tasks must be completed:

Configure the system passphrase
Create a new platform account
Remaove the default platform account

The Change Platform Defaults Wizard will help you complete this process.

Finish ¥ cancel

The system will not let you continue with default credentials. User names and passwords form
the front-line of defense against unauthorized system access.

Step 4. Follow the wizard, which includes creating a Passphrase, Username and strong Password. Click
Next, followed by clicking Finish.
The passphrase protects the platform’s file system, encrypting the HSQL database when you
create a station copy. The Distribution File Installer requires the system passphrase to restore a
backup .dist file. The Station Copier requires the same system passphrase to transfer a local file.

Best practice: Use the same Passphrase for your Supervisor and controller platforms.
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The system completes making the connection between the host and Workbench, and displays the

Nav Container View

Nav Container View

7

{new_jacel_nCloud2) . Platform
- Nav Platform
E@ O @ My Metwark Name
Application Director
b @ My Host: d e
- Q {new_jacel_nCloud2 0 Certificate Management
b T Platform () Distribution File Installer

Platform (:5011) & File Transfer Client

& Station (new_jacel_nCloud2) Q Lexicon Installer

e License Manager

o Platform Administration
0 Software Manager

e Station Copier

6 TCP/IP Configuration

% WiFi Configuration

@ Remote File System

12 objects

Description i3
Control applications and access console output

Manage X.502 Certificates and Host Exemptions.

Install distribution files to the remote host

Transferfiles to and from the remote host

Install lexicons to support additional languages

Manage licenses and certificates

Update the platform daemon's port or credentials, or set its date and time
Install software to the remote host

Transferstationsto and from the remote host

Manage the host's TCP/IP settings

Manage the host's WiFi Networks and Settings

The remote host's file system

Step 5. Make sure that for Type the Platform TLS Connection is selected from the drop-down list; for

Host IP, enter the IP address for the controller; then click OK.
A secure TLS connection is the default. This protocol provides data encryption and server
authentication to prevent malicious hacks into the system.
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The Identify Verification window opens with an error message.

Identity Verification

A Unable to verify host identity

Controller commissioning

The supplied certificate could not be validated:

- the certificate was issued for a different address
- the certificate was not issued by a trusted authority

ASMN.1View  PEM View
Properties:
Version V3
Serial Mumber 45 dé 05 20 €= bb c% 92 0a 21 44 37
Iszued By Niagarad
lzzuer DN CH=Niagarad,0=Tridium, =05
Subject Hiagarad
Subject DM CH=Niagarad,0=Tridium, =035
Mot Before Tue Oct 23 13:32:02 EDT 2018
Mot After Wed Oct 23 13:32:02 EDT 2019
Key Algorithm R3L
Key Size 2043
Signature Algorithm SHR2S56WITHRSL
Signature Size 256

Basic Constraints
Key Usage

Extended Key Usage
MD5 Fingerprint

Subject Type: End Entity

digitalSignature, keyEncipherment

TLS Web Server huthentication (l1.3.6.1.5.5.7.3.1), TLS Web Clie
97:39:el:04:3d:2e:758:63:94:02:02:2d:dec8:0d: 28

Accept Reject |

The error message indicates that the controller’s server certificate is self-signed. As such, it can
encrypt data communication, but it cannot authenticate the server (the controller) to its client
(Workbench). This is because none of the root certificates in the Workbench Trust Store recognize
this certificate. Since you know that the controller is a valid server you can accept the self-signed
certificate temporarily so as to continue with the login.

Commissioning a controller

Commissioning installs the software on a controller. This procedure works for commissioning a new controller
or upgrading an existing controller.

Prerequisites:
You are working in Workbench. You are connected to the controller platform.

Step 1. Double-click the Platform node for the controller in the Nav tree.
The Authentication window opens.
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Step 2. Enter the credentials you just created when you connected to the platform for the first time,

enable Remember these credentials, and click OK.

The Nav Container View opens.

Step 3.

Double-click Platform Administration row in the table.

The Platform Administration view opens.

Platform Administration

# View Details

a User Accounts

‘.\ System Passphrase

4 Change HTTP Port

ij Change TLS Settings

.:p Advanced Options

? Change Qutput Settings

View Daemon Qutput

View System Log

r Configure Runtime Profiles

G) Change Date/Time ‘

f‘ Configure NRE Memory

1) Backup

Reboot

Step 4. Click the Commissioning button.
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Baja Version
Daemon Version
System Home
User Home

Host

Daemon HTTP Port
Daemon HTTPS Paort
Host 1D

Model

Product

Local Date

Local Time

Lacal Time Zone
Operating System
Niagara Runtime

Architecture

Tridium 4.5.74.4

45744

Jopt/niagara

/home/niagara

172,31.66.10 (J8_Unit10_Fips)
3011

5011
Qnx-TITAN-ATAL-EB27-0CG0-843E
TITAH

JACE-3000

14-May-18

%35 Eastern Daylight Time
America/New_York (-5/-4)
qnx-jace-nd-titan-am335x-hs (4.5.74.6)
nre-core-gqnx-armle-v7 (4.5.74.4)

armle-w7

Enabled Runtime Profiles rt,uxwb
Java Virtual Machine

Niagara Stations Enabled enabled

oracle-jre-compact3-gmx-arm (Oracle Corporation 1.8.0.141.4.0)

Number of CPUs
Current CPU Usage
Overall CPU Usage

Filesystem

Physical RAM

1
4%
%
Tatal
3,492,848 KB 3,294,376 KB 374
/mntfaram® 383215KB 393017KRB 0
8,192 KB 2131 KB 0

Free

[mntfram0
Total Free
1,048,576 KB 78,984 KB
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Step 5.
Step 6.

Step 7.

The Commissioning wizard opens.

\ Commissioning

This wizard combines steps for configuring a host to run stations. Please check below foreach type of configuration
change you wish to make:

Request orinstall software licenses

[#] setenabled runtime profiles

[#] Install a station from the local computer

[ Install lexicons to support additional languages
nstall/upgrade modules

[# Install/upgrade core software from distribution files
[ syncwith my local system date and time

[#] configure TCP/IP network settings

[] configure system passphrase

[#] configure additional platform daemon users

ClearAll | Checkal

Back

Finish X cancel

This wizard is intended for a remote controller only. This button is not available when connected
to any Windows platform. For commissioning details, refer to the appropriate installation and
startup guide for your particular controller.

NOTE: If the Workbench FIPS property Show FIPS Options is set to true certain FIPS options
become visible in this window. If selected, the framework enforces FIPS-strength password
requirements.

Follow the wizard, clicking Next until you configure all options.

After reviewing all changes, click Finish.

Commissioning begins.

CAUTION: Do not interrupt the commissioning process. If you interrupt, you may not be able to
restore the station.

After the commissioning process is complete, the controller boots.

When prompted, click Close.
The wizard installs the software and reboots the controller.

Installing a controller license

If you did not license the controller during commissioning, you either need to access the licensing server over
the Internet or have downloaded the license from the server in advance. You may use Workbench or the web
Ul to install a license in a remote controller. This procedure documents installation using Workbench.
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Your PC is connected to the controller platform and running Workbench. The PC is connected to the Internet,
or you downloaded and have available the license file.

Initial licensing needs to be done with a platform connection because the station will not run until it is licensed.

Step 1. Connect to the controller platform and double-click the License Manager row in the Nav

Container View.

The License Manager view opens.

Step 2. Click the Import button under the Licenses pane.
The Import License window opens.

& Importone or more licenses from files

<» Import licenses from the local license database

» Import INDIVIDUAL JACE-8000 (INCLUDES USD CARD) (Miagara 4.6) licenses from the licensing server

0K Cancel

Step 3. Select the import option to use and click OK.
After the software imports the license you see it in the License Manager.

File  Edit  Search

4 o~
172.31.66.10 (Entsec_J8_Unit10)

- Nav
O
@ My Host :VAS1LTC5CZQC2 glol
& iy File System

O My Modules
86 Platform

@ My Network

& Station (MyEntsecSupervi
@ 172.31.66.10 (Entsec_J8_Unit1

BT Platform

T Platform

& Station (Entsec_J8_Unitl

172.31.66.11

172.31.66.20

Bookmarks

o M

: Platform

Tools  Window  Help

o O - 2

License Manager
Host Address 172.31.66.10
Host ID Qnx-TITAN-ATAL-EB27-6C60-843B
Brand ID Miagara
Licenses

Conserveltlicense (Conservelt 4.6 - expires 2022-01-01)

Honeywell.license (Honeywell 4.6 - expires 2022-01-01)

Miagara.license (Tridium 4.6 - expires 2022-01-01)

Delete

Import Export View

/ License Manager -

Certificates
Conservelt.certificate (Conservelt - never expires)
Honeywell.certificate (Honeywell - never expires)

Tridium.certificate (Tridium - never expires)

Delete

Import View

Step 4. To view a license, select it and click View or double-click the license in the table.
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The license file opens.

Tridium.license >

Llicense vendor="Tridium" eXpiration="2020-058-30" hostlId="0nx-TITAN-TESZ-R1C7-
<feature name="brand™ accept.station.out="%*" accept.wb.in="*" accept.wb.out="
<feature name="aaphp"” expiration="2020-0%-30"/>
<feature name="about"™ owner="Tridium Tech Pubs"™ project="Technical Publicatis
<feature name="accesaControl™ expiration="2020-09-30" point.limit="none"™ rea(
<feature name="adr" expiration="2020-0%-30" history.limit="none" point.limit-
<feature name="alarm" expiration="2020-09%-30" console.limit="none"™ type="bas:
<feature name="analytics™ expiration="2020-09-30" alerts="none" algorithms="1
<feature name="andoverAC256¢" exXxpiration="2020-0%-30"/>
<feature name="appFramework™ expiration="2020-0%-30" app.limit="none™/>
<feature name="axisVideo™ expiration="2020-09%-30"™ history.limit="none™ point.
<feature name="axvelocity" expiration="2020-09%-30"/>
<feature name="bacnet™ expiration="2020-09-30" history.limit="none™ point.lir
<feature name="bacnetiws"™ eXpiration="2020-0%-30"/>
<feature name="bacnetOws"™ expiration="2020-09-30"/>
<feature name="bacnetws"™ eXpiration="2020-09-30"/>
<feature name="box" expiration="2020-0%-30" session.limit="nons"/>
<feature name="cloudBackupService™ expiration="2020-0%-30"/>
<feature name="cloudSentiencefonnector™ eXpiration="2020-09-30" systemlype="I

ok |

A license and a certificate are each a digitally-signed text file, with differences briefly as follows:

* A license file is unique to a specific host, and enables a set of vendor features. All hosts
require a branded Tridium license. If third-party modules are installed, one or more additional
licenses may be needed.

* A certificate file varies by vendor, and matches that vendor to a public key used for
encryption and to verify the authenticity of license file. All hosts require a default certificate.
If third-party modules are installed, one or more additional certificates may be needed.

CAUTION: Do not delete an existing license or certificate without a specific reason, as you will
likely render the controller inoperable until a proper license or certificate is reinstalled!

Step 5. After installing a license, open the Application Director, confirm that both Auto Start and Restart
on Failure are selected, then start the station by clicking Start.

Creating a new station in a controller

If the controller you are using already has a station on it, you can bypass this procedure. If your controller is
brand new and contains no station, this procedure uses Workbench to install the distribution file.

Prerequisites:
You successfully commissioned the controller. There is no station in the controller.

Step 1. Make a platform connection to the controller.

Step 2. Right-click the controller’s Platform node in the Nav tree and click Views > Distribution File
Installer.
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Step 3.
Step 4.

Step 5.

Step 6.

By default, this view opens to the cleanDist folder.

File  Edit Bookmarks  Tools  Window  Help
‘ O-oaS O m- B o
172.31.66.10 (Entsec_J8_Unit10) : Platform / Distribution File Installer -~

/C:/Niagara/EntSecurity-2.4.18.286/cleanDist
2 distribution files were found in directory "/Ci/Miagara/EntSecurity-2.4,18,286/cleanDist"
O ®Owm
o b

File Version Status Description B
c}qnx-jace-ni-nme:«x-etfﬂciE-clean.dist Tridium 4.0.22.16 Differenttarget platfiorm WARNING: restores unitto empty N

- Palette = mqnx-jace-nrl-titan-am335x-clean.dist Tridium 4.1.27.20  Maodified WARNING: restares unitto empty N-

- Template
- Template

0I!:hm:u;eDireq:l:or:ur | Acleaning | AConversion | ‘BBackups P Install

The .dist (distribution) files that are available in this folder return the controller to near factory
defaults. Do not use these files unless you need to start completely from scratch.

If a distribution file is not available, the Status message reports the error. Refer to
Troubleshooting.

Click Choose Directory, navigate to the ~sw\restore folder and click OK.

Select the system .dist file and click Install.
The Distribution File Installer wizard opens.

Click Finish to follow the wizard.
The wizard installs the distribution file, and reboots the controller.

When prompted, click Close and wait for the controller to reboot.
This could take a few minutes.

Related information

Maintenance

Configuring the Application Director to restart

There are any number of reasons that a controller station my stop running. As a best practice, you should
configure the Application Director to restart the station automatically.

Prerequisites:
You are working in Workbench running on a PC.

Step 1.
Step 2.
Step 3.
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Open a platform connection to the Supervisor or controller platform.
Double-click Application Director.

If needed, drag the window down so you can see the station, and confirm you are working with
the expected station.
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/ Application Director =

Application Director

Connected to localhost

Mame

Type

== entSecSupTest 01 station

INFO
INFO
INFO
INFO
INFO
INFO

[0Ex40:50
[0E:40:51
[07:38:50
[07:38:50
[07:38:50
[07:38:50

0&-Dec-18
0&6-Dec-18
0&-Dec-18
0&6-Dec-18
0&-Dec-18
0&-Dec-18

Step 4. Enable Auto-Start and Restart

Result

Status Details

Auto-Star

Running fox=n/afoxs=4911 http=n/a,http=443 true

EST] [orionToola.replicate’
EST] [ays] Sawved C:\Prograr
EST] [sys] Sawving station..
EST] [orion] begin checkpo:
E5T] [orion] end checkpoim
EST1 laws1 Sawed C:\Proarar

on Failure.

W Auto-Start

If you are debugging an issue, disable Restart on Failure so you can view the log.

Creating and updating the HSQL database password

Each controller ships from the factory with a default HSQL database password and upgrading an AX station to
an N4 station resets the HSQL database password back to the factory default. While the default password

initially works, as soon as you install or upgrade a controller and its software, you should change this password
to a unique and strong string. The password is automatically generated and successfully stored in the key ring.

Prerequisites:

You have just installed a new controller or upgraded an existing controller from AX to N4. You are using
Workbench running on a PC that is connected to the network that services the controller.

Step 1. Connect to the controller station using Workbench.

Step 2. Expand Config > Drivers > RdbmsNetwork.

Step 3. Right-click HsglDbDatabase and click Actions > Ping. The health property is updated based on the
ping results.
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(Station_811)

. Station (Station_811)

Niagara Enterprise Security Installation and Maintenance Guide

! Config . Drivers

. HsglDbDatabase

/  Property Sheet -

7
- Nav O Actions & Topics  [B Slot Details
8 O @ My Network Display Name Value Commands
[=] (Station_811) (M Status ok}
& Platform (@ Enabled true @
# Station [Station_811) .
@ Fault Cause
‘ Alarm
© config B3 Health Fail [null]
@ Services ©Q Alarm Source Info Alarm Source Info
O orivers [ User Name
MiagaraMetwaork
6 2 & Worker Rdbms Worker
e BacnetNetwork
; HsqlDbDatabase Ul Export Mode By Historyld +
@ surveillanceViewer (M Use Unicode Encoding Scheme @ false
Apps (W Timestamp Storage Dialect Default
a Logic
i @ Points Rdbms Point Device Ext
@ Files
@Hlstory [m Sql Scheme Enabled @ false
9, Rdb Security Settings Rdb Security Settings
(@ Base Directory file:**hsqldb » v
[ Database Name
™ Defrag On Save @ false
+ Palette @l Defrag And Save Periodic Schedule 30 days {Sun}

NOTE: Starting in Niagara 4.14, the HsqlDbDatabase component properties Use Encrypted
Connection, User Name, and Password are replaced with a single Privileged Username
property. The HSQL database is automatically generated and not editable or visible. When using
HSQL, if the station keyring is corrupted, you need to load a backup station, as this instance of
the HSQL database is no longer operational.

Step 4. To access a new HSSQL database instance in the N4 station, right-click the HsglDbDatabase,
navigate to Views > Property Sheet.

The device's Property Sheet opens.

Step 5. Enter the User Name as SA and click Save.

Step 6. Right-click HsqlDbDatabase and click Actions > Ping. The health property is updated based on the

ping results.

Connecting to the controller station using Workbench

This procedure documents how to connect the controller for the first time using Workbench.

Prerequisites:
You commissioned the controller and installed the distribution file.

Step 1. Right-click the controller platform in the Nav tree and click Connect.
The Authentication window opens.

Step 2. Enter your platform credentials and click OK, or just click OK if Remember these credentialsis
enabled.

The Nav Container View opens.

Step 3. Double-click the Application Director.

The Application Director view opens.
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Step 4. If the station Status reports Idle, confirm that Auto-Start and Restart on Failure are

enabled and click the Start button.
The station is on line when its Status reports Running.

Step 5. Click File > Open > Open Station.
The Connect window opens.

Connect to station using foxover TLS,

q\ Open Station with TLS

Session

Type # Station TLS Connection

Host |IP 172.31.66.10 » O -

Port (4811

OK Cancel |

As the station starts, observe the Application Director log. Watch for errors and warnings.

Step 6. Select Station TLS Connection for Type, enter the Host IP, and click OK.
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The system may open the Detected Public Key Change window.

Detected Public Key Change x

A A change in the public key that was previously approved has been detected.

ASN.1View  PEM View

Properties:

Version V3
-} 7€ B3 07 3d &3 00 gk 7L 0Ok 21 €% 8%
Serial Mumber {_:I _”f - - 24 C’ I.I: E_I : I_. o 1;” il
Iszued By Hiagarad
lzsuer DN CW=Niagarad, t=Tridium, =05
Subject MNiagarad
Subject DN CH=Niagarad,=Tridium,=U5
{-) Thu Oct 1% 13:11:52 EDT 2017
Not Before (+) Thu May 17 10:21:45 EDT 2018
-} Fri Cct 1% 13:11:52 EDT 2012
Not After (=) Fri Oct 17 e
Key Algorithm RSL
Key Size 20458
Signature Algorithm SHR2S6WITHRSA
Signature Size 2586
Basic Constraints Subject Type: End Entity

Key Usage digitalSignature, keyEncipherment

Accept Reject

Step 7. Click Accept.
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The Authentication window opens.

q\ Authentication
Logon reguired for access
Realm

Mame ip:172.31.66.10|foxs:
Scheme  Foxinddigest)

EnJ}entials

Username

Change User
Password |

[#] Rememberthese credentials

OK Cancel

The default Username is admin, and the factory default Passwordis Admin12345.

Application Director

Connected to 192.168.1.10
Name Type  Status Details Auto-Start  Restart on Failure 7

E entSec)ACE_01 statiom Running fox=n/afoxs=4211 http=n/a https=443 true true

PARNLINGT: UL UL JULIl 1EVE MUlLlUdSLE YDUUp: jdvd. k. CECLEEUTLLURLS EﬂLtD'Stﬂl't
java.lo.I0Exception: IF ADD MEMBERSHIP failed
at com.tridium. fu:ux sessmn LMulticastServer.lambdasnews0 {(MulticastServer E Restart on Failure

e e FawemT T mam Am TS rrd Tmermd FW it e Wl mdA L

Auto-Start enabled ensures that the station restarts after stopping. A Status of Running indicates
that you can connect to the station using the web Ul.

Step 8. Do one of the following:
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* If you are logging in to this station for the first time, enter the default password, if enabled,
disable Remember these credentials, and click OK.

* If you already changed the password using the web Ul, enter your password.
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If you entered the default password, the system displays the Password Reset window.

Password Reset
You are required to reset your password before continuing. Please

enter your new password and confirm.

Your password must contain:

- at least 10 character(s)

- at least 1 digit(s)

- at least 1 lower case character(s)
- at least 1 upper case character(s)
- at least 0 special character(s)

- Q
Wl New Password:

. .'rh.'- > o
5 Retype Password:

Login

Step 9. Change the default password to a new, strong password that includes special characters,
numbers, and lowercase and uppercase letters.

IMPORTANT: The password provides the front line of protection for your controller station. Share
this credential with only those who need to know. Change the password on a regular basis. Store
it in a secure location, preferably under lock and key.

Once you have created your own unique password, the next time you log in to the station you
can enable Remember these credentials before you click OK.

The Station Summary view opens. This view indicates that you are connected to the controller
station.

Step10. As the station starts, observe the Application Director log. Watch for errors and warnings.
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Chapter 6. Controller setup, users, access
rights, and schedules

This work takes place in a controller using the web Ul.
The options configured in this chapter prepare the way for configuring devices in the next chapter.

Best Practice: During station configuration it is a good idea to save a station frequently. To save the current
station, click Miscellaneous > Controller Maintenance, and click Save Station.

Connecting to a station using Workbench

There are any number of reasons that a station may be idle. A common troubleshooting step is to open the
Application Director and confirm that the station is running. If not, follow this procedure, which works the same
for a Supervisor or a remote controller station.

Prerequisites:
The platform connection is open.

Step 1. Open the Application Director tool. (One way to do this is to right-click Platform and click Views >
Application Director.)

Step 2. Stop any other stations.

Step 3. Select the station to start and click the Start button.

File Edit Search Bookmarks Tools Window  Help

o O- o A O [ = -~ 2 >
172.31.66.10 (AccessControllerStation_1) . Platform / Application Director
- Nav Application Director
1 'S’ @ My Netwark Connected to 172.31.66.10
- Name Type  Status Details Auto-!
Platform

EAccﬁsControllerStation_l station Starting fox=n/a foxs=4911 http=n/a https=443 true
& Station (AccessSupervisor)

@ 172.31.66.10 (AccessControllerStation_1

&T Platform INFO [nre] Launching Niagara Runtime Environment [#] Auto-Start
INFO [10:21:50 27-Jun-18 UTC] [nre] Booting )
&) Application Director INFO [10:21:56 27-Jun-18 UTC] [sys] Logging initializ[# RestartonFailure
- WARNING [10:21:56 27-Jun-19 UIC] [5ys]
€ certificate Management Start
@ pistribution File Installer Stop
@ File Transfer Client Restart
Q\ |EEE 802.1X Configuration Reboot
@) Lexicon Installer Kill |

Step 4. Notice any errors and warnings as the station starts.
Step 5. Confirm that the station has started (Status reports Running).

Step 6. To configure the station to start automatically in the event of an unexpected failure, enable the
Auto-Start property.
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Auto-Start

* If the electrical grid drops power to the building, an UPS (Uninterruptible Power Supply) or
other backup battery can maintain power to the controller and its access network as long as
is practical.

¢ If an emergency generator starts, the controller, access network, door locks and sensors
should be powered by critical circuits to the extent that the company considers physical
security to be a priority.

* If power to the controller ultimately fails, the system backs up the station automatically.

* When power is restored, the platform should automatically start the station and restore
physical security to the building (unless the building’s occupants over-road the door locks)
with no operator action.

Restart on Failure

e If the station fails, it automatically attempts to restart.

* AFailure Reboot Limit (defaults to three attempts) defines how many times a station
attempts to restart within a specific Failure Reboot Limit Period (defaults to 10 minutes).
You can configure both.

Connecting to the controller station using the web Ul

This procedure documents logging in to a controller station for the first time or after upgrading software.

Prerequisites:
The station has been commissioned and is running. You are using the web UlI.

Step 1. Open a supported web browser.

Step 2. Inthe address bar, type the address of the remote controller (the default IP address is:
https://192.168.1.120) and press the Enter.
The Login window opens. The Username defaults to admin . The password defaults to

Adminl2345.

Step 3. Do one of the following:
¢ If you are logging in to this station for the first time, and did not connect to the station
using Workbench, enter the factory default Password, if enabled, disable Remember these
credentials, and click OK.
* If you already logged in to the station using Workbench and changed the password, enter
your password.
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If you entered the default password, the system displays the Password Reset window.

Password Reset
You are required to reset your password before continuing. Please

enter your new password and confirm.

Your password must contain:

- at least 10 character(s)

- at least 1 digit(s)

- at least 1 lower case character(s)
- at least 1 upper case character(s)
- at least 0 special character(s)

- Q
)] New Password:

.x .'rh.'- > o
5 Retype Password:

Login

Step 4. Change the default password to a new, strong password that includes special characters,
numbers, and lowercase and uppercase letters.

IMPORTANT: The password provides the front line of protection for your controller station. Share
this credential with only those who need to know. Change the password on a regular basis. Store
it in a secure location, preferably under lock and key.

Once you have created your own unique password, the next time you log in to the station you
can enable Remember these credentials before you click OK.
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Step 5.

Step 6.

Guide

The interface opens and you are asked to confirm the station and system display name and the
network settings.

— p—

@ Help 2 Logout

niag

[ Schedules & User Management £= Backups % Remote Devices &% Access Setup &% Intrusion Setup

& Monitoring ﬁ Personnel #¥ Controller Setup

Before continuing, please review the following settings. Changes to any
of the platform settings will require a reboot. To keep the current
configuration press "Keep the Current Settings"."

Display Names
Station Display Name West Wing

System Display Name Building 1

Update Display Names

Station Name Settings (Changes to these settings require a restart the station to take effect)

Station Name |AccessControllerStation_1

| Apply Changes and Restart Station

Network Settings {(Changes to these settings require a reboot to take effect)

Host Name AccessController-301
Use IPvG No ¥
Domain

The Station and System names display in the top right corner of the web Ul. For example: the
station name might be: Second Floor, and the system name: Building 10. You can change
these values later by navigating to Controller (System) Setup > Network TCP/IP Settings. The
Reference explains the many properties you can configure in this view.

Scroll down and configure any of the many properties, then click Apply Changes and Reboot (at
the bottom of the page), and wait for the station to restart.

If the station does not restart, go back to Workbench, confirm that Auto-Start is enabled, click
Start, and log in using the web Ul again.

If the Guided Setup Tour does not open, and you wish to use it, click the Guide button at the top
of the Home view.

The Guided Setup Tour window opens.

Accessing the help system

Help is available on each view. This procedure demonstrates how to open a second pop-up window for the
help topic while retaining the view.

Prerequisites:
You are accessing a controller station using the web Ul.

Step 1.

98

Click the Help icon in the upper right corner of the screen.
The help topic for the view replaces the view.
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Step 2. Click the popup icon ([7]) in the upper right corner of the screen.
This opens a new browser window for the web Ul that contains the help text.

Controller setup, users, access rights, and

schedules

3 Home

user type. &d” Monitoring

E Schedules

If an existing user type is in a locked-out state, a Clear Lockout button displays
| view. You can click this button to immediately clear a user from a locked out stafy

| 5 4 u
| The tabs configure user types and the associated role(s). d Save || Users

| User Roles
| NOTE: A new user type is not created until you click the Save button. Full Name
Enabled
| Properties Expiration
Lock Out
Property Value Description | apnguage
| Full Name text, optional Assigns a lo| EMail
| the user typ¢
Password
Enabled true or false Turns the us
S,Zit;ieg;' Force Password Reset
)
user informa Password Expiration
system With( yetwork User
enable the u L.
However, us Authentication Scheme Name
credentials £ cell phone Number
unless and
is enabled. Auto Logoff Enabled
Use Default Auto Logoff Period
Expiration radio button and drop-down Sets a prede .
lists expiration dz AUto Logoff Period
Profile
never confi
never expire Home
. |Motes Required On Ack
Date option
properties— Default Alarm Console
| ¢ date ootion t Epable Video Settings

' Layout
<

v|j

Step 3.
view you need.

& Personnel

&, User Management

Reports

B= Backups #F H

PersMan
true v
® Never Expires O Expi
false v

]

Password: | ssssssss
Confirm: |eesssssse

false v
Never Expires O Expi
[false

DigestScheme | |

true ¥
true Vv
00000 |h[1s |m[z
Standard Access Profile
Home

true V|

Select an Alarm Console
true V|

Console and Playback

Go back to the primary view and click the browser’s go-back button or otherwise navigate to the

The browser displays the view while the help topic remains open in the pop-up window.

Guided Setup Wizard

This utility is comprised of a Guide Toolbar and a series of windows designed to direct you through the initial

setup process.
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Figure 8. Guided Setup Wizard

Guide 1 2 3 | Eb . |«—| Guide Toolbar

Guided Setup
Tour

Welcome to the Enterprise Supervisor Setup Wizard
®_ perform Guided Setup
( skip Guided Setup

Ok || Cancel

The Guided Setup Wizard serves as a checklist and navigation aid. It directs you to the proper screen for
setting up your system. It does not assign any values or configure properties automatically for you. For
example, on initial setup, you are directed to the Access Device Manager view in step three of the Guided
Setup Wizard. If no modules are in your database, you must discover and add modules, as required, before
proceeding. As you complete each step and save changes, re-open the wizard and note that the step is
completed. If you have questions about the setup process or any of the properties, refer to the procedures in
this section.

As you complete each step of the setup, Step Indicator buttons change color to indicate the status of the step
relative to the completion of the Guided Setup Wizard.

You can cancel the Guided Setup Wizard at any time by using one of the following three methods.
* Click the Guide button and select the Skip Guided Setup option in the Guided Setup Welcome window.
* In the final step, select the .. .Completed option and click Ok.

* Set the Show Guided Tour property to true (to display) or to false (to hide) the Guided Setup Wizard and
Guide Toolbar. This property is located here:

e Supervisor: System Setup > Miscellaneous > Server Maintenance
e Controller: System Setup > Miscellaneous > Controller Maintenance

Each step of the wizard process is tracked by monitoring its status. Each step may be in one of the following
four states:

* Next required step

Since the steps must be accomplished in a sequential order, only one step is available at any point during
the Guided Setup Wizard process. The Guide toolbar indicates the next required step by the white color
of the step indicator button.

* Step initiated but not complete

The system initiates a step when you access a view Guide window. The step indicator button turns yellow
when the step is initiated and stays yellow until the ™. . .Completed” option is selected from the
associated Guide window.

¢ Step completed
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Completed steps display as green step indicator buttons. A step must be completed before you can go to
the next step.

NOTE: A step is completed when you select the ...Completed option in the associated step window. There
is no programmatic verification that you performed a step.

* Step not available

A step is unavailable until you complete the previous step. The step indicator button displays as gray (or
dimmed) when the step is not available.

Starting the Guided Setup Tour

The Guided Setup Tour serves as a checklist to make sure that you configure all the important station
components. Rather than use the checklist, you can configure each component individually. The advantage of
the tour for first-time users is that using it helps you remember what needs configuring.

Prerequisites:
The Show Guided Tour property is set to true in the Controller Maintenance window (Controller Setup >
Miscellaneous > Controller Maintenance.

Step 1. If the tour does not open automatically, you can start it by clicking the Guide button at the top of
the view.
The Guided Setup Tour window opens.

Step 2. Confirm that Perform Guided Setup is enabled and click OK.
The background for the Guide button at the top of the view turns green and the background of
the 1 indicator turns white to indicate that you are on Step 1. This is an important step because
this is where you set up the station password for the admin user.

Step 3. Ensure that Go to Change Password is enabled and click OK.
The wizard navigates to Controller Setup > User Management , and opens the Password view.

Step 4. Enter the current password, create a strong new password, and click Save.
The Password Changed window opens.

Step 5. Click done.
The background of the step 1 button at the top of the view turns yellow.

Step 6. To restart the station, click Ok.
The station restarts. This could take a couple minutes. If you have the Application Director in
Workbench open, you can watch it restart. When Status reports Running, you can log in again to
the station using the web UI.

Step 7. Log in to the station and, to continue the rest of the Guided Setup Tour, click step 2.

The tour opens the Setup NTPPlatformService TimeServers window.
Step 8. Continue with the rest of the steps, which guide you to:

¢ Step 4: Add Connected Modules with Network Discovery

e Step 5: Set Up Schedules for Card Access

® Step 6: Set Up Wiegand Formats

* Step 7: Create Tenants

e Step 8: Create Access Rights

e Steps 9, 10 and 11: Set Up Personnel and Badges

* Step 12: Create New System Users

To continue after each step, click the yellow step button.

One of the options when you get to step 13 is Save System Configuration. When you click Save
Configuration Complete, the tour opens the 14th step for viewing the End User License
Agreement (EULA). Step 15 is for viewing third-party licenses. It provides the option to End
Guided Wizard Setup.
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Step 9. Click End Guided Wizard Setup and click OK.
If you configured properties at each step of the tour, your station is well prepared to begin

operations.

Result
The rest of this guide provides tasks in a similar order with the exception of creating personnel records and

badges, which are documented in the Facility Manager's Guide.

About the Guided setup wizard Toolbar
The Guide Toolbar appears, by default, the first time you log in to the system.

Figure 9. Guide Toolbar controls and indicators

Start Scroll Step Indicator Scroll
Buttong Buttong Buttonsg Buttong
Guide =

This toolbar is located at the top of the application user interface (on the Title Bar) and displays control and
indicator buttons. These controls and indicators allow you to navigate and visually track the progress of the
guided setup. The following list describes each Guide Toolbar control button:

Guide

. Start initiates the Guided Setup Wizard by opening the Guided Setup Welcome window. This button
may be white or green. white indicates that the guided setup process has not started yet. Green indicates
that the guided setup process has started, and is not yet complete.

* Scroll buttons are located to the left and right of the Step Indicator buttons. The Scroll buttons move the
visible step indicator buttons left and right so that you can view any set of three contiguous buttons.

* Step Indicator buttons, numbered: 1-11 or 1-12, indicate the step number and window. Each button may
display any one of four possible colors to indicate the status of the associated step.

10

. White indicates that this is the next step to be taken.
3

. Yellow indicates that the step has been initiated but not completed.
2

. Green indicates that the step has been completed.

. Gray indicates that the step is not available.

About the Guided setup wizard windows
Guide windows display when you initiate a step in the Guided Setup Wizard.
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Figure 10. Guide window

Step

Titleg
"Go to.. " Step 2 - Change System Time / Add Security Modules (Offling)
o to...
option§ ¥) Go to Miscellaneous Configuration
“"Completed” 0 Miscellanecus Configuration Cempleted
option
rons [ Ok ] [ Cancel

Each window has an instructional title that describes the step and two options:
® Go to

... displays the view associated with the next step that needs to be performed in the setup.
[ ]

. Completed displays the window for the next step in the Guided Setup Wizard.

Configuring a secure browser connection

Secure communication with the browser is controlled through the Web Service.

Prerequisites:
You are using the Web UI.

Step 1. To configure a secure connection through a browser, access the Web Service by clicking Controller
Setup > Miscellaneous > Web Service.
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Step 2.

Step 3.

Step 4.

Result

Guide

The Web Service properties tab opens.

&d” Monitoring &g Personnel

E Schedules &, User Management B= Backups #% Remote Devices

E save
Web Service
Status fok}
Fault Cause |
Public Server Port g0 [1 - 55535]
Http Enabled false W
Public Server Port 1- 65535]
Https Enabled
Https Only
Https Cert |5uper-.ri5c+rcert |
X Frame Options
Show Stack Trace
Applet Module Caching T',rpe
Web Start Enabled
Create Start Menu Shortcut
Create Desktop Shortcut
Min Threads [4 - 30]
Max Threads [7 - +inf]

0 |hlos |m|oo |s[isec- +inf]

=
=]
=]
=]

Thread Idle Timeout

Set Http Enabledto false, Https Enabledto true, and Https Only to true.

If you are upgrading your installation, you may have pointers to old Http ports. When Https Only
is set to true, the system automatically redirects any Http connections to secure connections
(Https). This saves having to manually change each occurrence of an Http port in legacy
installations.

Change Https Cert to identify the root CA-signed server certificate you created for this
platform/station, and click Save.

When you enable Https in the Web Service, the system automatically enables Foxs in the Fox
Service.

If you did not import the company’s root certificate into the browser’s trust store, go back to the
Secure Communication chapter and set it up.

Any communication using the browser is secure.

Configuring the platform/station’s network connection

Establishing the connection between the controller platform/station and the local area network involves
configuring the port and connection security.

104
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Prerequisites:
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You made a browser connection to the controller and are using the web UI.

Step 1. To access connections, click Controller Setup > Remote Devices > Station Manager, and click the

settings icon (| # ).
The Settings window opens.

The following properties are for the local station only,
they do not effect remote stations.

Fox Enabled

|
Fox Port 1911

Foxs Enabled | true ¥
Foxs Port 4311

Foxs Only  true 7|

Foxs Cert tridium

0Ok || Cancel

Step 2. Configure the station’s Fox Port or Foxs Port based on whether or not the configuration

Step 3. To continue configuring a secure connection, confirm the following configuration:

requires security and fox streaming.

If your configuration uses fox streaming for video, this port (Fox or Foxs) should be different from
the port used to connect a video device (camera, DVR, NVR or server) to the network. If your
configuration does not use fox streaming, this port should be the same as the port used to

connect the video device.

The following properties are for the local station only,
they do naot effect remote stations.

IFox Enabled | false ¥ ||

Fox Port 1911

\Foxs Enabled | true ¥ |
Foxs Port 4511

Foxs Only true ¥

Foxs Cert tridium

ok

Cancel

Step 4. For Foxs Cert, enter the platform/station’s server certificate.
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Foxs Cert is the last property in the Settings window.

The following properties are for the local station only,
they do not effect remote stations.

Fox Enabled | false ¥

Fox Port 1911

Foxs Enabled |true ¥

Foxs Port 4911

Foxs Only true ¥
Fﬂxs Cert tridium lI
Ok | Cancel

The tridium certificate is the default, self-signed certificate. For maximum security store a
unique server certificate in each controller/station’s User Key Store that was signed by a root CA
certificate in the User Trust Store.

Defining a display name for a controller station

Every station on the network requires a unique IP Address. In addition to this address (a series of numbers),
each station can have a unique Display Name and a unique Station Name. The station’s Display Name adds an
easily-understood text name. Its Station Name can be more technical using industry abbreviations, acronyms,
and labels. If the system has a single controller, the default Station Name is sufficient. In a company-wide
installation, a best practice is to give each station (controller and Supervisor) meaningful names that conform
to a standard naming convention.

Step 1. Click Controller Setup > Miscellaneous > Network TCP/IP Settings.

Step 2. Enter a descriptive Station Display Name and a System Display Name.
The System Display Name refers to the whole installation. Often, this is the company name or
system name for the whole company. These names should differentiate controllers from one
another and from one or more Supervisor stations.

Step 3. Click the Apply Changes and Reboot button. Allow the platform to restart.

Setting the date and time
This procedure configures the platform date and time . Both platforms (Supervisor and controller) require this
configuration step.

Prerequisites:
You are working in web Ul.

Step 1. Expand Controller (System) Setup > Miscellaneous, and click System Date Time.

Step 2. Click the check-box next to Change System Time.
The software warns you that saving time zone changes requires a platform restart. The system
requires this restart even if the time differential does not change. For example, changing from
America/New York to America/Toronto requires a restart, even though the current time may be
the same in both places.

Step 3. To activate the date and time properties, click Ok.
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Step 4. Configure the properties and click Save.
The Supervisor PC or remote controller restarts.

User management

A user can be a person who configures and manages a station or a software program that accesses a station
without requiring human intervention (machine-to-machine user). The personnel function does not manage
users, and user names are not the same as person names. Persons access the building. Users access the system
that manages the building.

User management involves editing the default users provided by the system and creating additional users as
needed. User configuration sets up credentials, authentication scheme, home page, cell phone number, and
other properties.

Creating a obix user to access a station via the Obix Network is an example of setting up a machine-to-
machine user. This user requires the HTTPBasicScheme and is often given the user name: obix.

Roles

Roles define a set of permissions or privileges that control the system functions available to specific users. A
user may have multiple roles. Every user needs at least one role.

The system provides default roles for which permissions are already configured.

* The Admin role has full system privileges and can see all views and administrator-only functions including
those involving controller setup, network discovery, and object linking.

* The Badge Operator role may handle only badge administration, view reports and create custom reports,
but cannot configure properties, view or acknowledge alarms.

* The Maintenance role includes the ability to view hardware reports and perform system maintenance
tasks, such as configuring remote controllers, creating and updating graphics, as well as adding and
editing user-role information.

* The primary task of the Operator role is to monitor and acknowledge alarms using the alarm console. The
operator can view, but not edit, certain other system and personnel reports.

* The Personnel Management role provides access to tenant and personnel views. This user can edit
personnel and badge management properties and has read-only access to access right and tenant
management properties.

The following tables summarize the features each default role can access.

Table 14. Monitoring

Role:

Personnel
Management

Badge

Function: Operator Maintenance Operator

Alarm Console
Activity Monitor

Video Monitoring, Surveillance Viewer

X X X X
X X X X
X X X X

Video Monitoring, Playback Viewer

Table 15. Personnel

Role:

Personnel
Management

Badge Maintenance Operator

Function: Operator

People X X X X X
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Role:

Badge q Personnel
Function: Operator R R Management
Badges X X X X X
Access Rights X X X X X
Tenants X X X X X
Additional Personnel Data X X X X

Table 16. Reports

Role:

Personnel
Management

Badge Maintenance Operator

Function: Operator

Access History
Alarm History
Intrusion History
Attendance History
Audit History

X X X X X X

Log history

Hardware Reports, Doors

Hardware Reports, Readers

Hardware Reports, Inputs

Hardware Reports, Outputs

Hardware Reports, Elevators (controller only)

Hardware Reports, Remote Modules

X X X X X X X X X X X X X

Hardware Reports, Intrusion Displays

Hardware Reports, BACnet Points

LDAP Audit History

Miscellaneous Reports, Person Access Right Report
Miscellaneous Reports, Person Reader Report

Miscellaneous Reports, Access Right Reader Report

X X X X X X X X X X X X X X X X X X X
X X X X X X X X X X X X X X X X X X X

X X X X X
X X X X

Miscellaneous Reports, Personnel Changes

Table 17. Controller (System) Setup

Role:

Personnel
Management

Badge Maintenance Operator

Function: Operator

Schedules, Schedules X X X X

Schedules, Calendar Schedules X X X X

User Management, Users X X X

User Management, Roles X X X

User Management, Change Password X X X X X
Backups X

Table 18. Controller (System) Setup, Remote Devices

Role:

Badge . Personnel
Function: Operator LA LI Management
Remote Drivers X X X
Remote Modules, Remote Module Setup (controller only) X X X
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Role:

Personnel

Badge
Management

Maintenance Operator

Function: Operator

Remote Modules, Remote Module Identification (controller only) X
Remote Modules, Access Network Setup (controller only) X
Niagara Integration IDs X
BACnet Network (controller only) X
BACnet BDT Manager (controller only) X

X

X

Station Manager

X X X X X X X
X X X X X X X

Certificate Manager

Table 19. Controller (System) Setup, Access Setup

Role:

Personnel
Management

Badge

Function: Operator Maintenance Operator

Access Zones X X X X
Card Formats X X X X
Access Control Setup X X X X
Additional Personnel Entry X X

Table 20. Controller (System) Setup, Intrusion Setup

Role:

Badge . Personnel
Function: Operator TR (Ol el Management
Intrusion PINs X X X
Intrusion Zones X X X
Intrusion Displays (controller only) X X X

Table 21. Controller (System) Setup, Alarm Setup

Role:

Personnel

Badge
Management

Maintenance Operator

Function: Operator

Alarm Classes X X X X
Alarm Instructions X X X X
Alarm Count Relays (controller only) X X X
Email Accounts X X X X
Email Recipients X X X X
Station Recipients (controller only) X X X
Power Alarm Setup (controller only) X X X
Alarm Consoles X X X X
Alarm Extensions X X X X

Table 22. Controller (System) Setup, Miscellaneous

Role:

Badge q Personnel
Function: Operator TR (Ol Management
Keypad Configuration X X
PDF Styles X X X
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Role:

Personnel
Management

Badge Maintenance Operator

Function: Operator

License Manager
Network TCP/IP Settings
Controller Maintenance (controller only)

Graphics, Graphics Management

X

Graphics, Images
Graphics, Navigation Groups

Server Maintenance (Supervisor only)

X X X X X X

Configure Database

Web Service

Replication Service (Supervisor only)
Jobs

System Date Time

End User License Agreement

Third Party Licenses

X X X X X X X X X X X X X X X
X X X X X X X X X X X X X

TimeServers Settings

Table 23. Controller (System) Setup, Threat Levels

Role:

Badge q Personnel
Function: Operator LTS (Tl Management
Threat Level Groups X X X X
Threat Level Setup X X X X

Permissions

Permissions are the properties of role categories that can be configured.

Figure 11. Permissions in Edit Role view

Fead | Write | Invoke
Admin ] O] L]
Badge Management
Personnel Management
Graphics ] ]

You can grant or deny permissions for each category that is available to a role by selecting or clearing the
appropriate option box for that permission. The following list describes each permission type:

* Read allows the user to view information of this category type. If this permission is denied, the user cannot
see information that is assigned to this category.

e Write allows the user to view and modify information of this category type. If this permission is denied, the
user may be able to see information that is assigned to this category (if Read permission is granted) but not
modify it.

* Invoke relates to calling or activating a command or subroutine. Depending on the context, an invoke is
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some sort of action, such as a ping, update, override, or door-unlock action. Different actions are available
and based on the component, and many have no actions available.

When an invoke permission is granted for a certain category, the user can initiate an available action on
the components assigned to the category. If an invoke permission is denied, the user cannot take any
action on a component that is assigned to this category.

For example, a user with Alarm Console invoke permission can force clear an alarm. With only read and
write permission, a user can acknowledge alarms, view and edit alarm notes and details, but cannot force
clear.

For example, a personnel manager requires multiple role permissions.

Figure 12. Permissions granted to a personnel manager

Paswonnel Massgeoesd

(o] (e
Rale
Busrig e Pereonnel Masageme Badge Manageme“t
1s D laselt Fne o
Dtaps s Personnel Management
Al ¥ ajgm|
Rt gt B @
P — BB
Srapie o/olo
Mty
e s ALCCE5S Rights TS
abadeler
i e ? HiO| 0O
P olo|o
Pt M | s taty [a] [} ]
Aarm ety Oo|jo|o
Bemsts e tetey ][] [
Camtraliar L bep ololo
Comaral Raperts gjol o

Tenant Management I:l I:l

A Personnel Management role includes the following permissions assignments:

Badge Management: Read, Write, Invoke

Personnel Management: Read, Write, Invoke
Access Rights: Read
Tenant Management: Read

Creating (editing) a user role

A role assigned to a user (as that user’s only role) controls what a user may view, such as personnel, badgeand
access rightsviews. Typically, when you assign a role, you also choose the Personnel Entry Access Profile
for the Profile property on the User tab. For convenience, you may use a personnel management role to filter
views so that only personnel management views are available to a user.

Prerequisites:
You are working in a Supervisor station.

Step 1. From the main menu, click System Setup > User Management > Roles.

Step 2. To open the Add New Role view click the Add button (| & | ) at the top of the view.
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The add new role view opens. The Role Name property appears above the tabbed area.
Step 3. Use the Role Name property to assign a unique name to the role.

Step 4. Fillin the Permissions boxes to associate with the role and click Save.
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In this example, a Personnel Management role includes the following permissions assignments:
e Badge Management: Read, Write, Invoke.

* Personnel Management: Read, Write, Invoke.

® Access Rights: Read.

e Tenant Management: Read.

CAUTION: Be careful with selecting Super User. A person with this role has access to the entire
system.

Creating (editing) a user and assigning a role

The term user refers to someone who is authorized to manage and configure the system. A user is also a
person in the system. Other people who use the system to access the building are persons, not users.

Prerequisites:
Roles have been created. You are using the web Ul to create a user in the controller station.

Step 1. From the main menu, click Controller Setup > User Management > Users, and do one of the
following.
e To create a new user, click the Add button at the top of the view to create a new user type.
* To edit all properties for an existing user, double-click the user row in the table.

* To edit selected properties, right-click the user row in the table and click Rename or the
Quick Edit button (

=4
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Step 2.

Step 3.

Step 4.

Step 5.

116

Niagara Enterprise Security Installation and Maintenance

Home
[ Schedules

da” Monitoring

& Personnel

A& User Management

#¥ Remote Devices

f= Backups

Guide

#% Coniroller Setup A Threat Levels

#¥% Access Setup

(®) Never Expires () Expires On |03-Jan-19

E save || [ users

User Roles
Full Name |Securit\_.r Officer
Enabled
Expiration
Lock Out false v
Language ]
Email

Gassword 3

Force Password Reset

Password Expiration
MNetwork User
Authentication Scheme Name

Cell Phone Number

Auto Logoff Enabled

Use Default Auto Logoff Period
Auto Logoff Period

Profile

=

Notes Required On Ack
Default Alarm Console

Enable Video Settings

Lavout

‘ security@thecompany.com

Pasawurd:|nuu"u |

Confirm: ||-||¢¢"nu |

false v

(® Never Expires () Expires On |03-Jan-19
[false
DigestScheme ﬂ

true W
true
(00000 |h|15
| Standard Access Profile V|

Surveillance Viewer L

true v

|C0n50IeRecipient ‘V|

true ¥

| Console and Playback v

‘ m [2mins - 4hours]

Enter the User Name at the top of the view above the Save button.
This is the User Name part of the log-in credential.

Enter and confirm the Password.

#¥ Intru

1159 [P[v]

[11:[s9 [PM[v]

For the Https authentication user, this is the password defined in each respective application. If
you need to configure these apps, you may edit their users later to provide credentials.
Otherwise, the apps will not connect to the station database.

Configure other properties, including Home.
Home configures the initial view the user sees after they log in. For example, the Ul may open to

the Alarm Console for an operator.

Click the Roles tab.
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Step 6.
Step 7.

Step 8.

Step 9.

Step10.

schedules

The assigned and unassigned roles view opens.

» powened by

[ Schedules = User Management F= Backups &% Remote Devices &% Access Setup  #¥ Intrusion Setup &F Alarm Sef

E save | ) users

User Name |User

User Roles H &

Newly Assigned

Unassigned

Admin

Badge Operator
Maintenance

Operator

Personnel Management

defaultPrototype

To view the list of Unassigned roles, click the Assign Mode button (|5 ).

Select an unassigned role and click the Assign button ([ @ ).

The system assigns the role to the user provided that the role assigned to the current user
includes adequate permissions. You cannot assign a role to the currently-logged-in user. In other
words, a currently-logged-in user cannot change their own role assignments.

To edit the permissions associated with the assigned role, double-click the role in the Assigned
pane, change permissions and click Save.

After entering at least a name, password and role you may click Save.
At least one assigned role is required to create a user.

Test each user you add by logging out of the web Ul and logging back in with the new user name
and password.
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¢ Verify that the username and password combination works.
¢ Verify that the Ul opens to the correct view.

e For an Alarm Console user, initiate an alarm and acknowledge it. To simulate a door-forced
alarm, modify a schedule to force the building into the unoccupied period of the day. Or you
could generate a door-held-open alarm.

Creating a controller machine-to-machine user

A machine-to-machine (M2M) user sets up network communication without requiring human intervention.

Prerequisites:
You are working in the web Ul connected to a controller station.

Step 1. Navigate to Controller Setup > User Management > Users, and click Add (| & | ).
The User tab opens.

&d” Monitoring ﬁ Personnel #% Controller Setup /b Threat Levels

[ Schedules = & User Management 2= Backups #F Remote Devices ¥ Access Setup  #F Intn

E save || &) users

User Name |M2M

User Roles

Full Name |Machine—tu—machine |

Enabled

Expiration ® Never Expires () Expires On [03-Dec-18 E:E M| v |
Lock Out false v

Language I:I

Email | |

F’asswurd:||--|¢¢|.-||o|| |

Password
Confirm: |"run|¢|muun|| |
Force Password Reset false v
Password Expiration ®) Never Expires () Expires On |03-Dec-18 [11:[59 [pm[+]
[ P SEpRNRN PN | R '_|I_I__

Step 2. Configure at least the User Name, Password and confirm that Enabled is be set to true, Password
Expiration is set to Never Expires, and Authentication Scheme Name is set to DigestScheme.

Step 3. Click the Roles tab and select the Admin role for this user and click Save.

Configuring a user’s web profile

This procedure edits an existing user. To create a new user, double-click the User Servicenode in the Nav tree
and click the New button.

Prerequisites:
You are working in Workbench.

Step 1. Inthe Nav tree, under the Services node, expand the UserService node and double-click a user.
The selected user property sheet opens.

Step 2. Inthe User property sheet view, confirm that the Web Profile property is set to Standard
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Access Profile or EntsecWeb Profile, and that the appropriate Nav file is selected in the Nav
File property, then click Save.

Special user for third party software application

While you can use the default admin superuser to create and configure all system functions, this user does not
work with third-party software application.

Third-party application software require a special user to facilitate access to the station database. The reason
that the admin user does not work with these third-party apps is that it defaults to DigestScheme
authentication. The third-party software require HTTPBasicScheme authentication.

You must create a separate user for each app. You can use Workbench or the web Ul to create these users. The
credentials you define for each user are those required by third-party software.

Configuring the WebService for Easy Lobby

Easy Lobby requires that two properties in the WebService to be configured before you can use it to manage
visitors. This procedure requires Workbench to configure these properties, which are not available in the web
ul.

Prerequisites:
You are connected to the station that will support Easy Lobby and are using Workbench.

Step 1. Expand Config > Services and double-click the WebService.
The WebService's AX Property Sheet opens.

EcSupervisor) . Config . Services . WebService / AYX Property Sheet -
Property Sheet
@ webservice (Web Service)
(W status {ok}
[fil Fault Cause
(@i Enabled @ true
@il Http Port 80 tcp
[l Http Enabled @ false
[l Https Port 443 tep
@i Https Enabled @ true
(@i Https Only @ true
m Hitps Min Protocol TLSw1.2+ - |
@i Cipher Suite Group Supported
Ul Main Https Cert tridium
U@l Server Certificate Health tridium == tridium : Ok
ﬁ Require Https For Passwords . true
(Ml Remember User Id Cookie @ true
E Same Site Lax
[l Allow Username Autocomplete @ e
[l Login Template A null -
¢ [fl LogFile Directory file:**weblogs

Step 2. Confirm that Https Min Protocol is set to TLSv1.2+.
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Step 3.
Step 4.

NOTE:

TLSv1.0 and TLSv1.1 are still supported for backwards compatibility, but it is recommended to

use TLSv1.2 and higher.
Change Cipher Suite Group to Supported.

To save these changes, click Save.

Setting up an Easy Lobby user

For security reasons, a separate user is required to set up Easy Lobby for visitor management. This procedure

creates an Easy Lobby user and assigns the Admin role to the Easy Lobby user.

Prerequisites:
Using the web Ul, you are connected to the Supervisor station.

Step 1.
Step 2.

Step 3.

Step 4.

Step 5.

120

From the main menu, navigate to System > User Management > Users.

To create an Easy Lobby user, click the Add button (| g | ).
The New User view opens.

E save | & users

User Name |EasyLubh1,r

User Roles =

Full Name |Eas\,r Lobby |

Enabled
Expiration (®) Never Expires () Expires On |25-Jul-18 [11:[59 [mM[~]

Lock Qut false v
Language .
Email | |
Passwurd:||.--oolo.- |
Password
Confirm: ||uunou |
Force Password Reset false v

Password Expiration (®) Never Expires () Expires On |25-1ul-18 [11:[59 [mM[~]

Network User

Authentication Scheme Name v
Cell Phone Number — |

Auto Logoff Enabled
Use Default Auto Logoff Period
Auto Logoff Period oooon | h IEI m [2mins - 4hours]

Praofile [standard Acress Profile vl

Enter at least a password and an Authentication Scheme Name of HITPBasicScheme.
New users default to the DigestScheme, which does not work with the Easy Lobby software.

NOTE: If the HTTPBasicScheme is not available, use Workbench to add it to your installation.
Refer to "Third-party software application” in the System Security chapter of this document.

To assign the Admin role to this user, click the Roles tab, click the Assign Mode button (g |),
select the Admin role in the Unassigned pane, click the Assign button (| o | ), and click Save.

Make a note of the User Name and Password so you can enter them into the Easy Lobby
software.
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Related tasks
Setting up HTTP Authentication scheme for third party application

Access rights

An access right defines a schedule and tenant. You associate access rights with readers and personnel. They
allow you to define and schedule what readers a person can use for entry and exit. Access rights provide
information about where a person typically resides in a building. In Enterprise Security, an Access Right can
have only one tenant, multiple tenants cannot be assigned to one Access Right. However, you can assign more
than one Access Right to a single tenant. For example, you can assign the access right named "Employee
Access" and the right named "Custodial Access" to a single tenant, as shown in the following image.

Access Rights
Fh »
[+ | : | L=l ca : I H| (2@ (s
Access Right Name Schedule Mame Integration Name Tenant Name
Employee Access Alweays Acme Financal
Custodial Access Always Acme Financal
wvigitor Always

Access rights control access to a facility while sharing access to some of the same entry and exit locations.
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Figure 13. Access right associated with a person and card reader

A

Access Right

Schedule: Business Hours I
Tenant: Acme Inc.

Assigning an access right to a reader associates the schedule and tenant with the specific reader and door.
Assigning the same access right to a person grants that person the right to enter or exit the tenant’s building
using the reader and door identified by the access right, during the time granted by the schedule.

NOTE: A person may have more than one access right assigned. Users do not have access rights — only
Personnel are assigned access rights.

Access rights control other system functions including threat levels and building controls.

Elevator control

An access right controls the floor(s) that a person can select in an elevator.

The system manages elevator access by providing a relay output for each floor that the elevator serves. This
relay is typically in the elevator control room (use an RIO module) and is wired in series with the floor buttons in
the elevator car. This wiring prohibits access to a floor unless the relay is energized, such as by an access right
or by a calendar schedule. When the person with the elevator access right swipes their badge, the relays for
the floor(s) they can access come on for a few seconds so they can make their selection.

When creating an elevator access right, you choose the card reader that is associated with the elevator, then
specify the floors that are accessible by the person with that access right. You can also assign a schedule to
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individual floors such that during daytime hours, the floor can be enabled automatically.

Creating an access right

Access rights define general information that applies to person types. The schedule associated with an access
right defines when the right is valid. Creating an access right includes associating specific card readers, doors,
and elevators and people.

Prerequisites:
You are working at the Supervisor station. A schedule to associate with the access right exists.

Step 1. From the main menu, select Personnel > Access Rights.
The Access Rights view opens.

Step 2. Click Add (| @)
The Add New Access Right view opens.

Step 3. Fill in the name of the right.
The name might be associated with a building or other location or relate to the type of user.

Step 4. Click the chevron next to the Schedule property, select a schedule from the Ref Chooser and click
Ok.

Step 5. [If the building is configured for multiple tenants, click the chevron next to the Tenant property,
select the tenant from the Ref Chooser and click Ok.

Step 6. Click the Save button.
The access right is saved and the edit existing access right viewopens.

Editing access right effective date and assigned threat level

Access right Effective Date and Assigned Threat Level apply only to a single access right assignment. To
change these properties, you navigate to a view that includes both the person and the assigned access right.
The following steps describe how to change these properties starting from the Access Right view. Similar steps
may be used to change these properties starting from the Add New Person and edit person views.

Step 1. From the main menu, select Personnel > Access Rights.
The Access Rights view opens.

Step 2. To edit the access right, double-click its row in the table.
The edit view opens.

Step 3. Click the People tab and highlight the person whose access right effective date you want to
change.

Step 4. In the toolbar menu, click the Change Assignment Properties button ( (= | ).
The Change Assignment Properties window opens.

Step 5. Configure the properties: Start Date and End Date and Assigned Threat Level, and click the
Ok button.

The access right properties are changed.

NOTE: Changing the Assigned Threat Level in an access right breaks the connection between
the access right and the threat level defined by the access right’s associated threat level group.
Future changes to the threat level as defined in the threat level group will not affect the threat
level that has been configured directly on an access right.

Step 6. To update the database, click the Save button at the top of the view.
Access control setup

Access is controlled by a complex combination of hardware (card readers and doors), passwords, PINs
(Personal Identification Number), access zones, intrusion zones, integration IDs and access rights.
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Access zones control occupancy levels and monitor the entry and exit actions of personnel for a defined area.
You may use anti-passback controls based on occupancy. This guide provides procedures for setting up access
zones.

Access control methods

An access method determines how a person gains access to a building or area.
The system provides these methods to control access:

e Card-only access allows entry or exit using a card at a reader. No PIN is required for this type of access.
® Card plus PIN access requires both a card and a PIN (Personal Identity Number).

* Card or keypad access requires either a card swipe, card number entry, or an intrusion PIN entry using a
keypad for access.

* Control access by schedule allows access only at certain times, depending on the schedule parameters. The
Installation and Maintenance Guide provides procedures for setting up regular schedules. This guide covers
special events.

* Access is available through the graphical user interface, which controls the doors.

Access zones

An access zone is a secured physical area used to control and monitor the entry and exit of personnel to and
from the zone. Entry and exit doors, their associated readers, and configuration properties define each access
zone. When an access zone is enabled or disabled, a log entry is written and, optionally, an alarm is generated
(for disabling the access zone).

The system monitors zone occupancy by counting the number of people who enter and exit, by identifying
occupant type (supervisor or other), and by maintaining an occupant threshold (the maximum or minimum
number of people allowed in the zone). Access zone-related alarms are configurable in terms of high, medium,
low, or off, as defined by their associated alarm classes.

Supervisor requirement
You may designate any person-type as supervisor. When supervisor enforcement is in effect for an access zone,
at least one occupant of the access zone must have the supervisor designation.

Occupancy counts and thresholds

Occupancy identifies who is in an access zone at any given time. Occupancy monitoring must be enabled.
When enabled and an entry reader grants access, the system increments the occupancy count. When a reader
grants an exit, the system decrements the occupancy count. A user with proper authorization may reset
occupancy count to zero manually at any time or automatically according to a designated time-schedule.

Occupancy thresholds configure the minimum and maximum number of occupants that are allowed in an
access zone. Thresholds may be enforced by denial of access at the entry door or by the generation of an
alarm—or a combination of both, using hard or soft enforcement, as described, below.

Anti-passback feature

The return of an occupant to an access zone after leaving the zone is called a passback. The system’s anti-
passback feature configures when an occupant is allowed to pass back. In addition to tracking who enters and
exists (occupancy), the system monitors the time between badge swipes. An occupant must exit through a
controlled exit reader door, and the Passback Timeout must expire for the occupant to be eligible for re-entry
into the access zone. A re-entry attempt by an occupant or a second badge swipe that occurs prior to the
Passback Timeout value is an anti-passback violation, which may generate an alarm.

System users whose access zone permission is configured for write enabled may change the Reset Occupancy
Time and Passback Timeout properties for an access zone.

Access enforcement
Several options exist for enforcing the supervisor requirement, count thresholds, and the anti-passback
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feature.
¢ Enforcement may be disabled.

¢ Hard enforcement may be configured. This type of enforcement results in access denied at a card reader
and the generation of an alarm.

e Soft enforcement results in access granted but with the generation of an alarm.

In an environment where enforcement depends on a network connection, hard enforcement results if network
communication is lost.

Multiple controller zones

When an access zone spans multiple controllers, one controller serves as the zone master. All other dependent
controllers rely on the master to maintain occupancy and configuration data. Dependent controllers query the
master to determine the authentication criteria at any given time.

The system maintains configuration data in all remote controllers so that in case there is a loss of
communication, a designated form of fall-back enforcement takes effect. When an access zone is configured
with supervisor monitoring, threshold monitoring, or anti-passback, fall-back enforcement occurs as follows:

e Hard enforcement denies access, and post an entry to the access report indicating that the denial of access
was due to communication failure.

e Soft enforcement grants access, but posts an entry to the access report indicating that the current
occupancy criteria are unavailable due to communication failure.

Grouping

You use grouping, in an access zone to include other stations and their readers as part of the access zone. A
remote controller that originates (or creates) an access zone is always the access zone master—even if the zone
is created from a stand-alone controller that is subsequently added to a Supervisor. As the access zone master,
this controller maintains the list of all people who have access to the zone.

NOTE: Do not create access zones from the Supervisor station. Create and maintain the access zone master at
a remote host controller so that a network connection to a Supervisor is not critical to keep the access zone
functioning. If the Supervisor is the master, and a network connection to the Supervisor is lost, the access zone
does not function.

Note the following points about grouping and the Add New Access Zoneor Edit Access Zone views:

® You must be connected to the master controller station.
* The stations (points) to add to the group must be joined in a peer role relationships with the master station.
* The Entry Reader and Exit Reader tabs display only local readers.

* The Occupants tab and the Supervisor tab are always available in the access zone views but the information
they display is based on settings from the access zone master station.

* You can only add readers to access zones when you are connected to the reader’s assigned station. Readers
are not visible or configurable from remotely-grouped stations.

Creating a new master access zone

A master access zone groups related stations and their readers that share physical proximity. The stations
within an access zone share access zone naming, status, occupancy, and Supervisor information. The controller
that originates (or creates) an access zone is the access zone master — even if the zone is created from a
stand-alone controller that is subsequently added to a Supervisor station.

Prerequisites:
Entry and exit readers are required for access zones to track occupancy.
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You perform this procedure in a remote controller station. You cannot create an access zone from the
Supervisor station. If a Supervisor station served as the master and connection to the Supervisor is lost, the
access zone would not function and access might be denied.

Step 1. From the main menu, select Controller Setup > Access Setup > Access Zones.
The Access Zones view opens.

# Home || & Monitoring || &, Personnel || [ Reports |J?Systﬂm Setlup| 3 Photo ID H A\ Threat Levels ‘

[f Schedules & User Management ¥i) Backups & Remote Devices & Access Setup ¥ Intrusion Se

YR CRILE
Zone Name & Station Name Fallback Enforcement
TenantB entSecurity8000 Hard

Step 2. Click the Add button at the top of the view.
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Step 6. To create the zone, click the Save button.

Guide schedules
The Add New Access Zone view opens with the Access Zone tab selected.
&d” Monitoring ﬁ Personnel Reports #% Controller Setup
B Schedules & UserManagement A= Backups #* Remote Devices &% Access
EH save | [ Access Zones
Display Name :ﬁ.c cess Zone-1|
Summary Access Zone Activity Alert Exts Occupants Supervisors = Entry Re
Occupancy Count 0 {ok}
Occupied false {ok}
Lock Down false ¥
Occupancy Criteria Any v
Passback Mode Hard v
Above High Threshold Enforcement off ~
At High Threshold Enforcement Off
Below Low Threshold Enforcement |off
At Low Threshold Enforcement Off
Supervisor Required Enforcement |off v
Pending Time 00 m |15 s [10secs - 1min]
Passback Timeout 00000 | h |00 m |00 s [Oms - 1day]
Reset Occupancy Enabled false ¥
Reset Occupancy Time 12 ¥ ;00 v ||AM ¥ |EST
High Threshold 100
Low Threshold -1 -
b
Step 3. Enter the name of the master zone in the Display Name property.
Step 4. Configure zone properties on the Access Zone tab.
Several properties provide soft and hard options. The Reference manual explains these properties
in detail. Hard means that if the occupant does not meet the requirement, the system denies
access and generates an alarm. Soft means that even if the occupant does not meet the
requirement, the system allows access, but also generates an alarm.
Step 5. Configure all applicable properties on the other tabs.

The editview of the access zone opens, with the Summary tab active.

Adding readers to an access zone

Entry and exit readers keep track of building occupants and supervisors.

Prerequisites:
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The access zone exists in the local station.

Step 1. From the main menu, select Controller Setup > Access Setup > Access Zones.
The Access Zones view opens

Step 2. Double-click an access zone row in the table.
The editview for the access zone opens.

Step 3. Click a reader tab (Entry or Exit Readers), and click the Assign Mode button ([ g|)
A list of the available readers opens in the Unassigned pane.

Step 4. Select the name of a reader from the Unassigned list and click and the Assign button (| o ).
To remove an entry and exit reader from the station’s currently-displayed access zone, select the
row in a Assigned pane and click the Unassign button (

@
).

Extending an access zone to include multiple stations
An access zone that includes multiple stations is a group. In addition to extending the access zone physically,
this allows sharing of access zone naming, status, occupancy, and supervisor information.

Step 1. From the main menu, select Controller Setup > Access Setup > Access Zones.
The Access Zones view opens

Step 2. Double-click an access zone row in the table.
The edit view for the access zone opens.

Step 3. Click the Grouping tab, and click the Assign Mode button ( 5] ).
The Assigned pane lists the stations that are part of the group. The Unassigned pane lists the
stations that are available to join the group.

Step 4. To assign a station, select its row and click the Assign button (| & ).
The system associates the station with the group.

NOTE: Access zone information is passed to a Supervisor station, as appropriate, but entry and
exit readers are not configurable or visible from the Supervisor.

Step 5. To remove a station from the currently-displayed group, select its name in the Assigned pane and
click the Unassign button ([ g | ).

Assigning a supervisor to an access zone

Only people designated as supervisors are eligible to be assigned as a supervisor for a specific access zone.
These have the Supervisor property configured as true on their personnel record.

Prerequisites:
The access zone exists in the local station.

Step 1. From the main menu, select Controller Setup > Access Setup > Access Zones.
The Access Zones view opens

Step 2. Double-click an access zone row in the table.
The edit view for the access zone opens.

Step 3. Click the Supervisors tab, and click the Assign Mode button ( 5/ ).
A list of any currently-assigned supervisors opens in the Assigned pane. A list of authorized
supervisors opens in the Unassigned pane.

Step 4. To assign a supervisor, select the person row and click the Assign button (| o).
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The system associates the person with the zone as a supervisor. To remove a supervisor from the
currently-displayed access zone select the name in the Assigned pane and click the Unassign
button (

@
).

Weekly schedule setup

Weekly schedules define when a building is open for business.

A weekly schedule defines normal working days.
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Figure 14. Weekly scheduler view

&d” Monitoring ﬁ Personnel & Controller Setup ﬂ'}, Threat Levels

B schedulez B User Management 0= Backups #' Remote Devices @' Access Setup  @F |

k= Save | ) Schedules

Summary Scheduler Schedule Setup Special Events  Access Rights  Intrusion Pins
T B £ QD

Sun Mon Tue Wed Thu Fri Sat

Granted Denied Granted Denied Granted Denied Granted

Start: (11 ™[{30 v||pM v|EDT
Finish: [11 v [{30 v|[PM v|EDT

Output: L null

The Default Output for this Schedule is currently set to "Denied {ok}".

The scheduling interface uses a simple calendar view. The screen capture is an example of a schedule used to
configure access rights for a daily shift. The procedures in this chapter configure a basic weekly schedule,

which you can associate with doors. The Facility Manager’s Guide explains calendar schedules and how to add
special events and holidays.

Adding or editing a schedule (default settings)

This procedure describes how to create a standard schedule that represents normal daily building activity.

Prerequisites:
You are working in the Supervisor station.

Step 1. Click System Setup > Schedules.
The Schedules view opens.
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Step 2.

Step 3.

Step 4.
Step 5.

schedules

Do one of the following:
¢ To start a new schedule, click the Add button (

&)
).

¢ To edit an existing schedule, double-click the schedule row in the table.
If you are adding a new schedule, the Add a New Schedule window opens.

Choose Default True /False Text...

True Text |Granted | )3

False Text |Denied | »

Choose a Schedule Usage...
&) pccess Right
O boor Unlock

| ok || cancel |

O boor Qverride
':::' Cuskom

| ok || cancel |

The Usage property in the Add a new Schedule view identifies the purpose of the schedule
making it convenient to identify and assign schedules to appropriate components (access rights,
door overrides, door unlock, and others). Selecting the Custom option defines a new use. Each use
can have its own facets so that the Boolean true, and false change as appropriate for the
schedule’s application. For example, for an access right, true can change to “Granted” and false
to “Denied.”

For a new schedule, select the type of schedule and click Ok.
After defining the purpose for the schedule, the system opens the Add New Schedule view,
Scheduler tab.

Enter a name for the calendar schedule in the Display Name property.

To add or edit an event, click in a day at the approximate event start time, and drag down to
define the start and finish times.
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Step 6.

Step 7.

Step 8.

Guide

Denied

U

Start: 06 V{00 v|[amM V| EDT
Finish: 112 v||00 v||PM v|EDT

Output: L1 ull

The Default Output for this Schedule is currently set to "Denied {ok}".

Once entered, events appear as solid colored blocks, while unscheduled (default output) time
appears as light gray. The event remains selected (by default, pink colored) when you release the
mouse button.

As needed, click again and drag on the event'’s top or bottom edge to change its start or finish
time (in broad increments).

Right-click on a scheduled block to use the popup menu to copy and paste event times across
predefined days of the week, to delete an event or to clear a day or week.

Choose an Output option (true or false) and use the Start and Finish properties to specify
when the Output option is effective.

NOTE: When you click on the block in the scheduler, you can choose if that block is true or false.
For example, when you add the event, the block may be set to "locked" when in fact you want
the door to be unlocked during that period. Sometimes you may need to use the start and finish
to get the exact time because the dragging function isn't very granular.

Use the properties on each tab to define a schedule, and click Save.

NOTE: For weekly schedules, it is a good practice to save your changes while working in each
tab, even though any save applies to changes made on all tabs.

The system saves the new or edited schedule and displays it in the edit schedule view.

Creating a custom-usage schedule

Most schedules control access rights, door unlock and door override. A custom-usage schedule expands the
capabilities of the system.

An example of when you may want to use a custom-usage schedule is in the case where you want to set up a
schedule that automatically arms and disarms an intrusion zone. You could name the usage “Intrusion.” You
may set the true state to armed, and the false state to disarmed . Make the default state true. Now you
can easily schedule your intrusion zone to disarm during occupied periods.

Step 1.

Step 2.

132

From the main menu, click System (Controller) Setup > Schedules.
The Schedules view opens.

Start a new schedule by clicking the Add button ([ g | ).
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The Add A New Schedule window opens.

Add a new Schedule

Choose a Schedule Usage...
) Access Right

 Door Unlock

) Door Override

®) Custom

[ox] [cance |

Step 3. Click the Custom option and click Ok.
The Choose a Usage... window opens.

Choose a Usage...

Usage b

(o (ot

Step 4. Use the string chooser to select the component with which to associate the schedule, and click
Ok.
The Choose Default True/False Text... window opens.

Step 5. Define what you want to appear when the condition is true, and what should appear when it is
false and click Ok.
The Add New Schedule view opens.

Step 6. Configure the Start and Finish times and drag the cursor to fill in each day.
Notice that the true and false text you defined appears in the Output property drop-down list.
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Chapter 7. NAC Driver Controller Setup
and Integration

The chapter describes the steps to discover and configure the NAC controller to the existing system.

Prerequisites

Workbench is already licensed with Niagara Access Application for Supervisor.
Niagara Access (NAC Server) is already installed and configured.

The Rdbms Network and the database is configured under Rdbms Network.

P wbh

The NAC Controllers have already gone through the initial configuration setup. This step must be
completed before the controller can be used and added to Niagara Access and NAC Network.

Add NAC Network

This topic explains to add the NAC network.
Step 1. Navigate to the Config > Drivers and double-click on the Drivers tab.

Step 2. Click the New button on the Driver Manager view.

T New X

Troetoadd ) mar e

oH Canorl
A New window opens.

Step 3. Select the NAC Network from the drop-down list and click OK .

Harme Type Enabled L
) HACHstwork  MAC Hetwoik thue

Ul Name  HRCHeTwork

Ui Tvpe  MAC
(i Enabled i true

Lo ot

A second New window opens.

Step 4. Use this window to give the network a unique name and click OK .
Configure NAC Network
This section provides instructions for a NAC network configuration.

Prerequisites:
Login to Niagara Access in Web Browser.

Step 1. Right-click the NAC Network > Views > Property Sheet.
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»  Station [Entsec) : Config : Drivers I NACNetwork _/ Property Sheet ~

- Nav NACNetwork O Actions & Topics  [B Slot Details

Cop

-i # O G)”’_“Et ok Display Name Value

My F - -
© MyFile System 'MW Status {fault,down,alarm,unackec

O myModules
& Platform ‘M Enabled true @
> & Station (Entsec)
A Home
© config 2 Health

L Services
@ © Alarm Source Info Alarm Source Info

v 6 Drivers

O HiagaraNetwork L Monitor Ping Monitor

(m Fault Cause Unlicensed: javax.baja.license.FeatureNotLicen

Fail [19-Mar-25 9:21 AM IST] Server authentication failed

B X Tuning Policies Tuning Policy Map
@ Milestone Network
) Asisvideo Network I+ Poll Scheduler N Poll Scheduler
o N & Http Config NAC Http Comm Config
Graphics

& Files (M N AC Server Details NAC Server Details

https://localhost/bajaun/webwidget/view:webEditors:MultiSheet itheme=ZebratformFactor=maxkuseLocalWbRe=trueLattachAfterinit=false
The Property Sheet view opens.

Step 2. Configure the following properties for the network
a. Expand Http Config > Address. Enter the IP Address as Localhost.
b. Enter the Port number already set for Niagara Access (NAC Server) in the Niagara Access
Configuration application.

Siahes  Databass Web Server Cortrolers Licerse  About

Fort 445
B HTTPS
[ Disabe web user inberface fonky AP1 infegrations allowed)

Cerihcme Sell-Signad et Rese

Launch the Niagara Access Configuration application via the desktop shortcut on the
system hosting the Niagara Access (NAC Server) to locate the Port number. Note that
administrator privileges on Windows are required to run this application. Once open, go to
the Web Server tab and check the Port field.

c. Expand NAC Server Details to enter server Credentials. Ensure the Username and
Password entered match those already configured for the Niagara Access (NAC Server),

then click save.

Step 3. Right-click on NAC Network > Actions > Ping. Once the ping action is completed, proceed to
approve the host certificate.

Step 4. Navigate to Tools > Certificate Management. Under the Allowed Hosts tab, choose the desired
certificate and click Approve to validate the host certificate.

AX Certificate Management
Certificate Management for Miagara Workbench

User ey Store  System Trust Store  User Trest Store  Allowed Hosts
Houts and host certificates that could net be validated:

Allowed Hosts

Hicrst Subject Approval Created lssued By

B localhostass CHstridivm.com, DU=Tridium, O=Tridium, L=Richmond, S=V&, C=US  na Wed Jan 08 15:23:43 15T 2025  CN=tridéurucom, OUsTridium, D=Tridism, Ls|

W Wad lan 08 167814 IST 2025 Niosrarad

M1 lnralhactaad Misoarad
|!| [ | .ﬂ'w I ¥ Unapprove m Dlete
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Step 5. To authenticate the connection with the server right-click on NAC Network > Actions >
Authenticate. If authentication is successful, the network status will update to OK, and the fault
cause will be cleared.

Step 6. To synchronize all configurations with the server, click on NAC Network > Actions > Sync To
Server.

NAC Network Actions

In addition to the standard operations, the actions supported by the NAC Network component include the
following.

Actions

* Ping : The Ping action establishes communication with the server to confirm the connection.

* Authenticate : You must authenticate to the server before adding any device to the network, using the
correct username and password for successful authentication.

e Terminate: This action terminates a session initiated through authentication, invalidating the associated
session token once triggered.

* Sync to Server: Transfer network and device configuration properties to the server whenever NAC
Network or NAC Device properties are modified.

* All Controller Firmware update: Update the firmware for all controllers listed under the NAC Network.

NAC Device Setup and configuration

This chapter explains about NAC Device setup.
Currently, NAC Driver can support two types of controllers.

1. ZKTeco Controller
2. Azure Controller

Adding NAC Controller to Workbench

NAC device Manager view manages the devices (NAC devices) connected or that need to be added to the
NAC network. It is available only for configuring NAC Devices.

The NAC Controllers have completed the first configuration setup. For more information, see the "NAC
Controllers-Initial Setup.pdf" page.
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NAC Controller can be added and configured in two ways
1. Manually add the controller using a new command.
2. Add controller using the discover option.

Discovering and Adding NAC Controller
This topic explains how to add an NAC controller to the Workbench.

Prerequisites:

Ensure that the controllers are connected to the same network as the server before attempting to discover
them in the Device Manager view.

Step 1. Navigate to the NAC Device Manager view within the NAC Network.

Step 2. Click onthe Discover button located at the bottom of the NAC Device Manager view.

W paites | [Gmem | a0 e | w s

o s ' #

The discovery process will search for controllers in the local network database and display all the
controllers found on the network.

Step 3. Right-click on the desired discovered controller and click the Add button.

Step 4. Inthe Add window, verify the configuration properties, such as the IP Address and Port of the

device.

Step 5. Click OK to add the controller to the server.
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Adding NAC Controller Manually to Workbench
This topic explains the steps to add the NAC controller manually to the Workbench.

NAC Controller can be added and configured in two ways
1. Through Device Manager View.
2. Through Palette.

Step 1. Right-click on ViewsNAC Network > Views > NAC Device Manager.

Step 2. Click the New button on the Device Manager view.

5 Me

MHame Type Enabled lpAddress Porl NemOfDeors B

iIIAIIDﬂIrD-‘H HAC Controller  true 13T.000.1 1] 1

@ e e = =
: E s e A EIMIII ST S S |
' Pm
.
= T .
iiﬂ- A ] N LI &L Dbl (LSS U ]
T :
- EAC Gt
®E 0D b e Mats Fasth bbb S| | nabind b -
Gk (TR GHSH
b ke -
A T —— e
v G
= -
™ | emm]
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& -
.
]
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LI ot | |G | | | || | W] ] | s # 1-emiaie Lostn

NAC Driver Controller Setup and
Integration

[ Hame HACCaatToller

. Trpe MHAC Controller

[l Enabled P e

[ waddress  [127.0.0.1 i
[ ot ]

. HumOf Doors | 1

oo o]
The New window opens.

Step 3. Select the required controller from the drop-down list and click oK .
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. Station (Entsec) . Config . Drivers . NACNetwork / NAC Device Manager =
* Nav New X
E 1 C [A] D objects
| . : Name Type Enabled Ip Address Port Num Of Doors R
=
D 1y Modules & AzureController Azure Controller  true 127001 0 4
Ir Platform
[i Name AzureController
v Station (Entsec) 3
[ Type Azure Controller
h Home [ . blad .
Enal true
4 eConfig -
2 ~B
> @ services [ 'pAddress 127.0.0.1 o
v 6 Drivers [i Port 0 1 objects
» NiagaraNetwork [i NumOf Doors 4
e £ k£ Num Of Doors ]
» eRdbmsNetwork
> Milestone Networ]
6 OK Cancel I
3 GAmsVideoNetwo

» 6 NACNetwork
» O Graphics
Q Files
@ History

K& New Folder || [ new | # Edit  §4 Discover W Cancel (B Add P Match &

New: Create new objects

A second New window opens

Step 4. Use this window to give the controller a unique name and click OX .
Follow the below steps to quickly add the device type directly from the palette.

Step 5. Open Workbench.
Step 6. Click on Config > Drivers > NAC Network under the station to open the Drivers view.
Step 7. Once the Drivers view is open, search for nacDriver in the palette's search bar.

Step 8. Drag the required controller type under the NAC driver to the Device Manager.

- Station (Entsec) . Config . Drivers v . NACNetwork / NAC Device Manager ~

) My Network Discovered 0 objects

p axisvideo Network
+ € NACNetwork
+ [P NACDeviceFolder
o i ZKTecoController

Device Name Address Device Type Number Of Doors =

b o Alarm Source Info

» €D points

-

b mm,NAC100 Database 1 objects

Name Type Exts Status Health IpAddress Port &

- Palette : Il NACDeviceFolder N AC Device Folder

W [X] 5 @ nacoriver

v OZKTecDContmllers
» @ NAC100
» o Atlas260
} g Atlass60

-~ ~ . K& New Folder | Dllcw | _I‘ Edit nllimr | W Cancel @Add

nacDriver-NACController

This component explains how to configure the NAC Controller.
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Figure 15. NAC Controller Property Sheet

. Station (Entsec) : Config . Drivers . NACNetwork : NACDeviceFolder . ZKTecoController . NAC100 / Property Sheet =
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s v "
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* Component Location:nacDriver Palette

* To access these properties, expand Config > Drivers > NAC Network > NAC Device > NAC Controller
and right click the controller Views > Property sheet.

* Other than the standard properties (status, enabled, fault cause, health, Alarm Info, and poll frequency)
these property supports the controller component.

Property Value Description
Points Door, Reader, and other points of The folder space consists of NAC
property sensor points, NAC Device points

and multiple door component based
on the controller type (1, 2,4 Door
Components). Refer Points Section
for more details

IP Address Read-only Defines the IP address or host and
port of the NAC Controller. The
location can be on the network or
elsewhere available on an intranet or
the internet

Port Read-only Network port of the controller (all
controllers would be updated with
443 by default)

Mac Address Read-only Corresponds to the MAC Address of
the controller

Number of Doors Read-only Reports the Controller type like 1
Door, 2 Door or 4 Door and the
maximum number of doors
supported by the controller

Firmware version Read-only Represents standard controller
firmware version
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NAC Door Setup and Configuration

With the controller, the default access mode for the door is Card Only. But there are other modes also

available like Card and Pin, Facility Code Only, Card and Bio, Card and Bio and Pin, Bio and Pin, Bio Only etc
By default the Controller component consists of one Door component with nacReader component along with
NACDevicePoint , NACStrikePoint and NACSensorPoint.

Figure 16. NAC Door
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If a door needs to be designated as an Exit Door, the Exit Door Extension must be added from the Palette.To

add it, simply drag the ExitDoor Extension from the palette into the NAC Door View.

T 1

EEEOORID _

Exit Door can be configured as same as another door.
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NOTE: Each Door component may include up to one Exit Door along with Readers. However, the Access
Points associated with the Door component are shared between both the Access Door and Exit Door
elements.

nacDriver nacDoor

The component provides the door configuration property for the NAC Driver. By default, the Controller
component includes a single Door component, which is equipped with a nacReader component, as well as
NACDevicePoint, NACStrikePoint, and NACSensorPoint elements.

Figure 17. NAC Door Property Sheet

[ = | L
W Eruadsle -‘
o —
m 0s »
W Ex .,..
W s " 3l Eme i ixi:
. . ..,.
|mall] L
i@ = . g
B e -
- .
- . I
W G Tndlof
Orc "
0O "
E -
W - MAL B

* Component Location:nacDriver Palette

* To access these properties, expand Config > Drivers > NAC Network and right-click the Controller Door >
Views > Property sheet.

® Other than the standard properties (Enabled and Door Mode Status) these property supports the
controller component.

* If a door needs to be configured as an Exit Door, the Exit Door Extension must be added from the Palette.

Property Value Description

Default Door Mode drop-down list Contains door modes to access the
door like Card and Pin, Facility Code
Only, Card and Bio, Card and Bio
and Pin, Bio and Pin, Bio Only, etc.

Exempt From Global Lockdown true or false (default) Specifies a particular door that is
excluded from auto-locking after it is
opened.

Exempt From Global Emergency true or false (default) Specifies a particular door to exclude

Unlock from the emergency unlock doors.
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Property Value Description

Deny Duress Transactions

Override Schedule

Strike Time

Held Open Alarm Time

Minimum Strike Time

Activate Strike on Rex

Re Lock On

Sensor

Exit Request

Strike

144

true or false (default)

null (default), true or false

hours minutes seconds (defaults to 5
seconds)

hours minutes seconds (defaults to
30 seconds)

hours minutes seconds (defaults to O
seconds)

true (default) or false

drop-down list

Additional properties

Additional properties

Additional properties

Allows to open the door if more
pressure applied.

When null is enabled, reports the
incoming value from the device.
You cannot change this value.

To change this value, click the
double-arrow to the right and
remove the null check mark.

Sets the duration for the card swipe,
ensuring it is maintained for the
specified amount of time.

Configures how long the door may
be held open before an alarm
condition manifests.

The card swipe must be maintained
for at least the minimum specified
duration

The strike is activated when a
Request to Exit is initiated.

Defines what should happen with
a door that has just been
unlocked.

Relock on the End of Strike Time,
and locks the door as soon as
strike time ends.

Relock on Door Open, lock the door
as soon as it unlocks. Relock on Door
Close, lock the door either after the
Access Unlock Time expires (if the
door has been unlocked but not
opened) or when the door closes.

Sensors are contact devices that
monitor the state of a door

Normal exit from an access zone.
Exit requests are devices that
provide access to leave through a
door without having to present a
badge/card.

Defines the state of the door like
lock is released or not
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Property Value Description

Door Forced Additional properties Configures the Door Forced
Extension to set the alarm-related
properties.

Door Held Open Additional properties Configures the Door Held Open
Extension to set the alarm-related
properties.

Suppress Rex Event true (default) or false Suppresses the Exit Request events.

Reader additional properties This component is documented in a
separate topic.

NAC Reader Setup and Configuration

The section addresses a way to configure the NAC Reader that is present under the NAC Access Door.
Figure 18. NAC Reader

I_IIIII_QI_CIIII_IIII_IIIIIII_I_I:"

Configure the NAC Reader properties

1. Double-click on the Reader to open the Edit window.

2. Edit the reader configurations, including Name, Enable, Reader Type, Address, and OSDP Address.
3. Click OK to save the changes.

nacDriver-nacReader

The component provides the reader configuration property for the NAC Driver.
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Figure 19. Nac Reader Property Sheet

My Modules + nacDriver . module palette . NACReader / Property Sheet -

O Actions & Topics [§] Slot Details

(@ Status
{ok}

[ Fault Cause

@ services (@ Enabled

 Drivers true @

6 NiagaraNetwork
© RrdbmsNetwork (@ Current Badge Read
6 Milestone Network
e Axis Video Network )
 NACNetwork (@ Last Badge Read
I NACDeviceFolder

i ZKTecoController

- s vi
g ZKTecoControllerl M Last Badge Activity

* Component Location:nacDriver Palette

* To access these properties, expand Config > Drivers > NAC Network and right-click the controller Door >
Views > Property sheet.

e Other than the standard properties (status, enabled, fault cause) these property supports the controller
component.

Property Value Description

Current Badge Read read-only Reports the number of the badge
being processed now.

Last Badge Read read-only Reports the number of the last-read
badge.

Last Badge Activity read-only Reports the last read or write using a
badge.

Last Person Name read-only Reports the owner of the last badge
read.

Last Person Id read-only Reports the ID of the owner of the

last badge read.

Validate Timestamp read-only Reports when the system validated
the badge.
Reader Type drop-down Allows to choose protocol as per

controllers between O S D P and
Wiegand format to read card data.

Attendance drop-down Allows selection of options: None,
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Property

Address

O S D P Address

Firmware Version

Led Type

Assignment

Reader Tamper

Prevent Remove

Alarm Info

Activity alert extensions

Value

number

number

read-only

drop-down

read-only

additional properties

false (default)

additional properties

additional properties

NAC Driver Controller Setup and
Integration

Description

Check In, and Check out for
recording attendance.

Address for specific reader.

Address of OSDP, if the readeris O S
D P type.

Displays current firmware version
installed on controller.

The LED activates upon a card swipe,
displaying either Green or a
combination of Red and Green.

Shows which door is assigned to the
reader.

Sets up the Reader Tamper
Extension to define alarm-related
properties in case the reader is
tampered with.

If the remove action is executed on a
controller with an encrypted
connection, a window appears to
confirm whether or not to proceed
with the removal.

Standard alarm-AlarmSourcelnfo
component.

Standard accessDriver-ActivityAlertExt.
Each has the same set of alarm
source info.
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Chapter 8. Device configuration

Devices include doors, readers, and sensors and any other components that can be controlled by the Niagara
Framework.

Discovering and adding access control modules
This procedure documents how to discover and add to the station database access control modules that are
connected to an RS-485 serial bus.

Prerequisites:
You are working in a controller’s web Ul.

Step 1. Navigate to Controller Setup > Remote Devices > Remote Modules > Remote Module Setup.

Step 2. Click Discover ( gy ).
The discovery process displays the discovered modules in the lower Discovered pane.

Step 3. Select each individual module and click Add (| & ).
The system adds the device to the station database.

Step 4. You can rename the module as you add it to the database and click OK.

Step 5. To verify that the device is online, right-click it in the Database pane and click Wink Device or
select it and click Wink ([ o | ).
The device responds.

Step 6. Instead of discovering modules, you can add each one individually by clicking Manage Devices (
& ), selecting Add and clicking OK, selecting the type of device to add and clicking OK, giving
the device a name and clicking OK,

Step 7. For each module, compare its firmware Installed Version and Available Version columns in the
table.

Step 8. If a more recent firmware version is available, select the module, click Upgrade Firmware ( 2, ),
verify that the version successfully updated, and click OK.

Step 9. To save the station, click Controller Setup > Miscellaneous > Controller Maintenance > Save
Station

Door configuration
Large companies may have thousands of doors. The procedures in this chapter configure single doors. You can
use replication to automatically configure additional remote doors.

Doors are connected to modules, which are hardware components that connect to a controller to provide
specialized functions. The devices that secure access doors and elevators connect to these modules.

Best Practice: During door configuration it is a good idea to save a station frequently. To save the current
station, click Miscellaneous > Controller Maintenance, and click Save Station.

Configuring a door with an electric strike mechanism
This procedure configures a typical door mechanism that locks upon a loss of power.
Prerequisites:

The door to configure has a card reader with no keypad, a fail-secure electric door strike, a door sensor with
alarm notification and a request to exit for shunt alarms only; it does not unlock. A schedule indicating when

March 21, 2025 149



Device configuration Niagara Enterprise Security Installation and Maintenance Guide

the door is unlocked (for normal business hours) exists.
Step 1. Navigate to Controller Setup > Remote Devices > Remote Modules > Remote Module Setup.

Step 2. Double-click the module to which the door and its reader are connected.
The Remote Reader Module tab opens.

Step 3. To associate the reader with the door, set Enabled to true and click the Doors tab.
The Doors tab opens.

Step 4. To give the door(s) more descriptive names, click Manage Devices, select Rename and click Ok,
select the door and click Ok, type in a name and click Ok.

Step 5. Click the hyperlink to the door view.
The Readers tab opens.

Step 6. To give the reader a more descriptive name, click Manage Devices, select Rename and click Ok,
select the reader and click Ok, type in a name and click Ok.

Step 7. Click the Strike tab and configure its properties according to the screen capture using the
company'’s Unlock Schedule.

&d” Monitoring ﬁ Personnel #¥% Controller

B Schedules &, User Management B= Backups <% Remote Devices

I save || & Manage Devices | [ R2ZR Lobby Access | [ Doors | O

Readers Strike Sensor Exit Request

Locked State

Status Locked {ok}

Auto Relock | Unlock Time V|

Schedule Operation |Unlock On First Validation V|

Unlock Schedule | |Wnrkjng Hours [Unlocked] b (%]
Override Schedule | |N{me b
Access Unlock Time |I}D | m |[]5 |s [1sec - 59mins]

Log Exit Requests |Nnne V|

Log Schedule Acti".ﬁtf

Threat Level Group /& |None »

Door Lock Output |Re|a}r Output 1 V|

Schedule Operation requires a schedule so that the system can identify the first validation,
which triggers unlocking the door.

The Door Lock Output value depends on the hardware configuration.

Step 8. Click the Sensor tab and configure the properties according to the screen capture.
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&d” Monitoring ﬁ Personnel #¥% Controller Setup

B Schedules & User Management 8= Backups | &% Remote Devices ¥ Access

I save || & Manage Devices | [ R2R Lobby Access || ) Doors | 0 Manual Ove

Readers Strike Sensor Exit Request

Closed State

Status Opened {alarm,unackedAlarm}

Door Held Open Limit |EIEI | m |31J | 5 [1sec - 59mins]

Debounce Time ) None ®lo0 |mlo1 |jooo |s[oms - Ssecs]
Door Forced Alarm Class | High v| | B& video Setup

Door Held Open Alarm Class| Medium V| B Video Setup

Sensor Fault Alarm Class | High V| | B Video Setup

Sensor Input |Supervi5ed Digital Input 1 V|

The Sensor Input value depends on the hardware configuration.

Step 9. Click the Exit Request tab and configure the properties according to the screen capture.

Home | | &o" Monitoring | | 4 Personnel #% Controller Se

B Schedules £ User Management A= Backups @ +#% Remote Devices

I save || & Manage Devices | [ R2R Lobby Access || ) Doors | O M:

Readers Strike Sensor Exit Request

Inactive State

Status Inactive {ok}

Inhibit Sensor false {okl

Enabled Schedule i |Nune >
Unlock On Exit Request

Exit Request Fault Alarm Class| High V| & video Setup
Request-to-Exit Input |Supenfised Digital Input 2 V|

The Request-to-Exit value depends on the hardware configuration.

Step10. To save the configuration, click Save and test the door.

Configuring a door with a mag lock

This procedure configures a door equipped with a mag lock. The contact closes to lock the door.

Prerequisites:
The door has a card reader with no keypad, a magnetic door lock (fail safe), a door sensor with alarm
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notification and a request to exit for shunt alarms only (it does not unlock). A schedule exists, which indicates
when the door is unlocked (for normal business hours).

Step 1.
Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Step 7.

Step 8.
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Navigate to Controller Setup > Remote Devices > Remote Modules > Remote Module Setup.

Double-click the module to which the door and its reader are connected.
The Remote Reader Module tab opens.

To associate the reader with the door, set Enabled to true and click the Doors tab.
The Doors tab opens.

To give the door a more descriptive name, click Manage Devices, select Rename and click Ok,
select the door and click Ok, type in a name and click Ok.

Click the hyperlink to the door view.
The Readers tab opens.

To give the reader a more descriptive name, click Manage Devices, select Rename and click Ok,
select the reader and click Ok, type in a name and click Ok.

Click the Strike tab and configure its properties according to the screen capture.

&d” Monitoring ﬁ Personnel #¥% Controlle

B Schedules &, User Management B= Backups <% Remote Devices

I save || & Manage Devices | [ R2ZR Lobby Access | [ Doors |

Readers Strike Sensor Exit Request

Locked State

Status Unlocked {ok}

Auto Relock |Re|nck On Door Close V|

Schedule Operation | Follow Another Strike V|

Follow Strike ] |R2R Lobby Access.Tenant A Door.Strike * (%]
Unlock Schedule | |Wnrkjng Hours [Unlocked] b (%]
Override Schedule | |N{me b
Access Unlock Time |I}D | m |DS |s [1sec - 59mins]

Log Exit Requests |Nnne V|

Log Schedule Acti".ﬁtf

Threat Level Group /& [None »

Door Lock Output |Re|a1,r Output 1 V|

A Schedule Operation of Follow Another Strike requires you to identify the door whose strike
this door follows (Follow Strike). The Door Lock Output relay depends on the hardware
configuration.

The Door Lock Output value depends on the hardware configuration.

Click the Sensor tab and configure the properties according to the screen capture.
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&d” Monitoring ﬁ Personnel #¥% Controller Setup

B Schedules & User Management 8= Backups | &% Remote Devices ¥ Access

I save || & Manage Devices | [ R2R Lobby Access || ) Doors | 0 Manual Ove

Readers Strike Sensor Exit Request

Closed State

Status Opened {alarm,unackedAlarm}

Door Held Open Limit |EIEI | m |31J | 5 [1sec - 59mins]

Debounce Time ) None ®lo0 |mlo1 |jooo |s[oms - Ssecs]
Door Forced Alarm Class | High v| | B& video Setup

Door Held Open Alarm Class| Medium V| B Video Setup

Sensor Fault Alarm Class | High V| | B Video Setup

Sensor Input |Supervi5ed Digital Input 1 V|

The Sensor Input value depends on the hardware configuration.

Step 9. Click the Exit Request tab and configure the properties according to the screen capture.

Home | | &o" Monitoring | | 4 Personnel #% Controller Se

B Schedules £ User Management A= Backups @ +#% Remote Devices

I save || & Manage Devices | [ R2R Lobby Access || ) Doors | O M:

Readers Strike Sensor Exit Request

Inactive State

Status Inactive {ok}

Inhibit Sensor false {okl

Enabled Schedule i |Nune >
Unlock On Exit Request

Exit Request Fault Alarm Class| High V| & video Setup
Request-to-Exit Input |Supenfised Digital Input 2 V|

The Request-to-Exit value depends on the hardware configuration.

Step10. To save the configuration, click Save and test the door.

Configuring a monitored exit door

The system can monitor doors and lock them in case of a loss of power. A sensor (balanced magnetic switch)
monitors this door, but its lock is purely mechanical.

Prerequisites:
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The door has no card reader, no door strike, no ability to receive an exit request, but it has a sensor with alarm

notification.

Step 1.
Step 2.

Step 3.
Step 4.

Step 5.

Step 6.

Step 7.

Step 8.

Navigate to Controller Setup > Remote Devices > Remote Modules > Remote Module Setup.

Double-click the module to which the door is connected.
The Module tab opens.

Click the Doors tab.

Click Manage Devices, select Rename and click Ok, select the door and click Ok, give the door a
descriptive name, and click Ok.

Click the hyperlink for the door.
Reader, strike and request-to-exit functions are not needed for this door. The various inputs and
outputs that are normally reserved for those functions are available for use elsewhere.

Click Manage Devices, select Delete and click Ok, select the reader associated with this door, and
click Ok.

Confirm that the Readers tab is no longer available.

If you need another relay output somewhere else in the configuration, you can delete the strike
for this door. RO2 will then be available on theAdditional Points tab for the module. There is no
harm in allowing the Strike tab to remain with everything set to the defaults.

If you need another supervised digital input somewhere else in the configuration, you can delete
the request to exit for this door. SDIn will then be available on the Additional Points tab for the
modaule.

If you choose not to delete the request to exit, set the Exit Request Fault Alarm Class on the
Exit Request tab to Off Alarm Class to prevent nuisance alarms.

Testing a door

This procedure tests the configuration to ensure it is working as expected.

Step 1.

Step 2.

Step 3.

Step 4.
Step 5.
Step 6.

Result

While viewing the Strike tab, click Manual Override, select an Override Type and confirm that the
Status changes to Unlocked as expected:

e For a door with an electric strike mechanism, the mechanism energizes the strike magnet to
lock the door after the override Time.

¢ For a door with mag lock, the contact closes to lock the door after the override Time.

While viewing the Sensor tab, open and close the door to verify that the sensor reports when the
door is open.

Assign a schedule on the Strike tab that sets up the door to be currently locked, then open the
door.

On the Sensor tab, verify that the sensor generates a door forced alarm.
Open the alarm console and acknowledge the alarm.

While viewing the Exit Request tab, issue a request to exit through the door and verify that
Status changes to Active and that, even though the schedule indicates the door should be
locked, the sensor does not generate an alarm.

Best practice: All doors should be configured to function the same way regardless of the locking mechanism.

Reader configuration

Readers are associated with doors.
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Best Practice: During reader configuration it is a good idea to save a station frequently. To save the current
station, click Miscellaneous > Controller Maintenance, and click Save Station.

Adding a reader

This procedure adds an existing reader to the station database.

Prerequisites:
You are using the web Ul. The reader has been installed next to the door.

Step 1. Navigate to Controller Setup > Remote Devices > Remote Modules > Remote Module Setup.

Step 2. Double-click the module to which the door and its reader are connected.
The Remote Reader Module tab opens.

Step 3. To associate the reader with the door, set Enabled to true and click the Doors tab.
The Doors tab opens.

Step 4. Click Manage Devices (g | ), and, select Add, and click Ok.

Step 5. Select the reader, click Ok, name the reader and click Ok.
The software creates the reader.

Step 6. Click the reader hyperlink, followed by clicking the Reader tab.
The Reader view opens.

do” Monitoring ﬁ Personnel

B Schedules & User Management E= Backups | &% Remote Devices

H save | [ Door
Summary Reader Activity Alert Exts Qutput Configuration

Status |{0 K}

Enabled
Reader Config | Reader Plus Keypad VI HID 5355 hl
Time Attend

Assignment |L{:I::t|ﬂ_.-r Main Door
Last Badge Read |
Threat Level Group /A, |None »
< >

Step 7. After configuring reader properties, configure the Activity Alert Exts and Output Configuration
tabs, then click Save.

Assigning a reader and floor to an access right

Each access right supports readers and floors. The association between an access right and its reader(s) tells a
Supervisor which of its subordinate stations needs the Orion data. A controller that is wired to a reader and
affiliated with a particular access right stores the data required to grant access to personnel who have the right
to swipe their badges at its readers.

Prerequisites:
You are working in the web Ul. You have already created one or more access rights. You have set up doors,
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readers and floors.

Step

Step

Step

Step

Step

Step

Step

Step

Step

1.

Click Personnel > Access Rights.
The Access rights view opens with the list of access rights.

Double-click an access right and click the Readers tab.
The assignment view opens.

Click the Assign Mode button ([ g])
The Unassigned pane opens and populates it with reader records.

Select the reader to associate with the access right, and click the Assign button (| & |).
The reader record moves from the Unassigned to the Newly Assigned pane.

If the access right applies to a specific floor, click the Floors tab.
The Floors discovery view opens.

Click the Assign Mode button ( g/)
The system opens the Unassigned pane and populates it with floor records.

Select the floor to associate with the access right, and click the Assign button ([ & |).
The floor record moves from the Unassigned to the Newly Assigned pane.

Click the Save button.
The access right is saved and the Summary tab opens.

Verify that the correct readers and floors (at the bottom of the view) are assigned to the access
right.

Configuring entry and exit readers for attendance tracking

Readers cause doors to open or remain closed based on scanning the information presented to the reader on a
badge. They provide the information the Personnel department needs to tract attendance.

Prerequisites:
A door has an electric door strike, a sensor with alarm notification, and entry and exit readers with no keypads.
The door’s request to exit shunts alarms only. It does not unlock.

Step 1.
Step 2.

Step 3.

Step 4.
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Navigate to Controller Setup > Remote Devices > Remote Modules > Remote Module Setup.

Double-click the module to which the door and its reader are connected.
The Remote Reader Module tab opens.

Click the Doors tab and click the door’s hyperlink.
The Doors tab opens.

Configure the Strike, Sensor, and Exit Request tabs as follows and click Save.
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Tab Property Value
Strike Locked State Open

Auto Relock Relock On Door Open

Schedule Operation Normal

Unlock Schedule None

Override Schedule None

Door Lock Output Relay Output 1 (depends on your configuration)
Sensor Closed State Closed

Door Held Open Limit 30 Sec

Door Forced Alarm Class High

Door Held Open Alarm Class Medium

Sensor Fault Alarm Class High

Sensor Input Supervised Digital Input 1 (depends on your
configuration)

Exit Request Inactive State Open

Enabled Schedule None When no schedule is assigned, the system enables a
request-to-edit by default.

Unlock On Exit Request No

Exit Request Fault Alarm High

Class

Request-to-Exit Input Supervised digital Input 2 (depends on your

configuration)

Step 5. To give an existing reader a more descriptive name, click Manage Devices, select Rename and click
Ok, select the reader and click Ok, type in a name and click Ok.

Step 6. To add a reader, click Manage Devices, select 2dd and click Ok, select a reader and click Ok, type
in a name and click Ok.
To add a reader, you must have already installed the hardware.

Step 7. Click the entry reader’s hyperlink, configure its properties, then click the exit reader’s hyperlink
and configure its properties. Click Save after configuring each set of properties.

Tab Property Value
Reader Enabled true
Reader Config Reader Only
Time Attend Clock Inforthe entry reader and Clock Out for the exit
reader
Assignment (defaults to name of the door)
Activity Alerts Exts for all alarms: Alarm Class Medium
for all alarms: Enable Logging (selected)
Output Configuration Valid Green Follow Strike State
Green Inactive State Open
Red Inactive State Closed
Valid Beeper Custom Time, On 1 Sec
Invalid Beeper Custom time, On 2 Sec
Beeper Inactive State Open
Beeper on Door Held Open Warning Only with warning time: 15 seconds before the
Alarm door-held-open alarm sounds. Activating the beeper-on-
door-held-open alarm reminds employees to shut the door,
saving energy and preventing anything else from entering
the building.
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Input/output: configuring a roof hatch sensor

In addition to door-monitoring sensors, the system supports other sensors, including roof hatch sensor, motion
detector, glass break sensor and auxiliary door sensor using input and output points. A roof hatch sensor
provides an example of how to configure these types of sensors.

Step 1.
Step 2.

Step 3.

Step 4.

Step S.

Step 6.
Step 7.
Step 8.
Step 9.
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Navigate to Controller Setup > Remote Devices > Remote Modules > Remote Module Setup.

Double-click the remote I/O module to which the sensor is connected.

The tab opens.
Click the Additional Points tab.

Identify the input point to use and give it a more descriptive name by clicking Manage Devices,
selecting Rename and clicking Ok, selecting the input name and clicking Ok, typing in a name and

clicking Ok.

Click the input point’s hyperlink.
The tab opens.

1 Home | | &o° Monitoring | | &g Personnel R

. Schedules & User Management £& Backup

I save | & Manage Devices | [ Remote IO

Configuration  Alarm Setup

=1 Edit
Facets 1. falseText=inactive
2. trueText=active
Status inactive {disabled,stale}

Enabled
Inactive State

Verify the facets: falseText=inactive, trueText=active

Set Inactive Stateto closed.

Set Enabled to true.

Click the Alarm Setup tab and configure the roof hatch alarm.
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I save | & Manage Devices | [ Remote IO

Configuration  Alarm Setup
[ZAalarm$20Settings

Alarm Class | High v| | B video Setup

Alarm Time Delay |1]III | m |DEI | s [0ms - 59mins 59secs]
Roof hatch compromised

Active Alarm Message

Roof hatch shut

Return to Normal Message

Alarm Inhibit Schedule [EE |Nune »

[FSupervisor$20Fault$20Settings

Alarm Class B Video Setup

Supervised Fault Cleared

Return to Normal Message

Step10. Save the configuration.

Motion, glass break, and auxiliary door sensors

The following properties provide examples of how to configure individual sensors.

Motion detector

Property

Configuration Facets trueText=active, falseText=inactive
Enabled true
Inactive State Closed

Alarm Setup Alarm Settings Alarm Class High Priority
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Property

Active Alarm Message Motion detected office

Return to Normal Message No motion

Alarm Inhibit Schedule Business Hours (or the equivalent)
Supervisor Fault Alarm Class High Priority

Glass break sensor

Tab Property Value
Configuration Facets trueText=active, falseText=inactive
Enabled true
Inactive State Closed
Alarm Setup Alarm Settings Alarm Class High Priority
Active Alarm Message Broken window office
Return to Normal Message none
Alarm Inhibit Schedule none
Supervisor Fault Alarm Class High Priority

Auxiliary door sensor

Tab Property Value
Configuration Facets trueText=active, falseText=inactive
Enabled true
Inactive State Closed
Alarm Setup Alarm Settings Alarm Class High Priority
Active Alarm Message Auxiliary door open
Return to Normal Message Auxiliary door shut
Alarm Inhibit Schedule none
Supervisor Fault Alarm Class High Priority

Converting a BA station into a Enterprise Security station

A BA (Building Automation) station manages analog and digital inputs from automation devices and
components. A Enterprise Security station manages a limited set of access-control components. Converting
Supervisor and controller stations to Enterprise Security stations involves installing services and setting up
users.

Prerequisites:
You are working in Workbench on a PC that is connected to the network.

Step 1. Open a platform connection to the platform (PC or controller).
A controller platform may be named for its IP address or domain.

Step 2. Connect to the station (PC or controller) you wish to convert.
Step 3. Expand the Config > Services folders in the Nav tree.
Step 4. If needed, open the Palette (click Window > Side Bars > Palette).

Step 5. Drag the following services from the appropriate palettes to the Services folder in the Nav tree.

Palette Service component

orion OrionService

entsec Enterprise Security Service

entsec AccessControlService

entsec ReplicationService

entsec Intrusion Service

entsec Intrusion SmartKeyService (controller only)
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Step 6. Set up an admin user with specific properties.

Property

Nav file module://entsec/rc/entsecHome.nav
Role admin

Default Web Profile Standard Access Profile

Hx Theme Lucid

Building control integration

Building logic manages a facility’s mechanical and electrical systems, such as its HVAC and lighting.

By associating an integration ID with the access right exercised by a person when they enter an access zone,
the system can automatically turn on lights and the building’s HVAC system.

Integration IDs link an access right to the building’s control logic. As an option for any access right, an
administrator creates a unique integration ID (name and integer value) and assigns it to an access right. When a
person exercises the access right to enter the building, the integration ID integer value is available to the
building control logic. The integration ID value may be used, along with a valid badge value to initiate HVAC
and lighting controls for the areas appropriate to the person or group that is represented by the integration
ID.

NOTE: The valid badge property has a true or false state that defaults to false until an authorized, active
badge is swiped at an appropriate reader. When this occurs, the property status changes to true momentarily
(2 seconds by default). This property is only available in Workbench under the reader. You use it in wiresheet
logic to determine when a person with valid access has used a reader

An access right may contain only one integration ID. Since many persons may share an access right, they also
share the access right integration ID. Therefore, access rights with integration IDs are typically defined and
named in terms of the common physical location that persons occupy.

For example, two access rights: Acme West and Acme East might relate to two sides of a single floor in the
Acme building. Persons with different access rights may enter the building through a common door and
actually have the same overall access to the building. However, if the different access rights contain unique
integration IDs, they can trigger building controls to turn on lighting in the west side offices for the west side
occupants and the east offices for east side occupants, as appropriate.
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Figure 20. Niagara Integration ID
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The graphic illustrates a person whose access right identifies an integration ID value of Acme West [1]. The
person enters the Acme building using a valid badge. The Building Automation System picks up the
ValidBadge=True and IntegrationID=AcmeWest[1] property values from the system (possibly over a BACnet
network) and the building control logic triggers a boolean control to turn on the west-side office lights.

Creating access rights with integration IDs

The following example can be performed from the system'’s browser interface by an administrator with proper
credentials.

Prerequisites:
You are working in a controller station and using the web Ul. You have people and one or more schedules in
the database.

Step 1. Navigate to Controller Setup > Remote Devices > Niagara Integration IDs.

Step 2. To create an integration ID, click Add ([ & |).
The Niagara Integration ID tab opens.

Summary Niagara Integration ID  Access Rights

Integration Name Acme West
Integration ID 1

Tenant (P Acme Pharmaceuticals » B O
Use this ID to indicate the presence of

Description personnel who have offices on the West side
of the Acme building o

Step 3. To create an access right, click Personnel > Access Rights, click Add (| & |).
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Step 4.
Step 5.

Step 6.

A blank Access Right tab opens.

Summary Access Right People Readers Floors

Access Right Name Acme West

Schedule | ‘Any Time Building Access »
Niagara Integration ID 4 Acme West [1] » B O
Tenant {(J Acme Pharmaceuticals » B0
Threat Level Group /& Threat Level Group - Code 2 » B9
Threat Level Operation Normal v

Default Assigned Threat Level --Default—- v

This access right allows you to enter the
Description Acme Buildin% at any time. It also activates
West-side building controls. p

NOTE: For convenience, name the access right the same name as the integration ID. Access right
and integration ID names do not have to match.

Fill in the blanks. Assign the Niagara Integration ID you created to this access right.

Click the Readers tab, click the Assign Mode button ([g|), select the desired reader from the
Unassigned list and click the Add button (| & |), and click Save.

To assign an access right to a person, click the People tab, double-click a person or select the
person and click Hyperlink ( ‘@] ), click the Access Rights tab, click the Assign Mode button ([ 5]),
select the access right assigned to the integration ID, and then click Save.

Setting up building control logic to use integration IDs

The following example is provided for system integrators using Workbench.

Prerequisites:
Workbench is open with network access to both the Enterprise Security system and the building control

stations.

Step 1.

In the station, navigate to Config > Drivers > AccessNetwork and expand the module, points,
door and reader that you are using for access integration (from a Supervisor station, perform
point discovery, if necessary).
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r
» Nav
I:=9 G @ My Metwork
B station (entSeciacE_o1)
h Home
.‘. Alarm

e Config
@ SErvVices
6 Drivers

6 MiagaraMetwork
e RdbmsMetwork
e AccessNetwork
2 R2R Lobby Access
oﬁ.lﬂrm Source Info

a Paints
0 oi1
© oiz
|i Lobby Main Door
() Exit Request
0 Sensor
0 Strike
i Froa
0 Last Location Id
) valid Badge

-} Invalid Badee

* Last Location Id contains the integration ID value of the last badge that was presented at the
reader.

* Valid Badge has a Boolean value output that provides a two-second (default) pulse when a valid
badge is presented.

Step 2. Using the Last Location Id and Valid Badge points as inputs, create logic on a Workbench wire
sheet that requires both of the following to be true:
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¢ Last Location Id (lastLocationld) value must equal the value of the targeted location. Multiple
locations can be defined as a group with a single value. This is the value that the integration ID

from the access right must match.
¢ Valid Badge (validBadge) value must be set to true. The badge-holder must be authorized as
having access at the targeted building door.
The combination of these two pieces of information indicate that an authorized person entered

the space and the occupation area associated with the person. The following simple wiresheet
illustration provides an example of logic that could be used to turn on lighting when an authorized

person gains access to an area.

Lights-Room 101
Eowolean Writable

a

Cut False okl @ def
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Chapter 9. Supervisor/controller
connections

Once a controller has been configured, and users, schedules and access rights have been set up, it is time to
establish communication between a controller and Supervisor stations, and synchronize the Orion database
(HSQL) in the controller with the Orion data (MySQL or MS SQL) in the Supervisor PC. This chapter is not
necessary for small companies with a single access controller.

The system’s discovery feature (learn mode), initiated from a Supervisor station, finds controllers on the local
subnet. Discovery is not possible when controller stations are on the other side of a router. Since an Ethernet
cable is limited to 300 ft (90 m) and large systems may have multiple routers, it is almost certain that the
system cannot discover all the stations in a large network. In addition to discovering remote stations, you may
need to manually add stations to the Supervisor.

The device management features are not available in a Supervisor station where configuration is called System
Setup as opposed to Controller Setup.

Logging in to the Supervisor station using the web Ul

The first time you log in the Supervisor station using the web Ul (browser), a setup wizard can prompt
configuration options.

Prerequisites:
You have opened one of the supported browsers. Your database exists and is ready to use. You have admin
rights.

Step 1. Inthe browser address bar, type the address of the Supervisor station ( localhost, if using your
PC) and press Enter.
The login window opens.

o

admin

Username:
[ B Change User

Password:

Login

Username defaults to admin .

Step 2. Enter your credentials (Username and Password), and click Login.
You set up the password when you created the Supervisor station.

Step 3. If the station’s Enterprise Security Service component’s Init Required property is set to true,
the wizard asks you to confirm the station and system display name, and the network settings
before proceeding.

Any change to platform settings requires a reboot.
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Step 4. Click each of the wizard buttons in order.
For each button, the wizard opens the appropriate station view for configuring the password,
database, and other properties.

Creating a Supervisor machine-to-machine user

A machine-to-machine (M2M) user in the Supervisor station sets up network communication without requiring
human intervention.

Prerequisites:
You are working in the Supervisor station using the web UL.

Step 1. Navigate to System Setup > User Management > Users, and click Add (| o).
The User tab opens.

Step 2. Configure at least the User Name, Password and confirm that Enabled is be set to true, Password
Expiration is set to Never Expires, and Authentication Scheme Name is set to DigestScheme.

Step 3. Click the Roles tab and select the Admin role for this user and click Save.

Defining a display name for a Supervisor station

A Station Display Name adds an easily-understood text name for the station that conforms to the building
owner’s technical jargon. The Station Name, which you entered when you created the Supervisor station from
a template conforms to a more cryptic technical convention with industry abbreviations, acronyms and labels.

Prerequisites:
You are connected to the Supervisor station and working in the web Ul.

Step 1. Click System Setup > Miscellaneous > Network TCP/IP Settings.

Step 2. Enter a descriptive Station Display Name and a System Display Name.
The System Display Name refers to the whole installation. Often, this is the company name or
system name for the whole company. These names should differentiate the Supervisor station
from all controller station in the network.

Step 3. Click the Update Display Names button.

Editing station information

This procedure configures login credentials and other properties in the Supervisor station’s database.

Prerequisites:
This procedure requires the Supervisor station.

Step 1. Expand System Setup > Remote Devices > Station Manager.
Step 2. Select the station in the Database pane and click the Edit button (| = ).

Step 3. Configure these properties: Login credentials and other properties for replicating a configuration
to one or more remote hosts, or for configuring the joining of a remote station to the Supervisor.

Configuring network settings
Check with your network administrator before setting up or changing network properties.

Prerequisites:

NOTE: If you are changing network properties, write down any changes you make so that you can reach the
changed remote controller after rebooting.
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Step 1.

Step 2.

Step 3.

Step 4.
Step 5.
Step 6.

Navigate to Controller (System) Setup > Miscellaneous > Network TCP/IP Settings.

The Display Names and Network Settings view opens. These names specify two separate titles
that appear in the top right area of the browser. The Station Display Name precedes the
System Display name, which also serves as a link to the Home view.

Type names and click the Update Display Names button.

The names appear in the top right corner of the title bar. The Interfaces properties are
displayed under the Network Settings heading in the lower part of the view. The following steps
are for the TCP/IP settings located directly under the DHCPv4 option list. On initial setup, these
properties contain the temporary factory-shipped IP Address.

CAUTION: Do not enable DHCP unless you are certain that the network has DHCP servers!
Otherwise, the controller may become unreachable over the network. In general (for stability), it is
better to use static IP addressing instead of DHCP, if possible.

For IPv4 Address, assign an IP address to the controller that is unique for the network you are
installing it on.
No other device on the network should use the same IP address.

For IPv4 Subnet Mask, assign the appropriate subnet mask used by the LAN.
Review, and if needed, adjust other TCP/IP settings.

To save your changes, click the Apply Changes and Reboot button.

The controller reboots to complete the network changes. During a reboot, the controller station’s
display name (top right corner of the user interface) dims while the station is unavailable. The
display name returns to the normal color when the station is restarted.

Configuring the database in the Supervisor station

The Supervisor station must be connected to a running database. If you connected the system database using
the Guided Setup Wizard, your database may not require additional configuration. This separate procedure
documents how to configure the database, which may be running on the same computer as the Supervisor, or
it may be running on a remote computer.

Prerequisites:
You are logged in to the Supervisor station using the web Ul with admin privileges. A database of the
appropriate type exists. You have configured the RDBMS network for secure communication.

CAUTION: Communication between the database and the Supervisor station must always be available,
otherwise the software will not work. Communication must also be secure.

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

From the Supervisor Home, click System Setup > Miscellaneous > Configure Database.
The Configure Database view opens with a Database Services tab, and a MySQLDatabase (the
default) tab. No database tab displays if no database driver is installed.

Configure the important database services properties at the bottom of the Database Services tab:
Replication Failure Alarm, Replication Overrun Alarm, and Replication Overrun Limit.
These properties apply to all databases installed on this Supervisor’s network.

To add or delete a database, click Manage Databases.
The Manage Databases window opens.

Select the Delete or Add option and click Ok.
The system lists the existing database tabs.

Select the database to add or delete and click Ok.
Only one database can be enabled at any one time. To use a database other than MySQL, such as
the MSSQL database, delete the MySQL database.

Enter the database name and click Ok.
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Step 7.

Step 8.

Step 9.

Step10.

The software adds the database as a tab to the view. This is the name of the MySQL or MS SQL
database you configured before installing the software.

Select the database tab, enable the database and configure at least these properties: Host
Address, User Name, Password, and Database Name.

* Host Address identifies the location of the database, which may be on the same computer as
the system software or in another location on the network.

* User Name and Password are the credentials you set up when you created the database
schema using MySQL or MS SQL. For MySQL, User Name should be a unique name other
than “root.”

e Database Name is the unique name you created using MySQL or MS SQL.

The database services are configured and you should now have a Database Services tab and a
specific database tab that matches the MySQL or MS SQL database you are connecting to.

Confirm that Use Encrypted Connection is set to true, and click Save at the top of the view.
This property provides flexibility should you need to turn off secure encrypted communication.

CAUTION: For normal operation, this property defaults to true, otherwise your data can be
compromised by someone with malicious intent.

Click the Set Orion Database button, select the database you just configured from the drop-down
list and click Ok.

CAUTION: Changing the Orion database removes ALL DATA from any current Orion database.
After designating the Orion database, you must restart the Supervisor station.

Click Restart Station, and click Ok to confirm the restart.

The station restarts. The station name, visible at the top right corner of the interface, changes
color or dims until the station is available again. After station restart, the station name displays in
the normal color.

Establishing two-way communication using discovery

The first step in setting up a network is to establish secure communication between the controller station and
the Supervisor station.

Prerequisites:
You are working in the Supervisor station using the web Ul.

Step 1.

Step 2.

Step 3.

Step 4.

170

To connect to the Supervisor station (localhost), open a browser and enter the address:
localhost.
The web Ul opens to the Login window.

Enter your PC (localhost) credentials, and click Login.
The web Ul home view opens.

Click System Setup > Remote Devices > Station Manager, and verify that the Discover button (
g ) is active (not grayed out).

Click Discover ( gy ).

The Supervisor station broadcasts a call, and all stations on the local subnet (not on the other side
of a router) respond. As each remote station identifies itself, the system populates the Discovered
pane, indicating that the Station Manager is in learn mode.

Because of each station’s configuration, communication can only occur using a secure (HTTPS)
port.

CAUTION: This discovery job may take several minutes to complete, depending on the number
of stations on the network and network speed. Do not refresh or close the view until the job
completes. Failure to allow the job to complete may result in duplicate or incomplete record sets
in the Supervisor's station manager database.
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Step 5. Select the station in the Discovered pane and click Add ([ o | ).
The Add Station(s) window opens.

EAB |

The following properties configure the connection The following properties configure the connection
from the bocal station to the remote station. from the remote station back to the local station.
Provide the details of the CROFTON_SEC station below, Provide the details of the Crofton station below,
{Username/Password must already exist on the remate staflon): {Username/Password must already exdst on the local station):
Enabled Enabled tue v
Credential Store
UsernamefndPassword UsernameAndPassword

Username Username

Password  ssssssss Password sssssess
Use Foxs true Use Foxs trug
Fox Port 4912 Fox Port 4911

‘What Is the role of the remote station from the perspective of the local station?
Desired Role | subordinate w

Ok  Cancel

This window sets up the network account for the Supervisor and all selected stations. The
properties on the left are for the Supervisor station. The properties on the right are for the
controller station.

Step 6. Read the sentence above Desired Role carefully and make sure you understand that, from the
perspective of the Supervisor (local station), the controller station is a Subordinate station.

Step 7. When you have configured both sides for secure communication (Use Foxs = true and Fox Port
= 4911), click Ok.

The system saves the configuration and returns to the Station Manager view.

Step 8. To verify the connection, select the station and click Ping (@ |).
The system confirms the state of the connection.

Establishing two-way communication manually

Establishing a connection between a remote station to a Supervisor station prepares the two for a join or
replicate. The software assumes a peer relationship, that is, it assumes you are connecting two remote stations.

To connect a remote station to a Supervisor station requires the definition of the remote station’s role in the
relationship.

Prerequisites:
Both stations are running. You are working in the Supervisor station running on a PC.

Step 1. Open your browser and log in to the Supervisor station (localhost).
Step 2. Using the same browser, log in to the controller station.

Step 3. In the Supervisor station, click System Setup > Remote Devices > Station Manager.
The Station Manager view opens.

Step 4. Click the New button ( ).
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Step 5.

The New connection window opens.

The following propertles configure the conmection

from the local station ko the remote station.

Previde the details of the REMOTE station below.
[Username/Password must already exist on the remote station):

Station Name
Enabled trua W
Address I

UsernameAndPassword
Usaername

Password sssesass

Use Foxs false ~
Fox Port 1911

Continue to Remote Configuration... | Cancel

This window configures the information about the remote controller that the Supervisor needs to
connect to the remote.

F

ill in the properties as follows and click Continue to Remote Configuration....
Station Name is the name of the remote station.
Enabled must be set to true.
Address is the IP address of the remote controller.

Username and Password are the credentials for logging in to the remote station. The example
uses the credentials for an M2M (Machine-to-Machine) user.

Use Foxs set to true and Fox Portsetto 4911 together configure the connection for
secure communication.
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The system connects the Supervisor to the remote station and opens the Remote Configuration
window from the standpoint of the remote station.

Remote Configuration

Thee following properties configure the connection

fram the remote station back to the local station.

Provide the detalls of the station below.
(Username/Password must already exist on the local station):

Enabled trug v
Credential Store

UsernameAndPassword

Username | admin

Password
Use Foxs true
Fox Port 4a11

What is the role of the remaote station from the perspective of the local station?
Desired Role Subardinate

Ok  Cancel

Step 6. Fill in or confirm the properties as follows, then click Ok.
* Enabled must be set to true.
® The credentials are those that the Supervisor station requires.

® Use Foxs set to true and Fox Portsetto 4911 together configure the connection for
secure communication.

* Desired Role defines the role that the remote station assumes in relationship to the
Supervisor station. This role defaults to Subordinate.
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The system attempts to connect back to the Supervisor station. If it does not work, try connecting

from the controller, then connect again from the Supervisor. You will notice the differences in the
above windows.

Whether or not the stations connect, the remote station appears in the Station Manager view of

the Supervisor station and the Supervisor appears in the Station Manager view of the remote
station.

Home || &c Monitoring & Personnel

#% System Setup [ "dgdrd

[raimdwork
E Schedules &, User Management E= Backups

#% Remote Devices #F Access Setup  #F Intrusion Setup  #F Ala

w0 zmelellslo aEklrlalae [lallzl® =

=

=

Station Name

Host Name Scheme Fox Port Status Actual Role Role Status Joined Auto Repl

accessControllerStation_1 192.168.1.10 foxs

4911 {ok} Subordinate {ok} false

false

https://localhost/ord?entsecnav:/setup/schedules h

Step 7. To edit the station details select the station and edit

»| icon.
Edit window opens.

CROFTON_SEC

The following properthes configure the conmection

from the local station to the remote station.

Prewide the details of the REMOTE station below.
(Username/Password must already exist on the remote station):

Station Name |CROFTON_SEC |
Enabled trug
Address [1ocalhosy J

UsernameAndPassword
Username | admin

Password sesssnss L
Use Foxs true v
Fox Port 4012

| Continue to Remote Configuration... | Cancel

Step 8. Update the required details and click Continue to Remote Configuration.
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Remote Configuration window opens. to save the changes click OK.

The following properties configure the conmection

from the remote station back to the local station.

Provide the detalls of the Crofton station below.
(Usernane/Passwond must already exist on the lecal station):

Enabled tae v

Credential Store

UsernameAndPassword

Username | admin

Password
Use Foxs true v
Fox Port 4911

Desired Role | Subordinate ~

Ok  Cancel

What is the role of the remote station from the perspective of the local station?

Step 9. In the Supervisor station, verify that Status is {ok} and that the role of the controller is

Subordinate.

Five new columns (Joined, Auto Replicate, Replication Status, Last Replication, and User Status)
and five new buttons (highlighted in the screen capture) appear.

Step10. To ping the controller, select its row and click Ping ( ).

Step11. Log in to the controller station, click Controller Setup > Remote Devices > Station Manager.

The Station Manager view opens.

Step12. Verify that Status is { ok} and the Actual Role of the Supervisor station is Supervisor.

Result
You are ready to join the stations.

Station join best practices

Once you install or upgrade the software, you join each remote controller station to its Supervisor. This adds
Schedules, tenants, access rights and personnel data that are stored on a single remote controller.

Before the join:

* Delete or rename any access rights that exist on a single controller if they match an access right that is

currently in the Supervisor station.

* Delete any calendar schedules that exist on a single controller.

* Secure communication between the Supervisor and remote station is very important and must include
both data encryption and server authentication. Since each station (Supervisor and remote controller) can
serve as both a client and a server, each station requires a root CA certificate in its Trust Store and a
unique, signed server certificate in its Key Store. Confirm that this is the case before you complete the

join.
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NOTE:

If you do not set up your certificates in advance, the join requires you to approve the self-signed
certificate. This process requires the Web Launcher.

Joining a controller station to the Supervisor station

Joining the two stations updates the Supervisor’s Orion database (My SQL or MSSQL) with data from the
controller’s HSQL database.

Prerequisites:
The controller and Supervisor stations are connected with the controller station configured as the subordinate
station.

Step 1. From the Supervisor Home page, expand System Setup > Remote Devices and click Station
Manager.
The Station Manager view opens. This view lists the stations that are currently part of the
Supervisor station database. The table is empty if no stations are in the database.

Step 2. Select a single station and click the Join button (| = ) at the top of the view.
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Step 3.

Step 4.
Step 5.

The Join Manager view opens with the station name as the title of the view.

Z2  Commit & Retrieve Import Status Reset Import Status ) NiagaraNetwork

Step 1: Make sure the System Date Times are synchronized within 1min of each other.

Supervisor Time 08-Mov-18 4:45 PM EST
Subordinate Time 08-Nov-18 9:45 PM UTC [} Srnchrnnize Time
Time Difference < imin

Step 2: Use the Distributed Schedule Manager to import schedules.
Distributed Schedule Manager

Step 3: Make sure the database will be imported properly.

Record Type Import Status
P Tenants Mo Objects
[F] Keypad Formats 3 Matched Objects
5: Wiegand Formats 5 Matched Objects
ﬁ Personnel Mo Objects
2y Additional Personnel Data | Mo Dbjects
] Badges Mo Objects
4% Miagara Integration IDs  No Ohjects
E Access Rights Mo Objects
A Intrusion Zones Mo Objects
2 Intrusion Pins Mo Objects
] Readers & New Objects
I Floors Mo DObjects
/My Threat Level Groups Mo Objects
= Threat Level Range 3 Matched Objects

If the Time Difference property is greater than one minute (displays in red), click Synchronize
Time.

A Synchronize Time window opens and, after confirming your choice, the time synchronization job
brings the time of both systems to within one minute of each other. This ensures that records,
which are added to the Supervisor station during the join process, have a common time reference.

To return to the Join Manager view, click the Back to Join Manager button ([ |).

Click the Distributed Schedule Manager link.
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Step 6.

Step 7.

Step 8.

Step 9.

Step10.

Step11.

178

The Distributed Schedule Manager view opens.

&a" Monitoring &, Personnel #% System Sefup /iy, Threat Levels

@ Schedules 5 UserManagement E= Backups =% Remote Devices &% Access Setup #¥ Alarm Setup  &¥

@ e (@) 2 (@20
A
After Hours Access Right {ok} Week: thursday false {ok} 0&-Feb-19 6:00 PM EST false {ok} /5
Always {ok} Default Output true {ok} 25-Feb-19 12:00 AM EST true {ok} ]
M-F: 6-6 {ok} Week: thursday true {ok} 08-Nov-18 6:00 PM EST false {ok} /5
‘Weekend Access Right {ok} Default Qutput false {ok} 10-Nov-18 12:00 AM EST true {ok} /5
‘Working Hours Door Unlock {ok} Week: thursday true {ok} 08-MNov-18 6:00 PM EST false {ok} /5
Discovered
& ¥ [d
After Hours slot: (Drivers/Miagaraletwork/entSecSupTest_01/schedules/Afters20Hours slak:(Services/EnterprizeSecurityService/scl
‘Weekend slot:/Drivers/MiagaraNetwork/entSecSupTest_01/schedulas/\Weekend slot:/Services/EnterpriseSecurityService/sd
‘Working Hours slot:/Drivers/Miagaraletwork/entSecSupTest_01/schedules/\Working$20Hours slot:/Services/EnterpriseSecurityService/sd

This step transfers schedules that originate in the remote host station to the Supervisor station
and subordinates them to the master schedules in the Supervisor station. These schedules are
not part of the Orion data.

To find the subordinate schedules in the host controller station, click the Discover button ( gy ),
select and Add (| @ | ) or Match (| &) the appropriate schedules to the join job.

Click Retrieve Import Status.

By default, the Import Status for all records is Not Configured. A direct correlation exists
between this list of Record Types and the actual table structure of the Database in the Supervisor
station. Clicking Retrieve Import Status aligns the information in the host station with the
database in the Supervisor station.

Visually verify that the import Status for each Record Type makes sense. You should have a feel for
how many people, badges, access rights and readers exist in the controller.
The process asks you to confirm the return to the not-configured state.

If needed, use the Reset Import Status button to undo the Import Status.

NOTE: All record types must be configured to identify matching objects (if any). The Commit
button is not available until all the record types are configured. If there are conflicts between data
on the Supervisor and the remote stations, a Recovery operation may be required instead of a
join.

To see the details of any synchronized record, click a link under the Record Type column.

If there are no schedules in the remote station to import, you can skip the next steps.

When the Import Status is configured for all Record Types, click the Commit button.
The system reports the status of the join.
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Replicating a configuration

Replication is a network management function used to speed the configuration of remote controllers. It
configures each remote secondary controller from an already-configured primary controller.

Prerequisites:
The software versions for both the Supervisor and remote station(s) are compatible. The system is open in a
browser running on your Supervisor PC.

Step 1. To navigate to the Station Manager view, click System Setup > Remote Devices > Station
Manager.
The Station Manager view opens.

Step 2. Click the Replicate button ( g:|).
NOTE: Join must be performed before replication can take place.

After configuring all record types, the Commit button is available for completing the join process.
If Replication is disabled, a window prompts you to enable and run replication.

Replication is disabled

Replication is currently disabled. Do you want to enable and run replication?

| ok || cancel |

Step 3. To enable replication, click the Ok.

Step 4. To start the replication job, click Replicate ( [g:|).

Once the replication job starts, a progress bar marks job progress until the replication job
completes successfully or fails, as indicated by the final job status window.

Step 5. Once the job is successful Replication success window appears. To see the details click Show
Details.
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J Success
Hide Details
Status Timestamp Moessage

) Message  0G-Dec-22 6:43 PM IST  Bagin replicating all subordinate stathons.

D Message  06-Dec-22 6:43 PMIST  Num of Replication Executors...5

| (D Message  06-Dec-22 6:43 PMIST  Begin replicating station CROFTON_SEC, Replication Timestamp is 06-Dec-22 6:39 PM IST

D Message  06-Dec-22 6:43 PMIST  Show summary for EntsecReplicator  Detalls,,,
@ Message  06-Dec-22 6:43 PM IST  Show summary for IntrusionReplicator  Detalls...
) Message  06-Dec-22 6:43 PMIST  End replicating station CROFTON_SEC [0 seconds]
) Message  OG6-Dec-22 6:43 PM IST  Clean BDeletion records upto: 1670332141641
) Message  06-Dec-22 6:43 PMIST  End replicating all stations [0 seconds]

o | Suocess 06:-Dec=22 6:43 PM IST  Job Success

ok || Export |
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Replication details window opens.
For more details of Replication click on Details. This gives additional information about the

records. Following is the window that displays details for EntsecReplicator and
IntrusionReplicator respectively.

Message [10:17:39 18-Nov-22] begin for CROFTON_SEC

Message [10:17:39 18-Nov-22] begin replicateFromJace

Message [10:17:39 18-Nov-22] pullDelete entsec:AccReaderRec 0 records

Message [10:17:39 18-Nov-22] pullPersist entsec:AccReaderRec 15 records
Message [10:17:39 18-Nov-22] pullDelete entsec:AccFloorRec 0 records

Message [10:17:39 18-Nov-22] pullPersist entsec: AccFloorRec 0 records

Message [10:17:39 18-Nov-22] end replicateFromJlace

Message [10:17:39 18-Nov-22] pushDelete entsec:WiegandFormat 0 records
Message [10:17:39 18-Nov-22] pushDelete entsec:KeypadFormat 0 records
Message [10:17:39 18-Nov-22] pushDelete entsec: Tenant 0 records

Message [10:17:39 18-Nov-22] pushDelete entsec:NiagaralntegrationID 0 records
Message [10:17:39 18-Nov-22] pushPersist entsec:WiegandFormat 0 records
Message [10:17:39 18-Nov-22] pushPersist entsec:KeypadFormat 0 records
Message [10:17:39 18-Nov-

22] pushPersistPerJace entsec:NiagaralntegrationID 0 records

Message [10:17:39 18-Nov-22] pushDelete entsec:ScheduleRec 0 records

Message [10:17:39 18-Nov-22] pushDelete entsec:AccReader]oin 0 records
Message [10:17:39 18-Nov-22] pushDelete entsec:AccFloorJoin 0 records

Message [10:17:39 18-Nov-22] pushDelete entsec:PersonAccloin 0 records
Message [10:17:39 18-Nov-22] pushDelete entsec:Badge 0 records

Message [10:17:39 18-Nov-22] pushDelete entsec:AccessRight 0 records

Message [10:17:39 18-Nov-22] pushDelete entsec:Person 0 records

Message [10:17:39 18-Nov-22] begin threadReplication

Message [10:17:39 18-Nov-22] pushDelete entsec: ThreatlevelGroupRec 0 records
Message [10:17:39 18-Nov-22] pushDelete entsec: ThreatLevelStationJoin 0 records
Message [10:17:39 18-Nov-22] threadReplication not required entsec:AccReaderRec
Message [10:17:39 18-Nov-22] pushPersistPer]ace entsec:AccessRight 0 records v
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begin for CROFTON_SEC

pullDelete entsec:IntrusionZoneGroup 0 records
pullPersist entsec:IntrusionZoneRec 0 records
pullPersist entsec:IntrusionZoneGroup 0 records
pushDelete entsec:ScheduleRec 0 records
pushDelete entsec:Tenant 0 records
pushPersistPerJace entsec:Tenant 0 records
pushDelete entsec:IntrusionPinJoin 0 records
pushDelete entsec:IntrusionPin 0 records
pushPersistPerJace entsec:IntrusionPin 0 records
pushPersistPer]ace entsec:IntrusionPinloin 0 records
end for CROFTON_SEC

Message [10:17:39 18-Nov-22
Message [10:17:39 18-Nov-22
Message [10:17:39 18-Nov-22
Message [10:17:39 18-Nov-22
Message [10:17:39 18-Nov-22
Message [10:17:39 18-Nov-22
Message [10:17:39 18-Nov-22
Message [10:17:39 18-Nov-22
Message [10:17:39 18-Nov-22
Message [10:17:39 18-Nov-22
Message [10:17:39 18-Nov-22
Message [10:17:39 18-Nov-22

S Ty S [ S S S Sy T _—

Replicating a configuration to NAC server

The replication service replicates data to the NAC server according to the configurations applied to the NAC
controllers.

Step 1. Navigate to Workbench, expand Station > Config > Services > Replication Service.

. Station (Entsec) . Config . Services . ReplicationService #  Propertyheet ~

O Actions & Topics @ Slot Details

- Nav ReplicationService
E # O

& MyN

© auditHistory
© LogHistory
@ ProgramService

(@ Status

{fault}

@ Fault Cause

@ BackupService

@ WebService

A QrionService

B emailservice

B EnterpriseSecurityS
% AccessControlServic
14 ReplicationService
M intrusionService

[ intrusionSmartKey$

com.tridium.orion.OrionException: Database Ol
(Ml Enabled
true .

[ State

G Execution Time O
2:00 AM {Sun Mon Tue Wed Thu Fri Sat}

The Replication Property Sheet Opens.

Step 2. Right-click on the Replication Service, select Actions > Execute as Job.

Replication job starts. When the replication job begins, a progress bar tracks its progress until it
is either completed or fails, as shown in the final job status window.

Step 3. To verify the replication status, navigate to Config > Services > Job Service. When the Job

window appears, click on the Replication Job.

182 March 21, 2025



Niagara Enterprise Security Installation and Maintenance Guide Supervisor/controller connections

& Job Log ¥ R
Shatun Tinelemp Mrspe Dl ibi, N ]
[I] mesiage o9-btar-25 BECPUIST  Bepn mplbcating M
[[] miotnage  tri-har-25 540 PM ST  bum of Besleation Eurcuton 5 L
m Weviage ObWar-J3 343 W AT Bepr Brpboating ML Brplicstcr Repbestion Timetanp m 08 War- 34 648 11T

M
m Metiage OFMar- 24 10 PM AT Shaw tormemasy Tor KAC Beplicater Meiiage | 1LA000 0% sar 28] Started MAC Beplication
[ mwseapr ot-star-24 240 PR ST End Bephasting HAS Beplicatos [0 sexnads I
[ meseope o-btar-28 330 PR AT Clean BOeleteon reosrds upte: 1AS1I1TE0 M

[[] wessage ©3-Mar-25 342 FMIST  End allvephcatsnas |1 seconds)

) Sworess  09-Mar-15 RSOPMIST  Job Suocess

o=

Job Log Window Opens.

Step 4. Click on the success message to get the job details.

& Log Details #

Hessage [15:50:58 0%-Mar-2%] Show susmmary for MACReplicator

Message [15:50:58 05-Mar-25] Started HAC Replicatiom

Message [15:50:58 05-Mar-25] - Deleved 0 records : entsec:WiegandFormat
Mesaage [15:50:58 05-Mar-25] entaec: ScheduleRec
Measage [15:50:58 05-Mar-25) Qa enrsec: EnumScheduleRec
Hessage [15:50:58 O%-Mar-25%5] 0 entsec:AcceasBight
Measage [15:50:58 05-Mar-25) a ARTsas: Aecs gl onaRes
Message [15:50:58 05-Mar-2%) 0 records : entsec:Person

Measage [15:50:58 0&-Mar-25] Deleted 0 records : encsec:Badge

Message [15:50:58 05-Mar-25) 0 records : entsec:ihccReaderdoin
Message [15:50:58 0%-Mar=-25] 0 records : entaec:Personhccloin
Message [15:50:58 05-Mar-25] 0 records : sntsec:EncryResderlonstodl
Hessage [15:50:58 O05-Mar-2%5] 0 records : entsec:ExitReaderZoneJoin

HRRERRERRERRERRERRERR
-]
i

Message [15:50:58 05-Mar-25] Saved 0 records : entsec:WisgandFormac
Hessage [15:50:58 O05-Mar-2%] 0 records : entsec:ScheduleRec
Message [15:50:58 05-Mar-25] Saved 0 records : encsec:EnumScheduleRec
Message [15:50:58 05-Mar-25] Saved 0 records : entsec:AccessRight
Message [15:50:58 05-Mar-25] Saved 0 records : entsec:AccessloneRec
Message [15:50:58 05-Mar-25) Saved O records : encsec:Person

Message [15:50:58 05-Mar-25%) Saved O records : entsec:Badge

Message [L5:50:58 05-Mar-215) Saved O records @ entsec:AccReaderJoin
Hessage [15:50:58 05-Mar-25] Saved 0 records : entsec:Personhccloin
Message [15:50:58 05-Mar=-25] Saved 0 records : encsec:EntryReaderZomeJoin
Message [15:50:58 05-Mar-25] Saved 0 records : entsec:ExitReaderlonedoin

L
NOTE: Only the access control data related to the NAC controller is replicated to the NAC server.
Setting up domain names

In the absence of a DNS (Domain Name System) server, the system can correlate station IP addresses with
domain names. Domain name connections may be easier to remember than IP addresses.
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Prerequisites:
You are connected to a computer and running Workbench.

Step 1.

Step 2.

Open Workbench using Run as administrator (right-click the icon on the desktop and click Run as
administrator, or right-click the application in the start menu and click More > Run as
administrator.

In the Nav tree, expand My File System > C: > Windows > System32 > drivers > etc, right-click
hosts and click AX Text File Editor.

The hosts file opens in the AX Text File Editor view editor.

- Nav

¥ C

@ My Network

Q drivers
O ave
O DriverData
{:}EWUS
{:}E&ES

Wiews

Cut
Copy
Paste

Duplicate

127.0.0.1 localhost
192.168.1.9 supervisor.thecompany.lan
192.168.1.10 controller.thecompany.lan

» AXText File Editor
AX Text File Viewer
Hex File Editor
Guide Help
Bajadoc Help

Step 3.

Step 4.

Step 5.
Step 6.

Step 7.
Step 8.

184

Delete

Spy Local

FELEN S

Refresh Tree Node

Go Into

- -

Scroll to the end of the document, place your cursor at the end of the last line and press Enter to
create a new line.

3]co1 3

Type a line for each Supervisor and controller:
<999.999.99.99 > where:

® <999.999.99.99> is the IP address on the network of the PC or controller.
® <domainName> is the domain name the system can use to connect to the controller.
There must be at least one space between the IP address and the domain name on each line.

Click the Save button (B ).

To verify that the hosts file contains the domain names, open a platform connection to your
localhost and double-click TCP/IP Configuration.

To open the Hosts File, click the double down arrows ( ).

If needed, scroll to the bottom of the file and confirm that the IP addresses are associated with
the correct display names.
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Chapter 10. Personnel setup

Before regular office procedures for processing new people can be set up, the personnel manager or other
administrative person must set up access rights, badges, and a number of optional configurations, including
Niagara Integration IDs, tenants, threat level groups, and, possibly, additional personnel data to be maintained
by the system.

The term “person” refers to a human being, usually an employee, who possesses one or more rights to enter
and use a facility. A “user” refers to a person who is authorized to manage the system. For example, an
employee who works in manufacturing is a person with a badge for entering and exiting the building. In
addition to being a person with a badge, a Human Resources associate is a user of the system who enters new
employees and issues badges.

While you may add personnel to the database without assigning access rights or badges, to successfully add
personnel, access rights, schedules, and access zones should already exist before you add people.

If your topology includes a Supervisor computer and one or more remote controllers, set up all personnel and
assign badges only at the Supervisor station that serves the company-wide system.

CAUTION: Enter all personnel information using the Supervisor station ONLY and not using any remote
controller station. If you enter personnel information at the remote controller, duplicate personnel records may
occur in the system. The system disables some control buttons when you work connected to a subordinate
station.

This does not apply to a single controller functioning without a Supervisor computer. If yours is a small
company with a single controller, connect a computer to the network and launch the software from your
computer.

Personnel data from the LDAP server

The following topics describe how to install and configure an Lightweight Directory Access Protocol (LDAP)
network in a Enterprise Security system. Topics describe how to connect to an LDAP server to import
personnel information from the server to your personnel database.

The more you know about the LDAP attributes that you are working with, the easier it is to map them to
system properties and import personnel records from the Ldap server to the station database.

Adding an LDAP network
This procedure describes how to add an Ldap Network.

Prerequisites:
You are logged in toEnterprise Security Web UL.

Step 1. From the main menu, select System Setup > Remote Devices, and click Remote Drivers.

Step 2. Click the Manage Drivers button ( [ ).
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The Manage Drivers window opens.

How would you like to Manage Drivers?
@@ add

[:]@ Delete

[:]|:| Rename

[:]f"j Cuplicate

[:]L‘D Copy

Ogg cut

Step 3. To add a new network select Add and click OK.
The Add Driver window opens.

(axis video Metwork (naxisvideo)
(Milestone Network (nmilestone)
()Milestone X Protect Network (xprotect)
(Clobix Netwark

@Ldap Metwork

Step 4. Select Ldap Network and click OK.
Another Add Driver window opens.

Driver Type Ldap Network

Name [lLdap Network |

Step 5. Name the network or accept the default name and click OK.
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Result
This adds Ldap Network to the Remote Devices.

#% System Setup

A Threat Levels

i= Backups #% Remote Devices #¥ Access Setup #% Intrusion Setup  #% Alarm Setup 4% Miscellaneous

Home || &d Monitoring

E Schedules

&. User Management

Remote Drivers

-y E‘E] %68 [4

Name / Status Enabled Fault Cause

& Ldap Network {ok} true

Adding an Ldap server

This procedure explains how to add an Ldap Server to an existing Ldap Network.

Prerequisites:
You added the Ldap Network.

Step 1. From the main menu, select System Setup > Remote Devices, click Remote Drivers and double-
click on Ldap Network.

Step 2. Select the LdapServers tab.

Home 6d” Monitoring a Personnel Reports #% System Setup é_} Threat Levels

B Schedules & UserManagement [ Backups % Remote Devices &% Access Setup #F Intrusion Setup #F Alarm Setup #F Miscellaneous

Ldap Network

k=l save || & Drivers

Ldap Network ~LdapServers

LdapServers

BeE EE0E

Display Name / Connection URL Status Enabled Fault Cause

Step 3. To add a new Ldap Server click the new button ( | ).
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Display Name
Status
Connection Host
Connection Port
Enable TLS
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".d ap Server

Tokt

| example.com

636

frue

Connection User uid=admin,ou=system |

Connection Password

Enable Connection Pooling trug W

Initial Size D

Max Size

Pref Size D

Connection Timeout (in milli seconds) E

Search Scope | Object Scope W |

Polling Interval [+ w|ooooo  |hfos  |mfoo s

(k) ot

A New window opens.The Niagara Enterprise Security Reference documents these properties.

Step 4. To add the server click OK.
The Ldap server is added.

Step 5. To establish the connection, click the Ping button ( F ) .
It takes a few seconds for the server row to update in the table.

Step 6. Check that the status of the server indicates that the connection is {OK}.

Configuring LDAP import attributes

Specifying the import attributes before importing the groups is a onetime configuration procedure.

Prerequisites:
The LDAP server has been identified and you are open at the LdapServers tab.

Step 1. From the main menu, select System Setup > Remote Devices, click Remote Drivers and double-
click on Ldap Network.
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The Ldap Driver Device UX Manager window opens.

@@@lz@‘zj@ Ldap Driver Device Ux Manager v

Connection User Connection Password Enable Connection Pooling)g

Ldap Network

Ldap Server LdapServer @ @ @  {ok} example.com 636 true uid=admin,ou=system  —password— true

I New Folder LNE\M‘ ‘ 0Edit‘

Step 2. Navigate to Idap Server > Views > Property Sheet, click Ldap Import Config.
The Property Sheet opens.

LdapImportConfig

Display Name Value Commands
@ Import Freguency Daily w
@ Last Import Time 25-Apr-22 8|45 |AM v | IST
@ Group Attribute |memberof

@ Allow New Inactive Users

@ Status Attribute | |

) Active Status Values | |

@ Account Expiry Date Time Attribute | |

Step 3. Configure the LDAP parameters and click Save. Refer to Niagara Enterprise Security Reference for
further details.

Creating access rights for LDAP importing

This task describes how to create access rights in the system. You can use access rights to import Ldap
personnel records from an Ldap server.

Step 1. From the main menu, select System Setup > Personnel and click Access Rights.
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Step 2.

Step 3.

Step 4.

190

Access Rights

D| @] = I H| (2@ (s
Employee Access Alweays Acme Financal
Custodial Access Always Acme Financal
wvigitor Always

The Access Rights window opens.

To add a new access right click, the Add button ( (5 ).

ﬁ? System Setup /i Threat Levels

%3 Home

fo People

&c” Monitoring Reporis

ff'. Badges 7 Access Rights § Tenants ™, Additional Personnel Data

Add New Access Right

H save || Access Rights

Summary Access Right People Readers &
Access Right Name || |

Schedule ] |None [ »

Niagara Integration ID 3 |None | »

Tenant 3 [None [ »

Threat Level Group /A [None [ »

Description

The Add New Access Right view opens.Refer to

Enter the following details:

* Access Right Name: Access Right Name associates this right with the role of the system user,
for example, "LDAP."

* Schedule: Schedule controls when this right is in operation. It opens a Ref Chooser window.

a. Niagara Integration ID: Niagara Integration ID associates this access right with a specific
tenant who is identified by this ID.

b. Tenant: Tenant identifies the tenant to which this access right applies.

c. Threat Level Group: To select the threat level group click ( 3 ). The Ref Chooser window
opens. Select the tenant and click Ok or click Add button ( & ).

d. Description: Enter a brief description for the access right.

To add the access right click Save.
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Home &d” Monitoring s Personnel Reporis ﬁ]‘ System Setup f_@; Threat Levels

fe People ff" Badges 7§ Access Rights | § Tenants ™=, Additional Personnel Data

Access Rights

© 2)[&)( GEIBRP

Access Right Name / Schedule Name Integration Name Tenant Name Threat Level Group Name
Test Always

Visitor Always

Discovering and assigning attributes for Idap importing
Discovering and assigning attributes is an important part of successfully importing personal records.

Step 1. From the main menu, select Remote Devices > Remote Drivers, double-click Ldap Network, click
the Ldap Server tab and double-click the Ldap Server row in the table.
The Ldap Server view opens.

Step 2. Click on Attributes tab.

&3° Monitoring a Personnel Reports #% System Setup Ay Threat Levels
Schedules & UserManagement Bx Backups | #% Remote Devices % Access Setup ¥ Intrusion Setup % Alarm Setup ¥ Miscellaneous

Ldap Server
k=l Save Ping & Import Ldap Network

Ldap Server = Attributes  Groups

LDAP Attributes Manager

) HAFAE
Display Name / Mandatory Parent Class Data Type Description MappedORD isRDN
LDAP Attribute Manager view opens.
Step 3. To discover attributes from the LDAP Server, click the Discover button ( (s ).
. 9 =@
Object Class List
organizationalPerson
The Discover window opens.
The Object Class identifies the group of personnel records to import from the LDAP server.
Step 4. To manage the Object Class List, click add (button), edit (button) or delete (button).
191
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Step 5. To discover, select the object class attribute (for example, "organizationalPerson” or "User") and
click Ok.

Step 6. The discovered attributes are displayed in Discovered pane.

&R Personnel &% System Setup

/iy Threat Levels

&, UserManagement 8- Backups | & RemofeDevices ¥ Access Setup &F Intrusion Setup &% Alarm Setup & Miscellaneous

45 Monitoring Reports

B Schedules

Ldap Server

H save ping || & tmport || & Ldap Network

Ldap Server Attributes  Groups

LDAP Attributes Manager

& Flllzllld)l @
Display Name / Mandatory Parent Class Data Type Description MappedORD isSRDN
Discovered

2 ]I NI Page Size
attrName isMandatory parentClass dataType description AttributeExists

assistant false organizationalPerson String false
attributeCertificateAttribute false person String false
< false organizationalPersan String false
@ true person String false

< false organizationalPersan String false -

Step 7. Select a discovered attribute and click Add (button) ( (o).

Device Type Ldap Attribute

Display Name | |

Data Type

Mapped O R D |Person | Last Name v |

IsRDN

The Add window opens.
Step 8. To add the attribute to database pane, fill the following details and click OK:

a. Display Name cannot be changed. This remains as it is in LDAP server.
b. Data Type provides two options String or Binary.

c. Mapped O R D selects Person or PersonInfo or Badge. Last Name is the mandatory
attribute.

d. Is RD N selects true or false from the drop-down list.

Result
This adds the discovered attributes to the database.

Discovering, selecting and configuring groups for Ldap importing

Discovering, selecting and configuring groups filters the records coming in from the LDAP server. The group of
users are given specific access rights.

Step 1. From the main menu, select Remote Devices > Remote Drivers, double-click Ldap Network, click
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Step 2.

Step 3.

Step 4.

Step 5.

the Ldap Server tab and double-click the Ldap Server row in the table.
The LdapServer view opens.

Click on the Groups tab.

&d" Monitoring Reports #% System Setup /_i} Threat Levels

Schedules & User Management A= Backups | &% Remote Devices #% Access Setup ¥ Intrusion Setup #F Alarm Setup #¥ Miscellaneous

Ldap Server

Il save || E Ping & Import | [ Ldap Network

Ldap Server Attributes = Groups

Ldap Group Manager

LDAP Group Manager view opens.

To discover the groups from LDAP Server, click Discover icon ( (g ).

Discover

Group Search Base |DC=tridium2012,DC=nst | »
Group Search Filter (T8 sty ] »
Group Search Scope

The Discover window opens.The discovered groups are displayed in Discovered pane.

Identify the groups associated with access rights.

4% System Setup

& Personnel

[, Threat Levels

E= Backups = #% Remote Devices ¥ Access Setup &% Intrusion Setup  #F Alarm Setup &% Miscellaneous

Reports

B Schedules & User Management

Ldap Server

H save Ping & mport || ) Ldap Network

Ldap Server = Attributes  Groups

Ldap Group Manager

4 gzl @
GroupName / AccessRight
Discovered
Q| = |3 P | Page I:I of 3 Page Size
distinguishedName an ‘GroupExists
CN=~Access Control Assistance Operators, CN=Builtin,DC=tridium2012,DC=net Access Control Assistance Operators false
CN=Account Operators, CN=Builtin,DC=tridium2012,DC=net Account Operators false
CN=Administrators, CN=Builtin,DC=tridium2012,DC=nsat Administrators false
CN=Allowed RODC Password Replication Group,CN=Users,DC=tridium2012,DC=net Allowed RODC Passweord Replication Group false
CN=Backup Operators, CN=Builtin, DC=tridium2012,DC=net Backup Operators false -

This helps the system identify which access rights should be given to each employee.

Select the discovered groups and click the Add button ( [ |).
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The Add window opens.

Step 6. You can change the Description if needed. you can select the Access Right from the drop-down
list. To add the user to database, click OK.

Device Type Ldap Group
Display Name |Cl=Account Operators,Cl:|
Group Name |Ci=Account Operators,CN=Builtin, DC=tridium20 |

Description | Account Operators |
Access Right | Visitor |

Importing users from |dap server
Importing multiple personal records from the LDAP server saves time.

Prerequisites:
The LDAP server is on line.

Step 1. Expand Remote Devices > Remote Drivers, double-click Ldap Network

Step 2. Click the Ldap Server tab and double-click on LdapServer.

/M Threat Levels

B= Backups | #%f Remote Devices &% Access Setup &% Intrusion Setup &% Alarm Setup  #¥ Miscellaneous

Reports #% System Setup

&a” Monitoring

Home
[E Schedules

£, User Management

Ldap Network

=l save || Drivers

Ldap Network LdapServers

LdapServers
BIDILIIr B[P
Display Name Connection URL Status Enabled Fault Cause
Ldap Server Idaps://172.31.64.11:636 {funackedAlarm} true

Step 3. To import records from Ldap Server click the Import button ( & ).
The Import Preferences window opens.

Step 4. Configure the properties to import users. and Click OK.
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The following configurations are used for Ldap Import..

User SearchBase | DC=tridium2012,DC=net |
User SearchFilter | (ohjectclass=organizational Person) |
Search Scope | Subtree Scope |

Group Attribute | memberof |
Allow New InactiveUsers frue

Status Attribute | |
Active Status Values {Comma Seperated) | |

* User SearchBase configure the parent class to import the records associated with the parent
class.

* User SearchFilter configure the object class for the record import.

Result
LDAP server imports the records.

Badges

Assigned badges help keep a person uniquely identified. You can create individual badges using the procedure
in the Operator’s Guide. More likely, you should create a batch of badges (cards) at one time.

Automatic badge association

During a join, if a person has no badge assigned and the person’s uuid matches the uuid of a badge record in
the database, the system automatically matches the badge with the person. If the person has no badge and no
uuid matches, the system creates a new-person record.

Barcodes on badges
The system does not support adding and scanning barcodes.

However, a person’s record contains 10 additional data fields. To use barcodes, you would assign a credential
to the person just as you would for a proxy card. You then associate that credential with a barcode field on the
card template you build in the Asure ID application. That barcode can be printed on a card. When the Wiegand
reader scans the barcode, our system compares it to the assigned credential.

Card formats

A card format describes what a number means or how the system uses it to grant access. The format interprets
the number, and, therefore, is separate and distinct from the number itself.

Different format technologies support a variety of bit-sizes for cards and readers. Bit size alone is not an
indicator of a particular format type. For example, within the Wiegand family of formats are many possible bit
sizes (26, 34, and many others). This system supports up to a 256-bit Wiegand format.

A format may comprise this information:

e Data bits contain such information as Facility Code, Credential Number, Job Number, and other

information. The details of the format specification designate how many data bits are available for each
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element of information.

e Parity bit(s) serve as a simple accuracy check for the transmitted binary data.

¢ Total bits is the sum of the parity bit(s) and the data bits. This number is associated with the format name.
For example: 26-bit Wiegand, 36-bit HID.

Figure 21. Example of a hypothetical 30-bit format

_— 3 Parity Bits
Parity Bits Job Number 6 Job fflur;ber Bits
3 Bits 6 Bits 6 Facility Code Bits  Datasits
15 Employee No. Bits
PPPFFFFFFFFFFFF NNNNNNNNNNNNNNN | = 30-bithypothetical format
Facility Code Employee Number
6 Bits 15 Bits

The example above shows how a format might be set up. The data bits include: six bits for Job Number, six
bits for Facility Code, 15 bits for Employee Number, and three parity bits, for a total of 30 bits.

Within a given format bit length, the size and location of the data element, such as, Credential Number or
Facility Code may vary. For example, a single 34-bit format may have an eight-bit Facility Code starting with
bit number two, or it may have a 12-bit Facility Code starting at bit number 21.

You use the Wiegand Format Editor to create and view card formats, which require this information:

¢ Total bits

* Number and location of (if any) parity bits

¢ Parity bit format: odd or even

e Bit total and beginning bit number for Facility Number bits
¢ Bit total and beginning bit number for Credential bits

* Layout (format) for each parity bit

About the Wiegand format

The name “Wiegand” occurs in a variety of contexts. For the purposes of this document, it refers to the badge
format or the associated reader-to-controller interface. The Wiegand Format Editor is required to define badge
formats.

The system supports from 25-bit to 256-bit Wiegand formats.
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Figure 22. Standard 26-bit Wiegand format

Leading Parity Bit (Even) Trailing Parity Bit (Odd)
Facility*tode (8 Bits)  Card h*lumber (16 Bits)

P FEEFEEFENNNNNNNNNNNNNNNN £

617 021 22 23 23

First 13 Bits (12 + Parity) Last 13 Bits (12 + Parity)

The parity bit confirms the accuracy of the transmitted binary data by totalling the number of ones (1). If the

total is an odd number, the format sets the parity bit to zero (0). If the total number of ones is even, it sets the
parity bit to one (1).

Figure 23. Wiegand badge with embedded wire

” || || || Magnetic Bits

Wiegand badges contain strips of wire embedded in the badge. When a person inserts a badge into or passes

it through the set of magnetic field coils in a Wiegand reader, each strip sends a binary signal back to the
reader.

Creating (or editing) a card format

The popular Wiegand format provides many options. This procedure documents how to use the Wiegand
Format Editor to create a Wiegand care format.

Prerequisites:

You are connected to the controller station and working in the web Ul. If you are creating your own format, you
have the specification that defines the format properties.

Step 1. Click Controller Setup > Access Setup > Card Formats.
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The Card Formats view opens.

> )(@)B)(e)le]) (¥)(®)(2) (@)L

/3
26-Bit Wiegand Format (HID-H10301) 26
34-Bit Northern Wiegand Format 34 OFFFFFFFFFFFFFFF NP
37-Bit Wiegand Format (HID-H10302) 37 PNINNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNP
40-Bit Wiegand Format 40 PNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNE
55-Bit Wiegand Format 55 P NNNP
test 26 N---— -

Step 2. Do one of the following:
¢ To create a new default format, click the Add From Default Card Formats button (

(]

), and select a default format from the list and click Ok.

A default format is useful if you deleted a format and want it back, or if you upgraded
your system and do not already have these formats available.

¢ To design your own card format, click the Add button (
*)
).
* To edit an existing format, select the format row, click the Hyperlink button (
&
) and click the Wiegand Format tab.

NOTE: You cannot edit or delete a card format that is in use (assigned to a badge). In-use
card formats display as read-only in the View Existing Wiegand Format view. Card formats
that are not currently associated with a badge display in the Wiegand Format Editor view
and may be edited.

198 March 21, 2025



Niagara Enterprise Security Installation and Maintenance Guide Personnel setup

If you clicked the Add button the Wiegand Format Editor (Add New Wiegand Format) view opens
to the Wiegand Format tab.

kd Save | [) Wiegand Formats

Summary Wiegand Format

Wiegand Format Name

Default Facility Code

Validation Bits | All v

Bit Length 26 [0 - 256]

Parity Bits 0 [0 - 5]

Facility Start 0

Facility Length 0

Credential Start 0

Credential Length 1

Format N-———F&—"7T"T"T"T"T"T"T"T"""""“""""——

Step 3. Carefully fill in each property and click Save.
Parity Bits specifies the number of parity bits in the format. It does not identify the bit location(s).

Step 4. Define Facility Start and Facility Length, as well as Credential Start and Credential
Length.

Step 5. Enter the format characters in the Format property.
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Leading Parity Bit (Even) Trailing Parity Bit (Odd)
Facility Code (8 Bits)  Card I:umber (16 Bits)

P FEFFEFFENNNNNNNNNNNNNNNN £
First 13 Bits (12 + Parity) Last 13 Bits (12 + Parity)

Valid format characters include:
® P — Parity bit (an extra bit added for error detection)
e F - Facility code bit

N — Credential number bit

e 0 - Constant character of 0 (zero)

1 — Constant character of 1 (one)

Based on the number of Parity Bits, additional Parity Layout properties appear below the
Format property. If the value of Parity Bits is zero (0), no Layout properties appear. Parity
Layout properties indicate the expected parity: Odd or Even.

Format FFFFFFFENNNNNNNNNNNNNNNNE
Parity Layout 0 EEEEEEEEEEE-——————————————
Parity Layout1 = |——————————— ODODODODODODOQQ

Parity Bit-0 Alignment Parity Bit-1 Alignment

g +

The locations of the “E” and “O" characters in the Parity Layout property designate the bits
that are used to calculate the parity sum. Follow these rules as you enter these characters:

E - indicates that an even number of ones (1) is required to verify transmission accuracy.
O - indicates that an odd number of ones (1) is required to verify transmission accuracy.
Do not combine “E” and "O" characters in a single Parity Layout definition.

In each Parity Layout definition, at least one parity bit character must align vertically
beneath a credential bit or facility code bit. Additional characters are not required to align
with any particular character, however, at least one character must be below a data field
(Facility Code or Credential Number).

Position the first “E” or “O" directly below the “P” in the Format property (Parity Bit-0
Alignment and Parity Bit-1 Alignment for right-to-left validation). Add additional characters of
the same type, as required by the parity format definition.

Align an additional “E” or “O" vertically under any additional parity bit (P) in the Format and
add additional characters of the same type as required by the definition.
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Setting up usable credential numbers

A reader or keypad requires that a person present a valid badge, or key in a valid credential number followed
by the # key. Credential numbers can be very long. Their use is prone to error when someone has to key in a
long string of numbers including leading zeros. You can create a custom, 16-bit credential number (00001 to
65535), which is easier to enter.

Step 1. Create a new Wiegand format.

Step 2. Configure these properties and click Save:
e Validation Bits: All
e Bit Length: 16
e Credential Length: 16
e Format: NNNNNNNNNNNNNNNN (the letter “N” entered 16 times)

Step 3. To assign this format to a badge, click Controller Setup > Personnel > Badges.
Step 4. To create a new badge, click the Add button (g ).
Step 5. Enter a five-digit custom credential in the Credential property (00001 to 65535).

Step 6. Click the chevron to the right of the Wiegand Format property and select the 16-bit format you
created from the Ref Chooser and click Ok.

Step 7. To save the configuration, click Save.

Creating multiple badges (batch-create)

You can create a group of badges that have common properties.

Prerequisites:
You are working at the Supervisor station.

Step 1. From the system’s home view, select Personnel > Badges.
The Badges view opens.

Step 2. Click the Batch Enroll button ( (&) ).
The Batch Enroll Badges view opens.

Step 3. Complete the properties that are to be shared for all badges scanned, including Description,
Wiegand Format, Status, Issue Date, Expiration Date, Owner, Tenant, and Enrollment
Reader.

Step 4. Swipe a set of cards (a batch) one at a time.
As you swipe each card, the card data displays in the New Badges property.
NOTE: If badge numbers do not appear, the corresponding Wiegand format has not been
defined.

Step 5. To complete the batch-badge creation process, click the Save button.
The system saves the badges, and opens the Edit Badges view. The new badges appear in the
table of badges.

Photo ID badges

Before you install and configure the Photo ID software, take a few moments to understand how the various
elements work together.
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RDBMS and Orion

Figure 24. Photo ID architecture

i 4 F '
Supervisoror )
P ) Photo ID workstation
remote controller station (client)
[server)
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Webcam
Photo 1D license
T &
( ) Card printet
I . ,i i i

F Port 3001
Obix Netwark httos EntsecAsurelD
S o G

If you are seeing the above illustration in color, the blue boxes represent the framework’s features that support
Photo ID including RDBMS, license, networks and EntsecAsurelD applet. The other boxes and internet clouds
represent third-party software.

The Relational DataBase Management System (RDBMS) contains all personnel, badge (card), and other system
records. It may be located on the Supervisor PC or on another network server. The OrionService in the station
connects to the RDBMS.

Supervisor or remote controller station
This station, running in the Supervisor PC or in a stand-alone remote controller, connects the (Native Badge
Printing Application) supported from EntSec 4.15 with the RDBMS .

e The Photo ID license authorizes use of this feature.
* The OrionService connects the station to the RDBMS.

* Secure communication over the Obix Network requires a machine-to-machine user, password, and
HTTPBasicScheme authentication.

While you may access the Supervisor station using Workbench, it is recommended to use the web Ul running in
a browser.

Photo ID workstation

Although the Supervisor station and Photo ID workstation may share the same platform, separating them
provides the most secure configuration. Installations with a single, stand-alone controller require a separate
Photo ID workstation. The Supervisor station and Photo ID workstation communicate via the Internet or local
area network.

* A browser lets you access the Supervisor or remote controller station remotely.

202 March 21, 2025



Niagara Enterprise Security Installation and Maintenance Guide

Personnel setup

® The third-party Asure ID software manages the webcam and prints photo IDs using personnel data
retrieved from the database. Asure ID relates to the Photo ID Network as a device on the network.

e EntsecAsurelD running in the Photo ID workstation relates as a child to the oBIX Network.

Installation summary

The variety of applications that make up the Photo ID feature require several separate procedures. Photo ID
installation and configuration involves these tasks:

* Decide on names and password clue.

* Set up the Photo ID Network and discover the Native Badge Designs device.

* Create a px view for Native Badge Designs template.

* Create a template for a badge.

* Assign a template to a badge.

* Configure Photo ID options in the station.

Names and password clue

You will have the opportunity to name various items and create oBIX credentials (username and password)
during the configuration process. If you have only one Photo ID workstation you can accept the default names.
With multiple workstations, it helps to differentiate among them. The table that follows provides a place to

keep track of configuration names.

NOTE:

For security reasons, do not write the password itself in the table. Rather write a clue that will help you

remember what the password is.

Table 24. Required names and credentials

Where used

oBIX machine-to-machine Sets up Obix Network
role access permissions

Name

oBIX machine-to-machine Sets Obix Network user,

user password, and assigns
the machine-to-machine
role

Photo ID Network Manages Asure ID client

and badge templates

Obix Network Manages the connection
between Third party
software and the Photo

ID network

Associates a camera
with a view in the
software.

Photo ID Viewer Name

Templates Display Name Used to assign a

template to a badge.

Used to select the
badge

Badge Description

When created

User Management > Roles
tab

User Management > Users

System Setup (Controller
Setup) > Remote Devices >
Remote Drivers

System Setup (Controller
Setup) > Remote Devices >
Remote Drivers

Photo ID > Photo ID
Viewers (tab)

Entered when you discover
template(s).

Entered on the Personnel >
Badge tab.

Name

Suggested role name: obix

Suggested user name: obix

Name defaults to Photo ID
Network

Name defaults to Obix
Network

Suggestion: name the viewer
for location of the camera in
the building.

Name defaults to the name

used when you created the

template. Suggestion: name
the template for the tenant

company.

Suggestion: use a name to
describe the type of badge.

Other name/notes

Password clue:

Setting up the Obix role

A machine-to-machine oBIX role sets up the permissions required for the EntsecAsurelD to access the Obix

Network.
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Prerequisites:

Using the web Ul, you are connected to the Supervisor station.

Step 1. From the main menu, click System > User Management > Roles.

Niagara Enterprise Security Installation and Maintenance Guide

Step 2. To create the role, click the Add button (| & ).
The Add New Role view opens.

E save

=y Roles

Role Name |Fhul:o D

Role Users =
Enabled
DSuper User
Read | Write | Invoke
Admin ]

Permissions

Badge Management

Personnel Management

Graphics

Monitoring

User Management

Schedules

Access Rights

Access Setup

Intrusion Setup

Alarm Setup

Remote Device Setup

Controller Setup

General Reports

Access Reports

Intrusion Reports

Hardware Reports

Alarm Console

Tenant Management

Video Subsystem

PhotoID Network

Threat Level Management

O&O0doooooooooggogu o) s

O&O0O0OOoooooooooggogo ol d

O&O0O0OOoooooooooggog ool ™

Step 3. Enter obix for the Role Name.
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Step 4. Grant full access to the Badge Management and the Photo ID Network, then click Save.

Result
If you recently upgraded your system from AX, the migration tool may have created an obix role for you.

Setting up the oBIX user

This user configures credentials that permit the EntsecAsurelD to access the Obix Network.

Prerequisites:
You are using the web Ul and are connected to the Supervisor station.

Step 1. From the main menu, navigate to System Setup > User Management and click Users.
The User Management view opens.

Step 2. To create the user, click the Add button (| & |).
The New User view opens.

&l save || & users

User Name |asureID

User Roles =

Full Name |A5ure ID |

Enabled
Expiration ® Never Expires () Expires On |25-Jul-18 [11:[s59 [pm[¥]

Lock Out false v
Language [ ]
Email | |

Passwurd:|-o-ooc|.oo |

Password

Confirm: |lo--oc|..- |

Force Password Reset

Password Expiration (®) Never Expires ) Expires On |25-Jul-18 [11:]s9 [pm[~]
Network User Cgﬁlie

Authentication Scheme Name
Cell Phone Number r—_‘ ——>
Auto Logoff Enabled

Use Default Auto Logoff Period
Auto Logoff Period 00000 | h m [2mins - 4hours]

Profile [standard Access Profile vl

Step 3. Enter the User Name, which is just below the Save button.
Use the name you planned. If you are upgrading from AX, the migration tool may have created
and configured a user for you with the name obix.

Step 4. To set up the credentials for accessing the oBIX network, enter a password that meets N4
standards and an Authentication Scheme Name of HITPBasicScheme.
New users default to the DigestScheme, which does not work for machine-to-machine users.

NOTE: If the HTTPBasicScheme is not available, use Workbench to add it to your installation.
Refer to “Setting up the authentication scheme for Asure Id and Easy Lobby” in this document.

Step 5. To assign the Photo ID role to this user, click the Roles tab, click the Assign Mode button (|5 ),
select the role in the Unassigned pane, click the Assign button ([ @), and click Save.
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Step 6. If needed, make a note of the User name and Password so that later you can enter for any third
party application software required to establish communication.

Setting up the Photo ID Network
The Photo ID Network manages the Native Badge printing application supported by the EntSec 4.15 version.

Step 1. Click System Setup > Remote Devices > Remote Drivers.

Step 2. Click the Manage Drivers button (| g ), select Add and click Ok.
The Add Driver window opens.

Step 3. Select Photo ID Network and click Ok.
The Add Driver window opens.

Step 4. Name the network, and click Ok.
The system adds the Photo ID Network to the database and displays the restart-station message.

Step 5. To restart the station, click Ok.
The Status column for the Photo ID Network indicates { fault} as the station restarts (this could
take several minutes). During restart the station display name in the upper right of the browser
view dims. When the station is running again the station display name appears normal.

Native Badge Designs Device under photo id network

The Native Badge Design Device allows for Badge Printing without third-party software. Follow the steps
below to verify if the Native Badge Designs exist under the photold network.

Step 1. Click System Setup > Remote Devices > Remote Drivers.
The Remote Drivers view opens.

Step 2. Confirm that the Status column for Photo ID Network indicates, OK.

Step 3. Double-click on the Photo ID Network row in the table to open it. Confirm that the Status
column for Photo ID Network indicates OX.

TRIDIUM W

e e kL

The Photo ID Network view opens.
Step 4. Check the Native Badge Designs device is present under the photo ID network.

Create a px view for the Native Badge design template

Once the Native Badge Design Device is configured, you must create a new template linked to the badge
"Template. Px." Each badge design template consists of two files or properties, "Front Design and Back
Design," that must be associated with the px created by the users under the workbench; follow the below
steps to create px for the Badge Design Template.

Step 1. Navigate to the station under the Workbench and open the Files folder.

Step 2. Right-click on New under Files, then rename BadgeTemplate.px as required.
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Personnel setup

Step 3. Right-click on the file created and select view > px editor, the px file opens in px file in edit mode,

with BadgeDesignPane as the default pane.

Step 4. Double-click on the BadgeDesignPane under the widget tree, and update the required badge

Layout and badge type property on BadgeDesignPane based on the card type.
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BadgeDenipnPane >~ i 3
B Badge Design Puss
'| - T
BadgeTrpes W BudpeDrignPane [Root
O]
L ]
G
(=1 Cancel tat "

Bpc pelai g P a B I
B Bacigr Sruge Fane

We currently support two types of standard cards, CR80 and CR100, the industry's most
commonly used ID cards. The card size will automatically update based on the selected badge

type and layout properties.
The default view size for the Badge type property is listed below:

Badge Badge Width Height
Type Layout

CR80 Portrait 153 243
CR80243 243 153
CR100  Portrait 189 279
CR100 Landscape 279 189

NOTE:

If the user needs to create a custom card, they can directly update the width and height under
the view size property. The badge type will automatically be updated to 'Custom.' However,
the badge layout property does not apply to the custom badge type.

Step 5. After updating the badge type and layout, you can design the badge using existing widgets such
as Label and Picture and two new design widgets: BadgelLabel and BadgePicture.
¢ BadgePicture: The BadgePicture widget automatically retrieves the individual's image from
the database.
* Badgelabel: The Badgelabel widget fetches the necessary person and badge properties

from the database.
Here are some properties of dataOrd for the BadgeLabel widgets that could be retrieved
from the database:
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Step 6.

Personnel setup
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After designing the badge, you can save it as a Px file and then return it to the Enterprise Security
appliance view in the browser.

Create a badge template

Create a template for Native Badge Designs located under the photoldNetwork section.

Step 1.
Step 2.

Step 3.

March 21, 2025

Login to the station and click on photo Id > photolIDNetwork.
Under photolDNetwork double click on NativeBadgeDesigns > Templates.
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To create a template, click the Add button and select New Template, update the name, and click
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OK.

Step 4. Once the template is created, click on the 5 button to select the px file created in the
workbench for FrontDesign and BackDesign.

TRIDIUM
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Ord Chooser w
8 BadgeTemplate.px

& Station

s

P
BadgeTemplate.px

HTpane 1 . P

AL g 0 =

¥ P i
B ECE. X

The FileordChooser window opens.

Step 5. Select the appropriate px file ord from the list and click Ok .

NOTE: Please note that if the front design is updated, the badge will only be printed on one side.
If double-sided badge printing is required, the Front and Back Designs must be updated with
appropriate px files.

Step 6. Once both the orders are selected, click on the Save button.
Assigning a template to a badge
The system defines each badge by associating it with a specific Native Badge Designs template.

Step 1. From the home view, click Personnel followed by clicking the Badges tab.
The Badges view opens.
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Step 2. To add one or more badges, click the add button (| @ |) or scan the badge.
How to add a badge is explained in detail elsewhere.
The Add New Badge view opens.

Step 3. Click the chevron next to the Template property.
The Ref Chooser window opens.

e B L. e e T i Bl

. e

Step 4. Select the badge, click Ok and click SAVE.

Setting up a camera

Viewers associate cameras connected to the Photo ID workstation with the Photo ID Network.

Prerequisites:
You use the web user interface and are connected to the Supervisor station or remote controller.

Step 1. Expand the Photo ID and double-click the Photo ID Viewers node.
The viewer's view opens.

Step 2. Click the Add button ([ @ ).
Step 3. Enter the name of the camera and click Ok.

Configure photo options

The system displays the photo associated with an individual employee badge side-by-side with the feed from a
surveillance video camera. You may add and configure all properties related to network device setup, such as
how long to leave the photo up.

Step 1. From the home view, click Photo ID and the preferences button.
The Configure window opens.

Step 2. Change the properties as necessary, and click OK .

Adding the Obix Network

The Obix Network, functioning as a server, enables communication between the framework and third party
application software if required to establish communication through Obix network.

Prerequisites:
You are using the web Ul and are connected to the Supervisor station.
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Step 1. Click System Setup > Remote Devices > Remote Drivers.
The Remote Drivers view opens.

& Monitoring ﬁ Personnel #% System Setup

B Schedules &, User Management B= Backups <% Remote Devices

#el=le (&=l

Name / Status FEnabled Fault Cause
[ Ldap Metwork {ok} true
g Obix Metwork {ok} true
[z Photo ID Network {fault}  true Database ORD not configured properly.
L 4 >

Step 2. Click the Manage Devices button ( g ).
The Manage Drivers menu opens.

Step 3. Click Add.
The Add Driver menu opens.

Step 4. Select Obix Network and click Ok.
The Add Driver window opens.

Step 5. Optionally, you can change the name of the driver followed by clicking Ok.
Step 6. Check the Status column on the Remote Drivers view. It should read, {ok}.

Binding template data properties to database properties

Data that appear on a badge need to be associated with individual database fields. The process of binding
these data establishes these associations.

Step 1. Double-click on the newly added template.
The Template view opens, this time with three tabs: Template Data, Tenants, and Badges.

Step 2. Click the Discover button ( gy ).
The Discovered pane shows the properties you set up previously using the Asure ID software.

Step 3. Select the property row and click the Add button (| |).
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Device Type PhotoID Template Data

Display Name |Deparl:menl:

Data Type IS';.-'stem.String

Data Binding |F'ers::|n vIDepartment b

| ok || cancel |

Step 4. Accept the default binding or change the Data Binding using the two options lists, and click Ok.
NOTE: You must bind each property individually, but you only need to do this once.

The first option list provides the set of options for the second option list. So, for example, to
bind a person’s department you would select Person in the first property. The Person option
includes Department (and other options) in the second property. Then you can select
Department in the second option list.

When you add the Photo property, Image Ratio and Image Format properties appear in the Add
window. You can specify these parameters, as needed.

Device Type FPhoto ID Template Data

Display Mame IEmpIu:-';.-'ee Photo

Data Type ISystem.Eyte[]

Data Binding |F‘ersu:un Portrait VIImage V|

Image Ratio |Rati|:| V| width: |3 | height:
Image Format

| ok || cancel |

Step 5. Configure the binding, enter the aspect ratio (for Photo properties) you used with you created the
template and click Ok.
When finished, the Template Data database view reflects the new values in its Data Binding
column.

Assigning a template to a badge
The system defines each badge by associating it with a specific Native Badge Designs template.

Step 1. From the home view, click Personnel followed by clicking the Badges tab.
The Badges view opens.

Step 2. To add one or more badges, click the add button (| @ |) or scan the badge.
How to add a badge is explained in detail elsewhere.
The Add New Badge view opens.
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Step 3. Click the chevron next to the Template property.
The Ref Chooser window opens.

I . - -_-I_l_._”£d

Step 4. Select the badge, click Ok and click SAVE.

Setting up a camera
Viewers associate cameras connected to the Photo ID workstation with the Photo ID Network.

Prerequisites:
You use the web user interface and are connected to the Supervisor station or remote controller.

Step 1. Expand the Photo ID and double-click the Photo ID Viewers node.
The viewer's view opens.

Step 2. Click the Add button ([ @ ).
Step 3. Enter the name of the camera and click Ok.

Configuring photo options

The system displays the photo associated with an individual employee badge side-by-side with the feed from a
surveillance video camera. You may add and configure all properties related to network device setup, such as
how long to leave the photo up.

Step 1. From the home view, click Photo ID and click the preferences button (| #|).
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The Configure window opens.

Default Image Ratio | v1 width: 3 hieight: 4

Default Image Format |

Max Image File Size

L000 | 5 [Oms - +Hinf]

PhotoID Timeout 00000 |h |00 |m |00

s lastPersontanes

FwglidateTiwmestawp:
YlastBadogeictivity:

PhotoID Format

Photo I D Font Size |17

| ok || cancel |

Step 2. Change the properties as necessary, and click Ok.
For example, the PhotoID Timeout defaults to zero (0), which indicates no timeout. Configuring
this value determines how long to display a photo from a swiped badge to keep the display
current.

Configuring Asure ID alarms

Misuse of a badge to access a building generates an alarm. This procedure configures the alarm information
collected from the Photo ID computer.

Prerequisites:

NOTE: This alarm indicates that communication is NOT active. For example, if the Photo ID workstationr is a
notebook PC that only gets started to take pictures, you should not use this alarm.

Step 1. On the Photo ID Network view, double-click the AsurelD Client Device row.

Step 2. Click the chevron next to Alarm Source Info.
The view expands to display alarm options.

Step 3. Configure alarm text as desired.
The Video Setup button enables video.

Creating a new tenant

Tenants separate personnel based on the company they work for. This is important when managing a multi-
company building.

Step 1. Click Personnel > Tenants
The Tenants view opens.

Step 2. Click the Add (| |) button.
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Step 3.
Step 4.

The Add New Tenant view opens.

E save || &) Tenants

Summary Tenant Niagara Integration IDs Intrusion Pins People Badges Threat Level Groups Access Rights ]

Tenant Na me|| |

Description

Provide the Tenant Name and an optional Description for the tenant.

Configure the individual tabs for each tenant and click Save.

Each tab provides a set of standard control buttons and two tables. The tables include assigned
and unassigned assets (people, integration IDs, access rights, and badges) to associate with the
specific tenant.

The new tenant is created and the edit tenant view opens with the newly created tenant
properties.

Editing an existing tenant

Once created, you may edit tenant information as required.

Step 1.

Step 2.

Step 3.

Click Personnel > Tenants.
The Summary tab of the Tenants view opens.

To edit a tenant, double-click the tenant row in the table.
The view associated with that particular tenant opens.

*» personnel lﬁ‘ Controller Setup ﬂ"_\, Threat Levels

&d” Monitoring

b ] People fii Badges ‘H Access Rights & Tenants ", Additional Personnel Data

Save || &) Tenants

summary Tenant MNiagara Integration IDs Intrusion Pins People Badges Threat Level Groups

PA Company

[ Type: P Tenant

D Tenant Name: A Company

4 Niagara Integration IDs . Intrusion Pins &g People

4 Lighting [1] Pin Ent Sec 4 Sanders, Randy

This view displays no updated information until you enter data using the remaining tabs and save
the updated information. The Summary tab may also include context-appropriate lists of the
integration ID, people, badges, and access rights associated with the tenant.

Edit the information on each tab for the selected tenant and click save.
The Summary tab of the Tenants view updates.

Setting up additional personnel properties

The Person tab of the Add New Person view collects basic personnel information (name, employee ID, etc.).
You may have other information to collect. For example, you may need to know the level of security clearance
the employee obtained or the person’s rank in the military. You set up additional properties as information
templates, which appear on the Person tab as additional properties.
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Step 1. Click Personnel.
The People view opens.

Step 2. Click Additional Personnel Data.
The view opens.

Step 3. To add a property, click the Add button (| |).
The Info Template tab opens.

Step 4. Give the new property a name and default value.

Step 5. To set up a string chooser from which to select a drop-down list of options, set Smart Sense to
true.

Step 6. If the information to collect requires more than a single line of text, set Multi Line to true.

Step 7. To save your template, click Save.
The system adds the template as a property to the end of the Person tab.

Setting up person types
You can configure person types based on your organization’s needs. Only persons whose person type is
designated as “supervisor” are eligible to be assigned as a supervisor for a specific access zone.

Prerequisites:
No person types exist yet in the system.

Step 1. Click Personnel.
The People view opens.

Step 2. Add a new person by clicking the Add button (| |).
This can be a test person record, which you may delete later.
The Person tab opens.

Step 3. Enter a value in the Person Type property along with other properties, including a PIN, and click
Save.
The system adds the person to the database. In the process, it uses the Person Type value you
entered as the first person type in the system.

Step 4. Open the person record you created by double-clicking it in the table, and click the Person tab.
The Person tab opens.

Step 5. Click the chevron (>>) to the right of the Person Type property.
The String Chooser window opens.

Step 6. Select the person type you created.
This action enables the Add button (

&

) in the String Chooser.

Step 7. Add additional employee types and click Ok.

Importing personnel data from a CSV file
Importing personnel data is the quickest way to set up personnel records in the station database. This
procedure imports the data into the Supervisor station’s database.

Prerequisites:
The CSV (Comma-Separated Values) file that contains personnel information exists and is ready to use. The
Wiegand format has been identified or created and is ready. A Wiegand Format has been selected.
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NOTE: The Import Info function only works at a Supervisor station.

Step 1.

Step 2.
Step 3.
Step 4.
Step 5.

Step 6.

Navigate to System Setup > Access Setup > Additional Personnel Entry.
The Additional Personnel Entry view opens.

EH save - Export

Import Info
Tenant P |Nune »
Wiegand Format = |None »
User Pass Key |esssssss |
File C:\Users\H277129)\Desktop\ABS3.1 Setup.zii Browse...

Open the Tenant Ref Chooser () and select the tenant name.
Open the Wiegand Format Ref Chooser and select the card format.
Enter the User Pass Key and click the Browse button to find the CSV file.

To initiate the import, click Save.

NOTE: When you open an exported CSV file, long credential numbers display in scientific
notation.

The import process runs as a job and displays a list of errors (if any) at the end of the process.

To confirm that the data are in the station database, click Personnel, followed by clicking People,
Badges, Access Rights and observing the new data.

Exporting personnel data from a CSV file

Exporting additional personnel data to a CSV file makes the data available to import into another Supervisor
database or to use for some other purpose. Exported data are password protected by a Pass Key you create
when you export the file. At import, the same pass key is required to successfully import the personnel data.

Step 1.

Step 2.
Step 3.
Step 4.
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Navigate to System Setup > Access Setup and click Additional Personnel Entry.
The Additional Personnel Entry view opens.

EH save - Export

Import Info
Tenant g |Hune »
Wiegand Format = |None »
User Pass Key |ssssssse |
File C:\Users\H277129\Desktop\ABS3.1 Setup.zif Browse...

Open the Tenant Ref Chooser and select the tenant name.
Open the Wiegand Format Ref Chooser and select the card format.

Create the User Pass Key.
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Step 5. Enter the name of the CSV file to create and click the Export button.
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Chapter 11. Intrusion zone management

An intrusion zone combines multiple sensors into logical groups for arming and disarming a defined space
(zone) within a building. A group of points defines a single intrusion zone. Grouping points from other
connected stations can become part of the single intrusion zone. A single intrusion zone status point
represents the state of the intrusion zone and identifies, by sensor, any alarms generated in the zone.

The system offers flexibility when it comes to arming and disarming intrusion zones. To manage multiple zones
from a single location, a single reader or keypad may be assigned to several zones. To allow arming and
disarming a single zone from multiple locations, several devices may be assigned to a single zone. Intrusion
zones may be controlled by schedules, hardware inputs, and by configuring properties in a browser interface.

Grouping includes points from other connected stations as part of a single intrusion zone. This lets you extend
the zone to include readers, points, or relays that are under those additional stations. In addition to extending
the intrusion zone physically, this allows sharing of arming status and zone enabled. For example, to view or
control a zone's status (armed or disarmed) from a peer station or a Supervisor station, you can do so if they
are grouped.

The system logs all activity regarding enabling, disabling, and alarms within an intrusion zone. In addition, it
independently logs by zone and source sensor any alarms generated by a sensor in the intrusion zone.

Devices used to enable and disable intrusion zones

Depending on the requirements and available hardware configuration, the enabled and disabled status of an
intrusion zone may be controlled by different methods. If a single reader is assigned to more than one intrusion
zone, then that reader enables or disables all zones to which it is assigned.

The system allows you to associate these devices and methods with intrusion zones:

e Card reader

* SmartKey device (SmartKey device provides keypad for entering a PIN and for arming, disarming, and
displaying the status of intrusion zones.)

* Schedule
¢ Contact input
* A manually-configure method using the browser interface.

You configure the zone-device relationship by assigning the device to the zone or the zone to the device.

Intrusion zone status indicators
The behavior and display color of designated LED indicators indicate the current status and operation of the
intrusion zone (armed, disarmed, arming, disarming, waiting for exit, waiting for PIN, and other indications).

Audible beepers indicate current status and operation of the intrusion zone (armed, disarmed, arming,
disarming, and other states).

Audible beeper patterns indicate current status and operation of the intrusion zone (armed, disarmed, arming,
disarming, and other states).

Zone alarms related to groups can initiate system actions, including:

* OQutput to arelay
e Email notification

¢ Dialer interface
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Grouping
Creating a group adds peer-to-peer and subordinate stations to an existing intrusion zone. In so doing, it
relates the remote host’s intrusion zone to the Supervisor station. Specifically:

* Stations to group must be joined in either a peer-to-peer or Supervisor-to-subordinate relationship.
* The Entry Reader and Exit Reader tabs display only on the local controller readers.

* You can only add readers to intrusion zones when you are connected to the reader’s assigned station.
Readers are not visible and cannot be configured from remotely-grouped stations.

Using both a schedule and a PIN

If you plan to use both a schedule and a PIN:

¢ If the zone is armed using a schedule, the PIN can disarm the zone. To arm the zone again, the schedule
must change state to disarm and back to arm.

¢ If the zone is armed using a schedule, and the zone is already armed, entering the PIN arms it again. The
system counts down again, but the state stays the same. If the zone is armed by a PIN and a schedule
changes to the arm state, nothing happens.

Adding or editing an intrusion zone

This procedure documents how to add or edit an intrusion zone in a remote host controller. This is the first step
in setting up a building'’s intrusion zone.

Prerequisites:
You are connected to the remote host controller station.

Step 1. Click Controller Setup > Intrusion Setup > Intrusion Zones.
The Intrusion Zones view opens.

#% Controller Setup

&3 Personnel A, Threat Level

[ Schedules & UserManagement 8= Backups #F Remote Devices #% Access Setup | &

o a@ I EEEE0
Y

Intrusion Zone Dizarmed 20secs Szecs [Services/AlarmService/Intrusion Zone

Lobby Dizarmed 20secs Szecs [Services/AlarmService/Lobby

Main Office Dizarmed 20secs Szecs [Services/AlarmService/Main Office

Step 2. Do one of the following:
e To add an intrusion zone, click the Add button (

5)
)

e To edit an existing zone, double-click the zone in the table or select the zone, click the
Hyperlink button (
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Step 3.
Step 4.

Step 5.

Step 6.

Step 7.
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), and click the Intrusion Zone tab.
The Add New Intrusion Zone or edit view opens.

K Save | [} Intrusion Zones

Display Name |Inl:rusion Zonel |

Intrusion Zone Recipients Relay Links

Ack Required
Priority

Offnormal | 255 | Alert|255

Ioi
loi
|07
Unacked Alarm Count Ia

Time Of Last Alarm 01 ¥ ~Jan V{1970 05 V|[:30 v | AM V| IST
Escalation Levell Enabled

Escalation Levell Delay (00000 |h m [1min - +inf]

Escalation Level2 Enabled

Escalation Level2 Delay (00000 |h m [2mins - +inf]

Escalation Level3 Enabled |false Vv

00000 |h m [3mins - +inf]

| Fault |255 | Normal |255

Total Alarm Count
Open Alarm Count

In Alarm Count

Escalation Level3 Delay

Zone Enabled false {ok}

Zone Schedule il |None »
Zone Input L ] INOI‘IE »
Zone Status Disarmed

Arming Test Status Success {ok}

Time Delay 00000 |h[00 |m[20 |s[0Oms - +inf]
Warning Time 00000 |h[00 |mfos |s[Oms - +inf]
Count Down 0 sec

Last Activity 01 ¥ ~Jan V{1970 05 V|[:30 v | AM V| IST

Create or edit the Display Name for the zone.

Use the Ref Chooser to select the custom schedule you created in the Zone Schedule property.
You may use a schedule to automatically arm a system as the only arming/disarming method or in
conjunction with a keypad. (The last one to arm or disarm wins.)

Define a Time Delay and Warning Time.
The time delay allows personnel to exit the zone after arming, as well as an alarm delay for
disabling the zone when entering it.

You configure these times in the Supervisor intrusion zone. The system pushes them down to
remote host controller intrusion zone in just a few seconds...no replication necessary.

Enable one escalation level in the Supervisor intrusion zone.

Intrusion zones can employ up to three levels of alarm escalation. Use this feature to notify up to
three people if alarms go unacknowledged. You may also use this feature to give an operator a
chance to acknowledge and clear an alarm before notifying an off-site monitoring company.

Define other properties and click the Save button at the top of the view.
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The system creates or updates the intrusion zone record in the database of the local station. The
Niagara Enterprise Security Reference document explains each intrusion zone property.

Intrusion points

The points you can assign to intrusion zones relate to reader and door modules.

Point Description

Base Reader These are digital inputs that are mapped to different doors, which give the access based on the badge validity.

Module.Di2, Di3

Base Reader If the door has an exit request device, This field allows you to designate the supervised input that is used for the

Module.Door 1.Exit request to exit sensor.

Request

Base Reader If the door has a sensor device, use an option list to designate the supervised input that is used for the door sensor.

Module.Door Sensor is mainly used to specify door is Locked or Unlocked.

1.Sensor

IntrusionTimeoutExt An alarm event that occurs if the intrusion zone is armed and the door sensor changes to true after access is
granted and the intrusion zone is not disarmed before the countdown expires. The extension must be edited as an
Entry Point. If the zone is disarmed before the countdown expires, the countdown ends and the alarm is inhibited.
This allows for annunciation that the zone is armed.

Adding points to an intrusion zone

Any point to be monitored as part of an intrusion zone must be added to the intrusion zone.

Prerequisites:
The intrusion zone record in the local station exists. You are using the web Ul connected to the remote host
station.

Step 1. Navigate to Controller Setup > Intrusion Setup > Intrusion Zones.
The Intrusion Zone view opens.

Step 2. Double-click the zone to which you are adding the point.
The edit view for the zone opens.

Step 3. Click the Points tab and click the Assign Mode button (5] ).
The Unassigned pane opens with the list of available points.

Step 4. Select one or more points to assign and click the Assign button (| o).
The assigned points move to the Newly Assigned pane.

Step 5. To delay the alarm on a point when the system arms, select the point, and click the Edit Entry
Point button ([@|).

Step 6. To cause the alarm on a point to be always enabled regardless of the arm/disarm state, select the
point and click the Edit Always Armed button ( ).

Step 7. Extend the zone to include readers, other points, or relays that are under the station.

Step 8. To complete adding points to the intrusion zone, click Save.

Assigning the Supervisor station

To identify the Supervisor station to which the remote host controller belongs involves creating a group. In
addition to extending the intrusion zone physically, expanding the zone by adding stations shares the arming
status and zone enable status with all stations in the zone. You can view or control a zone's status (armed or
disarmed) from a peer station or a Supervisor station if the stations are grouped.

Prerequisites:
You are using the web Ul in the remote host station.

Step 1. From the main menu, click Controller Setup > Intrusion Setup > Intrusion Zones, and double-click
an existing intrusion zone.
The Intrusion zone view opens. The name of the view reflects the name of the zone.
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Step 2. Click the Grouping tab, and click the Assign Mode button (|5 ).
The Unassigned pane opens with a list of available stations.

Step 3. Select the Supervisor station to assign to the group and click the Assign button (| |).
The system assigns the station to the intrusion zone group. The Supervisor station now lists the
original intrusion zone in its own list of intrusion zones.

Step 4. Connect to the Supervisor station you just added.

Step 5. To view its intrusion zone properties, from the main menu click System Setup > Intrusion Setup >
Intrusion Zones, and double-click on the existing intrusion zone.
The Intrusion Zones view opens.

Step 6. Double-click the intrusion zone.
The remote host's intrusion zone status shows correctly in the Supervisor station’s intrusion zone.

Assigning a Supervisor station causes the zone status to show correctly and updates to occur
without replication.

Do not use the Reader tab on a Supervisor station.

Deleting an intrusion zone from a station

When you delete an intrusion zone from one station, which is grouped with other stations that have two-way
communication, the system deletes the intrusion zone from all grouped stations. If you remove the station from
the group first, and then delete the intrusion zone, the system only deletes the zone from the local station. In
this case, to delete the intrusion zone from the other stations in the group requires a separate manual process
on each station.

Step 1. Navigate to Intrusion Setup > Intrusion Zones.

Step 2. Select the intrusion zone and click the Delete button ([ g ).

Removing a station from an intrusion zone

To un-group a station, you remove its assignment to the group.

Step 1. Navigate to Intrusion Setup > Intrusion Zones, and double-click the zone that contains the station

to remove.
The edit view for the intrusion zone opens.

Step 2. Click the Grouping tab.
The list of stations with assignments to the group opens.

Step 3. Select the station with the group assignment to remove and click the Unassign button (| g ).
The system removes the station from the group.

Routing intrusion zone alarms to the Supervisor

This procedure configures the system to send intrusion zones alarms to the Supervisor station.

Prerequisites:
You have created the intrusion zone in the controller station.

Step 1. In the controller station, click Controller Setup > Intrusion Setup > Intrusion Zones, double-click
the zone, click the Points tab, and click the Assign Mode button (g ).
The Unassigned pane lists the available points.

Step 2. Add the points in the controller station for the intrusion zone.

Step 3. Click the Grouping tab and click the Assign Mode button (|5 ).
The Unassigned pane lists the available Supervisor stations.

Step 4. Select the Supervisor station in the Unassigned pane, click the Assign button (| |), and click
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Save.

Step 5. Click the Recipients tab and click the Assign Mode button (|5 ).
The Unassigned pane lists the available alarm recipients.

Step 6. Select the Supervisor as the alarm recipient, click the Assign button (| ), and click Save.

Step 7. Connect to the Supervisor station, click System Setup > Remote Devices > Station Manager, and
click the Replicate button.
You can now view the intrusion zone in the Supervisor as well as the remote controller station.

Step 8. In the Supervisor station, click System Setup > Intrusion Setup > Intrusion Zones, click the Add
button (| @ |), click the Recipients tab, and click the Assign Mode button (|5 ).
The Unassigned pane opens with the list of available alarm recipients.

Step 9. Select the Console Recipient or other applicable recipient, click the Assign button (| & |), and click
Save.

Replicating the intrusion zone from the Supervisor

This procedure ensures that the intrusion zone is viewable at the Supervisor station as well as in the remote
host controller station.

Prerequisites:
Using the web Ul, you are connected to the Supervisor station.

Step 1. From the main menu click System Setup > Remote Devices > Station Manager.
The Station Manager view opens.

Step 2. Click the Join button (= |).
After configuring all record types, the Commit button is available for completing the join process.
If Replication is disabled, a window prompts you to enable and run replication.

Replication is disabled

Replication is currently disabled. Do you want to enable and run replication?

| ok || cancel |

Step 3. To enable replication, click the OK.

Step 4. To start the replication job, click Replicate ( [g:).
Once the replication job starts, a progress bar marks job progress until the replication job
completes successfully or fails, as indicated by the final job status window.

Setting up intrusion alarms in the Supervisor station

This procedure configures the console recipient for intrusion alarms.

Prerequisites:
Using the web Ul, you are connected to the Supervisor station.

Step 1. From the main menu, click System Setup > Intrusion Setup > Intrusion Zones, double-click the
intrusion zone name in the table, and click the Recipients tab.

Step 2. To display the available alarm classes, click the Assign Mode button (|5 ).

Step 3. Select the recipient.

226 March 21, 2025



Niagara Enterprise Security Installation and Maintenance Guide Intrusion zone management

Step 4. Select the recipient in the Unassigned pane and click the Assign button ([ |).

Step 5. To assign the recipient, click Save.

Configuring intrusion zone alarms to appear on the Supervisor

This procedure explains how to configure an intrusion zone in a remote host controller so that intrusion alarms
appear in the Supervisor's alarm console.

Prerequisites:
The remote host controller is installed, you are connected to its station, the intrusion zone already exists.

Step 1. To assign the relevant Supervisor from the main menu, click Controller Setup > Intrusion Setup >
Intrusion Zones, double-click an existing intrusion zone, click the Grouping tab, click Assign Mode
(/8 ), select the Unassigned Supervisor station, and click Assign (| & ).

Step 2. To route intrusion zone alarms to the Supervisor, click the Recipients tab, click Assign Mode ( 5§ ),
select an unassigned Supervisor recipient, and click Assign (| @ | ).

Step 3. Click Save.

Step 4. Replicate from the Supervisor.
The Supervisor station can view alarms from the remote intrusion zone.

Step 5. In Supervisor, click System Setup > Intrusion Zone, double-click the intrusion zone in the table,
click the Recipients tab, and assign the console recipient or other applicable recipient.

Setting up a schedule to arm and disarm an intrusion zone

A optional schedule associated with an intrusion zone can arm and disarm an intrusion zone automatically.

Prerequisites:
For a company-wide configuration, you are using the web Ul in the Supervisor station. Otherwise, you are
using the web Ul in the controller station.

Step 1. To begin, click Controller (System) Setup > Schedules.
The Schedules view opens.

Step 2. To create a new schedule, click the Add button ([ @ |).
The Add a new Schedule window opens.

Step 3. Choose Custom, and click Ok.
The Choose a Usage... window opens.

Step 4. Click the chevron to the right of Usage, select Intrusion, and click the Assign button (|5 ), and
click Ok.
The Schedule view opens.

Step 5. Name the schedule, for example, Intrusion zone.

Step 6. Configure the Default output so that true = Armed, and false = Disarmed.

Step 7. On the Scheduler tab, set up the schedule so that the zone is disarmed during weekdays.
Step 8. To save your changes, click Save.

Step 9. Export the schedule from the Supervisor to the remote host controller station.

Step10. Assign the schedule to the intrusion zones in the Supervisor and the remote host controller.
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Assigning the schedule to the intrusion zone

For a company-wide system you assign the schedule to the intrusion zone in both the Supervisor and the
remote host controller.

Prerequisites:
You are working in the Supervisor station, followed by working in the remote controller station. The intrusion
zone already exists.

Step 1. To begin in the Supervisor station, click System Setup > Intrusion Setup > Intrusion Zones.
Step 2. To select the intrusion zone, double-click a zone and click the Intrusion Zone tab.

Step 3. Click the chevron next to the Zone Schedule property, select the schedule you created from the
Ref Chooser, and click OK.
The name of the schedule appears in the Zone Schedule property.

Result
When the schedule transitions to true, the system arms the zone and performs any associated actions.

Setting up an intrusion PIN

You may use a PIN (Personal Identity Number) to arm and disarm an intrusion zone. An associated schedule
may determine when the PIN is valid.

Prerequisites:
Using the web Ul, you are connected to the Supervisor station.

For a standalone configuration, you create an intrusion PIN in your controller station. For a company-wide
configuration, you should set up intrusion PINs in the Supervisor station.

Step 1. Click System Setup > Intrusion Setup > Intrusion PINs.
Step 2. To add aPIN, click Add (g |).

Step 3. Enter a name for the PIN.
This name might identify the intrusion zone.

Step 4. Enter the schedule and, if applicable, the tenant.
Step 5. Finally, enter the PIN, and click Save.
Step 6. If you need multiple PINs, repeat these steps for each PIN.

Step 7. To complete the configuration, click Save.

Assigning a PIN to an intrusion zone

You create an intrusion zone PIN in the Supervisor station and assign it in the controller station.

Prerequisites:
You are using the web Ul in the Supervisor station. The PIN and intrusion zone exist.

Step 1. To begin, click System Setup > Intrusion Setup > Intrusion Zones, doublt-click an intrusion zone,
and click the Intrusion Pins tab.
The Intrusion Pins tab opens.

Step 2. To view the available PINs, click the Assign Mode button (| 5/ ).
Step 3. Select an unassigned PIN and click the Assign button (| ).

Step 4. Assign the Display/Keypad to the remote host controller’s intrusion zone.
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Push button for arming and disarming

You may arm and disarm an intrusion zone with a hardware input, such as a push button.

The push button input device should be momentary rather than latching. The system toggles the zone status
every time it activates the associated input. The system initiates the arm-with-delay function when you activate
the button and disarms the zone. If the zone is not secured, it will not arm. There is no feedback to the user
with this method unless you install additional hardware.

Niagara Touch display

The mobile Niagara Touch display locks down the browser to a specific URL and serves as an intrusion zone
arming and disarming keypad. Client certificate authentication automatically logs in the display to a controller
station. This section sets up a Niagara Touch display with a client certificate and connects it to a controller
station. The display runs the Android operating system.

Standard tools and certificate authentication support the display. You will need a separate display, certificate,
display user and nav file for each zone. To save Time, Niagara 4.10 includes a sample Px view with an onscreen
keypad, default user and role in a restore distribution file. The Px file is also available in the Px folder of the
Supervisor station.

NOTE: Assigning a user certificate requires the FoxService and WebService to restart. To avoid disrupting daily
operations, configure a new Niagara Touch display after hours.

Files

Configuring the Niagara Touch display involves several files. As a best practice, take time to identify where you
will save these files so that you can easily find them when you need them.

You can name your files differently from the names used in this table. These names are used as examples in
these configuration procedures.

File Where stored Comments
Certificate .pem  User home: C: /Users/<User This file will reside in the User Key Store of the remote controller station.
file Name>/<Software The remote controller is the client in this client-server relationship.
version>/tridium/
certManagement
Certificate .pem C:\certs This path should be short because you enter it when using OpenSSL to
file with key and convert a .pem certificate file to a .p12 file.
.p12file

This certificate is destined for the display, which is the server
in this client-server relationship.

Px page Station > Files in the controller station  This page provides a sample intrusion keypad to appear on the display.

Before you use the File Copier utility to copy this file to the
controller station’s Files folder, put it on your PC in a location
that is easy to find.

Nav file Station > Files in the controller station  This file tells the display to open the onscreen keypad when someone logs
in.

Prerequisites

To install and configure the Niagara Touch display your configuration needs these prerequisites.
¢ Up to a 4GB USB thumb drive

¢ Up to an 8GB MicroSD card

These components must not exceed these sizes.
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Certificate and authentication setup

Creating and exporting the client certificate

A certificate authenticates the display to the station that manages the device. You need a separate certificate
for each display.

Prerequisites:
You are working in Workbench connected to the station that manages the display device.

Step 1. To create a client certificate, expandConfig > Services > PlatformServices, double-click
CertManagerService and click New.

Step 2.

Step 3.
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T

he Generate Self Signed Certificate window opens.

Generate Self Signed Certificate

Generates a self signed certificate and inserts it into the keystore

E

Alias CeTt {required) _

Comman Name (CN) client certificate (required)
*thiz may contain the host name or address of the server

Organizational Unit (OU) My Department

COrganization (0] My Company (required)

Locality (L)

State/Province (5T)

Country Code (C) Us ireguired)

Mot Before B-Jun-0202 01:03 PM EDT |

Mot After 8-Jun-2022 01:03 PM EDT ﬁ

Key Size <5 1024 bits 4> 2048 bits > 3072 bits <> 4096 bits ’
Certificate Usage < Server & Client > CA > CodeSigning

Email Address

Digital signature [] Mon-repudiation [] Keyencipherment
Key Usage |:| Data encipherment |:| Key agreement |:| Certificate signing
[ ] cRLsigning [] Encipheronly [] Decipheranly
oK | Cancel |
nter values for at least these required properties:

Alias provides the certificate name. Enter it as “cert.” This is a required name.
Common Name should match the display user you will set up with certificate authentication.
Organization is your company.

Country Code is the two-character ISO CODE you can find at countrycode.org.

Select Client for Certificate Usage and click OK.
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The certificate appears in the User Key Store.

The next step exports the certificate so that you can associate it with the display user you just
created.

Step 4. To export the certificate, select it in the User Key Store and click Export.
The certificate file is located here: C:\Users\<<your user>>\<<Niagara
Version>>\tridium\certManagement where:

® <J<your user>> isyour user name

® <<Niagara Version>> is the folder that contains the Niagara software
The Certificate Export window opens.

Certificate Export *

Certificate

Export format: [JE|.,-|

[# Exportthe public certificate

TableView = ASM.1View PEM View

Properties:

Version w3

Serial Mumber 76 B3 07 3d 5f 30 41 32 65 Bf ab bO

Issued By intrusion keypad

Issuer DN CH=intrusion keypad, OU=NyDepartment, 0=MyC

q\ Private Key

[ Exportthe private key

[#] Encrypt exported private key

0K Cancel

Do not export this certificate with its private key.

Step 5. To continue, click OK, store the certificate’s . pem file where you can find it later and click OK again
to close the Certificate Export window.

Next steps
The next step sets up single sign-on in the AuthenticationService.
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Client authentication verifies that a keypad user is authorized to connect to the security system. This user is not
a person, rather it represents the Niagara Touch display.

Prerequisites:

You are working in Workbench connected to the station that manages the display device. The station has an
AuthenticationService in the Services folder.

Step 1. Expand Config > Services > AuthenticationService > AuthenticationSchemes.
By default, this station comes with one ClientCertAuthScheme.

Step 2. If you need a second scheme, open the clientCertAuth palette and drag the

Step 3.
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Station (NewEntSecSupens /

- Palette

@ My Metwork

o AlarmService

O auditHistory

e AuthenticationService
Authentication Schemes
ﬁ DigestScheme
ﬁ A¥DigestScheme

m HTTPBasicSchene

m ClientCertAuthScheme
m 550 Configuration
@) BackupService

Station Summary -

] E] E i clientCertAuth

(@l cllentCertAuthScheme

ClientCertAuthScheme component from the palette to the Authentication Schemes node under

the AuthenticationService.

Double-click SSO Configuration (this component is at the same level as Authentication Schemes

under the AuthenticationService).
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The SSO Configuration AX Property Sheet opens.

. Station (NewEntSecSupervisor) . Config I Services . AuthenticationService I S50 Configuration / AX Property Sheet -

- Nav Property Sheet

[#l 550 Configuration (SSO Configuration)

fl G @ My Network
= # Auto Attempt Single Sign On ® e

AlarmService
o m Ignore Auto S50 If User Cookie Present . false

O suditHistory
.true

@ Authenticationservice [ Display S50 Schemes On Login Page

D Authentication Schemes [l Remember My Choice Domain

m DigestScheme

m AXDigestScheme

m HTTPBasicScheme

m ClientCertAuthScheme
@ 530 Configuration

-

- Palette

Step 4. Set Auto Attempt Single Sign-On to true, confirm that Ignore Auto SSO if User Cookie
Present is set to false and click Save.

Next steps
The next step associates the exported certificate with the display user.

Setting up a display user
This system user represents the Niagara Touch display, which is authorized to connect to the station and

should be configured with the most restrictive role and permissions possible. This procedure creates this user
and assigns the authentication certificate you created to this user. You will need a separate user for each

display.

Prerequisites:
You are working in Workbench connected to the station that manages the intrusion zones.

Step 1. Expand Config > Services and double-click the UserService.
The User Manager opens.

Step 2. To create the user for the client certificate you created, click New, select the number of users to
create and click OK.
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The New view opens.

Mew *
Name  FullMame Enabled Expiration Roles Allow Concurrent Sessions  Auto Logoff Settings  Mebwork User
a Kiosk KioskUser true Mewer defaultPrototype,a true Auto Logoff Settings  false
(il Name [Kiosk |
li Full Name Kiosk User KE
li Enabled . true
li Expiration @ Mever Expires O ExpiresOn |21-Jun-2021 11:59 PM EDT
defaultPrototype

[l
Badge Operator

»

Maintenance
Operator
Personnel Management

Intrusion Display

. true

I Auto Logoff Enabled

F. Allow Concurrent Sessions

'. false ﬁ

Use Default Auto Logoff Period . true

F. Auto Logoff Settings

Auto Logoff Period 00000h 15m
[l Network User @ false
F. Prototype Name
F. Language A"_Ef

[i Authentication Scheme Name | ClientCertAuthScheme

Password |

Confirm
li Authenticator

Force Reset At Mext Login . false

& MeverExpires < ExpiresOn |21-Jun-2021 11:5% PM EDT
[ Email ~B
li Cell Phone Number ;_?

oK | Cancel ‘

Step 3.

Step 4.

234

Enter values for at least these properties:

Name can be the Common Name you used for the certificate.
Roles, for now assign the admin role. You will change this later to the most restrictive role.

Under Auto Logoff Settings, remove the check mark to select false for Auto Logoff
Enabled.

Authentication Scheme, set to ClientCertAuthScheme.

To accept the changes and save the user, click OK.
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The software alerts you that the credentials for the user need to be updated.

Authentication Scheme Changed *

E Authentication Scheme Changed

Authenticator has changed and the credentials may need to be updated foruser: Zonel.

Step 5. To assign the certificate to this user, open the user again by double-clicking UserService, select the
user you just created and click Edit.
The Edit window opens.

Step 6. Scroll down to Authenticator and under Certificate, click Choose File.
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A File Chooser window opens.

| | Mame FullMame Enabled Expiration Roles Allow Concurrent Sessions  Auto Logoff Settings  Network Use
a Kiosk KioskUser true Mewver defaultPrototype,admin  true Auto Logoff Settings  false

‘ . Name Kiosk ‘

. Full Name File Chooser x

.l Enabled g File Spa ces Current Path |

. Expiration ~certManagement ‘

Q Files on Station (NewEnts —
4« O A = ¢  o-08 3
0 My Modules
E] cert.pem

— |

Ll Roles

s rt.

Ll Allow Concurr s 1 '::m

A
R Bookmarks 21-Jun-213:33 PM EDT

. Auto Logoff 5¢

. Network User

. Prototype Nam

. Language

[l Authentication Filename: |cert.pem Open

Files of type: |AllFiles (*.") Cancel
| |li Authenticator
Ul Certificate ]

[ = . ~B
| Ll Email Aes

. Cell Phone Number A'-_lf

| Time Format {default)

|l Facets

Himit CAamirarciam MAarna
OK | Cancel |

Step 7. Navigate to the client certificate you created and, to assign the certificate to this user, select the
certificate and click Open.
If you used the default location, double-click User HomeCertManagement.
The system advises you that the FoxService and WebService need to restart.

Step 8. To save the change you just made, click OK.

Next steps

Next, for Niagara 4.9 and earlier, you export the same certificate, but this time with its private key. Then, for all
versions you add the certificate to the server socket's TrustAnchor list. You will return to this user to configure
more properties later.

Exporting the certificate with its private key (Niagara 4.9)

If you are using Niagara 4.9 you may export the display certificate with its private key. This provides the most
robust security for data communication.
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Prerequisites:
You are using Niagara 4.9 or earlier. You are working in Workbench running on a PC. You are connected to the
station that manages the display device.

If you are using Niagara 4.10 or later you do not need to export the certificate with its private key. You can use
the .pem file you exported to configure the UserService. OpenSSL does not support .pem files and private
keys exported from Niagara 4.10.

NOTE: The private key of the server certificate validates the public key presented to the display by the client
station. A server certificate without a private key is less secure than one with its private key. Without the
encryption of the private key, a malicious user could install the certificate into devices that should not be
allowed to make a connection. However, when a PIN is involved, as it is with arming and disarming an intrusion
zone, the risk is low.

Step 1. To export the certificate with its private key, expand Config > Services > PlatformServices;
double-click CertManagerService; in the User Key Store, select the certificate you created and
click Export.

The Certificate Export window opens.

Certificate Export >

Certificate

Export format: PEWY

[#] Exportthe public certificate

TahleView = ASM.1View PEM View

Properties:

Version w3

Serial Mumber 76 B3 07 3d 5f 20 41 32 65 Bf ab bO

Issued By intrusion keypad

Izsuer DN CH=intrusion keypad, 0U=MyDepartment, 0=HyC

q\ Private Key

[#] Exportthe private key

[# Encrypt exported private key

Password essssssses

confirm | {XXXXTXTRR

0K Cancel |

Step 2. Enable Export the private key, create and confirm a strong password to protect the key,
record the password in a safe location and click OK.
A File Chooser window opens.
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Step 3. Save the file in a location other than the location you used for the first save, for example,
C:\certs.
Since you will use an OpenSSL command prompt to convert the .pem file to a .p12 file, a short
path will make it easier to enter the commands.

Result
The next procedure downloads OpenSSL to create a .p12 certificate.

Preparing the .p12 server certificate

OpenSSL converts a .pem certificate file to a .p12 certificate file. The display recognizes this format.

Prerequisites:
You are working in Workbench running on a PC. You are connected to the station that manages the display
device.

Step 1. Download the appropriate version of OpenSSL for Windows and install it.
Multiple sites provide pre-compiled executables. For example, you can download it from here:
https://slproweb.com/products/Win320penSSL.html.

More information about OpenSSL is available here: https://www.openssl.org/source/
This YouTube video provides a tutorial for setting up OpenSSL: https://www.youtube.com/
watch?v=7SkQ27sTto0

Step 2. Follow the instructions to install OpenSSL.

Step 3. Open an OpenSSL command prompt and change your directory to the folder that contains the
certificate you exported, for example: cd\certs.

Step 4. To run the OpenSSL conversion from the command prompt, type this command and press Enter.
openssl pkcsl2 -export -out cert.pl2 -in <your cert> -inkey <your
cert>.pem

The output certificate name must be cert.pl2.
OpenSSL prompts you to enter the pass phrase for the Niagara 4.9 (or earlier) certificate you
exported with the private key.

Step 5. Do one of the following:

* For Niagara 4.9, enter the password you created when you exported the certificate with its
private key.

* For Niagara 4.10, press Enter.
OpenSSL prompts you to create and confirm its password. Both certificates with and without an
export private key require this .p12 password.

Step 6. Enter, verify and record this password in a safe place.
OpenSSL creates a new certificate with the .p12 extension and associated password.

Step 7. Confirm that the new certificate exists and move it to a secure location.
You do not want an unauthorized person to have access to this certificate.

Next steps
The next step is to install the .p12 certificate in the display.

Installing the .p12 certificate

The display requires the server certificate to make a secure connection to the station.
Prerequisites:

Your display is charged and ready to use. Your network router is within range so that the display can connect to
it using WiFi.
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Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Save the .p12 certificate to a USB thumb drive or MicroSD card.
The USB adapter comes with the display unit.

Use the adapter to connect the USB thumb drive to the display’s mini-USB connector or insert the
MicroSD card.

Turn on the display (the on/off button is the small button to the right of the mini-USB receptacle
on one end of the display).

A start-up splash screen opens followed by a screen with this instruction: TAP HERE FOR
SETTINGS as the device connects to your local area network.

Tap TAP HERE FOR SETTINGS.

TRIDIUM

Certificate Auth
Found certificate. Please enter the password to save on device.

CANCEL  SAVE CERTIFICATE

The display finds the certificate on the thumb drive or MicroSD card, imports it and opens the
Certificate Auth window.
If, for any reason, you need to return to the first screen that reads, TAP HERE FOR SETTINGS,
press the on/off button, and select Restart.

Using the onscreen keypad, enter the password you created when you exported the certificate
using OpenSSL and tap SAVE CERTIFICATE.
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Step 6.

Step 7.

Step 8.
Step 9.

Step10.

The Networks and Content Sources view opens.

(10 switch to Ethemet, plug in Ethemet cable and reboot)

C Sources visible on current network

al
19216801
19216813
192168.14
041731€2dcb3
19216816
19216817

441123074103
18216819

[

On the left, under “Sources visible on current network” is the list of devices that are connected
to your network.

Using the IP address of the remote controller station, scroll down the list on the left, find the
controller and tap the blue, right-pointing arrow.
The controller appears under the “Display Content in Kiosk Mode” list.

The display supports only one source at a time. If more than one source appears in the list on the
right, swipe to the left over the source you do not need. This exposes a delete option (white X
on a red square). Tap this X to delete the extra option.

Expand the source by tapping the down arrow and tap to turn on Use https.
This enables secure communication between the display and controller station.

To preview the connection, tap PREVIEW.

Assuming the connection works as expected, tap LAUNCH.
The display connects to the controller station using certificate authentication.

In the browser, select Log in with SSO using the user you created in the station.
You do not need to input a password as the display recognizes the certificate you installed. The
display automatically logs in using this user each time it reboots.

Configuration

Associating the display with its zone

The station that controls your intrusion zone(s) is the one to which your Niagara Touch display connects. This
procedure uses the web UL

Prerequisites:
You created your authentication certificate and have set up your display. You are working in the web Ul and are
connected to the station that manages your building’s intrusion zones.

Step 1.
Step 2.

Step 3.
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If needed, set up one or more intrusion zones following the procedure earlier in this chapter.

To add a display, navigate to Controller Setup menu, select Intrusion Setup > Intrusion Displays
and click the Add button (| @ |).
The Intrusion Display tab opens.

Configure these properties:
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Give the display a Display Name.
Change Smart Key Device to none.
Step 4. To add an intrusion PIN or PINs, select true for Arming Pin Required.

Step 5. To assign the intrusion zone to a display, click the Intrusion Zones tab, click the Assign Mode
button (=), select an unassigned zone and click the Assign button ([ ).

Step 6. To save these changes, click Save.
The system adds the display to the database, shows it the top of the view, and adds it as a
component node under the AlarmService.

Step 7. Repeat these steps for each display.

Next steps

The next step is to create the onscreen keypad.

Setting up the px view

You can create a Px view of an onscreen application and install it on the display.

Prerequisites:
You are working in Workbench connected to the station that controls the display.

Step 1. To configure properties, expand Config > Services > AlarmService and double-click AndroidView.
The view’s Property Sheet opens.

Ltation (entSecu ity 801 Config P Alarn Sarvice Andidinirusigniisglyy Andmoidew / A Property Sheel =
= Mav Property Sheet

L=

1] 0 -'f','j My Netwrarh 1:'! androidview (Folder
- 3 AndroidView  Px View

ol ,' Sration lentSequrity B
¥ Hame ,
& wam Ml Reguired Permissions ¢
- © conty R s e R
v (D Services
b %-'--:'.:'.sic"":-";c--,-.u
- n AlprmmEeraice

F L Messium

W fcon medule:/ficons/xlé/vieve/view.pag

. Px File file:‘pu/mcbileIne.px

b B Consoleecipient

# High
B Low

@ ot Alarm Class

L3 androidentrosionDispley
b [l vevalid Bin Namiber Alert
b L Mo Actve Schedule Alert
« () andraidiew

b a ApditHistory

d ﬂ AigthenticationSendks

NOTE: This Px view uses relative ords.

Step 2. To customize data flow, right-click AndroidView and click Views > Wire Sheet.
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The Wire Sheet view opens.

= Nav Wire Sheet

t O [X] @ Mybetwork

v o.i.llrmkn'm
b [a Medium
b [ consolerecipient
b O High
b ﬁ Low
b @ offalarm Class
b B intusion Zone
w [ AndroidintrasionDisplay
b .\i Irvvalid Pin Humber Alert

O authenticationService
@ esckupservice

® Basserice

© categorysenice

Step 3. To open the Px Editor, right-click AndroidView and click Views > Mobilelnt.
This displays the Px view.

) My Network

» al RemoteVideoService

»  #¥ ReplicationService

» 6D Roleservice

» Q) Searchservice Mobile Intrusion Keypad
» W securityService

» ) TogDictionaryService

» [B) Templateservice

L] o UserService

*

© webservice

b vrY PlatformsServices
» 6 orivers
[ 4 0 Graphics
v @ Files
L3 o Nav
- O px
[E) mobiteint.px
» Hierarchy
» @ History

Step 4. Test the arming and disarming function to make sure that the numeric keys function properly and
that the station accepts your PIN.
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Result
The next step is to set up a navigation file so that the keypad Px file opens on the display.

Setting up a navigation file
The onscreen Px view serves as the home page for the display user. When a person turns the display on, it
defaults to this page. You need a separate .nav file for each display.

Prerequisites:
You are working in Workbench connected to the controller station.

Step 1. Create a folder under the station’s Files node named Nav.
Nav files must reside under the Files node. They are not stored in the station database.

Step 2. To create a new .nav file, right-click the Files node and click New > NewfFile.nav.
The Name for New File window opens.

Step 3. Give the .nav file a name, click OK and expand the Files node.

Step 4. To associate the .nav file with the onscreen display, double-click the file name, select the slot and
click Edit.
The Edit window opens.

1R A L 145 fem et ity 80| Bhation | el ncurity S| iry , iy il Ediar

Prerneinelinslntaemt  Ften IS0 Sivites Al Sese Ardssadivie s Dy Badrsdiiew

sty e TS

FEATEOAT | RIS/ SR Vi o/ AL aTmI4 EVLD

» ©-

Kos BoSuln /7 10082 0 LTt g

Targat Grd

5] wtramen ey

T
) ey

Faew | A | W oclete | a weveup | w mowe Down l Mhow Compaacnts | [ Shaw tiles

Step 5. Click the folder icon and use the File Ord Chooser to select the location of the display folder.
In the example, this location is: station: |slot:/Services/AlarmService/
AndroidIntrusionDisplay/AndroidView.

Result
The next procedure creates an display role.

Updating the role assigned to the display

This special role limits the actions that a person can perform with the display to only arming and disarming an
intrusion zone. Niagara 4.10 includes a default role for the display along with a Px view in its restore
distribution file.

Prerequisites:

You are working in Workbench connected to the controller station that manages your building’s intrusion
zones.
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Step 1. Expand Config > Services and double-click RoleService.
The AX Role Manager view opens.

Step 2. To edit the default role, select the role and click Edit.
The Edit window opens.

Step 3. Inthe Nav tree, double-click the role name.
The AX Property Sheet for the role opens.
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Step 4. Confirm that Operator level read (R) and invoke (I) permissions are configured for two categories:
Graphics and Intrusion Setup.

Step 5. Enable Admin level read and invoke permissions for Alarm Console, click OK and click Save.

Result
The next procedure updates the display user.

Updating the user assigned to the display

You already set up this user when you created and assigned the certificate to it. This procedure updates this
user with additional information: role, .nav file and other information.

Prerequisites:
You are working in Workbench connected to your station that manages the display device.

Step 1. Expand Config > Services and double-click the UserService.
The User Manager opens.

Step 2. To edit the existing user, select it in the table and click Edit.
The Edit window opens.

Step 3. Configure these properties:
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* For Roles, assign the name of the role you created, for example, Intrusion Display

* For Nav File, assign the name of the file you created, for example, file:"Nav/
Intrusion.nav

e For Allow Concurrent Sessions, select false

Step 4. Configure the Default Web Profile, HTMLS5 Hx Profile as follows:
e Enable Hx Workbench View = Yes
¢ Enable Nav Tree Side Bar = No
* Enable Search Side Bar = No
¢ Enable Nav File Tree = No
* Enable Config Tree = No
* Enable Files Tree = No
* Enable Histories Tree = No
* Enable Hierarchies Tree = No
* Enable View Selection = No

Step 5. For the Mobile Web Profile, configure properties as follows:

* For Mobile Nav File enter the name of the file you created, for example, file:"Nav/
Intrusion.nav.

¢ Set Type to Handheld Hx Profile.

Step 6. When you finish setting up these properties, click OK.

Result

The display should now be able to connect to your station. The role and permissions you configured for the
display user are the minimum needed to operate the device. You can certainly add more permissions later. To
ensure that your display always attempts to navigate to the correct station page, add a path to the url for your
controller in the display setup of your station connection. Using the example of an intrusion keypad, the url for
the display could be: /ord/station: |slot:/Services/AlarmService/AndroidIntrusionDisplay/
AndroidView.

Configuring the intrusion display

These AlarmService properties control what appears on the display.

Prerequisites:
You are working in Workbench connected to your station that manages the intrusion zones.

Step 1. Expand Config > Services > AlarmService

Step 2. Double-click the AndroidintrusionDisplay node.
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The intrusion display’s AX Property Sheet opens.

Property Sheet

3 AndroidintrusionDisplay (Intrusion Display)

(l Default Message

(@ Smart Key Device
(M Scroll Start Delay
(M Scroll Column Delay
(@ Change Delay

(@ Inactivity Time

(@l Status Beep

(@ Arming Pin Required
(@ Status Pin Required

(M Point Display

» [ invalid Pin Number Alert
» [ No Active Schedule Alert

(@ Default Page
(@l In Alarm Beep

(@ In Alarm Max Beep
» Q) Androidview

Step 3. Set up the Default Message.

Intrusion Heypad

Hone ﬂ
00000h 00m 01.250s & [0ms-<inf]
00000k 00m 00.1502|4 [0ms-«inf]
00000h Q00m 03.000s & [0ms-+inf]
00000h Olm 00s & [0ms-+inf]

Qe [
@ false u
@ folse u

Marmal Path u

Activity Alert Ext

Activity Alert Ext

Time u

@ false u

00000h 00m 3033 [0ms-+inf]
Folder

This message displays when Default Page is set to Time. This page displays after a period of

inactivity.

Mobile Intrusion Keypad

a. Default Message
b. Default Page

Step 4. Select Summary from the drop-down list for Default Page.
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This page displays under the Default Message on the default screen. It can display the current
time or the state of the intrusion zone(s) that are associated with the display. If your display is in a
public area, you may not want to use the summary page as your default.

Mobile Intrusion Keypad

Intrusion fone - ' -

a. Default Page

Step 5. If aPIN is required to arm the system, set Arming Pin Requiredto true.
A PIN is always required to disarm the system.

Step 6. If a PIN is required to view the status of the system, set Status Pin Requiredto true.

Step 7. Select a value for Point Display.

Normal Path displays the station path to a point that is in alarm when performing an arming test
or arm-with-time-delay-system. If the point exists in another station, the path displayed points to
the remote station, for example: entSecurity801.Input/Output Module.sdil. If the point
is in the local station, this property outputs None.

Displays the Station Path to a Point: displays the path to a point starting with the point
reference when doing an arming test or arm-with-time-delay-system. For example:
Sdil.Input/Output Module.entSecurity801

None: displays the local station path to a point that is in alarm when doing an arming test or arm-
with-time-delay-system. For example, entSecurity801.Input/Output Module.Sdil

The keypad interface

The onscreen keypad resembles a mechanical keypad. Its display window has a default view and a summary
view.

The default display includes a timestamp.
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Figure 25. Intrusion keypad with default view

Mobile Intrusion Keypad

1. Display window with default information
2. Standard numeric keypad

3. Enter executes a selected action; Back returns to the previous view; the scroll bars navigate to additional
zones.

The summary display shows the current state of the building, the number of zones and available action.

Figure 26. Intrusion keypad with summary view

Mobile Intrusion Keypad

1. Current state of the building
2. Number of zones in the building
3. Auvailable action

For example, this summary indicates that the display is associated with three intrusion zones and all are
currently disarmed.

You can arm all the zones at once or one at a time. To arm all zones simultaneously using a PIN, each zone must
have the same PIN.
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Arming a building

Several options are available for arming and disarming. These include preventing the arming of the building if
any points are in alarm.

Prerequisites:
You have set up zones including required PINs.

Step 1. To test, before arming, if any points are in alarm, scroll down, select Arming Test and tap Enter.

Step 2. To select the zone to arm, scroll and select one of the following.
e To arm all zones at once, select Arm system.
* To arm zones one at a time, scroll up to the first line and select an intrusion zone.
® To arm with a time delay, select Arm with Time Delay system.
* To arm regardless of any points in alarm, select Force Arm.

* To arm regardless of any points in alarm as well as apply a time delay, select Force Arm
with Time Delay.
The display indicates your selection.

Maobile Intrusion Keypad

The screen capture shows arming a single zone.

Step 3. To arm the zone, tap Enter.
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If you attempt to arm a building with a point in alarm, the display reports Unable to Alarm.

Mobile Intrusion Keypad

If you selected Arm with Time Delay, the display includes a countdown timer.

Mobile Intrusion Keypad

After arming, the keypad displays the summary page with the option to disarm selected.

Mobile Intrusion Keypad

Disarming a building

You may disarm all zones simultaneously or one at a time.

Prerequisites:
Zones have been armed. To disarm all zones at once, all zones have the same PIN.
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Step 1. Do one of the following and tap Enter:
¢ To disarm all zones simultaneously, select Disarm system.

¢ To disarm a single zone, scroll to Disarm Armed zone.
If a PIN is required, the keypad prompts you to enter the Login PIN.

Mobile Intrusion Keypad

Enter Login PIN . - .
HHn
B

Step 2. Use the keypad to supply the PIN and click Enter.
When the disarm command is successful, the keypad displays the summary view.

Mobile Intrusion Keypad

If the PIN is invalid, the keypad displays PIN error and prompts you to enter the PIN again.

SmartKey display/keypad

The SEC-INT-KP Remote Intrusion Display/Keypad (SmartKey device) provides a keypad and display screen for
arming and disarming assigned intrusion zones.

The maximum number of SmartKey devices you can add or discover is six for each remote controller. If you add
more than the maximum-allowed, the Status property for the extra SmartKey Devices displays { fault}
Exceeded device.limit of <n> (where <n> is the maximum number of licensed SmartKey devices). Refer
to the Remote Intrusion Display/Keypad installation sheet for installation and wiring instructions.

SmartKey device user interface
The SmartKey device user interface has three major parts:

March 21, 2025 251



Intrusion zone management Niagara Enterprise Security Installation and Maintenance Guide

Figure 27. SmartKey device
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Function
Keys
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* Display: The top (upper area) of the display shows system information. The bottom area is reserved for two
sets of function icons that work in conjunction with the function keys (F1-F4).

* Function Keys: These keys (F1-F4) open and navigate menus, and select menu items. Each function key
corresponds to the menu function icon that appears directly above it on the display screen.

* Keypad: The twelve keys represent the numbers 0-9, asterisk (*) and pound (#) characters.

Function key controls
The four function keys (F1-F4) serve as selection keys for items that appear directly above them on the device
display.
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Figure 28. SmartKey device function keys and icons

F1 User F2 System F4 Device Select Menu Back Key
Menu Menu Menu Key Scroll Keys
i - - 5 i - 1 N

| %?@é) L\'/A'vbj

LR G )

Following is a description of each function key.
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NOTE: Several of the menus require that you enter a login PIN to access them.

e F1 User Menu g

When the User icon displays, pressing F1 key opens the Modify Logon PIN screen.

* F1 Select action \/

When the Select icon displays, pressing F1 key performs a selection action, similar to using anEnter key or
Ok button.

¢ F2 System Menu ii

When the System icon displays pressing the F2 key opens access to the System, Time, and Advanced...
menus.

* F2 Scroll Up action A

When the Scroll Up icon display, pressing the F2 key moves the selection indicator up one row each time
you press the key.

e F3 Scroll Down action '

When the Scroll down icon displays, pressing the F3 key moves the selection indicator down one row each
time you press the key.

¢ F4 Device Menu ®

When the Device icon displays, pressing the F4 key opens the “Device” menu, which contains device ID
and Firmware version information.

e F4 Back Q

When the Back icon displays, pressing the F4 key changes the display screen back to the previous screen.

Assigning a SmartKey PIN and ID

A unique ID identifies each SmartKey device on the network. Using the SmartKey device itself, you must assign
this three-digit ID before you connect the device to the remote controller.

Prerequisites:
The SmartKey display/keypad has been installed and powered on.

The first time you use the SmartKey device, it prompts you to define a login PIN. Write down this PIN and keep
it in a safe place.

CAUTION: If you lose this PIN, the SmartKey device must be sent back to the manufacturer.

Step 1. On the SmartKey device, press the F2 key.
The Login screen opens.

Step 2. Enter the Login PIN number, press the F1 key and select System menu from the display.
The System menu opens.

Step 3. Select Set ID and press the F1 key.
The Input screen opens.

SmartKey intrusion keypads ship with a default ID (address) of 1. To connect more than one
keypad, you must re-number them prior to discovery.
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Step 4. Use the numeric keypad buttons to set a unique ID number (1-255) and press the F1 key to save
the entry.
The Operation Saved message appears temporarily to confirm that the ID number is set.

Step 5. Write down the ID number and location of each SmartKey device so you can easily identify
SmartKey devices when setting up SmartKey devices in the Keypad Configuration view.

Discovering SmartKey devices

Discovery relies on the system to locate SmartKey devices connected to a remote controller.

Prerequisites:
You have configured the PIN and ID (address) of the SmartKey display/keypad. Using the web UI, you are
connected to the remote host controller to which the keypad is connected.

NOTE:

You do not need to use SmartKey discovery if you already added a device using a valid SmartKey ID number. If
the device shows a valid status, {ok}, in the SmartKey Devices tab, it is already on line and discovery is not
necessary.

Step 1. Under the Controller Setup menu, select Remote Devices > Intrusion Displays/Keypads.
The SmartKey Device Manager - Database view opens.

Step 2. Click the Discover button ([ ag|).
The Discover window opens.

Timeout looooo  |hfoo  |mo3  ||ooo s foms - +infl
Retry Count [0 - +inf]
Min SmartKey ID ICI[D—EEE]

Max SmartKey ID |:| [0 - 255]
Do Not Ask Again

0k | Cancel

Step 3. To narrow the search, modify these properties and click Ok.
The discover job executes and displays found SmartKey devices in the Discovered pane.

Step 4. Select one or more discovered device(s), and click the Add button (| & | ).
The system adds the device(s) to the Database pane.

Step 5. Name the device and click Ok.
Step 6. To update the database, click Save.

Adding and editing a SmartKey device

This procedure describes how to add Smart Key devices to the system database. You may add Smart Key
devices while the device itself is off-line or online. Each SmartKey device has an ID, which you assign at the
device. If the SmartKey ID has been assigned but you do not know it, and the device is currently online, use the
discovery process to add the device instead of this manual process.
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Prerequisites:
You are logged in to the remote station.

Step 1. Under the Controller Setup menu, select Intrusion Setup > Intrusion Displays.
The SmartKey Device Manager - Database view opens.

Step 2. Click the Add button ([ @ ).
The Intrusion Display tab opens.

Step 3. Enter an identifying Display Name for the device, select SmartKey Device from the Smart Key
Device drop-down list.

Step 4. To require a PIN when the device is used to arm and disarm the intrusion zone, select true for
Arming Pin Required.
Step 5. To assign the intrusion zone to the display/keyboard device, click the Intrusion Zones tab, click the

Assign Mode button, select an unassigned zone, and click the Assign button (| @ |).

Step 6. To save the record to the database, click Save.
One new device is added under the database at the top of the view.

Deleting a SmartKey device

This procedure explains how to delete SmartKey devices using the SmartKey Device Manager - Database view.
You can also delete SmartKey devices from the Keypad Configuration view (under the SmartKey devices tab)
by clicking the trash can icon).

Step 1. Under the Controller Setup menu, select Remote Devices > Intrusion Displays/Keypads.
The SmartKey Device Manager-Database view opens.

Step 2. Select the device to delete and click the Delete button (| & |).

Step 3. To reset the SmartKey device count, restart the station.

NOTE: Simply removing SmartKey devices from the database does not reset the SmartKey device
count. You must restart the station.

Assigning a device to an intrusion zone

This procedure documents how to add a reader, keypad, or display to an intrusion zone. You can only add
devices to intrusion zones when you are connected to the remote host station to which the device is
connected. Devices are not visible and cannot be configured from remotely-grouped stations.

Prerequisites:
You are working in the remote host station to which the device is connected. The intrusion zone record in the
local station exists.

Step 1. Click Controller Setup > Intrusion Setup > Intrusion Zones, and create a new zone or double-click
an existing zone.
The Summary view for the display/keypad opens.

Step 2. Click the appropriate tab: Intrusion Displays for keypads and displays or Readers for card readers,
and click the Assign Mode button (|51 ).
The Unassigned pane opens with a list of available devices.

Step 3. Click to select the device, and click the Assign button ([ ).
The system assigns the device to the intrusion zone.

Assigning an intrusion zone to a device

This procedure documents how to assign or update the assignment of an intrusion zone to a display and
keypad.

Prerequisites:

256 March 21, 2025



Niagara Enterprise Security Installation and Maintenance Guide Intrusion zone management

You are working in a remote host controller station and have already created your intrusion zones.
Step 1. Click Controller Setup > Intrusion Setup > Intrusion Displays.

Step 2. Do one of the following:
* To create a new display/keypad, click Add (

&
).
* To edit an existing display/keypad, double-click on the display name entry in the table.
Step 3. Enter at least a Display Name and Default Message.
Step 4. To assign an intrusion zone to the display/keypad, click the Intrusion Zones tab.

Step 5. To locate the zone, click Assign Mode (| g ).
The unassigned zones appear in the Unassigned pane.

Step 6. To complete the assignment, select the zone and click the Assign button (| o).
Step 7. To save your configuration, click Save.

Arming and disarming an intrusion zone

How to arm and disarm depends on the hardware used to set up the zone. If the zone is not secure, it will not
arm. This procedure uses the SmartKey display/keypad.

Prerequisites:
The access right assigned to your role permit you to arm and disarm.

Step 1. Ensure that all doors in the zone are secure.

Step 2. To arm a zone, do one of the following.
e If the zone is configured with a card reader, swipe your card at the reader.
e If the card reader has a keypad, enter the PIN.

* If the zone has an intrusion keypad, press the function key below the check mark.
If you are using the intrusion keypad, the initial display looks like this:

Intrusion Eeypad

3:03 M

v AW
1 2 3
4 5 [+
7 B ]
* [i] #
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Step 3. Use the up and down arrows to view additional information, such as system status, then touch the
check mark.

Armed:

Disarmed: 2

1 2 3
4 5 6
7 8 9
z (1] #

Step 4. Using the up and down arrows, scroll to the zone to arm or disarm, and press the check mark key
to select the zone.

Intrusion Zonel

Intrusion ZoneZ

- v @

1 2 3
4 5 &
7 B 9
* o #

Step 5. Use the up and down arrows again to select the operation.
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Intrusion Zonel

Disarmed

v v &

1 2 3
4 5 [
7 B 9
z 0 #

The operations are:
* Arming Text tests the zone to see if it is secure before attempting to arm.

* Arm with Time Delay arms the zone with a delay to allow the person to leave the area
before the zone arms. If the zone is not secure, it will not arm. If you select this option, and
Arming Pin Requiredis setto false, the arming process begins when you touch the check
mark. The display beeps and counts down to armed. This allows the person to leave the area
before the zone is armed.

® Force Armarms the zone immediately. If the zone is not secure, it goes into alarm when it
arms.

® Force Arm with Time Delay arms the zone with a delay. If the zone is not secure, it goes into
alarm when it arms.

Step 6. To test the device, select Alarm Test and touch the check mark.
If the test fails, a description of the point in alarm scrolls across the bottom line of the display. If
the test is successful, it displays Test Successful!

Step 7. After the test completes, touch the back arrow and select another option.

Step 8. You may arm, disarm and test an individual zone or multiple zones if all the zones are assigned the
same PIN.

The action takes place when you touch the check mark or after you enter the PIN (if required). If a
PIN is required, only the zones associated with the PIN are affected by the action.

Step 9. To use the PIN, enter it followed by #.

Assigning a card reader to an intrusion zone

This procedure sets up a single card reader without a keypad to use for arming and disarming an intrusion
zone. Assigning a reader to a single zone is advised. If the reader is assigned to multiple zones, and one of the
zones fails to arm, the person attempting to arm the building will not know which zone did not arm.

Prerequisites:
Your card reader has connections for LED and beeper control, and is connected to an R2R module on a host
controller. Your PC is connected to the station of a remote host controller. The intrusion zone exists.
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Add the reader at the module level. This reader may not be used to lock and unlock a door. Do not associate it
with a door. The beeper and LED provide feedback to let the user know if the intrusion zone is armed or
disarmed.

Step 1. To access the intrusion zone, click Controller Setup > Intrusion Setup > Intrusion Zones.
The Intrusion Zone view opens.

Step 2. Double-click the intrusion zone in the table.

Step 3. Click the Readers tab and click the Assign Mode button (| 5] ).
The system finds all the readers and populates the Unassigned pane.

Step 4. Select the reader in the Unassigned pane and click the Assign button (|| ).
The system moves the reader to the Newly Assigned pane.

A Comroiier Sep | [ RERERTESET
W Schedules B Use Msagement Ty Backsps @ Remole Devices @ Access Setup | O intnmion Selep O Alam Selp O Meoelaneods

Envtruson Fone
B vuensl Geerice | G Intromos Tores
Summary  Intrusion Zone  Intmion Pins  [Intneson Displays Readers  Points Grouping Reopients Redary Links
Assdgmed
il =]
EY
ArmrengRasde [k} e Eiacker Dy Here Intrussn. Jonesi: Tninusion Jons Tt At ceablerter's, Fiprmots Fanader Mo

Step 5. To update the database with the newly-assigned card reader, click Save.

Step 6. To assign the reader to an existing access right, click Personnel > Access Rights, double-click the
appropriate access right and click the Readers tab.
If needed, create an access right for the reader.

Step 7. To discover the reader, click the Assign Mode button (|5 ), select the reader in the Unassigned
pane, and click the Assign button (| |).

Step 8. To arm and disarm the zone, present your badge at the reader.
Only people to whom the associated access right is assigned can use their badge to arm and
disarm the zone.

If the zone is not secure, it will not arm. For example, if a door is propped open when the person
tries to arm the zone, it will not arm. The person will need to find the problem and correct it
before arming the zone.

Setting up a card reader with a keypad

This procedure sets up a single card reader with a keypad to use for arming and disarming an intrusion zone.
Assigning a reader to a single zone is advised. If the reader is assigned to multiple zones, and one of the zones
fails to arm, the person attempting to arm the building will not know which zone did not arm.

Prerequisites:
Your card reader has connections for LED and beeper control, and is connected to an R2R module on a host
controller. Your PC is connected to the station of a remote host controller.

Add the reader at the module level. This reader may not be used to lock and unlock a door. Do not associate it
with a door. The beeper and LED provide feedback to let the user know if the intrusion zone is armed or
disarmed.

Step 1. To add the reader to the database, click Controller Setup > Remote Devices > Intrusion Displays/
Keypads, click the Manage Devices button ( & | ), to add, respond to the prompts.
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Step 2.

Step 3.
Step 4.
Step 5.

Step 6.
Step 7.

To assign the reader to the intrusion zone, click Controller Setup > Intrusion Setup > Intrusion
Zones.
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Add the reader to the intrusion zone.
If needed add a PIN to the intrusion zone.

To arm the zone, enter the PIN followed by #.
The system arms the zone after the delay period set up in the zone. The zone will not arm if it is
not secure (a door is open).

If the zone does not arm, clear the issue and try again.

To disarm the zone, enter the PIN.
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Chapter 12. Video installation

A network of video devices may include one or more Axis cameras, a Milestone DVR (Digital Video Recorder)
and display device connected to the DVR or Maxpro cameras and an NVR (Network Video Recorder). The
system provides the Axis, Milestone and Maxpro drivers. Each device has its own installation procedure, which
is documented in materials provided by the manufacturer. This chapter segregates installation and
configuration procedures based on the driver.

While these procedures use the web Ul, you may prefer to use Workbench instead. Refer to the Niagara Video
Framework Guide for Workbench procedures.

Browsers
HTMLS video rendering has been tested using Internet Explorer and Google Chrome.

Web Launcher and the Java applet

Niagara 4.9 supports HTML5 as well as the older Java-applet technology for rendering and playing back video
clips. Video drivers, which support HTML5 (Milestone and Axis) do not require the Web Launcher (Web Start
replacement) and Java applet, which run completely outside of a web browser.

These configurations require the Web Launcher and Java applet:

* Configurations that use the Maxpro video driver

* Configurations that use any video driver to play back older video clips that were rendered using the Java
applet
¢ Configurations that use the Surveillance Viewer

TLS secure communication

TLS (Transport Layer Security) is a methodology for server authentication and data encryption. When TLS is
enabled, all communication is automatically encrypted, including the data transferred from a camera to a
station.

In addition to encryption, certificates provide device (server) authentication over a local area network in two
ways:

* If you know that the self-signed certificate provided by a video device is valid, you can accept it the first
time the station connects to the device and then manually approve it as an allowed host. Thereafter, no
further action is required.

* More secure than using a self-signed certificate is to import a certificate into the video device that was
signed by a CA (Certificate Authority) whose root certificate is in the station’s trust store. The first time
the station connects to the device, authentication occurs automatically.

Over the Internet, an additional server certificate is required in the camera to authenticate the camera, as a
server, to the browser that manages the transmission from the camera to the station. Again, you may accept
and then approve a camera’s self-signed certificate, however, importing a signed server certificate into the
camera is much more secure and should be your standard practice for securing all video devices when using
the Internet.

A company may use a third-party CA, or serve as its own CA.

Security caveat
RTSP (Real Time Streaming Protocol) over TCP (Transmission Control Protocol), which is used for streaming
media servers (video on demand and voice recording), is not secure. It does not use a TLS connection.
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Video and port connections

When a configuration uses fox streaming to deliver video from a device, including a camera, DVR, NVR, and
server (Axis, Maxpro, Milestone, XProtect), the controller station processes the incoming video and transmits it
to users via the Web Service. This means that a device’s network port can be different from the station’s
network port.

When a configuration does not use fox streaming, the station does not process the incoming video. Instead,
the video stream transmits from the device to the user. This means that the video device must share the same
network port as the station.

Requirements

To configure a video network, you need installed devices that are ready to be accessed, framework software,
video drivers , additional licenses, one or more commissioned remote host controllers and signed server
certificates.

Installed devices are ready to be accessed

All component devices (DVR, cameras, displays, NVR) must be physically installed, powered on, functioning
correctly and ready to be accessed. For example, your camera(s), DVR, display(s), NVR must be connected to
the network. Remote host controller must be on the same network as the video devices each controls.

For the a host station to access a device you need the following information:

* Device IP address and port number: These are required to set up UDP communications for the device.

* Device user name and password: Credentials are required for http access to devices for configuration, as
specified by each individual driver.

* Appropriate ports open; the default are port 80 for the web, port 554 for control, port 9000 for data and
port 9797 for motion detection.

Software and driver modules
This framework requires latest version of Niagara. The following general-purpose video driver jar files must be
present in your installation’s modules folder or already on the target station’s controller.

e ndriver-rt.jar

e ndriver-wb.jar

e nvideo-rt.jar

* nvideo-wb.jar

e videoDriver-rt.jar

e videoDriver-wb.jar

* videoHx-rt.jar

e remoteVideo-rt.jar
e remoteVideo-wb.jar

You can view these modules in the C:\Niagara\MySoftware-n.n.nn\modules folder, where
MySoftware-n.n.nn is your unique software installation folder.

You need one or more drivers for the specific manufacturer’s equipment.
Licenses
Your license file must include an entry for the videoDriver feature, as well as a vendor-specific entry. Other

device and point limits may exist in your license as properties associated with those features.

If your topology includes remote stations managed under the NiagaraNetwork, the Supervisor station must be
licensed for the remote video feature.
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Commissioned remote host controllers
Whether or not your network includes a Supervisor PC, each remote host controller must have been
commissioned using NiagaraWorkbench.

Signed certificates

Each device (such as a camera) requires a server certificate signed by the private key of a root CA certificate.
The root CA certificate with only its public key must be available in the station’s System or User Trust Store. To
authenticate a camera over the Internet, the root CA certificate must already be in the browser’s trust store, or,
if your company serves as its own CA, you must import the root CA certificate into the browser’s trust store.

Video drivers default to secure communication. If a camera or other device does not support TLS, and the
device must connect to the station, you may have to set Use Tls to false and change the device Http Port
from 443 to 80 .Where to make these changes depends on the driver.

CAUTION: Do not disable secure communication unless you are setting up a device that does not support
TLS. Disabling secure communication leaves your network vulnerable to a malicious attack.

About Axis network and camera configuration

The properties and options that configure Axis camera-to-station communication provide flexibility and
support for legacy cameras that lack a secure video stream as well as newer cameras that support TLS secure
communication.

Axis networks

You can have two Axis networks: one to manage legacy cameras that do not support secure communication,
and a second network to manage newer cameras that support secure communication. A single network cannot
support both configurations.

Two properties play important roles in configuring these networks.

Figure 29. Station with two Axis networks

1)

Axis Network 1: UseTls = true, Tep |p Port = 9797
Axis Network 2: Use Tls = false, Tep |p Port = 9728

—

2

—

1. Camera(s) that support secure communication
2. Legacy camera(s) without secure communication

The Use Tls property on the Axis network tab (property sheet) enables and disables TLS security. The Tcp Ip
Port must be unique for each network.

Axis camera communication channels

The camera properties configure the protocol, Web Port and CODEC used to communicate with the station.
Three channels of communication connect to each video camera. Ideally, each should be secure.
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5.
6.

Figure 30. Communication channels to and from a camera
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Station—this channel delivers configuration properties and presets to the camera. These control how the
camera operates.

Web Ul—this channel receives the video stream from the camera and displays it in a browser.

Enterprise Security (Workbench)—this channel receives the video stream from the camera and displays it
in a Surveillance Viewer.

Configuration data
Video stream
Video stream sent to Workbench

Newer cameras support TLS certificates for authenticating the camera as the server of video content and
encrypting the video stream. Two protocols (one or the other) manage the video stream: HTTP or HTTPS
(secure communication), and the more common RTSP (Real Time Streaming Protocol). Http and RTSP are not
secure. The camera property that configures the protocol is Use Rtsp Stream (true = RTSP, false = Http or
Https).

Communication security
The network property: Use Tls, and the camera property Use Rtsp Streamwork together to configure
secure channels when connected using a browser.

Properties Channel protocols

’ The video stream S

If Use The q to the Web e video
IfUseTls Rtsp configuration ::Iggllfir‘lgd::e ¢ Launcher/Java  stream to Comments
is ... Stream is data channel applet (for Workbench uses

uses ... Maxpro
streaming) uses ...

false false Http Http Http Http None of the channels are secure.
false true Http Http RTSP RTSP

The camera’s web Port must be
changed to 80. Its CODEC can
remain at the default (MPEG,
that is
Ffmpeg_CODEC_ID_MPEGA4).
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Properties Channel protocols

The video stream

to the Web The video

Launcher / Java  stream to Comments
applet (for Workbench uses

L HTMLS video

streaming uses

If Use Tls Rtsp configuration

is ... Stream is data channel

uses ... : Maxpro
streaming) uses ...

true true Https Https RTSP RTSP Configuration data are secure but the
video stream is not secure.

The camera’s Wweb Port can
remain at the default: 443. Its
CODEC should be changed to
H264
(Ffmpeg_CODEC_ID_H264).

true false Https Https Https Https Configuration data are secure but the
video stream is not secure unless you
accept and approve the camera’s self-
signed certificate or install a server
certificate in the camera that was
signed by a root CA certificate in the
browser’s trust store.

The Workbench video stream is
secure. The camera’s web Port
can remain at the default: 443.
Its CODEC should be changed
to MPEG4
(Ffmpeg_CODEC_ID_MPEG4).

A CODEC is a coder/decoder. The term refers to the method the camera uses to transmit a video stream.

More information about configuring Axis cameras for secure video streaming is available in the Niagara Video
Framework Guide.

Installing an Axis video network (Web Ul)

An Axis video network supports one or more Axis cameras. If some cameras support TLS (Transport Layer
Security) and others do not, you will need two Axis video networks: one network with TLS enabled, and the
other with TLS disabled.

Prerequisites:
The cameras are installed. The PC is connected to the camera network and running the web Ul in a browser.

Step 1. Connect either to your Supervisor station (large installation) or to the single remote host station
that controls the cameras (small installation).

Step 2. Click Controller (System) Setup > Remote Devices > Remote Drivers.
The Remote Drivers view opens.

Step 3. Click the Manage Drivers button (| & ), select Add and click Ok.
Step 4. Select the Axis Video Network from the drop-down list and click Ok.

Step 5. Optionally, give the network a unique name and click Ok.
The new Axis Network appears in the Network table.

Step 6. Double-click the newly-added network row in the table.
The Driver Manager view opens with the Axis Video Network tab selected.

Use Tls defaults to true, and Tcp Ip Port defaultsto 9797.
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Step 7.

Step 8.

Step 9.

To turn off TLS secure communication, change Use Tlsto false.

CAUTION: Disabling TLS secure communication opens your installation to maliscious hacking. Do
not disable this protection unless you know what you are doing, and, preferably, only if your
network is not connected to the Internet.

If this is the second Axis network you are installing, change Tep Ip Portto 9798.
Each network requires a unique TCP/IP port number.

Confirm that the network status is {ok}, and click Save.
If you have two networks, both network rows go into fault (turn yellow) until the software
establishes each port. This can take a few seconds.

Adding (or editing) an Axis camera (Web Ul)

Adding a camera may involve approving its certificate as well as configuring its communication properties. This
procedure adds a camera manually. You can also discover cameras and edit their properties after adding them.
Migrated installations list all existing cameras without the need to discover or manually add the cameras.

Prerequisites:

You are connected to the remote host station that controls the camera using the web Ul. The Axis network has
been set up, configured and its health reports Ok. For secure communication between camera and station, the
camera supports TLS secure communication.

268

Step 1.

Step 2.

Step 3.

Step 4.

From the main menu, click Controller Setup > Remote Devices > Remote Drivers.
The Remote Drivers view opens.

Double-click on the Axis Video Network row in the table.
The Driver Manager view opens with the Axis Video Network tab selected.

Click the Cameras tab.
The Camera Manager view opens.

This view displays a list of any existing cameras.

Do one of the following:

* To edit the properties of an existing camera, double-click the camera row in the table or
select the camera and click the Hyperlink button (

&
).

* To add an Axis camera manually, click the New button (
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The New window opens.

Display Name |Axis Video Camera
Description |

Url Address |192.168.1.82
Web Port

Supports Pan Tilt true %
Supports Zoom TUE
Ptz Support Supports Focus TUE

Supports Iris rue W

Supports Move To Preset

Supports Store Preset

Preferred Resolution
Preferred Frame Rate
Preferred Compression
Preferred Video Stream Fox

Username| |
Credentials

Password | |
Use Tcp Transport
Use Risp Stream
Rtsp Username |root |

Risp Password
Host Name |192.168.1.81/axis-media/media.amp|  x

Step 5. Give the camera a Display Name, and optional Description; enter its Url Address (usually an IP
address); and, to use secure Https streaming, click Ok.
A Web Port of 443 indicates that the communication channels default to secure communication.
The camera must support TLS to communicate successfully.

If the station renders video from the camera using fox streaming, this port should be different
from the station’s port used to connect to the network. Otherwise, if the camera renders its own
video and sends it to the user, this port should be the same as the port that connects the station
to the network.

NOTE:
If Use Rtsp Streamis true, the channel will not connect because RTSP does not support secure
communication from the camera to the station.

Step 6. To use RTSP streaming, set Use Rtsp Streamto true; define the credentials required by the
RTSP (Rtsp Username and Rtsp Password); define the Host Name (<IP>/axis-media/media.amp);
and click Ok.
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Step 7.

Step 8.

270

This value defines a port to communicate data from a device that does not support secure
communication.
The system saves the configuration to the station database.

To view the camera properties, navigate back to Controller Setup > Remote Devices > Remote
Drivers double-click the Axis video network row; click the Cameras tab; and double-click the
camera row in the table.

The system opens the Axis Video Camera tab.

&% Personnel #¥ Controller Setup /b Threat Levels

Home || &o” Monitoring

B Schedules & User Management E= Backups | &% Remote Devices #F Access Setup &% |

] save || Axis video Network

Axis Video Camera Events

Status |{Dk}
Enabled
Fault Cause |
Health Ok [28-Jun-18 5:07 PM EDT]
Alarm Source Info Alarm Source Info »
Video Device Id Description Security Camera,Url Address 172.16.10.212 »
Ptz Support .
Control Timing Camera Control Timings »
Video Preferences Video Source Preferences »

. Username|tridium |
Credentials

Password |"~u~u|. |

Preset Text Q

Pan Tilt Zoom Settings Axis Video Pan Tilt Zoom Settings »
Resolution Settings Axis Video Resolution Settings »

High Compression Codec| Ffmpeg _CODEC_ID_MPEG4H hd

Use Tcp Transport
Use Ritsp Stream

Rtsp Username |rtmt |
Rtsp Password |ﬂ"nu |
Host Name | |
Control Port 554
Data Port

L4

Status should be {ok}.

If Status is not {ok}, confirm that the High Compression Codec is appropriately configured for
the camera, and, if necessary, change this property and click Save.
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* For a secure Https:// connection between the camera and station, the CODEC should be:
MPEG4 (Ffmpeg_CODEC_ID_MPEG4).

e For an RTSP connection between the camera and station, the CODEC should be: H264
(Ffmpeg_CODEC_ID_H264).
Discovering cameras (Web Ul)

You can add cameras individually or use a discovery job to add cameras.

Prerequisites:
You are connected to the Supervisor station (large installation) or to the single remote host station that
controls the cameras (small installation.)

Step 1. Click Controller (System) Setup > Remote Devices > Remote Drivers.
The Remote Drivers view opens.

Step 2. Click the Manage Drivers button (| g ), select Add and click Ok.
The Driver Manager view opens.

Step 3. Click the Cameras tab.
The Camera Manager view opens.

This view displays a list of any existing cameras.

Step 4. Click the Discover button ([ag) ).
A discovery job runs. Some cameras will discover and others will not. If your camera does not
discover after a minute or two, click on the New button (

) and add it manually.

Step 5. Double-click each camera and enter the Host Name for each and click Save.
The camera appears in the list under the Cameras tab.

Step 6. Ping the camera and observe if the status shows {ok} or unacknowledged alarm.
Step 7. If you have a PTZ camera with presets, double-click the camera and add or rename presets.

Step 8. Observe the ports listed under the camera and make sure that your firewall is configured with the
needed ports open.
You will have issues with PTZ control and video motion if the required ports are blocked.
Approving a camera self-signed certificate (Web Ul)

If your browser permits self-signed server certificates, this procedure guides you to compare the Issued By
and Subject properties of this certificate before you manually approve the connection.

Prerequisites:
You do not have a server certificate for the camera that was signed by a valid root CA certificate.

Step 1. Accept the self-signed certificate and make a connection to the camera.

Step 2. To locate the certificate do one of the following:

* Using the web Ul, navigate to Controller (System) Setup > Remote Devices > Certificate
Management.

¢ Using Workbench navigate to Station > Services > PlatformServices > CertManagement.
The station opens the Certificate Management view.

Step 3. To acknowledge the security warning, click Allow and click the Allowed Hosts tab.

Step 4. To open the certificate, select it and click View.
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Step 5.

Step 6.

The Host Exemption window opens.

Confirm that the certificate’s Issued By and Subject properties contain names you recognize,

and click Ok.
For a self-signed certificate, these properties should be the same. They should contain the name

of the camera manufacturer or other identifiable text.

CAUTION: If you do not recognize the value of these properties, you may need to investigate
with the camera manufacturer. This certificate authenticates the camera as a valid video server.
Approving a bogus certificate opens your system to a man-in-the-middle attack.

Assuming that the certificate is valid, and, if the certificate has not been approved yet, click
Approve and respond to the confirmation window by clicking Yes.
The web Ul's Camera Manager view lists the camera.

Viewing the Axis camera video stream (Web Ul)

An Axis camera provides features for manipulating the HTMLS video stream.

Prerequisites:
The camera is installed and configured. The Axis Video Camera tab reports the camera’s health as Ok.

Step 1.

Step 2.

Step 3.

Step 4.

Result

From the main menu, click Controller Setup > Remote Devices > Remote Drivers, double-click on
the Axis network row in the Remote Drivers table, and click the Cameras tab.
The Camera Manager view opens.

Double-click a camera row.
The view opens to the Axis Video Camera tab.

Click the Live View button at the top of the view.
After a moment connecting, the video stream opens.

Reports ‘ &% System Setup [B Threat Levels

[ schedules & User Management £= Backups #% Remote Devices #¥ Access Setup #¥ Intrusion Setup  #¥ Alarm Setup  #¥ Miscellaneous

‘ QHome ‘ ‘ &d” Monitoring H &Fersonnel H

Select Preset  Home v | Apply Preset Store

30-Dec-19 11:57:15.182 AM IST

The first time you make the connection it takes a few seconds for the live view to open. If the
framework reports “Connection timeout,” just wait a little longer.

To adjust the Iris and Focus, click the controls.

An Axis camera can also appear in a Video Surveillance viewer.
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Configuring an alarm

This procedure uses a Motion Detected event in a connected camera to trigger an alarm. The steps use both
the web Ul and Workbench interfaces.

Prerequisites:
All cameras have been discovered or added to the station.

Step 1.

Step 2.
Step 3.

Step 4.

Step 5.
Step 6.
Step 7.

Step 8.

Step 9.

Step10.

Click the Events tab and click the Discover button (g ).
The discovery job searches for events.

Add Motion Detected to the database and double-click on Motion Detected.

Click on the Alarm Setup tab and notice that the alarm has already been mapped back to the
camera.

Using Workbench, find a camera under the AxisVideoNetwork in your Supervisor station and,
under the camera, the Motion Detected point.

Delete the Alarm Settings extension.
Open the alarm palette and drop a BooleanChangeOfStateAlarmExt on the point.

Open the videoDriver palette and drop a VideoAlarmExtParameters component on the
BooleanChangeOfStateAlarmExt.

Double-click on the alarm extension, scroll to the bottom of the view, click on the folder next to
the Camera Ord property, select your camera and save your changes.

Wave your hand in front of the camera.
The alarm console should report an alarm.

You can use this method to reference a camera to other alarms in your system and to play the
associated video.

Expand ConfigServices and double-click the AlarmService.
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Notice that a videoRecipient has been added to the AlarmService.

pn (Entsec_Laura) . Config . Services . AlarmService

Wire Sheet

videoRecipient n
Video Alarm Recipient
@4 Rout= Alammn

High A

Alarm Class
Alarm

Alarm Class
Alarm

Nomecioes &

Alarm

Enterprise Security adds this recipient automatically when you configure a video network. If you
are using video in a standard station, you will need to add this recipient yourself. A
videoRecipient is required to move a camera to a preset based on an alarm.
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About Milestone driver configuration

The system supports three Milestone software products with two drivers: nmilestone and xprotect.

Milestone drivers and software products
The nmilestone driver supports the XProtect Professional product:

e XProtect Professional
e XProtect Enterprise (deprecated, but uses the same nmilestone.jar API)
The xprotect driver supports the XProtect Professional+ and XProtect Corporate products.

* XProtect Professional+
* XProtect Corporate

Interfaces
Two interfaces are available to add and configure these drivers in a station:

¢ Workbench
e Enterprise Security Web User Interface (web Ul)

The Niagara Enterprise Security Installation and Maintenance Guide references both interfaces. The Niagara
Video Framework Guide (this guide) references the Workbench interface exclusively.

Licensing
The milestone and xprotect drivers require a Milestone software license.

Driver naming conventions
The two drivers are referred to in different ways depending on where you are in Workbench:

Table 25. Versions supported

Milestone Xprotect version supported by

Xprotect 2020 R3 and earlier Niagara 4.10u1 and earlier
Milestone Xprotect 2021 R1 Not supported
Palettes

Two palettes provide Milestone and XProtect components. These palettes require the Workbench interface.
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Figure 31. Palettes and components
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The xprotect driver provides these components:

* MilestoneXProtectNetwork sets up the network component.

e XProtectManagementServer connects to the Milestone management server, which may reside in a
separate computer.

e Cameras is a folder for collecting one or more XProtect-compatible camera devices.
® Recording Servers is a folder for collecting recording servers.

* XProtectCamera provides camera configuration properties.

* Events is a folder for collecting events, such as motion detected.

The nmilestone driver provides these components.

* NMilestoneNetwork sets up the network component.

* NMilestoneDvr sets up a Milestone DVR.

* Displays is a folder for collecting one or more monitors to display video.
e Cameras is a folder for collecting one or more camera devices.

Port numbers

If Milestone and the station are installed on the same PC, the Milestone management server requires ports 80
and 443 for its internal processes. Before connecting, you must change the ports used by the WebService to 81
and 444 or relocate the management server to another computer that shares the network.

If you change the WebService ports and have connection problems, you may need to open them up in your
firewall.

The nmilestone driver

This driver supports the Milestone Professional video management software program running in a stand-alone
(single controller) or company-wide installation that includes at least one Supervisor PC.

Nmilestone features

e Automatic discovery of cameras

* PTZ operations: control and go-to presets

* Motion detection alarms and recording alarms

e Surveillance Viewer
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¢ Alarm video playback

¢ Live video playback

¢ Switching between live and playback video
* Remote video connections

e Fox video streaming

¢ Graphics widgets

Tested models

The nmilestone driver has been tested with the Milestone XProtect Professional. Milestone XProtect Enterprise
is deprecated, but uses the same API.

Requirements

* |P access between the DVR or camera and remote controller

* Appropriate open ports: the defaults are port 80 for the web (image server port), central port 1237, and
upload events port 1234.

Compliance

* To create presets, use the Milestone application. This driver does not support preset creation. It does
support the Move-to-Preset option.

* Milestone cameras do not support: Enable Detection and Disable Detection. Even if you add an Event
Detection Control Ext, it will not work with a Milestone camera.

* This driver does not support Iris and Focus controls.
* Camera health continues to report Ok even after the camera is disconnected from the network. This is an
issue with the Milestone application. Video is not streamed for a disconnected camera.

CAUTION: Milestone products do not support secure communication, therefore, it is not possible to secure
the connection between a station and its Milestone devices.
The xprotect driver

This driver supports Milestone’s XProtect Corporate and XProtect Professional+ video management software
running in a company-wide installation that includes at least one Supervisor PC.

Versions supported

Milestone Xprotect version Supported by
Xprotect 2020 R3 and earlier Niagara 4.10u1 and earlier
Milestone Xprotect 2021 R1 Not supported

xprotect features
Supported features include:

* Automatic discovery of cameras

® PTZ operations: control and go to presets
* Surveillance Viewer

e Live HTMLS video streaming

¢ Playback HTMLS video streaming

* Switching between live and playback video
® Motion detection alarms and recording video triggered by an alarm
¢ Alarm console video playback

* Remote video connections

e Fox video streaming

* Graphics widgets
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* Support for a management server

Tested models

The Xprotect driver has been tested with the Milestone XProtect Corporate, XProtect Professional+, and the
Xprotect Essentials+ and is compatible with the Xprotect Driver of Niagara. The integration steps remain
unchanged.

Required files
This file in the Niagara Home\modules folder: xprotect-wb.jar

NOTE: The previous module name for the xprotect driver was xprotect-se. jar. If you upgrade a system,
do not copy this old file to the module folder. Running the software with both drivers introduces conflicts.

These files are in the Niagara Home\bin folder:

® VideoOS.Platform.dll
® VideoOS.Platform.SDK.dll

® xprotectBridgeService.exe
Compliance

NOTE: For the purpose of configuring a camera, the xprotect driver must run in the Supervisor PC. Stand-
alone systems, which have only one controller, do not support integrating a camera with the Milestone video
management software. In a company-wide installation, the xprotect driver running in a controller provides
alarm mapping (it resolves xprotect camera Ords that appear in the Supervisor’s alarm console). No other
xprotect features work in a controller.

* The Xprotect SDK API does not support preset creation. The xprotect video driver supports only the
Move to Preset option. To create presets, use the Milestone Corporate software.

* An action on the XProtect camera, called Get Preset List, must be invoked to read the list of presets from
the Milestone Corporate software. Workbench provides this action, which takes immediate effect.
Otherwise, getting presets from the camera occurs automatically on each camera ping.

* The XProtect SDK does not provide an API to add a camera programmatically to the management or
recording servers. As a result, the xprotect driver does not support the add-net-camera option from
Workbench. You must discover cameras to add them to a station.

* The XProtect SDK API does not support Iris and Focus controls. Consequently, the xprotect driver does
not support the Iris and Focus operations from Workbench.

* The xprotect driver supports only Motion Detection Started and Motion Detection Stopped alarm
conditions from the Milestone Corporate software.

* Since motion detection events are polled from a recording server, recording servers must be discovered
and added to the management server component apart from cameras.

HTMLS streaming

The latest versions of Niagara support the video framework HTMLS streaming using the Milestone xprotect
driver for video playback. The Surveillance Viewer continues to use the applet view (supported by Web
Launcher), however, the playback viewer supports HTML5-rendered video clips. HTMLS5 streaming makes use
of the MilestoneXprotectServer and XProtectMobileServer.

XProtect architecture

Milestone’s XProtect products offer comprehensive video performance for Niagara installations. In addition to
licensing and configuring the drivers, additional software ensures connectivity on hand-held devices connected
over the Internet.
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Figure 32. XProtect architecture
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The XProtectNetwork is the parent component. Its view, called the X Protect Server Manager supports one or
more XProtect Management Servers.

An XProtect Management Server (usually located in a separate computer) configures access from a Supervisor
station to all devices (cameras and recording servers) on the network. A Host Name identifies this computer on
which the XProtect Management Server is running. When the authentication type is Windows, authorization
properties identify the Domain name of the server (a separate IP address from that for the host computer) and
provide credential authorization (username and password) to access the server. A Hostname (another IP
address) and Port identify each Recording Server.

The XProtect Mobile Server supports access to cameras and recording servers from remote devices that
connect to the video network through the Internet. All devices that use the web Ul, including laptops/
computers, smartphones and tablets require the installation of the XProtect Mobile Server on the computer
with the XProtect Management Server.

XProtect requirements

Secure communication requires a secure connection between all components, processes and browsers.
XProtect products use an XProtectManagementServer to manage live video and store recorded video.

Native process protection

Behind the scenes a native process using port 9117 functions as a bridge between an XProtect management
server and the station. Running on the local computer that houses the station, the native process starts when
the xprotect driver starts and stops when the station shuts down.
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Figure 33. XProtect connections
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In Niagara, this process randomly assigned the port it used to connect without security to the station.

In Niagara, this connection requires a specific port through which only Niagara may make a secure connection
from the station through the native process and on to the server. A certificate assigned to the port provides
security for the native process. You must set up the Native Process Port and install the certificate.

Management and mobile servers
The MilestoneXProtectManagement server, which usually runs on a computer that is separate from the
Supervisor PC, manages live video and stores recorded video.

The XProtect Mobile server supports mobile devices that use browsers to connect to the XProtect network
over the Internet: computers, smartphones and tablets.

Before installing the xprotect driver:

* Use the Milestone XProtect VMS (Video Management System) Products System Installer, version 2019 R3
or later to install the XProtect software on a PC that is on the network other than your Supervisor PC.

* Ensure that the XProtect Mobile Server is installed and running on the Supervisor PC. This software
provides the HTMLS solution for the video.

Camera certificates

Devices may always connect without security (http:// ), but to protect your data, all devices, including
cameras, need to make only secure (https:// ) connections. Secure connections through a browser to
remote cameras require TLS certificates. The Milestone Mobile server will not connect securely to a camera
using even an approved self-signed server certificate. It requires that the camera have a certificate signed by a
root CA certificate in the browser’s trust store.

Adding a network (nmilestone or xprotect)

The Milestone networks support Milestone and XProtect surveillance hardware.

Prerequisites:
The station is licensed for one of two Milestone drivers: nmilestore or xprotect. You are running Workbench on
a Supervisor PC or laptop.

Step 1. Open the platform and connect to the station.
NOTE: It can take a few seconds to a minute to establish communication with the station.

Step 2. In the station Nav tree, expand the Config folder and double-click the Drivers folder.
The Driver Manager view opens.

This view manages network video drivers.

Step 3. Do one of the following:
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* To set up a network for the first time, drag the network component from the palette to the
click Drivers folder or click the New button at the bottom of the view.

* To change properties, select the network name (activates the Edit button) and click Edit.
This opens the Edit window, which provides access to most, but not all properties for
editing.

If this is a new installation, the New window opens. Two Milestone networks are available:
NMi lestoneNetwork and MilestoneXProtectNetwork. Your Milestone installation requires one or
the other, not both networks.

Step 4. To add the network, select it from the Type to Addlist and click Ok.
A second New window opens.

.New e

MName Type Enabled

€ MilestonexProtectNetwork  Milestone X Protect Network  true

m Name MilestoneXProtectetwork
m Type Milestone X Protect Network

m Enabled . true

oK | Cancel |

Step 5. Change the name and click OK.
The Driver Manager displays the added network.

Station (EntsecSup) . Config . Drivers / Driver Manager -

Driver Manager 2 objects

Mame Type Status Enabled FaultCause R

6 MiagaraMetwork Miagara Metwork {ol} true

6Milestun-:—){PrntectNEm-:urk Milestone X Protect Network  {ok} true

E"\} Taglt

BHEI\'

# Edit

Step 6. To confirm that the network is ready, wait for the Status column to read {Ok}.

Next steps
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If you installed a Milestone network supported by the nmilestone driver, you may add a DVR and discover
cameras. Milestone XProtect networks require additional configuration.

Creating the XProtect management server

The XProtect management server supports access to a video network’s NVR (Network Video Recorder) and
cameras from a Supervisor PC or laptop. The XProtect Corporate product requires this management server to
communicate with an NVR. This procedure sets up secure communication (Https) between the management
server and station.

Prerequisites:

The XProtect management server is on line and ready to connect. Your PC or laptop is connected to the video
network. You have admin privileges, are using Workbench, which is connected to a station with a
MilestoneXProtectNetwork and the xprotect palette is open.

Step 1. To create the XProtect management server in the station, do one of the following:

e Drag an XProtectManagementServer component from the palette to the network
component, double-click the new component and expand the Connection slot.

* Open the X Protect Server Manager view by double-clicking the MilestoneXProtectNetwork
node in the Nav tree followed by clicking the New button at the bottom of the view.
If you clicked the New button, the New window opens. If you expanded the Connection slot you
see the connection properties.

New e .. Connection 172.31.65.228 - Connected
M Host Name 172.31.65.228
Typeto Add - X Protect Management Server . Web Client Kittp Port BOS3
Mumberto Add |1 [1-100] M Web Client Https Port BOS4
OK | Cancel |

The Web Client Https Port must be different from the default.

Step 2. Optional: If you used the New button, you can change the name of the server and click OK.
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A second New window opens.

New >
Name Enabled HostName Web Client Hitp Port Web Client Hitps Port  Auth Type Domain  Usernz
; X¥ProtectManagementServerl  true 172.31.65.228 3083 3084 Windows 172.31.65.1 xprotec
. Name ¥ProtectManagementServerl
. Enabled ® true

172.31.65378 - Connected

[l Host Name 172.31.65.228

172.31.65.228

[l web Client Http Port 2083

[ Web Client Https Port | 5084

. Auth Type Windows . .
__‘_a’____...—-l--"'"-"-' B Domain 31.€5.141
.l Domain 172.31.65.141 —::r/, M Username x¥protectidministator
i W Fassword [TTTITITY
! sername Xprotect. inistator pe
u Admini
- M Connection State Connectsd
|l Password sesssssee] T A tes X ct Auth Attributes
TOHE 9 a-45a4-4cbT-a52c-%dddS404 16
'. Token Expiration 1:24 PM EDT
OK Cancel (O uri
Server £6a030%b-2dSE-45£0-2051-c5a5ad £8522F
£ d £6a030% 96-45£0-8c51-c5a5ad€85e2F
. Poll Freguency Slow
Recording Servers { Protect Recording Server Device Ext
| = B XP R ding 5 D E

The screen capture on the left represents the New window of the MilestoneXProtectNetwork
component. The capture on the right shows the same properties after expanding the
XProtectManagementServer > Connection component. These Connection properties enable
communication between the management server and the station.

Step 3. For Host Name enter the IP address and for the Web Client Https Port enter the port number
of the computer that hosts the management server.

Step 4. For the credentials, enter the Username and Password required by the Milestone corporate
(management) server.

Step 5. For secure communication enter the Web Client Https Port.
If the management server uses fox streaming to deliver video, this port can be different from the
port used by the platform/station to access the network. If the server does not use fox streaming,
this port should be the same as the port that connects the platform/station to the network.

Step 6. To save the configuration, click OK or Save.
The framework attempts to connect to the server, but it fails because a secure connection via the
native process bridge has yet to be established.

Configuring the mobile server

The web Ul supports access to cameras and video streaming over the Internet. This access requires the
installation and configuration of an XProtect Mobile Server in addition to the XProtect Management Server.
When using the browser user interface, video streams via this server must be enabled and running.

Prerequisites:
This procedure assumes this is a new installation, and that you have installed in the trust store of each
controller/station and camera, a certificate that was signed by a root CA certificate in the browser trust store.

If you recently downloaded and installed a Milestone X Protect Management Server, you also downloaded the
XProtect Mobile Server installer.

Step 1. Install the XProtect Mobile Server on a separate PC.

Step 2. To edit this server’s configuration file, use File Explorer to navigate to this path on your Windows
computer:
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Program Files\Milestone\Milestone Mobile Server

Step 3. Using a text editor, such as Notepad, open this file:
VideoOS.MobileServer.Service.exe.config.

Step 4. Scroll down or search for this HttpHeader tag:
add key="Access-Control-Allow-Origin” wvalue=“*"/>*

This line indicates if the response can be shared with requesting code from the given origin. The
asterisk (*) tells browsers to allow requesting code from any origin to access the resource.
Another possibility is:

add key="Access-Control-Allow-Origin” <origin>/>*

where you would replace <origin> with a single specific source: a hostname or constant IP
address for a station that does not change.

Step 5. Save any changes you made and restart the XProtect Mobile Server.

Step 6. To verify that the mobile server is operational, use your browser to contact the server by entering
the IP address and port number of the server’s PC:
<ip address>:8081 or https://<ip address>:8082

These are the default ports for the XProtect Mobile Server.

Using the web Ul to install a Milestone network
Adding a network to a station is the first step for discovering cameras that are compatible with a Milestone

system. While you can use the web Ul to add a network, to ensure connectivity the preferred method for
adding a network is to use Workbench, running it as an administrator.

Prerequisites:
The station is licensed for the nmilestone or xprotect driver. You are working in the web Ul.

Step 1. From the main menu, click Controller (System) Setup > Remote Devices > Remote Drivers.
The Remote Drivers view opens.

Step 2. Click the Manage Drivers button (| & ), select the Add option and click Ok.
The Add Driver window opens.

'3._.3'Dedi_ca1ied Micros Network (ndedicatedMicros)
'@:riiﬂzstune MNetwork (nmileston

——

(_)Rapid Eye N rapidEye
c@gstune X Protect Network (xprote
(OPhoto ID Network

\_'Obix Network

Step 3. Select the Milestone driver from the list and click Ok.
The Add Driver window opens.

Step 4. Use the default driver name or change the name and click Ok.

Step 5. To check the network configuration, double-click the network row, confirm the configuration
properties, and, if you change any, click Save.
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The network status should report {Ok}.

Adding a Milestone DVR
A DVR (Digital Video Recorder) can include a camera and display.

Prerequisites:
You are connected to the remote host station. You are working in the web Ul.

Step 1. From the main menu, click Controller Setup > Remote Devices > Remote Drivers.
The Remote Drivers view opens.

Step 2. Double-click on the Milestone Network row in the table.
The Driver Manager view opens with the Milestone Network tab selected.

Step 3. Click the DVRs tab.

Step 4. Do one of the following for the DVR:

* To edit the properties for an existing DVR, double-click the DVR row in the table or select
the DVR and click the Edit button (

|

).
e To add a new DVR, click the New button (

).

For a new DVR, the New window opens.

Display Name |I‘-'Ii|estone Dvr |

Description | |

Fox Video Stream Preferred

Milestone Engine Ip Address |### ##2 a2z 88 |
Milestone Image Server Port

Milestone Central Port

Upload Events Port

Username |Ad ministrator |

Credentials
Password |-||-||-||l |

Username | admin |

Milestone Central Credentials

Password [ssess| |

[0k ][ cancel |

Step 5. Enter at least these properties and click Ok:
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* Milestone Engine Ip Address is the IP address for the DVR software.
® Credentials (Username and Password) are for accessing the DVR.

* Milestone Central Credentials (Username and Password) are for accessing the Milestone
management server.

The Milestone Central Port connects the DVR to the network. If the DVR uses fox streaming
to deliver video, this port can be different from the port used by the platform/station to access
the network. If the DVR does not use fox streaming, this port should be the same as the port
that connects the platform/station to the network.

Result
Adding a DVR adds the tabs (containers) for cameras and displays as well as adding the driver to the Driver
Manager view.

Connecting a DVR to an XProtect server

An XProtect recording server provides IP video management software for large-scale, multi-site installations.

Prerequisites:
The driver has been added and configured. You are using the web Ul.

Step 1. From the main menu, click Controller Setup > Remote Devices > Remote Drivers.
The Remote Drivers view opens.

Step 2. Double-click the Milestone X Protect Network row in the Remote Drivers table.

Step 3. Click the DVRs tab.
The DVR view opens.

Step 4. Do one of the following:

* To edit the properties for an existing server connection, double-click the DVR row in the
table or select the server row and click the Edit button (

E]

).

¢ To connect a new DVR, click the New button (
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The New window opens.

Display Name ||5( Protect Management Server |
Fox Video Stream Preferred

Host Name | |
Auth Type

Domain | |
Username | |
Password |liiiilii

Ok Cancel

Step 5. Enter the IP address for the remote controller in the Host Name property, select Basic or Windows
for Auth Type and create supply credentials (Username and Password), and click Ok.

Step 6. Double-click the X Protect Management Server in the table.
The X Protect Management Server view opens with three tabs.

@ Schedules 2 User Management B= Backups #1 Remote Devices

o save || [ MilestoneXProtectNetwork

X Protect Management Server Cameras Recording Servers

Status ok}

Enabled true v

Fault Cause |

Health Ok [14-May-19 4:12 PM EDT]
Alarm Source Info Alarm Source Info »
Monitor Video Dvr Ping Monitor »

Fox Video Stream Preferred | Inherit v

Multistream Preferences X Protect Multistream Preferences »
Connection entSecurity801 - Disconnacted » I},
Poll Frequency Slow ¥

Notice that the Connection property shows “Connecting” and changes to “Connected.”

Secure camera communication using a browser

A secure connection from a station to a camera connected to a DVR or NVR by means of a browser requires a
server certificate in the camera that was signed by a root CA certificate in the browser’s trust store.

If the server certificate in the camera is not signed by a recognized root CA certificate in the browser’s trust
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store, you will need to connect using http:// to view video streams. This requirement is due to browser
security.

NOTE: If you logged in to your station using https:// and you need to switch and log in with http:// instead,
you must clear the browser cache to enable the login.

An https:// connection is always to be preferred. Before you discover cameras, make sure that each camera has
a server certificate that was signed by a root CA certificate in the browser’s trust store. The “System Security”
chapter in this document explains how to generate server certificates and get them signed by a CA (Certificate
Authority) as well as how to serve as your own CA.

Use the camera’s configuration web page to install the signed server certificate in the camera.

Discovering cameras

This procedure is for discovering cameras when using the web UL.

Prerequisites:
The camera(s) is/are connected to a remote controller and are ready to discover. You are using the web Ul and
are connected to the station.

Step 1. From the main menu, click Controller (System) Setup > Remote Devices > Remote Drivers.
The Remote Drivers Manager view opens.

Step 2. Do one of the following:

* If you are using the nmilestone driver, double-click the Milestone Network row inthe
table and click the DVRs tab, and double-click a DVR row in the table.

e If you are using the xprotect driver, double-click the X Protect Management Server
row in the table, click the DVRs tab, and double-click the XProtectManagementServer
row in the table.

Step 3. Click the Cameras tab.

Step 4. Click the Discover button ([ ).
The system discovers the cameras.

Step 5. Select a camera in the Discovered pane, and click the Add button ([ g | ).
The system adds the discovered camera to the Database pane.

Step 6. To configure the camera, double-click its row in the table.
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The Add camera window opens.

Display Name |lxTS P12/M20 Network Camera (192168 |

Description |AX1S P12/M20 Network Camera {192.168.1. |

Supports Pan Tilt
Supports Zoom
Ptz Support Supports Focus false
Supports Iris false W

Supports Move To Preset

Supports Store Preset false
Preferred Resolution
Preferred Frame Rate

Preferred Compression
Preferred Video Stream Fox

Fast Speed

These properties depend on the camera. To understand the implications of making changes to
camera properties, refer to the documentation for the camera.

Step 7. Check the configuration and click Ok.

Approving a camera self-signed certificate (Web Ul)
If your browser permits self-signed server certificates, this procedure guides you to compare the Issued By
and Subject properties of this certificate before you manually approve the connection.

Prerequisites:
You do not have a server certificate for the camera that was signed by a valid root CA certificate.

Step 1. Accept the self-signed certificate and make a connection to the camera.

Step 2. To locate the certificate do one of the following:

* Using the web Ul, navigate to Controller (System) Setup > Remote Devices > Certificate
Management.

¢ Using Workbench navigate to Station > Services > PlatformServices > CertManagement.
The station opens the Certificate Management view.

Step 3. To acknowledge the security warning, click Allow and click the Allowed Hosts tab.

Step 4. To open the certificate, select it and click View.
The Host Exemption window opens.

Step 5. Confirm that the certificate’s Issued By and Subject properties contain names you recognize,
and click Ok.
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For a self-signed certificate, these properties should be the same. They should contain the name
of the camera manufacturer or other identifiable text.

CAUTION: If you do not recognize the value of these properties, you may need to investigate
with the camera manufacturer. This certificate authenticates the camera as a valid video server.
Approving a bogus certificate opens your system to a man-in-the-middle attack.

Step 6. Assuming that the certificate is valid, and, if the certificate has not been approved yet, click
Approve and respond to the confirmation window by clicking Yes.
The web Ul's Camera Manager view lists the camera.

Discovering a recording server

A recording server is required to poll motion-detection events.

Prerequisites:
You have added the driver and X Protect Management Server. The X Protect Management Server tab on the X

Protect Management Server view is open.
Step 1. Click the Recording Servers tab.
Step 2. Click the Discover button ( gy ).

Step 3. When the recording server(s) are discovered, click a server, and click the add button (| & ).
The Add recording servers window opens.

Step 4. Make any changes to the Display Name and Description and click Ok.

Viewing live video
This procedure explains how to view a recorded video clip through the Cameras tab.

Prerequisites:
The xprotect driver and server have been added, cameras and recording servers found. The X Protect

Management Server view is open.

Step 1. From the main menu, click Controller Setup > Remote Devices > Remote Drivers, double-click on
the MilestoneXProtectNetwork row in the table, and click the DVRs tab.
The Server view opens.

Step 2. Double-click a server row and click the Cameras tab.
The view cameras opens.

Step 3. Click a camera row in the table.
The camera view opens with the X Protect Camera tab selected.

Step 4. Click the Live View button.
After a moment, the live view opens.
The first time you make the connection it may take a few seconds to open the live view.

Result
If you added a display, the resulting Surveillance Viewer lists the cameras displayed on the left side of the

monitor.

Playing back a recorded video

Using this procedure you can play back an HTML5-rendered video clip without leaving the alarm console
recipient.

Prerequisites:

You have a Milestone DVR installed and configured. An alarm condition has been configured to report
detected motion.
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Step 1. On the main menu, click Monitoring > Alarm Console.
The ConsoleRecipient - Snapshot view opens.

Step 2. Click the Playback View button.
The most recently recorded video plays back.

& Personnel Reports | | gi* System Setup | | /) Threat Levels [ “dgg‘!’wg

£ Home

I Alarm Console . Activity Monitor

== Monitoring

£, Video Monitoring

Select Camera | <Choose Camera> v

A4 | Be LA e u | @ | 9 Browse Events | 2 Play From Time

Step 3. Do one of the following:

* To select a specific event for viewing, click the Browser Events button at the bottom of the
window, select an event and click View.

* To start playback from a specific time, click Play From Time, select the time and click OK.
The saved video clip plays back.

Step 4. To return to the live view, click the Live button ( [@] ).

Configuring motion-detected alarms

This procedure uses Workbench to set up and confirm HTMLS motion-detected alarms.

Prerequisites:
The xprotect driver and all video hardware is installed, discovered, configured and reporting a status of {ok}.

Step 1. Expand the video network down to the camera, double-click the Events node in the Nav tree and
click the Discover button.

Step 2. To add the motion-detected event, select the discovered Motion Detected event type in the
Discovered pane, click Add and OK.
The Motion Detected binary point moves to the Database pane.

Step 3. Open the alarm palette, expand the Extensions node, drag a BooleanChangeOfStateAlarmExt to
the Motion Detected Boolean Point’s Property Sheet, drop it on the component name and click
OK.

Step 4. Expand the extension, open the videoDriver palette, expand the Alarm node, drag a
VideoAlarmExtParameters component to the BooleanChangeOfStateAlarmExt in the Property
Sheet, drop it on the extension name and click OK.
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Step 5. Scroll down to Meta Data and confirm that the Camera Ord has already been set.

Step 6. Scroll back up, double-click the Recording Servers node in the Nav tree, click Discover, add the
recording server and ping it to ensure that it is connected and its Status reports {ok}.

Step 7. Create motion in front of the camera and confirm that the Out property changes to true
{alarm, unackedAlarm}.
You may need to switch to the camera and ping the recording server again. The motion-detection
recording may take some time.

Step 8. To confirm that the Alarm Console reports a motion-detected alarm, navigate to and expand the
AlarmService in the Nav tree, double-click the ConsoleRecipient and confirm the alarm.

tsec) . Station (MotionDetection_Entsec) . Config I Services . AlarmService . ConsoleRecipient / AXAlarm Console ~

HT Application Director E ConsoleRecipient W ..(192.168.1.91) - Camera 1 O MotionS20Detected ) DESKTOP-Q56TB3B E]

AX Alarm Console

Time Range Tto? @
Timestamp Source State Ack State Source Alarm Class Priority Message Text =
A 10-)an-20 S:Oﬁs PMIST Offnormal OAcked /1Unacked Motion$20Detected Medium 150

A 10-Jan-202:03:19PMIST  Normal OAcked /1Unacked AxisVideoNetworkCameral0 Medium 150 Ping Success

Step 9. To confirm the alarm in the browser, log in to the system, click Monitoring.
The video icon (

B

) identifies the recorded clip associated with the motion-detection alarm.

Step10. To view the clip, use the check box to the left of the alarm row to select this alarm and click Show
Recurring > Review Video.
The HTMLS video clip plays back.

About Maxpro network, camera and NVR configuration

The Maxpro driver supports both legacy devices that lack a secure video stream as well as newer cameras and
NVRs that support TLS secure communication.

Through the web Ul you can enable and disable a Maxpro network and configure its Alarm Source Info,
Monitor, Tuning Policy and Fox Video Stream Preferred properties.

For video options in Workbench, refer to the Niagara Video Framework Guide.

Secure communication with video devices

By default, a Maxpro network provides TLS secure communication. If a camera or NVR on the Maxpro network
does not support TLS, you will need to disable secure communication using Workbench and change the Http
Port the device uses from 443 (secure) to 80 (not secure). You can change the Http Port using the web Ul.

CAUTION: Be aware that the framework cannot prevent a flooding attack or other malicious activity if you
must configure your devices without secure communication.

HTMLS5 streaming video

The Maxpro driver does not support HTML5 streaming. To support Maxpro devices, the browser requires the
Web Launcher.
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Installing a Maxpro network

Adding a network to a station is the first step for setting up a Maxpro video system.

Prerequisites:
The maxpro driver is licensed for this station and the driver’s software modules are available.

Step 1.

Step 2.

Step 3.

Step 4.
Step S.

From the main menu, click Controller (System) Setup > Remote Devices > Remote Drivers.
The Remote Drivers view opens.

Click the Manage Drivers button (| g | ), select the Add option and click Ok.
The Add Driver window opens.

Select the Maxpro driver from the list and click Ok.
The Add Driver window opens.

Use the default driver name or change the name and click Ok.

To check the network configuration, double-click the network row, confirm the configuration
properties, and, if you changed any, click Save.
The network status should report {Ok}.

Adding a Maxpro NVR

A Maxpro system with an NVR processes video data at the camera and streams it to the NVR.

Step 1.

Step 2.

Step 3.
Step 4.

Step 5.

From the main menu, click Controller Setup > Remote Devices > Remote Drivers.
The Remote Drivers view opens.

Double-click on the Maxpro Network row in the table.
The Driver Manager view opens with the Maxpro Network tab selected.

Click the NVRs tab.

Do one of the following:

¢ To edit the properties for an existing NVR, double-click the NVR row in the table or select
the NVR and click the Edit button (

=
).
* To add a new NVR, click the NVRs tab.

To continue adding a NVR, click the New button ( ), select the NVR from the drop-down list,
name it, and click OK.
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The New window opens.

Mame Maxpro Mvr

Description

Ip Address
Http Port Display Mame Maxpro Myr
Fox Video Strd Description Lobby

Ip Address 192.168.1.3
Credentials Http Port 443

Fox Video Stream Preferred | Inherit ¥

. Username LobbyMyvr
Credentials

Password ssssssas

Ok | Cancel |

Step 6. Enter at least these properties and click Ok:
® TIp Address is the IP address for the NVR software.
® Credentials (Username and Password) are for accessing the NVR.

CAUTION: Do not change the Http Port to 80 unless you are setting up an NVR that does not
support TLS secure communication. If port 80 is required, you must also turn off Use Tls using
Workbench. Disabling secure communication leaves your Maxpro network vulnerable to a
malicious attack.

If the NVR uses fox streaming to deliver video, the Http Port can be different from the port

used by the platform/station to access the network. If the NVR does not use fox streaming, this
port should be the same as the port that connects the platform/station to the network.

Result
Adding an NVR adds the tabs (containers) for cameras as well as adding the driver to the Driver Manager view.

Adding (or editing) a Maxpro camera

Adding a camera may involve approving its certificate as well as configuring its communication properties. This
procedure adds a camera manually. Migrated installations list all existing cameras without the need to manually
add the cameras.

Prerequisites:

You are connected to the remote host station that controls the camera using the web Ul. The Maxpro network
and NVR have been set up, configured and the health of each reports Ok. If the camera does not support TLS
secure communication, you must have used Workbench to disable Use Tls and changed the Http Port address
to 80. You cannot change these properties through the web Ul.

Step 1. From the main menu, click Controller Setup > Remote Devices > Remote Drivers.
The Remote Drivers view opens.

Step 2. Double-click on the Maxpro Network row in the table.
The Driver Manager view opens with the Maxpro Network tab selected.

Step 3. Double-click on the Maxpro NVR row in the table.
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The NVR Manager view opens with the Maxpro NVR tab selected.

Step 4. Click the Cameras tab.
The Camera Manager view opens.

This view displays a list of any existing cameras.

Step 5. Click the Discover button ( gg| ) or do one of the following:

¢ To edit the properties of an existing camera, double-click the camera row in the table or
select the camera and click the Hyperlink button (

L
).

* To manually add a Maxpro camera manually, click the New button (

).

The New window opens.

Display Name |b‘1axpru Camera |
Description
Camera Id 0
Supports Pan Tilt false ¥
Supports Zoom false ¥
Ptz Support Supports Focus false ¥
Supports Iris false ¥

Supports Move To Preset |false ¥
Supports Store Preset false ¥

Preferred Resolution High ¥
Preferred Frame Rate Low v
Preferred Compression Medium ¥
Preferred Video Stream Fox | Inherit ¥
Mormal Speed Speed _1 v
Fast Speed 4
Use Rtsp Stream false ¥

I'D_kl Cancel

Step 6. Give the camera a Display Name, and optional Description; enter its Camera ID (usually an IP
address).
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The Maxpro driver supports TLS secure communication by default.
NOTE:

If your application requires RTSP and you change Use Rtsp Streamto true, the channel will not
connect unless you already disabled TLS secure communication in Workbench.

Step 7. To use RTSP streaming, set Use Rtsp Streamto true and click Ok.
The system saves the configuration to the station database.

Step 8. Once the camera is set up, to view its properties, navigate back to Controller Setup > Remote
Devices > Remote Drivers double-click the Maxpro Network row; double-click the NVR row, click
the Cameras tab; and double-click the camera row in the table.

296 March 21, 2025



Niagara Enterprise Security Installation and Maintenance Guide Video installation

The system opens the Maxpro Camera tab.

Home || 65" Monitoring | | &g Personnel Reports &% System Setup

@ Schedules

&, User Management A= Backups <% Remote Devices &% Acce

I save || &) Maxpro Nvr B Playback View

Maxpro Camera Events

Status l(down, alarm, unackedalar
Enabled true ¥

Fault Cause |

Health Fail [13-Dec-19 11:12 AM EST] Connection timed out: conne
Alarm Source Info Alarm Source Info »

Video Device Id Description Lobby,Camera Id 0 »
Ptz Support o ?

Control Timing Camera Control Timings »
Video Preferences Video Source Preferences »
Normal Speed Speed _1 v

Fast Speed 4 [0 - 15]
Compression Codec Ffmpeg _ CODEC_ID_H264

Pan Tilt Zoom Settings Maxpro Pan Tilt Zoom Settings »

Q| =

1 Presstl

lso Presst125
Preset Text 126 Preset126

127

. Preset254

255 Presst255
Use Rtsp Stream false v

Rtsp Stream Url |

Use Custom Rtsp Url false v
Custom Rtsp Stream Url
Control Port 554
Data Port 2000
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Status should be {ok}.
Step 9. If Statusis not {ok}, confirm that the Compression Codec is appropriately configured for the
camera, and, if necessary, change this property and click Save.

* For a secure Https connection between the camera and station, the CODEC should be:
MPEG4 (Ffmpeg_CODEC_ID_MPEG4).

e For an RTSP connection between the camera and station, the CODEC should be: H264
(Ffmpeg_CODEC_ID_H264).

Playing back Maxpro-recorded video

The Maxpro driver does not support HTMLS5. Viewing videos recorded using the Maxpro driver requires the
Web Launcher and Java applet. This goes for all the video-related views including live view, playback view,
remote video views, and motion-detected video alarms.

Prerequisites:
You have one or more video clips recorded using the Maxpro driver.

Step 1. Open your browser and enter the station’s IP address in the Address field at the top of the
browser.
The Login window opens.

EntsecSup

o .
Username: jadmin

M Change User

Password:

Login

Use of this software is subject to the
End User License Agreement and other Third Party Licenses

To connect using Java Web Start click here
To connect using Miagara Web Launcher click here

Step 2. Click the link below the window that reads, “To connect using Niagara Web Launcher click here.”
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Step 3.

Step 4.

It may take a while for the Web Launcher to load and open a window for entering the station’s

Example: #ttps://localhost

URL.

Video installation

If you see an error message, click the browser’s back button.

Enter the IP address in this box, click Go, enter the password in the login window and click Login.

The web Ul opens supported by the Web Launcher.

Click Controller (System) Setup > Remote Devices > Remote Drivers
The software opens the applet view followed by the video view.

TRIDIUM
ﬁiagara4

framework

Loading (this can kake several minutes depending on connection speed)
Loading lexicon lisk

This works for both the Surveillance and Playback viewers.

Using the applet to play back applet-rendered videos
You may use the Niagara Web Launcher and Java applet to play back applet-rendered video clips associated
with alarms.

Prerequisites:
The applet-rendered video clip already exists.

The HTML5 Alarm Console is not available using Web Launcher.

Step 1.

Step 2.

March 21,

Open your browser and enter the station’s IP address in the Address field at the top of the

browser.
The Login window opens.

Click the link below the window that reads, “To connect using Niagara Web Launcher click here.”

2025
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It may take a while for the Niagara Web Launcher to load and open a window for entering the
station’s URL.

Example: #ttps://localhost

If you see an error message, click the browser’s back button.

Step 3. Enter the station’s IP address in this box and click Go
A different login window opens.

MotionDetection_Entsec

Username: admin
J“- I Change User
FPassword:

— |

Login \

Use of this software is subject to the
End User License Agreement and other Third Party Licenses

Step 4. Enter the station password and click Login.
The web Ul opens supported by the Web Launcher.

Step 5. Do one of the following:
¢ Click Monitoring > Alarm Console.

¢ Click System Setup > Alarm Setup, click Alarm Consoles, double-click the ConsoleRecipient
row in the table, and click the View Alarm Console button.

The applet loads (this may take a bit of time) and opens its Alarm Console view. Both access
methods load the same applet-based Alarm Console.

Step 6. Double-click the motion-detected alarm row in the table.
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A pop-up window opens with the recorded video.

24 Alarm Video

£ Home & Personnel

Alarm Console

Time Range Twr @
Timestamp Source State  Ack State Sour
[E0 M 04-Feb-20 3:08:18 PMIST  Normal DAcked /1Unacked  Motiol
#.04Feb 20 2:09:19PMIST  Normal 0Acked /1 Unacked  Axisiii

Video Playback

n|[e] al o]

The screen capture shows the applet Alarm Console with an open video clip.
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Chapter 13. Graphics configuration

A graphic provides a visual display of an access control area, can simulate actions including: doors opening and
closing, readers scanned, intrusion zones enabled, etc., report on current conditions, and include buttons for
implementing area-wide controls, such as turning on video surveillance and triggering threat level actions. A
graphical representation of reality enables operational personnel to respond quickly to threats in real time.

Target media

Prior to Niagara 4.9, no custom Px graphics ran in a browser (required by the web Ul). Instead, they used the
Java Web Start applet, which ran outside of the browser. The release of Niagara 4.9 replaced Web Start with
Java Web Launcher for Px graphics that still require an external applet. Other Px graphics support HTMLS5,
which runs in a browser.

The Graphic Editor supports two client-side, Px Target Media technologies:

e HxPxMedia are designed for the web Ul. Three widgets render in a browser using HTML5:
LiveVideoPlayer, Control Panel and CameraWidget. The remaining widgets: PanTiltJoystick, ZoomSlider,
MouseDownButton and VideoMultistreamPane require Web Launcher and render outside of the browser.

e WorkbenchPxMedia are designed for the Workbench interface. When used in the web Ul, all widgets
require the Web Launcher (applet).

The Graphic Editor advises you if you use a feature in a widget that is not supported by the target technology.

Consider carefully the basic capabilities and limitations of each technology. Obviously, a mobile phone is
limited as to what it can usably display when compared to a graphic viewed in a web browser running on a
computer. Keep this in mind, and test your views in all target media as you develop them.

The Niagara Graphics Guide documents in detail the capabilities of Hx and Px graphics. The Niagara Video
Framework Guide documents the videoDriver module and palette.

Summary steps

Configuring a graphical representation of a facility begins by hiring a graphics artist to create a set of three-
dimensional images to represent the building, including all areas, such as the parking lot or garage, to be
monitored. The images should be readily recognizable as belonging to the facility, looking down from above
each floor.
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Figure 34. A 3D image of a floor in a building

‘ A Home H & Monitoring H &3 Personnel || [ Reports H ¥ System Setup H 3 Photo ID H A\ Threat Levels |0Hxﬁmpr

T Third Floor T Threat Level 5] Parking Lot 5] Intrusion () HxHVAC

James Enter James Exit
Rick Enter Rick Exit
Laura Enter Laura Exit
Grantad

Carson, James

P

# of occupants: 1.0

|/

™~

b

Space Temp:. 718 °F
LY 1 1

Space Sipt: T'!:Z.D “F 3 .

Unoce Spt 82.0 °F
_ Setpoints Adjusted
e

Tenant C (VAV3)

Space Temp: 82.0°F
Space Sppt: 72.0 °F
Umocc Sipt: B2.0°F

d

Tenant A (VAV1)
Space Temp: B2.4°F

.. N

Tenant € | Space Spt 67.0 °F
Last Parzon Grantad Accas: Unocc Sipt 82.0 °F

Styles, John

The screen capture shows an image of a single floor in a building with overlaid controls for visually monitoring
access control.

The general process of creating presentation views for access control follows these general steps:

1. Create a view

Creating a view sets up a canvas on which to construct a representation of your facility. This view
establishes a relationship between a Px file and one or more components of various types, such as folders,
doors and readers.

2. Add widgets
A widget is a graphic visualization of an access component. You add widgets to the canvas.
3. Bind your data to the widgets
Data binding passes data collected from the access components to the widgets. These bound data
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objects animate (update) the widgets in real time.

Create a nav file

A .nav file sets up a customized tree structure so that users can easily access your views. You edit the .nav
file using the Nav File Editor and assign a particular nav file to a user in the user’s profile (using the User
Manager view).

Create and distribute a report

Reports display and deliver data to online views, printed pages, and for distribution via email.

Creating a view using Workbench

While you can use the Graphic Editor, which is available in the web user interface (web Ul), it is often preferable
to create graphics using Workbench. This is especially true for more complex graphics. This procedure creates
a graphic that can be accessed via user roles and, using Web Launcher, can be accessed from the web Ul.

Prerequisites:
You are working in Workbench on a Supervisor PC

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Step 7.
Step 8.

Result

Right-click the Config folder, click New > Folder, and give the folder a name, such as Customized
Views.

Create another folder within the Customized Views folder and name it for the view, such as Main
Floor, Lobby, etc.

Right-click the folder for the view and click Views > New View.
The New Px View window opens with the folder name as the default View Name.

As expected when using the Workbench interface, Target Media defaults to
WorkbenchPxMedia. These media are designed for the Workbench interface. Since they do not
work in a browser, they require Web Launcher when viewed in the web Ul.

Give the view a name, such as Main Floor, Lobby, etc. and click OK.
The software creates a . px file for the view and opens a blank canvas.

Open the videoDriver palette, expand the Px folder and drag a widget to the Px Editor canvas.
The side bars populate.

* A bound Object Resolution Descriptor (ORD ) connects the widget to a specific device slot
(object).

* The Widget Tree displays the hierarchy of widgets (panes, labels, graphic elements, and so
on) in the current Px view.

* Px Properties relate to the specific widget.

* Px Layers group objects in the Px Editor.

* Properties populate based on the widget type.

NOTE: Binding options that are dimmed indicate invalid options for the selected component.
Configure options and click OK.

The Secondary view area displays properties and options that are related to the selected Source
option.

To bind additional widgets, repeat this procedure.

To check how your view looks, click the Toggle View/Edit Mode: Hyperlink to Px Editor button (
# ) or click the name of the view in the Nav tree.
This button toggles between the finished view and the Edit view.

Refer to the Niagara Graphics Guide for more information about how to create and manipulate widgets.
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Creating a new graphic view using the web Ul
This procedure describes how to use the web Ul to create a graphic view that displays current room (access
zone) occupancy and temperature information.

Prerequisites:
You are working in the web Ul. You have an appropriate graphic image to represent the building.

You can create graphics in many ways, depending on your resources, your skill level and what you are starting
with. For example, if you already have a graphic page for building controls, you may add access information to
an existing page. In other cases, you may create a new page from the start. One general process for creating a
new graphic is outlined below with detailed steps following.

Step 1. Navigate to Controller (System) Setup > Miscellaneous > Graphics > Graphics Management..

Step 2. Click the Add button (| @ ).
The Add graphic window opens.

ViewName | LobbyEntrance |

Viewlcon | module://icons/x16/views,view.png |

TargetMedia | WorkbenchPxMedial x
WorkbenchPxMedia
HxP=Media

TargetMedia defaults to WorkbenchPxMedia. These provide the richest visual experience, but
may not be appropriate depending on the device (phone, tablet, computer).

HxPxMedia are designed for the web Ul. Three of the widgets run in a browser using HTML5:
LiveVideoPlayer, Control Panel and CameraWidget. The remaining widgets: PanTiltJoystick,
ZoomSlider, MouseDownButton and VideoMultistreamPane require Web Launcher and run
outside of the browser.

Step 3. Give the graphic a name, select HxPxMedia for TargetMedia, and click Ok.
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Step 4.

Step 5.

The system creates the graphic file in the station and displays the Graphics Management view
with the new graphic page listed.

& Monitoring ﬁ Personnel #% System 9

B Schedules & User Management E= Backups &% Remote Device

DIRIE ) (%82 (el

isplay Name Media Parent Display Path
7 Acme Floor 3 hxiHxPxMedia /Graphics/&cme Floor 3
7 Acme Floor 4 ha:HiPaMedia /Graphics/&cme Floor 4
3 Floor-3 workbench:WhPxMedia /Graphics/Floor-3

7 MyCamera workbench:WbPxMedia /Graphics/MyCamera

i Video View 1 workbench: WbPxMedia JGraphics/Video View 1
v Video View 2 ha:HiPaMedia /Graphics/Video View 2

Select the graphic you just created and click the Graphic Editor button (| 5 ).
The browser may prompt you to continue even though the certificate presented by the station
cannot be validated.

Click Continue.
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A blank Graphic Editor view opens.

Home || & Monitoring | | &3 Personnel #¥ Controller Setup MNic glgrwg

#% Alanm §

[ Schedules & User Management F£A= Backups #% Remote Devices #¥ Access Setup &% Intrusion Setup

Q a Q| E 7 6 &
~ Bound Ords

~ Widget Tree

— ’
|_J scrollPane (Root)

- Properties

&)

The side bars configure:

* A bound Object Resolution Descriptor (ORD ) connects the widget to a specific device slot
(object).

* Properties populate based on the widget type.

Step 6. Add a background using an image that you have prepared previously — such as a floor plan.

a. Double-click in the middle of the CanvasPane to open the CanvasPane properties window.

b. Inthe CanvasPane properties window, use the background property field to select Image
from the drop down option list and browse through the Image Brush Editor (use the File
Otd__Chooser) and File Chooser windows to select the desired image file, as shown below.

c. Click the Open button and then click OK to close all the windows and complete the
insertion of the image on the graphic view.

The background image displays on the page.

Step 7. Add a widget.
If you selected HxPxMedia for Target Media and you attempt to drop a widget from the palette
that requires the Web Launcher, the system displays, “Are you sure you want to create this
widget?” Media Validation for “HxPx Media” found these problems:” A widget ORD follows.

Step 8. If you got the error message, click Yes.
The software creates the widget, but it works only in Workbench.
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Result

Refer to the Niagara Graphics Guide for more information about how to create and manipulate the graphics
widgets.

Adding information to a graphic view

You can use labels to display information, such as images, static text, and dynamic information on your graphic
page.

Prerequisites:
The graphic view is available from the web Ul and the information to add is available to the station to which
you are connected.

Step 1. Add a label by right-clicking on the canvas pane and selecting New > Blank Label. You can use the
label properties palette to add text and formatting, as desired.
The image below shows static text used as a room label (“Room 401"”). The label properties are
edited to supply the text, a border and background shading.

B AN LT
MNew b EBlank Label Room 401

db i

,_l —t
1l

Step 2. Add dynamic information (such as room temperature or occupancy count) to the graphic page by
doing the following.

NOTE:

Adding dynamic information requires that you have information values (such as numeric point

values) available in your station logic so that you can bind that information to a widget on the

graphic view.

a. Add a new label, and then in the label’s Properties window, click the Add Binding button (
&® ). Select bajaui:Value Binding in the ord property, then browse to connect the ord

property to a desired control point in the station and click OK. With the ord connected, the
value is now available to be assigned to the label text property field.
As an example, you may have some logic in your station that calculates room occupancy
based on door entry and exit values. You can connect this field to the numeric point that has
that information and display it in the label.

b. To display the bound value in the label, right-click inside the text property, choose Animate
from the popup menu to display the Animate window, as shown below.
Use the BFormat field (Format) to designate the desired dynamic value and click OK.
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The graphic now has a label and dynamic value that displays changing information such as
occupancy or room temperature.

Step 3. To save your changes, click the Save button ([] ) on the toolbar at the top of the view.

Result
The graphic page displays values with updates.

Following is an example of a page that has more information.

1_1/-"

Tenant B {(VAVZ)
Space Temp. 71.9 °F

j— ]
Space Sipt: ;_IZ.D *F
Urocc . B2O°F

ints Adjusted
i
b :',"::_',

L
%

o

| “TenantA |
I | Tenant C |
Last Parson Grantad Accas!
Styles, John

Tenant C (VAV3)

Space Temp: B2.9°F
Spacs Spt: 72.0 °F
Unocc Sipt:  82.0 °F

Tenant A (VAV1)
Space Temp: B2.6 °F

Spacs Spt: 67.0 °F
Urocc Sipt B2.0 °F
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Adding video to a graphic
You can add live video or playback recorded video on a graphic page. This task describes how to add a live
video camera to an existing graphic page.

Prerequisites:
You are working in the web Ul. The graphic already exists.

Step 1. Navigate to Controller (System) Setup > Miscellaneous > Graphics > Graphics Management..
The Graphics Management view displays the list of graphics.

Step 2. Select the graphic and click the Graphic Editor button (|5 ).
The Graphic Editor view opens with the graphic in the editor.

Step 3. Piﬁ-click on the CanvasPane and select New > Video Cameras > Your Video Camera.
o camera is added to the graphic.

s
.

lan. 10 -
-Jan-149 o>

A,

Step 4. To save your changes, click the Save button ([\] ).

Widget layout

Widgets are components that provide graphic visualizations. You use the Graphic Editor to define user
interface functions for control and information display. An example of a widget is the label, which you can add
to a graphic for the purpose of annotating the drawing.

March 21, 2025 311



Graphics configuration Niagara Enterprise Security Installation and Maintenance Guide

NOTE: If either of the child objects is positioned outside of the view area of the parent, the system crops them
and only the part within the parent is visible.

Figure 35. Front Door widget in context

- A

-ﬂ,=B=E=

Front Door

The screen capture shows a simple layout of a widget (C), held by the parent canvas (B) that is the child object
of the scroll pane (A).

Widget panes

Some widgets are designed specifically to be container widgets that hold other widgets. These widgets are
called panes.

Figure 36. Pane hierarchy in the widget tree

»~ - Widget Tree

s @ scrollPane {Conkent)
EI CanvasPane {Conkent)
A EcundLabel [station: [slok: Lo

111

Kl
F Y

I

The screen capture shows the pane hierarchy in the widget tree and on the Graphic Editor canvas. Different
types of panes provide different functions.
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Table 26. Types of panes

Type of pane Description

CanvasPane This pane is used for absolute positioning.

BorderPane This pane is used to wrap one widget and provide margin, border, and padding similar to the CSS box
model.

ScrollPane This pane supports a single child that may have a preferred size larger than the available bounds. The

scroll pane provides a set of scroll bars for viewing areas of the child widget that go outside of its bounds.

Widget painting

Painting refers to how widgets present themselves graphically (using: colors, transparencies, and so on), as well
as cropping. Graphics are always translated so that the origin 0,0 is positioned at the top, left corner of the
widget. The graphics crop (visible area) is set to the widget's size. Alpha and transparent pixels blend with the
pixels already drawn.

The system draws widgets in property order with the first widget at the bottom, and the last widget on the
top. Effective z-order is reverse of property order.

Widget commands

Widgets can include user commands that are commonly activated with buttons and menu actions. Menu
commands are available and may be used on widgets.

Figure 37. A widget command

Maral Crwerri

Widget properties
Widget properties define many of the features, behaviors and appearance characteristics of widgets. By
editing widget properties, you control how a widget behaves.
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Figure 38. Widget properties
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The screen capture shows the properties in the side bar for a bound label. In this example, the text property of
the label is bound to the slot:/Drivers/AccessNetwork/baseReader/points/doorl/strike/out/
value value, as shown in the text property. The binding of this value allows the dynamic presentation of the
door strike in the Graphic view.

In the Graphic Editor view, you edit widget properties using the properties side bar or Properties window and
their secondary windows. Properties that appear with the ellipses open secondary windows, which provide
additional properties and options. These windows open when you click the property.

Animated graphics

Animated graphics are graphics whose values update in real-time. A graphic can be as simple as a single word
of text (ON) or a number (72), or it can be an animated image (door opening). Widgets are animated by
binding their properties to a legitimate data source.

For example, you connect numeric values to widget properties that use numeric values, and you connect
binary values to objects that use binary values. By animating the properties of a widget, you control the text
appearance of the image, as well as change a widget'’s location on the page, and even its visibility.

Data binding

An ORD (Object Resolution Descriptor) establishes the connection between a widget and an object. The ORD
is the universal identifier used throughout the system. The ORD unifies and standardizes access to all
information. Designed to combine different naming systems into a single string, it has the advantage of being
parsable by a host of public APIs (Application Program Interfaces).

A single binding consists of a single widget-object relationship. A binding’s ORD property identifies the
location of the object that updates and animates the widget.
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Figure 39. Widget data binding
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The screen capture shows a value binding to a text label widget as viewed in the Ord window of a binding.

The most common type of binding, the value binding, provides some of the typical functions that are
associated with building real-time information for presentation as both text and graphics. This includes support
for mouse-over and right-click actions. Additionally, it provides a mechanism to animate any property of its
parent widget using converters that convert the target object into property values.

Figure 40. Widget with three bindings
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The screen capture illustrates the object-to-widget property binding concept. In this example, a widget has
three separate data bindings. This means that each binding is coming from a different object and, therefore,
each binding has a different ORD that defines its binding. Each binding provides access to an object’s values so
that they may be used, as required, to animate the widget properties.
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Graphic views in the system menu

As the menu structure is a hierarchy with parent nodes and subordinate child nodes, you may create a nav
(navigation) group for graphics and assign child graphics to it. You may also add graphics to an existing node in
the navigation tree.

Graphics appear in the web Ul menu.

3]

& Monitoring

e

& Personnel
[ Reports

EH

4 System Setup
3 Photo ID
A Threat Levels
© HxGraphics

5 Third Floor

) Threat Level

5] Parking Lot

5] Intrusion
IE © HxHVAC
= |© Video Integration Graphics
T Third Floor - Video
T Threat Level - Video
5] Parking Lot - Video

) Intrusion - Video

B E

M

7 Video QOverlay

Creating (and editing) a navigation group

A nav group displays in the menu under its assigned parent.

Step 1. From the main menu click Controller (System) Setup > Miscellaneous, expand the Graphics menu
and click Navigation Groups.
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The Navigation Groups view opens.

| A Home || &+ Monitoring || &g Personnel || [ Reports |J15ystem Setup| 3 Photo 1D || A

FH Schedules & User Management *0) Backups 7 Remote Devices 7 Access Setup

® BYLRR

Display Name & Nav Name Parent Path Index
() HxGraphics HxGraphics / 8

G HxHWVAC HxHVAC /HxGraphics 10

) video Integration Graphics VideolntGraphics ! 9

This view displays a table of all the navigation groups that are available on the local station.

Step 2. Do one of the following:
* To add a nav group, click the Add button (

@

).
* To edit an existing group, select the group row in the table and click the Hyperlink button (

@
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If adding, the Add New Nav Group view opens.

| #A Home || &+ Monitoring || & Personnel || [] Reports |J?System5

[ Schedules & User Management i) Backups ./ Remote Devic
[M] save [Km NavGroups

Nav Group [ ¢ ]

MNav Name | |

Display Hame| |
Parent Path | Home W
lcon | module://icons/x16/folder.png |

Index |'I] |

< >

If editing, the system populates the properties displayed on the single tab below the Save button
and a Navigation Groups link. The Display Name property defines how the nav group appears in
the navigation tree. The Index property defines where the nav group appears in the menu
hierarchy. A 0 or 1 places the nav group first.

Step 3. Fillin or edit the properties and click the Save button at the top of the view.
NOTE: A Nav Group does not display in the menu until a child menu item is assigned to it.

Adding a graphic view to the navigation tree
A small graphic in the navigation tree provides a visual representation of the node.

Prerequisites:
The graphic exists.

Step 1. From the main menu click Controller (System) Setup > Miscellaneous, expand the Graphics menu
and click Graphics Management.
The Graphics view opens.

Step 2. Select the graphic row in the table and click the Edit Nav button ( (@ |).
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The Edit Nav window opens.

Edit Haw

May Mame ESrdFIu:u:ur

Display Name §3r|:| Floor

Parent Path araphics |

Index

| ok || cancel |

The Display Name property defines how the graphic appears in the navigation tree. The Index
property defines where the graphic appears in the sub-menu hierarchy. A 0 or 1 places the graphic
first.

Step 3. Fill'in the properties and click Ok.

Designing a reusable graphic

Graphic files that are used in multiple views on a local station or even possibly for use across different stations,
may supply an absolute value from a target device in a specific remote station, or a relative value from a device
within the current station. A relative path causes a Graphic file to resolve data bindings to identically named
components that reside in different locations, thus making one graphic file usable in many views. Refer to the
Niagara Graphics Guide for more information.

Prerequisites:
You have configured the same device names identically in multiple locations. The graphic to reuse is open in
the Graphic Editor.

Step 1. Select the device widget.

Step 2. Open the Widget Tree side bar and double-click the object in the Widget Tree or on the canvas.
Step 3. Select the BoundLabel under the Canvas Pane in the Widget Tree.

Step 4. Click Relativize ORDs.

Before I After I

« station:|slok:fLogic/HousingUnit/ &irHandler \DamperPosition | slob:DamperPosition
«# station: |slok: fLogic/HousingUnit/ &irHandler/Fan slok:Fan
«# station: |slot: fLogic/HousingUnit/ &irHandler /HeatingCoil slok:HeatingCoil

t.

March 21, 2025 319



Graphics configuration Niagara Enterprise Security Installation and Maintenance Guide

The Relativize Ords window opens.

Step 5. Change the absolute Ord (Before) to a relative Ord (After).
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Chapter 14. Maintenance

This chapter contains additional configuration procedures, as well as procedures for updating software,
replacing the Supervisor PC and replacing controllers. It concludes with a troubleshooting section that provides
some steps to follow when things are not working right.

All topics are available in the Niagara Community Resource Center. Through this site you can also comment on
these topics. The technical documentation team welcomes your suggestions for improving these procedures
with your real-world experiences.

Changing the admin password
The admin user has access to the entire system. Changing the password for this user on a frequent and regular
basis is a powerful best practice for maintaining a secure system. This procedure uses the web Ul.

Prerequisites:

You are logged in to the station with admin privileges. This procedure documents a task performed in both the
Supervisor PC and remote controller stations using the system’s browser interface. The alternative Supervisor
station command is in parenthesis.

Step 1. Navigate to Controller Setup (System Setup) > User Management > Change Password.
The Change Password view opens.

Step 2. Inthe New Password property, type a new strong password.

Step 3. To confirm that you typed the name correctly, type the new password again in the Confirm New
Password property, and click Save.
If the two values match, the system implements the change.

Step 4. To return to the home view, click Home.

Result

TIP: Your system should be set up with more than one user that has admin rights in case someone loses the
admin password.

Changing the system passphrase

The system passphrase protects sensitive information stored in file systems, and on the SD card in each
controller, and encrypts portable files, such as backups and station copies. You should define a strong system
passphrase. If you skipped configuring this phrase during installation, this procedure documents how to set it
up now.

Prerequisites:
You are working in Workbench running on a PC.

Step 1. Open a platform connection to the PC.

Step 2. Double-click the Platform node in the Nav tree and double-click Platform Administration or right-
click the platform node and click Views > Platform Administration.
The Platform Administration view opens.

Step 3. Click System Passphrase.
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The Set System Passphrase window opens.

Set Systemn Passphrase *

Set System Passphrase
Set System Passphrase

Enter new system passphrase

Current Passphrase |
Mew Passphrase
Confirm Passphrase

[ This host will be licensed for FIPS 140-2

OK Cancel |

Step 4. Enter the current passphrase, create a new passphrase and click OK.
If your installation is licensed for FIPS (Federal Information Processing Standard), this phrase must
be at least 14 characters including at least one number, as well as lower and upper case letters.

Changing the system database

If upgrading a system requires you to change the current Orion database, you may do so using the web UL.

Step 1. Download the new database software (MySQL or MSSQL), create the new database, and ensure
that it is running.

Step 2. Inthe web Ul, click System Setup > Miscellaneous > Configure Database.

Step 3. Click Set Orion Database.
The Set Orion Database window opens.

a

@ Schedules & User Management

B= Backups #¥ Remote Devices #¥ Access Setup  #F Intrusion Setup

g Manage Databases | B} Set Orion Database || B8 Restart Station

Database Services security_test

Enterprise Security Service {ok}

Access Control Service EGE:’ e
<__|'.] i

Intrusion Service

Orion Service {ok} Changing the Orion Database will result

Orion Database {down} security_test /), inremoving ALL DATA in the Orion Database.
I ) s 1

Replication Service {ok} ) You must also restart the station for

Replication Failure Alarm Alarm Source Info > the change to take effect.

Replication Overrun Alarm Alarm Source Info » Orion Database

Replication Overrun Limit |5000

Step 4. Select the new database and click Ok.

Step 5. When the system has used the new database without incident for a week or two, delete the
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database device from the rdb (Relational Database Management) driver in the Supervisor station.

Step 6. For security purposes, delete the database from the old location.

Viewing and updating module firmware

The Device Module view indicates the installed version of the module firmware and if a more recent version is
available.

Prerequisites:
You are connected to a controller using the web Ul.

Step 1. Navigate to Controller Setup > Remote Devices > Remote Modules > Remote Module Setup.
The view lists the connected modules.

Step 2. Compare the Installed Version with the Available Version column.
Step 3. If a more recent version of the firmware is available, click Upgrade Firmware ( |z, ).

Step 4. To discover and match the base board module of the new controller with the baseboard module in
the database, click the Discover button, select the discovered station and click the Match button (

al).

Step 5. Set the network’s TCP/IP settings in the new controller to the same settings as the old controller
(Controller (System) Setup > Miscellaneous > Network TCP/IP Settings).

Step 6. If necessary, change the adaptor settings on your PC for testing purposes.

Step 7. Test functionality by using a card to open a door.

Managing licenses

The License Manager view allows you to view, upload and remove licenses.

Prerequisites:
The software is installed and configured. You are working in the web Ul.

Step 1. To view access this view, click Controller (System) Setup > Miscellaneous > License Manager
The License Manager view opens.

Step 2. To view a license, click on the hyperlinked file name.
The license file opens in the browser.

Step 3. To remove a license, click the check box to the left of the license hyperlink and click Delete.

Step 4. To upload a new license, browse for the license in the Upload New license, certificate or lar File
section, and click Upload.

NOTE: If you update your license file you may need to clear your browser cache to view the
updated file. For how to clear the browser’s cache, refer to your browser documentation.

Data export
This feature makes data collected by the system available for processing and analysis outside the system.

In the web Ul you can export data wherever the Export button appears in the view. In Workbench, the Export
option is available in every table view from the drop-down list in the upper right corner of the view.

Exporting a schedule to a CSV file

This procedure documents how to export a schedule as a CSV file.

Prerequisites:
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You start out working on a Supervisor station.

Step 1.

Step 2.
Step 3.

Step 4.

Step 5.

From the main menu, click System Setup > Schedules.
The Schedules view opens.

Select the schedule to export and click the Export button ([]).

Select csv for File Type.
The window changes size.

.

Title Schedules
Export Range | Al v
File Type

Ok || Cancel

To continue, click Ok.
The system prompts to confirm the download and downloads the CSV file.

Save the file to a location where you can be sure to find it.

One way to discover and export schedules

You may use the Join (Add) Station view to discover and export schedules.

Prerequisites:
You are working in either the Supervisor or a controller station using the web UL.

Step 1.
Step 2.

Step 3.

324

If needed, return to the main menu.

Click Controller (System) Setup > Remote Devices > Station Manager.
The Station Manager - Database view opens.

Select a station in the database and click the Join button ([ = ).
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The Add Station view opens.

Add entSecurity&]

Ty Retrieve Import Status | «) Reset Inipart Status ” 15 MiagaraNetwork

Step 1: Make sure the System Date Times are SYN hronized within 1min of each other,

Supervisor Tine

Subordinate Tve Ti-Sep-09 0:44 AW EDT (T Synchranize Tims

Timwe Difference 1rrdr

Step 2: Use the Distributed Schedule Manager to import schedules.

Distributed Schedule Manager |

Step 3: Make sure the database will be imported properly.

Record Type Imnport Stabus
Tenants Hot Configured
Keypad Formats Hot Configured

Whegand Formats Motk Conhigured
S |

pilged

Miagara Indegration It M
Aooess Rights ot L crhgurned
i

Irebrrsion Fins

Above is a view of the link that takes you to the Distributed Schedule Manager view.

Step 4. Click the Distributed Schedule Manager link.
The Distributed Schedule Manager - Database view opens.

Ay Threat Levels

" Monitoring #% System Setup

mzl@eoe @EF 050

MNidydlc

Iramewor

[ Schedules & User Management A= Backups &=} Remote Devices #F% Access Setup &% Intrusion Setup

Display Name / Usage Status Out Source Out MNext Time Next Value Supervisor Id

After Hours Access Right  {ok} Default Qutput false {ok} 09-Jan-19 6:00 PM EST  true {ok} [Services/EnterpriseSecuritySer

Abways Access Right  {ok} Week: wednesday true {ok} 10-Apr-19 12:00 AM EDT true {ok} [5ervices/EnterpriseSecuritySel

Weekend Access Right  {ok} Default Qutput false {ok} 12-Jan-19 12:00 AM EST  true {ok} [Services/EnterpriseSecuritySer

Waorking Hours Door Unlock  {ok} Week: wednesday true {ok} 09-Jan-19 6:00 PM EST  false {ok}  /Services/EnterpriseSecuritySel
Discovered

soonc

Q| = Ealar

Display Name Path Supervisor Id  Type Sir

B-to-6 Schedule  slot:/Services/EnterpriseSecurityService/schedules/$3642dto32d6$205chedule MNULL schedule:Boolean5chedule

Step 5. To discover additional schedules, click the Discover button ( 33 ).
The Discovered pane opens with the additional schedule(s).

Step 6. Select the schedule records to export in either pane.
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Step 7. Click the Export button (|, |) for the pane.
The Export window opens.

[

Title |Di5tri|:|uted Schedule Manager - Database |
Export Range |-ﬁ-|| |
File Type |PDF |

Step 8. Fill in the properties and click Ok.

Another way to discover and export schedules

This method uses the Station Device Properties view to discover and export schedules.
Step 1. If needed, return to the main menu.

Step 2. Click System/Controller Setup > Remote Devices > Station Manager.
The Station Manager - Database view opens.

Step 3. Select a station and click the Summary button in the toolbar.
The Station Device Properties view opens.

Step 4. Choose the Device Exts tab and click on the Schedules link.
The Distributed Schedule Manager - Database view opens.

Step 5. Click the Export button (| ).
The Export window opens.

Step 6. Fill in the properties and click Ok.

Matching schedules

It is important to keep shared schedules up-to-date between the Supervisor and remote stations. Schedules
may get out of synchronization for any number of reasons. For example, if you remove a Supervisor from a
remote Station Manager Database, the system deletes from the remote controller station any schedules that
are mastered on the Supervisor. You use the match feature to recreate and synchronize schedules between the
remote and Supervisor stations.

Prerequisites:
You are working in the Supervisor station. The Supervisor and remote platforms are connected to the shared
network and both stations are running.

Step 1. Click Schedules > Schedules.

Step 2. Click the Discover button (agg ).
The system runs a schedule discovery job to learn (find) and display the schedules that are
available. When the discovery job finishes all discovered objects appear in the Discovered pane
below the Database pane. It is important to discover from the Supervisor station before doing
anything else to make sure that the latest schedules are available in the Supervisor and remote
stations.

Step 3. Do one of the following:
* If schedule changes do not appear in the remote stations, initiate a replication from the
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Supervisor station.

e If the schedule exists in both stations, select the schedule in the Discovered pane and click
the Match button (

=]
).

When you match a schedule between a Supervisor and remote controller stations, the Supervisor
version takes priority and overwrites the remote controller version of the schedule so that they are
the same.

NOTE: To keep the schedule, remove the schedule out of the NiagaraNetwork using Workbench
and change the schedule’s read-only flag.

Result

If you rename schedules, do it only while the Supervisor and subordinate stations are both online to allow for
synchronization. If you rename a schedule while a Supervisor and subordinate are disconnected, you must
discover and match each schedule in the remote stations.

Upgrading a device
Individual devices require updating if you changed the device or if the device’s firmware needs upgrading.

Step 1. From the main menu, select Controller Setup > Remote Devices > Remote Modules > Remote
Module Setup.
The Access Device Manager-Database view opens.

Step 2. Check that the modules have the latest firmware version by comparing the Installed Version
Column with the Available Version column.
NOTE: During a firmware upgrade, the modules are taken off-line temporarily. If a system is in
use, the upgrade process makes the system unavailable until the upgrade is complete.

Step 3. If the Available Version number is greater for any of the modules, click the Upgrade Firmware
button.
This initiates the upgrade on all modules in the database. You do not have to select a module for
the system to upgrade it. The system reports Upgrading Access Devices.... After the upgrade, all
modules should have the same firmware version number.

Supervisor platform upgrade

These procedures are unique to upgrading the Supervisor PC.
You may need to upgrade the software running on the Supervisor PC for several reasons:

* A new software version is available.
¢ New features need to be added to the system.
* The PC needs to be replaced.

Updating reader count

Before deleting a subordinate station, you should update the reader count. This action updates the counts for
all hardware components and removes items that no longer exist.

Step 1. Click (System Setup > Miscellaneous > Server Maintenance).
The Maintenance view opens.

Step 2. Click the Update Reader Count button.
This action updates the counts for all hardware components and removes items that no longer
exist.
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Removing the Supervisor from a remote station database
You may need to remove the Supervisor from a remote station database if you are replacing or adding a new
Supervisor PC to the network.

Step 1. While connected to the remote station, click Controller Setup > Remote Devices > Station
Manager.

Step 2. Select the Supervisor station row and click the Delete button (| & |).
The system removes the Supervisor station. In the process it also removes any schedules that
were mastered on the Supervisor. You will need to discover and match schedules in the remote
station with the schedules in the new Supervisor.

Remote controller upgrade

If your controller is connected to a Supervisor, upgrade the Supervisor first and then upgrade the controller
station from the Supervisor.

The procedures in this section are unique to upgrading a controller. There are several reasons to upgrade the
software in a controller:

* A new version of software has come out.

* The company wants to implement new features.

* The controller needs to be replaced with a new controller of the same model.
* The controller is being replaced by a different model controller.

If the upgrade is replacing the current software without making a hardware change, you should back up the
station by making a distribution file backup or a station copy, but you may not need to restore the station after
the upgrade.

If you are replacing the controller with a new controller of the same model, a distribution backup of the station
is the recommended best practice for upgrading the software.

If you are replacing the controller with a different model, a distribution file will not work. You must make a copy
of the station instead.

Disconnecting an old controller

Before you disconnect the existing controller, make sure that you take a note of its IP address and other
network settings. You will need to enter this information into the replacement controller before it will operate
on the network.

Step 1. To take note of the network settings, select Controller Setup > Miscellaneous > Network TCP/IP
Settings.
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Network Settings (changes to these settings require a reboot to take effect)

Station Name |sntSecurityS01

Hast Name [lo=athast
Use IPvE
Damain [

IPvd Gateway [182.188.1.1

DMSvd Servers{oomma separated) 19216211

IPvE Gateway [

DMSvE Servers{comma separated) |

Io )|
Deseription Onboand Etfemrnat Afspler mn0
Phy=ical Address 00:01:F:BECE-DC

Adapter Enabled Enabled .
DHCPvd Diizal=d .

IPv4 Address [132.288.0.9
IPvd Subnet Mask [z55.255.28550
IPvE Support e
IPv6 Enabled
Obtain IPvE Settings Automatically [ve=
IPvE Address [
IPvE Network Prefix Length [a
Interfares
ID =nl
Description Onboand Ethernet Acapler enl
Phy=ical Address 00:01:F:BE:CE-DD

Adapter Enabled Enatled .
DHCPwd Dizatizd[w |

IPvd Address |1§2.1EE.2.121
IPvd Subnet Mask |255.255.255.D
IPwG Support s

Step 2. Take a screen capture or write down the properties.
Scroll down. There are a lot of properties in this view.

Step 3. Remove both AC and battery backup power from the existing controller.

Step 4. Wait for the controller to shut down, then disconnect all connectors and remove the controller
from the cabinet.

Step 5. If the existing controller has an option card, remove the card.
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Installing the replacement controller

If an option card (module) was damaged when the controller failed, you may need to purchase a new option
card. If possible, try to install the option card from the previous controller into the new controller using the
same slot as on the old controller.

Step 1. Install the new controller in the cabinet and plug in the connectors for on-board 1/0O, remote
modules, and your PC.

Step 2. Apply power and connect the backup batteries.

Step 3. Set up your PC network adaptor to an IP address that is compatible with the controller’s default IP
address: 192.168.1.120.

Step 4. Open the new controller platform.
Step 5. Continue with the configuration steps in this chapter.

Creating and updating the HSQL database password

Each controller ships from the factory with a default HSQL database password and upgrading an AX station to
an N4 station resets the HSQL database password back to the factory default. While the default password

initially works, as soon as you install or upgrade a controller and its software, you should change this password
to a unique and strong string. The password is automatically generated and successfully stored in the key ring.

Prerequisites:
You have just installed a new controller or upgraded an existing controller from AX to N4. You are using
Workbench running on a PC that is connected to the network that services the controller.

Step 1. Connect to the controller station using Workbench.
Step 2. Expand Config > Drivers > RdbmsNetwork.

Step 3. Right-click HsglDbDatabase and click Actions > Ping. The health property is updated based on the
ping results.
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(Station_811) . Station (Station_811) ! Config . Drivers . HsglDbDatabase / ‘Property Sheet -
- .7 -
Nav O Actions & Topics  [B Slot Details
i~ N
t O @ My Network Display Name Value Commands
@ -[Station_811) [ Status {ok}
&' Platform [ Enabled true @
# Station [Station_811) .
@ Fault Cause
‘ Alarm
© config B3 Health Fail [null]
@ Services O Alarm Source Info Alarm Source Info
6 orivers [ User Name
MiagaraMetwaork
e 2 & Worker Rdbms Worker
e BacnetNetwork
; HsqlDbDatabase L Export Mode By Historyld +
@ surveillanceViewer (M Use Unicode Encoding Scheme @ false
) 4 - .
© sops @ Timestamp Storage Dialect Default  ~
a Logic .
@ Points Rdbms Point Device Ext
@ Files
@ History [m Sql Scheme Enabled @ false
9, Rdb Security Settings Rdb Security Settings
(@ Base Directory file:**hsqldb » v
[ Database Name
™ Defrag On Save @ false
- Palette @ Defrag And Save Periodic Schedule 30 days {Sun}

NOTE: Starting in Niagara 4.14, the HsglDbDatabase component properties Use Encrypted
Connection, User Name, and Password are replaced with a single Privileged Username
property. The HSQL database is automatically generated and not editable or visible. When using
HSQL, if the station keyring is corrupted, you need to load a backup station, as this instance of
the HSQL database is no longer operational.

Step 4. To access a new HSSQL database instance in the N4 station, right-click the HsglDbDatabase,
navigate to Views > Property Sheet.
The device's Property Sheet opens.

Step 5. Enter the User Name as SA and click Save.

Step 6. Right-click HsqlDbDatabase and click Actions > Ping. The health property is updated based on the

ping results.

Software upgrade
A release of the system is based on product development cycles and may lag or skip general releases of the
Niagara Framework.

License requirement

CAUTION: After commissioning a controller with upgraded software, it reboots. While it is rebooting, all door
lock relays are de-energized, and card readers do not respond. This may leave doors locked or unlocked, and
building occupants may be locked out, or non-authorized people may gain access. Plan ahead and be prepared
for how to deal with the system being down for five to ten minutes while the controller reboots.

Upgrading software may or may not require a new license and the installation of new software.

Before you upgrade
Before you install a new version of software, use this checklist to prepare the station:
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* On your Supervisor PC, verify that the MySQL database reports {ok}.
® Confirm that you can connect to all devices.

* Resolve any reported alarms.

Make a station backup
Before upgrading any station, you should back up the station and save the backup file in a safe location. There
are two ways to back up a station:

¢ Create a distribution (.dist) file of the station. You would use this backup method if you are upgrading just
the software or are replacing a controller to the same model as the current controller.

e Perform a station copy. You would use this backup method if you are upgrading to a different controller
model.

Driver modules

Be careful copying driver modules from a previous version of software to a new version. For example, an old
version of the Milestone XProtect camera driver is xprotect-se.jar. The newer version is xprotect-
wb.jar. Do not run a system with both files in the modules folder.

Backing up a station using the web Ul

A station backup, which creates a distribution (.dist) file is the most complete way to back up a station. It
includes all station data and module-dependent information. This type of backup automatically de-crypts the
keyring (used to secure encrypted passwords) and stores the passwords in the .dist file. This procedure backs
up the station you are currently logged into. This may be the Supervisor station or a remote controller station.
You use this type of backup to replace a controller with another controller of the same model and software
version and to install software on multiple same-model controllers.

Prerequisites:
Your PC is connected to the network with the remote controller. You are using the web Ul.

Step 1. Open one of the supported web browsers (IE or Firefox) and connect to the remote station.

Step 2. From the Home view, click Controller (System) Setup > Backups.
The Backups view opens.

& Personnel #% System Setup /b Threat Levels

& Monitoring

@ Schedules & User Management 8= Backups #* Remote Devices &% Access Setup  &F

Save | H& System Backup | = Local Backup | € Restore

Backup Archive Backup Schedule Recent Backup History

L @ =

E[ﬁle:Nhackupsfhackup_entSecSupTest_[]1_181212_1349.di5t 12-Dec-18 1:49 PM EST Local
B& file:~backups/backup_entsec_181212_1346.zip 12-Dec-18 1:47 PM EST System

Step 3. Continuing with the web UI, click the Local Backup button.
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Step 4.

Step 5.
Step 6.

Step 7.

Step 8.

Step 9.

A Local Backup window opens.

Local Backup

! Archive Backup on Supervisor
| Download Backup

[k [ conel

The first option saves the file in the backups folder under the Supervisor station. The second
option automatically downloads the backup to the computer’s Downloads folder.

To continue, click Ok.
The Job window displays a progress bar while the backup job runs. When the job is finished, the
Local Backup window opens.

Local Backup

Success
Show Details

Click the Show Details link to open a window that displays the history of this backup job.

To save the backup *.dist file to a designated location, click the Download button.
The browser prompts you to open or save the file. You cannot save it to the controller.

NOTE: You must save the file within five minutes of creating it. If you view the file, it opens from a
temporary directory. You must designate a save-to location to save the file to a location other than
the temporary location.

Save the file to a location other than the System Home or User Home, giving the file a short name
that identifies the station.

¢ Choose to save the file.

* Choose to open the file.
If you chose to save the file, a browser prompts you to open the Downloads folder. If you chose to
open the file, you can save it from the opening application interface (this must be a file-
compression application).

Make a note of the date and where you saved any downloaded backup files so you can find them
later.

As a best practice, consider renaming the resulting backup . dist file to a short, meaningful
name.

If the .dist file is for a new Supervisor or engineering workstation on a different PC, copy the
backup .dist file to the new PC, otherwise leave the backup .dist file in the backups folder.

Backing up a station using the BackupService

You may use this procedure to manually back up a single Supervisor or controller station. The Niagara
Provisioning Guide explains how to set up a job prototype to back up all stations on a network.

Prerequisites:
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You are using Workbench running on a PC and are connected to the remote station.

Step 1. Expand Config > Services and double-click the BackupService.
The Backup Manager view opens.

Step 2. To back up the station, select the station and click Backup.
A File Chooser window opens with a default location and name for the backup. The default
~backups folder is in the user home: C:\Users\<user name>\<framework
version>\tridium\backups where:

® <user name> is the name that identifies your PC

e <framework version> identifies the current version of the Niagara Framework.

Step 3. To change the backup location, use the icons at the top of this window or accept the default and

click Save.
The BackupService creates a . dist (distribution) file of the station in the folder you selected.

Viewing distribution file backup history

Before restoring a data backup, you may choose view the list of existing backups to see when the last backup
was made. This procedure uses the web Ul. It works for viewing backups of a Supervisor or remote station.

Step 1. From the main menu, select System (Controller) Setup > Backups.
The Backups view opens.

Step 2. Click the Recent Backup History tab.

Heports My 1hreat Levels

=@ Home &’ Monitonng i Fersonnel

B Schedules & UserManagement A= Backups &% Remote Devices #F Access Setup &% Intrusion

B Local Backup || @ Restore

Recent Backup History

Py

% o

=

W
26-May19 9:53 PM UTC AccessController-801 hx:backup_~AccessControllerStation_1_190526_2153.dist
26-Apr-19 9:52 PM UTC AccessController-801 hx:backup_~AccessControllerStation_1_190426_2152.dist
26-Mar-19 9:51 PM UTC AccessController-801 hx:backup_~AccessControllerStation_1_190326_2151.dist

£ >

This tab lists all backup jobs that have been run.

NOTE: If the backup file was not saved or downloaded to a designated location, its file name may
be listed in this table, but it may not be available to restore.

Backing up a station using Station Copier

A distribution backup (.dist) depends on platform files, which makes it inappropriate when upgrading to a
different model host. The Station Copier can back up all the files and subdirectories in a station so that you can
restore the backed-up station to a different model host platform. In addition, Station Copier can back up just
the config.bog, or just a single folder. Station copies do not contain encryption keys or software dependency
information. This procedure works for both Supervisor and remote controller stations.
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Prerequisites:
You are using Workbench running on a PC that is connected to the network.

For Enterprise Security customers, the web Ul does not support the Station Copier.

Step 1.
Step 2.

Step 3.

Step 4.

Step 5.

Open a connection to the remote platform.

Expand the Platform node in the Nav tree and double-click Station Copier or double-click the
Platform node, and double-click Station Copier.
The Station Copier view opens.

(AccessControllerStation_1) . Platform / Station Copier -

- Nav Station Copier
f' G @ My Network @ Stations on this computer HT Stationson
@ My Hosts! /C:/Users/U123456 /Niagarad.8/d 0 /home/niagara/stations
y Host: e ’
e My File System accessContral801 AccessControllerStation_1
GM P AccessStation24
y Modules
Supervisor_48
Ou My Tools p copy
& Platform
4 Copy
Platform

- _— R
& Station [AccessSupervisor) El Emls
@ AccessControllerStation_1) x Delete

& Platform
# Station (AccessControllerStation_1)

Click the File icon ( Q ) on the Stations on this computer pane (left pane) and select the folder in
which to store the station copy.

CAUTION: If you are copying only a security folder from the remote to your PC, do not
overwrite the security folder in your PC. This folder contains encryption keys, which you will
need in the new controller to decrypt user passwords.

Select the station or folder and click Copy.
The Loading Module Information window opens followed by the Station Transfer Wizard.

Click Next.
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The wizard prompts you to select what to copy.

™ Transferring station " StationName "
Which station files are to be copied?

<> Copyfilesfrom selected directories
@& Copy every filein the station directory and itz subdirectories
<> Copy only the "config.bog” station databaze file

4 Back | p HNext | Finish ¥ cancel

This option defaults to Copy every file in the station directory and its
subdirectories. While Station Copier can back up just the config.bog, or just a single folder, it
is recommended that you always back up every file in the station directory and its subdirectories.

Step 6. Make a selection, and click Next.
If a station with the same name exists in the target location, the wizard prompts you to delete or

overwrite the existing station.

Step 7. Accept the default (delete), and click Next.
The wizard reminds you that the station must be stopped before it can be copied.

5. Station Transfer Wizard

™ Transferring station “TCP_IP"
Running station must be stopped

The station cannot be copied while it is running. It will be stopped before
copying begins, and restarted afterward.

Finish K cancel

Back

Step 8. To continue, click Next.
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The wizard asks you to review the copy configuration (changes).

If you selected only specific station subdirectories to copy, they are listed.

Step 9. If needed, click Back and make changes, or, to complete the wizard, click Finish.

The Station Copier saves the station, if the remote station is currently running, begins the copy
process and reports transfer status in the Transferring Station window.

~ _ _
Transferring station
u g

Completing transfer:

€D Transferfiles Success
0 Startstation(s] Success

Transfer complete.

Tranaferring files...
Sending ~stations/testl/config.bog

FileStore::commit
FileCachedFileStoreElement: :commit file written C:\ProgramData\Miagarad.T7\tridium\staticons

FileStore::commitInstance commit complete
Station "testl™ starting.
Transfer complete.

Close

The Station Copier saves the station if the remote station is currently running and

Step10. When the save completes, click Close.

The date for all copied files reflects when the files were copied.

Exporting the platform/station’s server certificate

Before upgrading software, you should export the platform/station’s server certificate so that after the
upgrade you can import it to the upgraded platform/station’s Key Store.

Prerequisites:
You are working in Workbench on a PC that is connected to the network.

Step 1.
Step 2.

Step 3.

Step 4.

Create a folder on the PC or a thumb drive to hold the server certificate(s).

Open a platform connection to the platform and double-click the Certificate Management utility
or right-click Platform, and click Views > Certificate Management.
The platform/station’s User Key Store tab opens.

Confirm that this is the Certificate Management view you expected.
The IP address of the platform/station is identified below the view title.

Select the server certificate and click Export.
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Step S.

Step 6.

Step 7.

The Certificate Export window opens.

Certificate Export *

Certificate

[# Exportthe public certificate

Tableview = ASN.lView PEM View

Properties:

Version V3

Serial Humber 45 dg 05 20 b3 1d 32 81 1f &3 02 06

Issued By TheCompanyRootlertificate

lsser DM CH=TheCompanyRootCertificate, O=Thelompany

q\ Private Key

[# Exportthe private key
Private Key Password (required): [T

[# Encrypt exported private key

E Reuse password to encrypt private key

OK Cancel |

Select to export the certificate with its private key, create a strong password and click OK.
The Certificate Export browser window opens.

Navigate to the folder you created and click Save.
A message confirms the export.

Record in a safe place the location where you saved the certificate and the private key password.
CAUTION: Keep all certificates exported with their private keys safe. Do not email this certificate.

Installing the upgrade on a PC

You install and start a new version of Workbench following the same steps documented in the Software
Installation chapter. This procedure summarizes the installation steps.

Prerequisites:
You are working in Workbench. You have either a distribution file or a copy of the Supervisor station and
controller station(s).

Step 1.

338

Using the Platform > Application Director disable Auto-Start and Restart on Failure, and stop the
current Supervisor station.
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Step 2. To install Workbench, extract the new software build and run the installer program.
Step 3. Follow the installation wizard as it sets up the System Home, User Home folders and shortcuts.

Step 4. Copy an updated license file to the C: \niagara\niagara[version numbers]\security\
licenses folder of the new build.

Step 5. Start Workbench and open a platform connection to the Supervisor.

Result
At this point, you can use the upgraded installation to upgrade the software on a controller by commissioning
the controller. But, before you commission, you should restore the Supervisor station.

Related information

e Software installation

Commissioning a controller with new software

Commissioning an existing controller with new software follows the same procedure as that required to
commission a controller for the first time.

Prerequisites:

* You are on site where the controller to be upgraded is located. Commissioning a controller from a remote
location is not recommended because the network connection could inadvertently be interrupted.

* You are running an updated version of Workbench is installed on a Supervisor or engineering PC, which is
on the same network as the controller.

* The target remote controller is running (powered on).

* The version of the software you are using to commission the controller has identical brand properties (as
defined in the license file) and is the same or a more recent version than that currently installed on the
controller. A brand.123 upgrade tool cannot upgrade a brand.xyz controller. A Supervisor station will not
connect to a controller on which a more recent version of software has been installed.

* Upgrading may require new licensing. The PC is connected to the Internet so that it can contact the
licensing server.

CAUTION: The reboot after commissioning de-energizes all door lock relays. Card readers do not respond.
This may leave doors locked (building occupants locked in or out) or unlocked (unauthorized access a
possibility). Plan ahead, and be prepared for how to deal with the system being down for five to ten minutes
while the controller reboots.

Step 1. Make a platform connection to the controller by double-clicking the Platform node for the
controller in the Nav tree.
The Authentication window opens.

Step 2. Enter the controller credentials.
The Nav Container View opens.

Step 3. Double-click the Platform Administration row in the table.
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The Platform Administration view opens.
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Platform Administration

&' View Details ‘

a User Accounts ‘

"\ System Passphrase ‘

% Change HTTP Port ‘

E] Change TLS Settings ‘

G-) Change Date/Time ‘

.:P Advanced Oplions ‘

7 Change Qutput Settings ‘

View Daemon Cutput ‘

View System Log ‘

r' Configure Runtime Profiles ‘

"‘ Configure NRE Memory ‘

T) Backup ‘

Step 4. Click the Commissioning button.
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Baja Version
Daemon Version
System Home
User Home

Host

Daemon HTTP Port
Daemeon HTTPS Port
Host 1D

Model

Product

Local Date

Local Time

Lacal Time Zone
Operating System
Niagara Runtime

Architecture

Tridium 4.5.74.4

45744

Jopt/niagara

[home/niagara
172.31.66.10(J8_Unit10_Fips)
3011

5011
Qnx-TITAN-ATAL-EB27-6CE0-343B
TITAH

JACE-3000

14-May-13

9:35 Eastern Daylight Time
America/Mew_York (-5/-4)
qnx-jace-nd-titan-am33sx-hs (4.5.74.6)
nre-core-qnrx-armle-v7 (4.5.74,4)

armle-wT

Enabled Runtime Profiles rt,ux,wb

Java Virtual Machine

oracle-jre-compact3-gnu-arm (Oracle Corporation 1.8.0.141.4.0)

Niagara Stations Enabled enabled

Number of CPUs
Current CPU Usage
Overall CPU Usage

Filesystem

Physical RAM

1
4%
9

Total
!/ 3,452,843 KB 3,284 3T6 KB
/mntfaram® 383215KB 393,017 KB
8,192 KB 3,131 KB

Free

Free

Smntfram®
Total
1,048 576 KB 78,984 KB

Files Max Files

374 109152
] 0
0 0
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The Commissioning wizard opens.

\ Commissioning

This wizard combines steps for configuring a host to run stations. Please check below foreach type of configuration
change you wish to make:

Request orinstall software licenses

[#] setenabled runtime profiles

[#] Install a station from the local computer

[ Install lexicons to support additional languages
nstalliupgrade modules

[# Install/upgrade core software from distribution files
[ syncwith my local system date and time

[#] configure TCP/IP network settings

[] configure system passphrase

[#] configure additional platform daemon users

ClearAll | Checkal

Finish X cancel

Back

Step 5. Follow the wizard, clicking Next until you configure all options.
Step 6. On the Software Installation page, click Upgrade All out of Date and click Next.

Step 7. After reviewing all changes, click Finish.
Commissioning begins.
CAUTION: Do not interrupt the commissioning process. If you interrupt, you may not be able to
restore the station.

Step 8. When prompted, click Close.
After the commissioning process is complete, the controller reboots. During the reboot, any
upgrades to the database required for the new version are automatically installed.

Restoring a controller station from a distribution file using the web Ul

A distribution file is used to upgrade only the software (the platform did not change), or to upgrade to a new
controller that is the same model as the old controller. Upon restore, the system automatically re-encrypts the
stored keyring to the key material file that is unique to each controller. This ensures adequate security for all
encrypted passwords. This procedure works for a Supervisor or a controller station.

Prerequisites:
You have a distribution file backup of the station. You are using the web UI.

Step 1. Login to the platform, and click Controller (System) Setup > Backups.
The Backups view opens.
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Step 2. Click Restore.
The Restore Options tab opens.

&a” Monitoring Reporis #% Controller Setup /b Threat Levels

&g Personnel

#% Access Setup  #F Intru

[ Schedules #% Remote Devices

E save

Restore Options

Fila| Choose File hachkup_ﬁlcce...ﬁ_l442.dist

ackup_AccessControllerStation_1_190426_1442.dist i

£, User Management  EBl= Backups

Step 3. Click Choose File and browser to locate the distribution (.dist) file.

Step 4. Click Save.
The system restores the station.

Restoring a controller station from a distribution file using Workbench

A software upgrade may require that you restore the controller station from a backup .dist file. This procedure
works for a controller station only. You cannot restore a Supervisor station from a backup .dist file.

Prerequisites:
A recent distribution (.dist) of the station exists.

Step 1. Open Workbench in the newly-installed build.

Step 2. Inthe Nav tree, right-click on the Platform node and choose Views > Distribution File Installer.
The Distribution File Installer defaults to the C: /Niagara/<framework version>/cleanDist
folder (where <framework version> represents the version of software).

Step 3. Use the buttons at the bottom of the view to initiate a restoration of your backed-up controller
station to the newly installed station directory.
If you just upgraded the controller software and chose to install the platform daemon during the
software installation process, your existing station may not start automatically with a new platform
daemon.

Step 4. Maintaining your platform connection, change views to the Application Director view and select
the newly restored station.

Step 5. To configure auto-start, enable the Auto-Start property.

Step 6. To start the station, click the Start button.
The station is now ready. A Supervisor station should communicate successfully with any
subordinate stations, which should operate normally.

Step 7. To log in to the station, double-click the station entry.

Restoring a copied controller station to a new platform

A copied station installs the station files from a previous controller to a controller that is a different model. This
procedure works for a Supervisor or controller station.

Prerequisites:

The new controller is running Niagara 4.9 or later. You have a station copy that was made before disassembling
the old controller. You are working in Workbench running on a PC.
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First you stop the new station, then copy the hardware certificates and software licenses folder, followed by

copying the backed-up station.

Step 1. Open a platform connection to the remote controller.

Step 2. Stop the station using the Application Director.

File  Edit  Search
4 O- o A
172.31.66.10 (AccessControllerStation_1)
- Nav

tf O

@ My Netwark

b @ My Host: o
@ My File System
0 My Modules
ﬁ My Tools
BT Platform
Platform
@ Station [AccessSupervisor)
v e 172.31.66.10 (AccessControllerStatio
w Jr Platform
e Application Director

Step 3. Open the File Transfer Client and, on the controller side, delete the security folder on the

Bookmarks

. Platform

Tools  Window  Help

|I|.' D r

Application Director

Connected to 172.31.66.10
Name Type  Status  Details

EAmCDntrollerStation_l statiom Runmning fox=n/a,foxs=4911 http=n/a,https=443 true

[# Auto-Start
com.tridium.ndriver.comm.http.HttpComms LinkSession.
com.tridium.ndriver.comm.http.HttpComm. sendRequest |
com.tridium.naxisVideo.BAxisVideoCamera.doFetchPres
auto.com tridium naxisWVideo BAxisWVideoCamera.inwoke Start

com.tridium.sys.schema .CompEnem;SlotMap. invoke (Comp

com.tridium. sys. schema.ComponentSlotMap. invoke {Comp
javax.baja.sys.Blomponent. invoke (BComponent. java:12 Restart
Reboot

com.tridium.naxisVideo.BAxisVideoCamera. fetchPreset
com.tridium.naxisVideo.BAxisVideoCamera.doPing (BAxi
Kill
Numn Throode |

[#] Restarton Failure

javax.baja.driver.ping.BPingMonitor.checkPing (BPing
javax.baja.driver.ping.BPingMonitor.run (BPingMonitao
java.lang.Thread.run{Thread.java:748)

controller side (the security folder is in the /Niagara path).
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Step 4.
Step 5.

Step 6.

File  Edit  Search Bookmarks

4

~

O- o A O

. Platform
- MNav

1

L8]

|7 @ My Netwaork

& Station (AccessSupervisor)
v @ 172.31.66.10 (AccessControllerStation_1
v @ Platform
@ Application Directar
0 Certificate Management
@ pistribution File Installer
e File Transfer Client
@, |EEE 802.1X Configuration
0 Lexicon Installer
@ License Manager
o Platform Administration
O Software Manager
e Station Copier

Tools

window

G =~

Help

File Transfer Client

@ Files on this computer
[ 1]

Mame

O zradle

© applicationTemplates
0 audits

0 backups

© certManagement

© daemon

Q© dev

0 etc

O help

Q library

Niagara Enterprise Security Installation and Maintenance Guide

»

File Transfer Client -

FT Fileson "172.31.66.10"
1 ]

Name

© daemon
QO etc

0 logging
0 registry
O security
O shared

O stations

<
x|

Change directory
Transfer to local compute
Delete

Refresh

Navigate to the location that contains the backup of the security folder.

To restore the backup security folder to the controller's /Niagara folder, select the folder in
the left pane and click the copy button ( » |).

To copy the station, double-click the Station Copier Platform utility.
The utility opens.

(AccessControllerStation_1) . Platform

- Nav

t O [X] |® Mynetwork
v @MyHost:'- * ol g

b @Y My File System
4 0 My Modules
> J’ My Tools
» BT Platform
Platform
A Station (AccessSupervisor)
v Q@

© BT Platform

AccessControllerStation_1)

4 # Station (AccessControllerStation_1)

Station Copier

@ Stations on this computer

/C:/Users/ U123456 /Niagarad.8/d 0

accessControl3ol

AccessStation24
Supervisor_48

4

Station Copier -

&T Stationson -

/home/niagara/stations

AccessControllerStation_1

p Copy

4 Copy

[] rename
I

¥ pelete

Step 7. Navigate to the folder in the User Home that contains the station, select the station in the left

344

pane, and click Copy.
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The station may be under an earlier version of Niagara.

Starting the restored controller station

After restoring a station from a . dist file, you can perform the following task to restart it.

Prerequisites:
You have restored a station from a .dist file. You are working in Workbench.

Step 1.
Step 2.

Step 3.

Step 4.
Step 5.
Step 6.

Open a platform connection to the restored controller.

If the system reports that it is unable to verify the host identity, verify that both Issued By and
Subject contain Niagara4, and click Accept.

Open the Application Director and verify that the station started or is starting.
If you chose to install the platform daemon during the software installation process, your existing
station may not start automatically with the new platform daemon.

File  Edit Search  Bookmarks Tools Window  Help

4 O- o A O [ =~ [2 »
172.31.66.10 (AccessControllerStation_1) . Platform / Application Director
- Nav Application Director
1 'S’ @ My Netwark Connected to 172.31.66.10
- Name Type  Status Details Auto-!
Platform

== AccessControllerStation_1  station  Starting fox=n/a foxs=4911 http=n/a https=443 true
& Station (AccessSupervisor)

@ 172.31.66.10 {AccessCantrollerStation_1

& Platfarm INFO [nre] Launching Niagara Runtime Environment [# Auto-Start
INFO [10:21:50 27-Jun-19 UTC] [nre] Booting )
& Application Director INFO [10:21:56 27-Jun-18 UTC] [sys] Logging initializ [#] RestartonFailure
. WARNING [10:21:56 27-Jun-19 UIC] [sys]
€ certificate Management Start
@ Distribution File Installer Stop
@ File Transfer Client Restart
Q.. |EEE 802.1X Configuration Reboot
@ Lexicon Installer Kill |

If the station is not already starting, click the Start button.
Confirm that the station has started (Status reports Running).

To configure the station to start automatically in the event of an unexpected failure, enable the
Auto-Start property.

March 21, 2025 345



Maintenance Niagara Enterprise Security Installation and Maintenance Guide

Auto-Start

* If the electrical grid drops power to the building, an UPS (Uninterruptible Power Supply) or
other backup battery can maintain power to the controller and its access network as long as
is practical.

¢ If an emergency generator starts, the controller, access network, door locks and sensors
should be powered by critical circuits to the extent that the company considers physical
security to be a priority.

* If power to the controller ultimately fails, the system backs up the station automatically.

* When power is restored, the platform should automatically start the station and restore
physical security to the building (unless the building’s occupants over-road the door locks)
with no operator action.

Restart on Failure
e If the station fails, it automatically attempts to restart.

* AFailure Reboot Limit (defaults to three attempts) defines how many times a station
attempts to restart within a specific Failure Reboot Limit Period (defaults to 10 minutes).
You can configure both.

Step 7. To log in to the station, double-click the station entry in the Nav tree.

Result
The station is now upgraded. A Supervisor station should communicate successfully with any subordinate

stations, which should operate normally.

Importing a server certificate into an upgraded platform/station

After upgrading software, you import the exported server certificate back into a platform/station. Do this for
each Supervisor PC and platform/station. This procedure is not required by the Workbench stores because
Workbench is always a client, never a server.

Prerequisites:
You are working in Workbench running on a PC.

Step 1. Open a platform connection to the platform and double-click the Certificate Management utility
or right-click Platform, and click Views > Certificate Management.
The platform/station’s User Key Store tab opens.

Step 2. Click Import and navigate to the folder that contains your backed-up server certificates.

Step 3. Select the supervisor or controller certificate and click Open.
This certificate was exported with its private key.

Step 4. Supply the password that protects the private key and click OK.
The certificate opens.

Step 5. Confirm that the Alias, Issued By, and Subject are as expected and click OK.
The system imports the certificate.

Connecting to the upgraded controller station

Once upgraded, you connect to either a Supervisor or controller station.

Prerequisites:
You are working in Workbench running on the Supervisor PC.

Step 1. Right-click the station in the Nav tree and click Connect.
The Authentication window opens.

Step 2. Enter the admin station credentials.
The Platform Setup view opens.
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Step 3. To change the display names, enter new names and click Update Display Names.

Step 4. To keep the network settings as they are, click Reload Without Changes.
The Guided Setup Tour window opens.

Step 5. If you do not need the tour, select Skip Guided Setup and click Ok.

Upgrading a license using the web Ul

Updating a license is similar to installing a new license. The License Manager for updating a license is available
under the station in Workbench and in the web Ul. This procedure uses the web UI.

Prerequisites:
The new license is for a software version that is greater than or equal to the version you are upgrading from.
You are performing this procedure during off hours when few people require access to the building.

Step 1. Navigate to Controller (System) Setup > Miscellaneous > License Manager.
The LicensePlatformService view opens.

9 Home | | &a° Monitoring 1 & Personnel Reports Sl ST | Threat Levels n[agara

Frarmawirh

B Schedules & User Management 0+ Backups &% Remote Devices &% Access Setup &Y Intrusion Setup  £% Alarm Setup

Step 2. To select the license file to install, click the Browse button.

Step 3. Select true for Restart station after upload.
The system does not update the license until the station restarts.

Step 4. To continue, click Upload.
The controller reboots.

NOTE: While the controller reboots, all door lock relays are de-energized, and card readers do
not respond. This may leave doors locked or unlocked, and building occupants may be locked out,
or non-authorized people may gain access. Make sure to plan on how to deal with the system
being down for 5-10 minutes while the controller reboots.
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Rejoining a replacement remote controller to the Supervisor station
After the controller has been replaced, and the station has been configured, you will need to join the controller
to the Supervisor to synchronize the cardholder database.

Step 1. Unplug your PC and plug in the network cable that was plugged into the old controller.

Step 2. If you are connected to a Supervisor PC, use Workbench to confirm the new controller has
connected to the Supervisor.
Make sure that the network variables are set correctly, the ports are open, and communication
can be established.

Step 3. To join the new controller station to the supervisor click Controller Setup > Remote Devices >
Station Manager, discover and select the station in the table and click the Recovery button (| g ).

Step 4. Open the Station Manager and observe that the replication status for the newly-replaced
controller reports {ok}.

Step 5. To confirm that access activity at the controller is shown in the Supervisor activity report, Reports
> Access History.
The door open test should appear on this report.

Clearing browser cache after a license upgrade

You may need to upgrade a license if you are adding features to the installation.
If you update your license file you may need to clear your browser cache to view the updated file. The
following steps may vary, depending on your browser version.

* Microsoft® Internet Explorer Select Tools > Internet Options and click Delete Files... under the Temporary
Internet files heading. Then click the Ok button.

* Mozilla® Firefox™ do one of the following (depending on your version, the steps may vary).
* SelectTools > Clear Private Data and click Clear Private Data Now with the Cache option checked.

* SelectTools > Clear Recent History..., select the Cache option and click Clear Now.

Troubleshooting

These suggestions and procedures can help you resolve problems that occur when installing, upgrading, and
maintaining stations.

Networking
To run through this checklist you need a computer that has Workbench installed. The computer must be on the
same network as the remote controller(s).

Are you having networking issues?

You configure network properties in the operating system. Although you can view network settings using
Workbench and the web Ul, you configure them in the operating system.

Database
Do you have a MySQL or other database? Is it running?

If you do not have a database, you will need to download and install one. Refer to the Software Installation
chapter.

If you are using a MySQL database, do you have the database driver in the C:\Niagara\MySoftware\jre\
lib\ext folder, where MySoftware is your version of the system.

The driver filename is mysgl-connector-java-5.1.11-bin.jar. Refer to the Software Installation chapter.
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Platform

Is the daemon process running?

If not, or if a different (older or newer) version of the daemon is running than the one that comes with the
version of the system you are using, you need to install the daemon (Windows Start menu, followed by
expanding the software folder and clicking Install Platform Daemon command.

Is the platform running?

Launch the Enterprise Security, right-click Platform, click Connect, and log in with valid platform credentials.

Station
Is the station running?

If not, double-click the platform, double-click the Application Director, select the appropriate station template
and click Start.

What messages are reported in the station log?
To view the log, double-click the Application Director and select the running station.
If you are using a MySQL database, can the station find the database?

To check this in Workbench, expand Station > Config > Drivers > RdbmsNetwork, and double-click
MySQLDatabase.
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Figure 41. MySQlDatabase properties

MySQLDatabase (MySQL Database)
O @ Status [{ok}
O (@ Enabled (D) true [ -]
O ) Fault Cause |
m Health Ok [20-Jun-17 11:37 AM EDT]
L Alarm Source Info Alarm Source Info
O ) Host Address |IF' |v | |l|:|:'.a1h|:st | » B~
O ( User Mame ladmin |
O & Password [sessense |
g Worker Rdbms Warker
O ) Export Mode |Eh; History Id |1|r |
O ) Use Unicode Encoding Scheme
= @ Points R.dbms Paint Device Ext
O & Sqgl Scheme Enabled =
2 Rdb Security Settings Rdb Security Settings
O ) Database Name lentsec
O @ Port (33086 |
i Histories MySCL History Device Ext
O ) Extra Connection Properties |
Z Refresh Save

If the station and database are connected, the Health property reports Ok.
Other properties to confirm on this property sheet include:

¢ |s the Host Address correct?

* Are the Username and Password correct? These are the credentials required by the database, not your
credentials.

¢ |s the Database Name correct?

® |s the Port correct?

Certificates
Does the host (Supervisor PC or remote controller) have a unique signed server certificate in its Key Store?

This certificate must be signed by a CA root certificate, either one belonging to your company, or one supplied
by a third-party Certificate Authority. This certificate provides communication security when the platform

functions as a server.

Does the host have the signed root CA certificate in its Trust Store?
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This certificate provides communication security when the platform functions as a client.
Related information

Software installation

Qand A

This topic covers questions users ask as they install and use the software.

A person authorized to manage the system is locked out.

The user type associated with the person’s assigned role may be locked out because in attempting to log in,
the person exceeded the maximum number of failed log-in attempts. At the Supervisor station, click System
Setup > User Management, select the user type and click the Clear Lockout button, which displays at the top
of the view. Clicking this button immediately clears the locked-out state.

Is there a way to reset a controller to the factory defaults?
Yes. Turn the controller off. Hold in the reset button, and turn the power back on.

CAUTION: These steps wipe all data off the controller including all software. Do not do this unless you fully
understand the implication. If you are concerned about losing data, back up the station before you restore
factory defaults.

For more information, refer to the JACE-8000 Install and Startup Guide

| scheduled a report to be sent by email, but the recipient did not receive the report.

The system sends scheduled reports based on a schedule transition from a false to a true output state. This
means that if the schedule you are using is already in a true output state when you assign the schedule to the
report, the system does not send the report. The assigned schedule output must transition to false and then
to true for the report to be sent.

When installing a new controller, the Change Platform Defaults Wizard displays these messages when |
attempt to create the System Passphrase: “Request to platform daemon at ... failed: System Pw: Failed
to check system password,” and “Invalid passphrase, factory default value provided.”

You must change the password. You cannot use the factory default passwords.

The video from a camera appears stretched out, distorted or has black bars on the sides.

The camera’s Preferred Resolution may be linked to the video stream options and inherited. In some cases,
this may adversely affect the aspect ratio of your streaming video. Try setting the camera’s Preferred Aspect
Ratio to the Standard Definition option.

These camera options are available by clicking Controller Setup > Remote Devices > Remote Drivers followed
by double-clicking the driver row for the camera or DVR in the table, clicking the Cameras tab, and double-
clicking the camera row in the table.

| have a database that is configured and reports {ok}, but when | try to add records to it | get “Cannot
display page, HTTP ERROR 500, Problem accessing /ord. Reason: password must be at least 112 bits”
You have a license for FIPS mode and a station password does not meet the FIPS minimum requirement of a
14-character password (112 bits).

My xprotect camera will not connect or it connects, but drops off-line.
Confirm that you have only one xprotect driver module in the c: \Niagara\MySoftware\modules folder.
The name of the driver module is: xprotect-wb.jar. Delete any other driver files.

| created a MySQL database and successfully ping’ed it to confirm that it is on line. Even so, my station
indicates that the database is down.

Did you download the Connector/J from the MySQL web site? If yes, did you rename it from its downloaded
name to mysgl-connector-java.jar? Finally, did you copy the renamed connector to your
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niagara.home\jre\lib\ext folder?

If you forgot any of these steps, do them now, restart your station and confirm that the database is running.

Adjusting controller memory

Large applications with multiple readers, persons, badges and zones may experience memory issues that cause
remote station crashes. Adjusting the NRE (Niagara Runtime Environment) memory pools can provide room for
station operations.

Prerequisites:
You are using Workbench and are connected to a remote controller platform.

To adjust the memory pools values for Niagara Enterprise Security 4.10 follow the below mentioned steps:

Step 1. Double-click Platform Administration.
The Platform Administration view opens.

Step 2. Click Configure NRE Memory Pools.
The Configure NRE Memory Pools window opens.

Configure NRE Memory Poole X

Configure NRE Memory Pools
Configurs the memory allocation sizes of this platiorm’s Miagara Runtime Environment

System Reserve: The System Reserve iz used to reserve system memaory for background system s=rvices that otherwize would be
consumed by the Miagara Runtime Environment. Increasing the System Reserve can promote overall system stability.
A minimum size of ¢ MBis reguired.

Heap Space: The Heap Space isused to allocate memory and storereferences fornew Java Objects. Heap Space sizerequirements
willincrease with the numberof componentsin aMisgara Station. A minimum size of 54 MB isrequired.

Meta Space: The MetaSpace stores class and method data, staticvariable datz, and otherintzrnal Java VirtualMachine metadata.
Meta Space size requirementstypically increase asmoremodules are instzlled on & platform. & minimum size
of 34 MB is required.

Code Cache: The Code Cachz isuzed to store native code praduced by the Java UM Just In Time (JIT) Compiler. Increazing Code
Cachemay improve the perfformance of your Miagara Station butmay riskexhaustingothermemory pools.
Aminimum size of 2 MBis required.

RAM Disk: The RAM Disk stores station alarm and history dats. RAM Disk size requirementswill increase withthe number of
history and alarm records in aMiagara Station, A minimum size of 4 MBis required.

[ System Reserve Size ¢4 ME[ Heap Space Size 350 ME [T Meta Space Size 55 ME [T Code Cache Size 16 ME [l RAM Disk Size 320 MB

" Use Defaults |

Step 3. Using the sliders, adjust the memory pools values as per requirement and click Save:
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e System Reserve Size: 64 MB
* Heap Space Size: 360 MB

* Meta Space Size: 56 MB

e Code Cache Size: 16 MB

¢ Ram Disk Size: 320 MB

This will provide adequate memory to accommodate the needs of Niagara Enterprise Security
4.10

NOTE: By default the memory values forNiagara Enterprise Security 4.11 are set as follows:

Configure NRE Memory Pools X

Configure NRE Memory Pools
Configure the memory allocation sizes of this platform’s Niagara Runtime Environment

System Reserve: The System Reserve is used to reserve system memory for background system services that otherwise would be
consumed by the Niagara Runtime Environment. Increasing the System Reserve can promote overall system stability.
A minimum size of 0 MB is required.

Heap Space: The Heap Space is used to allocate memory and store references for new Java Objects, Heap Space size requirements
willincrease with the number of componentsin a Niagara Station, A minimum size of 64 MB is required.
Meta Space: The Meta Space stores class and method data, staticvariable data, and otherinternal Java Virtual Machine metadata.

Meta Space size requirements typically increase as more modules are installed on a platform. A minimum size
of 34 MB is required.
Code Cache: The Code Cache is used to store native code produced by the Java VM Just In Time (JIT) Compiler. Increasing Code
Cache may improve the performance of your Niagara Station but may risk exhausting other memory pools.
A minimum size of 6 MB is required.

[~ System Reserve Size 0 ME[ Heap Space Size 334 ME [~ Meta Space Size 64 MB [T Code Cache Size 32 MB

Use Defaults Save

System Reserve Size: 0 MB
* Heap Space Size: 384 MB
Meta Space Size: 64 MB
Code Cache Size: 32MB

Connection errors

These errors you may see in the Station Manager view, in the Station Error window, or buried in a log after you
click Details.

AlreadyParentedException ... Client credentials

Cannot complete reverse connection to address:ip:[address]

Attempting to connect the remote station to the Supervisor station from the standpoint of the Supervisor
station. This error indicates that the remote station cannot find the Supervisor station. The Supervisor platform,
which should be identified as localhost, is unknown to the system. This can happen if you are attempting a
connection over a VPN (Virtual Private Network).

Cannot complete reverse connection to address: ip: [IP address of the remote controller], reverting to
oldAddress

The connection timed out.

Cannot connect from remote station to local station
Attempting to connect the remote station to the Supervisor station from the standpoint of the Supervisor
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station. The attempt timed out.

Failure during remote configuration of station [station name]
Attempting to connect the remote station to the Supervisor from the standpoint of the remote station.

Failure during reverse side disabling of ‘[station name]’
Attempting to delete a station from the Station Manager view.

Mismatched station names: [station name1] != [station name2]
Attempting to connect the remote station to the Supervisor from the standpoint of the Supervisor station.

Removed local NiagaraStation for ‘[station name]’ even though reverse side could not be reached.
This message goes with “Failure during reverse side disabling of ‘[station name]’

Station name [station name] already exists, station names must be unique

Instead of adding the new station, click the Edit button ( Ex| ).

SysDef extension not in a valid state to change roles: {down}

Attempting to connect the remote station to the Supervisor station from the standpoint of the Supervisor
station.

The station [station name] cannot be a supervisor
Attempting to connect the remote station to the Supervisor from the standpoint of the remote station. The
software attempts to treat the Supervisor as a controller station.

Installing the platform daemon

To run a Supervisor station on a PC, the system requires the installation of the platform management service
(daemon). If you just installed Workbench for the first time, chose to have the installation program load the
platform management service and launch the software, you can skip this procedure. You may need to re-install
the platform daemon as a step in troubleshooting station problems.

Step 1. To start the platform management service, click Start, expand the software version you installed,
and click Install Platform Daemon.

Miagara 4 Security 2.4,
Mew

Alarm Portal

Mew

Conzole

Mew

Install Platform Daemon

New

Workbench
Mew
Workbench (Conscle)

New

Briefly, a command prompt opens and the installation command runs. When the daemon is
successfully installed, the command prompt closes.

Step 2. To verify that the platform daemon is running, click Start > Control Panel > Administrative Tools >
Services, and double-click the Niagara service.
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Step 3.

Step 4.

General |ogOn Recovery Dependencies

Service name: Miagara
Display name: Miagara
Description: Platform management service for Niagara tools

Path to executable:
"C\Miagara“Ent Security-2 4 31 3\bin‘\niagarad .exe”

Startup type: Automatic e

Service status:  Running

Stop Pause esume

fou can specify the start parameters that apply when you start the service
from here.

0] 4 Cancel Apph

Make a mental note of the location of the daemon/Niagara service file: niagarad.exe.
Notice that you can check the status of the Niagara service, stop, pause, and resume it.

A compatible platform daemon/service works with each version of Niagara that is installed on a
PC, but only a single platform daemon can be running at a time.

To reinstall the daemon once Workbench is running, click Window > Console.
This opens a command prompt at the bottom of the About view.

The console is inside the red rectangle.

Type plat installdaemon and press Enter.

Verifying database services

Once you finish configuring the Supervisor’s database services you should go back and verify that all services
are functioning as expected. This procedure also applies when troubleshooting.

Prerequisites:
You are working in the web Ul and are logged in to the Supervisor station with admin privileges. This
procedure should follow a database driver installation, setting the Orion database, and a station reboot.

Step 1.

Step 2.
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If needed, click System Setup > Miscellaneous > Configure Database
The Configure Database view opens. The Database Services tab displays the status of the
database services.

Verify that all services are showing a status of {ok}. Check any associated error message to help
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find the cause of any status other than {ok}.

If your MySQL database user name is “root,” you may receive an error. Open the MySQL
Workbench, create a new user with a strong password, and update this view with the new User
Name and Password.

Step 3. To save any changed settings, click the Save button at the top of the view.
The save command opens the Restart Station window.

Step 4. To initiate a station restart, click the Ok.

Step 5. Verify settings after the station has restarted.

Failed certificate validation

All system components should use secure communication. Since each station (Supervisor and remote
controller) can serve as both a client and a server, each station requires a root CA certificate in its User Trust
Store and a server certificate signed by the root CA certificate in its User Key Store. Each connected device,
such as a camera may also require a server certificate signed by a root CA certificate.

Failure to add or join

An attempt to add or join a remote station to a Supervisor station is an example of a server (the remote
station) connecting to a client (the Supervisor station). If the remote controller station does not have a server
certificate signed by a root CA certificate in the Supervisor station’s system or user trust store, the add or join
fails and one or more error messages appear in the Remote Config window.

Figure 42. Foxs requires certificate approval for station join or add

Remote Config

3 Failed

q} Running  17-Feb-16 2:05 PM IST  Remote Station 'entSecurity601’ configuration

Q Failed 17-Feb-16 2:06 PM IST  Cannot complete reverse connection to address:ip:10.77.15.183 Details...

Q Failed 17-Feb-16 2:06 PM IST  Cannot complete reverse connection to address: ip:10.77.10.69, reverting to oldAddress Details...

Q Failed 17-Feb-16 2:06 PM IST Failed certificate validation, Mo trusted certificate found for station entSecurity. Please select below CertificateManager button for approval.
Q Failed 17-Feb-16 2:06 PM IST | Job Failed Details...

| Export ” CertificateManager I

If you get this message because the remote station presented its self-signed certificate, you may approve the
certificate and the add or join may complete, but a better solution is to figure out why the remote station
presented its self-signed certificate or, if it presented a signed server certificate, why the root CA certificate
that signed the server certificate is missing from the Supervisor station’s system or user trust store. Import the
correct certificates into each station’s trust store and attempt the add or join again.

NOTE: Relying on a self-signed certificate provides encryption only. It cannot verify server identity, which is
required to prevent man-in-the-middle attacks.

Failure to connect to a remote camera

A browser connection between a local station and a camera requires a secure connection. The browser, serving
as a client to a remote camera, requires the root CA certificate in its trust store that signed the server
certificate in the remote camera.

If these certificates are not in place, the camera will not connect to the browser, and through the browser to
the station. Refer to the “System Security” chapter in this document for how to work with certificates.
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Stopping and starting the Niagara service

This topic describes how to stop the Niagara service under Windows Services.

Step 1. On a Windows 10 system, click the Start menu and type Computer Management and click to
select it.
The operating system’s Computer Management window opens with three vertical panes.

Step 2. Inthe central pane, double-click Services and Applications, then double-click Services.
The system displays all services in the central pane.

A& Computer Management - m} x

File Action View Help
e @ o= HE »enw

A Computer Managem| | < Services Actions

v m System Tools 5 8 N e Descrioti Stat A | Services -
(@ Task Schedulq | Ni2gara ame escription atus
[ Event Viewer i &k Network Connection Broker  Brokers connections that allow Windows Store A..  Running More Actions
51 Shared Folder Stop the service O Network Connections Manages ohjects in the Network and Dial-Up Co..  Running
=l Restart the service " R R R . Niagara -
P Local Users ar £ Network Connectivity Assis... Provides DirectAccess status notification for Ul c...
'?Ei' Performance & Network List Service Identifies the networks te which the computer h..  Running More Actions 4
& Device Manac E‘E;”Ptm": et L Network Location Awareness  Collects and stores configuration information fo...  Running

w 25 Storage atform management service for Ok Network Setup Service The Metwork Setup Service manages the installat...

Niagara tools

Disk Manager: This service delivers network notifications (e.g. i..  Running

v [y Services and App gara Platform management service for Niagara tools Running
@ SQL Server Cg & Office Source Engine Saves installation files used for updates and repa...
Services L) Offline Files The Offline Files service performs maintenance a...
& WMI Control ‘&) OpenSSH Authentication A.. Agent to hold private keys used for public key a...
) Optimize drives Helps the computer run more efficiently by opti...
‘&) Parental Controls Enforces parental contrels for child accounts in ...

&) Payments and NFC/SE Man... Manages payments and Mear Field Communicat.. Running v
< »

-
]

\ Extended /(Standard

Step 3. To stop the service, right-click on the Niagara service and select Stop or Restart.

Step 4. To start the stopped service, right-click on the Niagara service and click Start.

Photo ID configuration troubleshooting

These conditions relate specifically to PhotolD.

| changed a property, but it did not change in the database.
Make sure that you saved the change before leaving the view.

| cannot connect to my PhotolD station.
Make sure that you have a good connection from the Supervisor to the PhotolD host platform. If the Photo ID
platform does not have a fixed IP address, the address may have changed.

Also, make sure that the EntsecAsurelD applet is running and has the correct settings. If settings have
changed, you may need to restart the applet, verify that you have a good Obix Network connection, and ping
the device to confirm the connection.

The EntsecAsurelD rejects credentials. | tried using an existing user. | created a new user with all roles.
None will log in. | also tried each authentication scheme, but to no avail. Can you help me set up the obix
user so it will log in?

The framework requires a special machine-to-machine user and password whose configuration defines the
HttpBasicScheme for server authentication and a user role with permissions that include read access to the
Obix Network. If you are setting up a new system, you must create and configure this user. If you upgraded
your station from NiagaraAX, the migration tool created an oBix user for you. You need to confirm the
configuration, set the password and configure the Photo ID Settings.
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After clicking the Discover button to discover a template or template data, EntsecAsurelD displays this
message.

Request to wake up Entsec Asure ID failed. Please refer the documentation to make sure that the Content Security Policy under Web Service is configured correctly.
404 error

Details

OK Cancel

The WebService Content-Security-Policy HTTP header provider needs to be configured. Refer to “Configuring
Asure ID secure communication” in the “Personnel setup” chapter of this guide.
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Chapter 15. Glossary

The following glossary entries relate specifically to the topics that are included as part of this document.
To find more glossary terms and definitions refer to glossaries in other individual documents.

Alphabetical listing

Alarm Class

Defines alarm routing options and priorities. Typical alarm classes include High, Medium and Low. An alarm
class of Low might send an email message, while an alarm class of High might trigger a text message to the
department manager.

web Ul

web user interface refers to the framework software used to access a platform and station, which runs in a
browser.

Orion database

A relational database system developed at Purdue University for managing uncertain, probabilistic data.
Implementations of this database include MySQL and MSSQL.
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